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Chapter 1

Introduction to DANZ Monitoring Fabric

This chapter introduces the DANZ Monitoring Fabric (DMF) and the user interfaces for out-of-band monitoring
and configuration.

1.1  Overview

DANZ Monitoring Fabric (DMF) is a cloud-first Network Packet Broker (NPB) that provides a single pane of
glass with an integrated visibility fabric. The DMF solution includes NPB functionality with the DMF Recorder
Node and the Analytics Node for deeper monitoring and pervasive security of out-of-band workloads in hybrid
cloud deployments.

DMF leverages an SDN-controlled fabric using high-performance, open networking (white box/brite box)
switches and industry-standard x86 servers to deploy highly scalable and flexible network visibility and
security solutions. Traditional, box-based, hardware-centric NPBs are architecturally limited when trying
to meet the evolving security and visibility demands of Cloud Native data centers. DMF addresses the
challenges of traditional NPB solutions by enabling a scale-out fabric for enterprise-wide security and
monitoring, a single pane of glass for operational simplicity, and multi-tenancy for multiple IT teams, including
NetOps, DevOps, and SecOps.

1.2  Out-of-band Monitoring with DANZ Monitoring Fabric

As data center networks move toward 40/100G designs, cloud computing, hyper scale data analytics, and
5G mobile services, traffic monitoring must transition to next-generation designs. To manage the modern
data center, much network traffic must be copied and aggregated from TAP or SPAN ports and forwarded to
monitoring and analysis tools. These tools, used in managing network performance, application performance,
security, and compliance, leverage other systems such as data recorders, intrusion detection systems, data
leakage detectors, SLA measurement devices, and other traffic analyzers like Wireshark.

DANZ Monitoring Fabric (DMF) uses high-performance open-networking switches to deliver an open,
production-grade, and scalable monitoring solution based on Software Defined Networking (SDN) technology.
The centralized DMF Controller provides flexibility, simplifies policy management and monitoring fabric
configuration, and supports cost-effective monitoring of data centers and remote sites or branches with up to
several thousand TAP and SPAN ports.

DMF architecture, inspired by hyper scale networking designs, consists of the following components:

• HA pair of SDN-enabled DMF Controllers (VMs or hardware appliances), enable simplified and centralized
configuration, monitoring, and troubleshooting.

• Arista Networks SDN-enabled Switch Light OS is a production-grade, ONIE-deployable, lightweight OS
that runs on DMF Ethernet switches.

• Open Ethernet switches (white box/brite box) use the same merchant silicon ASICs used by most
incumbent switch vendors and are widely deployed in production data center networks. These switches
ship with an Open Network Install Environment (ONIE) for automatic and vendor-agnostic installation of
third-party network OS.

• DANZ Service Nodes (optional), a Data Plane Development Kit (DPDK)-powered, x86-based appliances
that connect to the DMF singly or as part of a service node chain. The service node provides advanced
packet functions, such as deduplication, packet slicing, header stripping, regex matching, packet masking,
UDP replication, and IPFIX/NetFlow generation.

1



 

• DANZ Recorder Nodes (optional) are x86-based appliances connected to the DMF and are managed via
the DMF Controller to provide petabyte packet recording, querying, and replay functions.

• Analytics Nodes (optional) are x86-based appliances that integrate with the DMF to provide multi-terabit,
security, and performance analytics with configurable, historical time-series dashboards.

Figure 1-1: Out-of-Band Monitoring with DANZ Monitoring Fabric

DMF lets a network operator easily deploy data center-wide monitoring with the following benefits:

• Organization-wide visibility: delivers traffic from any TAP to any tool at any time across one or
multiple locations.

• Flexible, scale-out fabric deployment: supports a large number of 1G, 10G, 25G, 40G, and 100G ports
(thousands per fabric).

• Multi-tenant tap and tool sharing: supports monitoring by multiple teams to enable Monitoring Fabric as
a Service.

• Massive operational simplification: provides a single pane of glass for provisioning, management,
monitoring, and debugging through a centralized SDN Controller. This feature eliminates the need for box-
by-box configuration.

• Centralized programmability: a REST-based API architecture enables event-based, centralized policy
management and automation for integrated end-to-end IT work flows. This feature leverages DMF Service
Nodes, Analytics Nodes, and Recorder Nodes.

• Dramatic cost savings: Achieving a significant reduction in the total cost of ownership by using open
Ethernet switches in combination with industry-standard x86 servers, optimized usage of tools, and SDN-
enabled operations and automation.

1.3  Using the DANZ Monitoring Fabric CLI

Before connecting to the DANZ Monitoring Fabric (DMF) Controller, ensure the DMF application is running.
Log in to the DMF Controller using the local console or SSH to the address assigned to the DMF Controller
during installation.

Note:  Make all fabric switch configuration changes using the Controller CLI, which provides
configuration options in the config-switch submode for each switch. Do not log in to the switch to
make changes directly using the switch CLI.

Mode and sub-modes divide CLI commands, which restrict commands to the appropriate context. The main
modes and their available commands are as follows:

2
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• login mode: commands available immediately after logging in, with the broadest possible context.
• enable mode: commands that are available only after entering the enable command.
• config mode: commands that significantly affect system configuration and can only be entered after

entering the configure command. The user can also access submodes from this mode.

Enter submodes from config mode to provision specific monitoring fabric objects. For example, the switch
switchname command changes the CLI prompt to (config-switch)# and lets the user configure the
switch identified by the switch name.

When the user logs in via SSH to the Controller, the CLI appears in login mode, where the default prompt is
the system name followed by a greater than sign (>), as shown below:

controller-1>

To change the CLI to enable mode, enter the enable command. The default prompt for enable mode is the
system name followed by a pound sign (#), as shown below:

controller-1> enable
controller-1#

To change to config mode, enter the configure command. The default prompt for config mode is the system
name followed by (config)#, as shown below:

controller-1> config
controller-1(config)#

To change to a submode, enter the command from config mode, followed by any object identifier required, as
in the following example:

controller-1(config)# switch filter-switch-1
controller-1(config-switch)# interface ethernet54
controller-1(config-switch-if)#

To return to enable mode, type end, as shown below:

controller-1(config)# end
controller-1#

To view the path to the current CLI prompt, enter the show this command from any nested submode, as in
the following example:

controller-1(config-switch-if)# show this
! switch
switch filter-switch-1
interface ethernet54

To view details about the configuration, enter the show this details command, as in the
following example:

controller-1(config-switch-if)# show this details
! switch
switch filter-switch-1
!
interface ethernet54
no force-link-up
no optics-always-enabled
no shutdown
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To view a list of available commands in the current or submode, enter the help command.

controller-1> help
For help on specific commands: help <command>
Commands:
%<n>                     Move job to foreground
debug
echo                     Print remaining arguments
enable                   Enter enable mode
exit                     Exit submode
help                     Show help
history                  Show commands recently executed
logout                   Logout
no                       Prefix existing commands to delete item
ping                     Send echo messages
ping6                    Send echo messages
profile                  Configure user profile
reauth                   Reauthenticate
set                      Manage CLI sessions settings
show
support                  Generate diagnostic data bundle for technical support
terminal                 Manage CLI sessions settings
topic                    Show documentation on topic
upload                   Upload diagnostic data bundle for technical support
watch                    Show output of other commands
whoami                   Identify the current authenticated account
workflow                 Show workflow documentation
controller-1>

To view detailed online help for the command, enter the help command followed by the command.

controller-1> help support
Support Command:         Generate diagnostic data bundle for technical support
Support Command Syntax:  no support skip-switches skip-cluster skip-service-
nodes 
                         skip-recorder-nodes sequential support [[skip-switch
es]
                         [skip-cluster] [skip-service-nodes]
                         [skip-recorder-nodes] [sequential]]
Next Keyword Descriptions:
sequential:              Use sequential (non-parallel) fallback collection
 mode, which will be slower 
                         but use fewer resources.
skip-cluster:            Skip cluster information from the collection.
skip-recorder-nodes:     Skip recorder nodes information from the collection.
skip-service-nodes:      Skip service nodes information from the collection.
skip-switches:           Skip switches information from the collection.
Support Command:         Generate diagnostic data bundle for technical support
Support Command Syntax:  no support skip-switches skip-cluster skip-service-
nodes
                         skip-recorder-nodes sequential support [[skip-switch
es]
                         [skip-cluster] [skip-service-nodes] [skip-recorder-
nodes] [sequential]]
Next Keyword Descriptions:
sequential:              Use sequential (non-parallel) fallback collection
 mode, which will be slower
                         but use fewer resources.
skip-cluster:            Skip cluster information from the collection.
skip-recorder-nodes:     Skip recorder nodes information from the collection.
skip-service-nodes:      Skip service nodes information from the collection.
skip-switches:           Skip switches information from the collection.
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controller-1>

To display the options available for a command or keyword, enter the command or keyword followed by a
question mark (?).

controller-1> support ?
<cr>
sequential               Use sequential (non-parallel) fallback collection
 mode, which will be slower
                         but use fewer resources.
skip-cluster             Skip cluster information from the collection.
skip-recorder-nodes      Skip recorder nodes information from the collection.
skip-service-nodes       Skip service nodes information from the collection.
skip-switches            Skip switches information from the collection.
controller-1>

To view any command's permitted values or keywords, enter the command followed by a space and press
the <Tab> key. The command completion feature displays a concise list of permitted values, as in the
following example:

controller-1> support <TAB>
<cr> sequential skip-cluster
skip-recorder-nodes skip-service-nodes skip-switches
controller-1>

For information about managing administrative access to the DMF Controller, refer to the DANZ Monitoring
Fabric 8.4 Deployment Guide.

1.4  Using the DANZ Monitoring Fabric GUI

The DANZ Monitoring Fabric (DMF) Graphical User Interface (GUI) performs similar operations to the CLI
using a graphic user interface instead of text commands and options. The DMF GUI is compatible with recent
versions of any of the following supported browsers:

• Mozilla Firefox
• Google Chrome
• Microsoft Edge
• Internet Explorer
• Apple Safari

To connect to the DMF GUI, use the DMF Controller IP address. Use the virtual IP (VIP) assigned to the
cluster if configured during deployment. Using the VIP ensures that the user connects to the current active
Controller, regardless of any failover that may have occurred.

Use the active Controller for all configuration operations and to obtain reliable information when monitoring
DMF. The standby Controller is provided only for redundancy if the active Controller becomes unavailable.
Do not perform any configuration using the standby Controller, and any information displayed may not be
accurate. The figure below illustrates connecting to the DMF GUI using HTTPS (port 443) at the IP address
192.168.17.233

Figure 1-2: Connecting to the DANZ Monitoring Fabric GUI
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Connecting to the Controller for the first time may result in a security exception prompt (message) because
the Controller HTTPS server uses an unknown (self-signed) certificate authority.

Note:  When using Internet Explorer, the login attempt may fail if the system time is different than the
Controller time. To remedy this, ensure the system used to log in to the Controller is synchronized with
the Controller.

After accepting the prompts, the system displays the login prompt, shown in the figure below.
Figure 1-3: DANZ Monitoring Fabric GUI Login Prompt

Use the admin username and password configured for the DMF Controller during installation or any user
account and password configured with administrator privileges. A user in the read-only group will have access
to options for monitoring fabric configuration and activity but cannot change the configuration.
Figure 1-4: DANZ Monitoring Fabric GUI Main Menu

When logging in to the DMF GUI, a landing page appears. This page shows the DMF Controller Overview,
dashboard, and a menu bar (pictured above) with sub-menus containing options for setting up DMF and
monitoring network activity. The menu bar includes the following sub-menus:

• Fabric: manage DMF switches and interfaces.
• Monitoring: manage DMF policies, services, and interfaces.
• Maintenance: configure fabric-wide settings (clock, SNMP, AAA, sFlow, Logging, Analytics Configuration).
• Integration: manage the integration of vCenter instances to allow monitoring traffic using DMF.
• Security: manage administrative access.
• A profile page that displays or edits user preferences, the ability to change the password or sign out.
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The newly designed dashboard displays information about the Controller, including switches, interfaces,
policies, and Smart Nodes.
Figure 1-5: DMF Controller Overview

The header displays the following basic information about the Controller:

• Active IP address
• Standby IP address
• Virtual IP address
• Redundancy Status - The status contains an informational tool tip that can be hovered for more details.

Four cards control the type of content displayed on the main section of the page. The cards are:

• Controller Health
• Switch Health
• Policy Health
• Smart Node Health
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Note:  This dashboard is on by default in the Settings page under the Navigation section. Toggling off
displays the previous dashboard, as illustrated below.

Figure 1-6: Legacy Dashboard

1.4.1  DMF Features Page

To navigate the DMF Features Page, click on the gear icon in the navigation bar.
Figure 1-7: Gear Icon
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Page Layout

All fabric-wide configuration settings required in advanced use cases for deploying DMF policies appear in the
new DMF Features Page.
Figure 1-8: DMF Features Page

The fabric-wide options used with DMF policies include the following:

Table 1: Feature Set

Auto VLAN Mode Auto VLAN Range

Auto VLAN Strip Control Plane Lockdown Mode

CRC Check Custom Priority

Device Deployment Mode Global PTP Settings

Inport Mask Match Mode

Policy Overlap Limit Policy Overlap Limit Strict

Retain User Policy VLAN Timestamp Settings

Tunneling VLAN Preservation

Each card on the page corresponds to a feature set.
Figure 1-9: Feature Set Card
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The UI displays the following:

• Feature Title
• A brief description
• View / Hide Detailed Information
• Current Setting
• Edit Link - Use the Edit button (pencil icon) to change the value.

View Detailed Information

Each configuration option has detailed information. For more details, click the View Detailed Information link
on each card.
Figure 1-10: View Detailed Information

Feature Settings

Auto VLAN Strip

1. A toggle button controls the configuration of this feature. Locate the corresponding card and click the
toggle switch.
Figure 1-11: Toggle Switch
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2. A confirm window pops up, displaying the corresponding prompt message. Click the Enable button to
confirm the configuration changes or the Cancel button to cancel the configuration. Conversely, to disable
the configuration, click Disable.
Figure 1-12: Confirm / Enable

3. Review any warning messages that appear in the confirmation window during the configuration process.
Figure 1-13: Warning Message - Changing

The following feature sets work in the same manner as the Auto VLAN Strip feature described above.

• CRC Check
• Custom Priority
• Inport Mask
• Policy Overlap Limit Strict
• Retain User Policy VLAN
• Tunneling

Auto VLAN Mode

1. Control the configuration of this feature using the Edit icon by locating the corresponding card and clicking
on the pencil icon.
Figure 1-14: Auto VLAN Mode Config
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2. A confirmation edit dialogue window appears, displaying the corresponding prompt message.
Figure 1-15: Edit VLAN Mode

3. To configure different modes, click the drop-down arrow to open the menu.
Figure 1-16: Drop-down Example
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4. From the drop-down menu, select and click on the desired mode.
Figure 1-17: Push Per Policy

5. Alternatively, you can directly input the desired mode name in the input area.
Figure 1-18: Push Per Policy
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6. Click the Submit button to confirm the configuration changes or the Cancel button to discard the changes.
Figure 1-19: Submit Button

7. After successfully setting the configuration, the current configuration status displays next to the edit button.
Figure 1-20: Current Configuration Status

The following feature sets work in the same manner as the Auto VLAN Mode feature described above.

• Device Deployment Mode
• Match Mode
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Auto VLAN Range

1. Control the configuration of this feature using the Edit icon by locating the corresponding card and clicking
on the pencil icon.
Figure 1-21: Edit Auto VLAN Range

2. A configuration edit dialogue window pops up, displaying the corresponding prompt message. The Auto
VLAN Range defaults to 1 - 4094.
Figure 1-22: Edit Auto VLAN Range
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3. Click on the Custom button to configure the custom range.
Figure 1-23: Custom Button

4. Adjust range value (minimum value: 1, maximum value: 4094). There are three ways to adjust the value of
a range:

• Directly enter the desired value in the input area, with the left side representing the minimum value of
the range and the right side representing the maximum value.

• Adjust the value by dragging the slider using a mouse. The left knob represents the minimum value of
the range, while the right knob represents the maximum value.

• Use the up and down arrow buttons in the input area to adjust the value accordingly. Pressing the up
arrow increments the value by 1, while pressing the down arrow decrements it by 1.

5. Click the Submit button to confirm the configuration changes or the Cancel button to discard the changes.
6. After successfully setting the configuration, the current configuration status displays next to the edit button.

Figure 1-24: Configuration Change Success

Policy Overlap Limit

1. Control the configuration of this feature using the Edit icon by locating the corresponding card and clicking
on the pencil icon.
Figure 1-25: Policy Overlap Limit
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2. A configuration edit dialogue window pops up, displaying the corresponding prompt message. By default,
the Policy Overlap Limit is 4.
Figure 1-26: Edit Policy Overlap Limit

3. Adjust the Value (minimum value: 0, maximum value: 10). There are two ways to adjust the value:

• Directly enter the desired value in the input area.
• Use the up and down arrow buttons in the input area to adjust the value accordingly. Pressing the up

arrow increments the value by 1, while pressing the down arrow decrements it by 1.
4. Click the Submit button to confirm the configuration changes or the Cancel button to discard the changes.
5. After successfully setting the configuration, the current configuration status displays next to the edit button.

Figure 1-27: Policy Overlap Limit Change Success

VLAN Preservation

1. Control the configuration of this feature using the Edit icon by locating the corresponding card and clicking
on the pencil icon.

Figure 1-28: VLAN Preservation Feature Set

2. A configuration edit dialogue window appears displaying the corresponding prompt message. The VLAN
Preservation defaults to:
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• Preserve User Configured VLANS: Off
• Preserve VLAN: No VLAN Configured

3. To configure Preserve User Configured VLANs, toggle on the switch.
Figure 1-29: Edit VLAN Preservation Configuration

4. To configure Preserve VLAN, click the Add VLAN button to add a configuration area for preserving the
VLAN value.
Figure 1-30: Preserve VLAN - Add VLAN

5. Click the drop-down button. There are two ways to configure the preserved VLAN value (minimum value:
1, maximum value: 4094) and a method to delete an entry.
Figure 1-31: VLAN Single Example
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• Add Single: Choose Single in the VLAN drop-down menu, and type in the value in the input area.
Figure 1-32: Add Single VLAN

• Add Range: Choose Range in the VLAN drop-down menu, and type in the input area's minimum and
maximum values.
Figure 1-33: Add VLAN Range

• Delete: Since there must be a corresponding number in the value input area when submitting the
configuration, when accidentally adding multiple redundant VLAN configuration areas, delete the

corresponding rows by clicking the red trash can icon .

Note:  The feature supports combinations of any number of single values and any number of range
values.

6. Click the Submit button confirm the configuration changes or the Cancel button to discard the changes.
7. After successfully setting the configuration, the current configuration status displays next to the edit button.

Figure 1-34: Preserve VLAN Configuration Change

Global PTP Settings

1. Control the configuration of this feature using the Edit icon by locating the corresponding card and clicking
on the pencil icon.

Figure 1-35: Global PTP Settings
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2. A configuration edit dialogue window appears displaying the corresponding prompt message. By default,
these features are not configured. Enter the desired configuration value in the corresponding input area.
Hover over the question mark icon to obtain additional explanatory information.
Figure 1-36: Edit PTP Settings

3. Click the Submit button to confirm the configuration changes or the Cancel button to discard the changes.
4. After successfully setting the configuration, the current configuration status displays next to the edit button.

Figure 1-37: PTP Timestamping Configuration Change

Feature Setting Notification Message

Successfully configuring a feature results in a success notification message pop-up with specific details.
Figure 1-38: Success Message
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Whenever an error occurs during the configuration of a feature, an error notification message pops up along
with specific details about the error.
Figure 1-39: Failure Message

Control Plane Lockdown Mode
Enable or disable the Control Plane Lockdown Mode feature.
1. A toggle button controls the configuration of this feature. Locate the corresponding card and click the

toggle switch.
Figure 1-40: Control Plane Lockdown Mode

2. Click the Enable button to enable Control Plane Lockdown Mode or the Cancel button to discard the
changes.
Figure 1-41: Enable Control Plane Lockdown Mode

Note:  Changing the Control Plane Lockdown Mode may cause some service interruption during
the transition.

21



 

3. On enabling Control Plane Lockdown Mode, a success notification message pops up with specific details.
Figure 1-42: Success Message

Timestamp Settings

1. Control the configuration of this feature using the Edit icon by locating the corresponding card and clicking
on the pencil icon.

Figure 1-43: Timestamp Settings

2. To configure different header modes, click on the drop-down arrow. There are two ways to edit the
timestamp settings - Replace Source MAC or Add Header after L2.
Figure 1-44: Edit Timestamp Settings
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3. For Add Header after L2 Mode, choose the header format as 48-bit or 64-bit.
Figure 1-45: Add Header after L2

4. Click the Submit button to confirm the configuration changes or the Cancel button to discard the changes.
Figure 1-46: Submit Timestamp Changes

5. Select Replace Source MAC Mode and Click the Submit button to confirm the configuration changes or
the Cancel button to discard the changes.
Figure 1-47: Replace Source MAC
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6. On enabling Timestamp Settings, a success notification message pops up with specific details.
Figure 1-48: Success Message

1.4.2  Dashboard Layout

The dashboard data displays four tabs:

• Controller Health
• Switch Health
• Policy Health
• Smart Node Health

Each tab has health indicators for that category, and accessing the tab displays the relevant data below.
Figure 1-49: DANZ Monitoring Fabric (DMF) Controller Tabs

If a category contains errors or warnings, clicking on the message in the tab opens a details window. It
displays the number of errors or warnings filtered by tab category.
Figure 1-50: Filtered by Category
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Review errors by clicking the bell icon on the right side of the Navigation bar, and it will list all fabric errors and
warnings instead of filtering by an individual tab.
Figure 1-51: Notification Bell

1.4.3  Controller Health

DANZ Monitoring Fabric (DMF) Interface Utilization

This widget displays the utilization of each DMF interface as follows:

• DMF Interface Name
• Interface Role
• Traffic Direction
• Current Utilization (%)
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• Peak Utilization (%)
Figure 1-52: DMF Interface Utilization

The bar indicates the current utilization and shows peak utilization with a vertical line. The color of the bar and
percentage changes depending on the utilization:

• Red means the utilization percentage is greater than 95%.
• Yellow means the utilization percentage is greater than 70%.
• Green means the utilization percentage is less than 70%.

Filter interfaces display only RX traffic, while delivery interfaces display only TX traffic. Other roles with
bidirectional data can have one item for each direction of traffic, RX, or TX.
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The Show All button directs you to the DMF Interfaces page.

On hover, the bar shows the interface’s Bit Rate, Peak Bit Rate, and Speed in bits per second.
Figure 1-53: DMF Interface Utilization Hover Details

Sort interfaces by Interface Name or Current Utilization. The interfaces are sorted by current utilization
(descending order) by default.
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Display the interfaces by filtering using Role, Traffic Direction, and Current Utilization.
Figure 1-54: Sort Roles
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Top DMF Interfaces by Traffic

This visualization displays each DMF interface's traffic (bit rate and packet rate).
Figure 1-55: Top DMF Interfaces by Traffic

The widget shows each interface's traffic direction, DMF Interface name, bit rate, and packet rate. The Show
All button directs you to the DMF Interfaces page. Sort interfaces by Bit Rate and filter by Metric and Role. By
default, DMF sorts the data in descending order of bit rate.

On hover, the widget shows the DMF name, bit rate, and packet rate.
Figure 1-56: Top DMF Interfaces by Traffic Hover Details

Top Policies
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The widget displays the top policies in DMF. For each policy, traffic is determined by totaling the traffic of each
of its configured filter interfaces.
Figure 1-57: DMF Top Policies

For each policy, the bar chart shows the following:

• Policy Name
• The sum of the bit rates of all filter interfaces associated with the policy.
• The sum of the packet rates of all filter interfaces associated with the policy.

On hover, the bar displays the policy name, bit rate, and packet rate.
Figure 1-58: DMF Policies Hover Details

Sort policies by Bit Rate and filter by Metric. By default, DMF sorts the policies in descending order of bit rate.

The Show All button directs you to the Policies page.
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1.4.4  Switch Health

Interface Usage Summary

This widget displays the usage statistics for all DANZ Monitoring Fabric (DMF) interfaces. The interface
utilization groups all active interfaces:

• Red means that the utilization percentage is greater than 95%.
• Yellow means that the utilization percentage is greater than 70%.
• Green means that the utilization percentage is less than 70%.
Figure 1-59: DMF Interface Usage Summary

There are three other categories for DMF Interfaces with no traffic. These appear beneath the Usage Bar:

• Admin Shutdown
• Link Down
• Unknown - when Interface Speed is undefined or not known
• Total Capacity Used displays with Total Capacity defined as the number of Active DMF Interfaces divided

by the Number of Total DMF Interfaces

On hover, the number of interfaces in each category appears in the respective usage bar.
Figure 1-60: DMF Interface Usage Hover Details

Switch Usage Summary

This widget displays the usage statistics for each switch. All switches are grouped by:

• Active (Green)
• Admin Shutdown (Yellow)
• Down (Red)
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• Quarantined (Grey)
Figure 1-61: DMF Switch Usage Summary

The total number of switches is displayed.

Three list items display the number of:

• Switches Admin Shutdown
• Switches Down
• Switches Quarantined

On hover, the number of switches in each category appears in the respective usage bar.
Figure 1-62: DMF Switch Usage Hover Details

TCAM Usage Summary

This widget displays the usage statistics for the TCAM of each switch and groups all active TCAMs by usage:

• Red means that the utilization percentage is greater than 95%.
• Yellow means that the utilization percentage is greater than 70%.
• Green means that the utilization percentage is less than 70%.
• Grey means that the utilization is Unknown.
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• A switch is grouped in the Unknown category when no TCAM usage statistics are available, generally
from a switch being shut down or disconnected.

Figure 1-63: DMF TCAM Usage Summary

The View Details link directs you to the TCAM Utilization tab of the Switches page.

Below the Usage Bar, there are three list items displaying:

• Switch Usage 71% - 95%
• Switch Usage 96% - 100%
• Unknown

On hover, the number of switches in each category appears in the respective usage bar.
Figure 1-64: DMF TCAM Utilization Hover Details

DMF Interface Utilization

DMF Interface Utilization is similar to the data displayed in the Controller Health tab. Please refer to its
description for more information.

Switch Utilization

This widget contains two tabs:

• Switch Usage
• TCAM Usage

Switch Usage
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The Switch Usage tab of the Switch Utilization displays essential information for each switch, including the
use of each switch interface and alerts for any warnings or errors.
Figure 1-65: DMF Switch Usage Tab

The widget displays the following data for each switch:

• Switch Name (contains a link to the Switches page for that specific switch).
• Switch Usage: Each section represents the number of interfaces with a specific role.
• Total Usage: Displays the Number of Interfaces with an assigned role divided by the Total Number of

Interfaces on the switch.
• Alerts: This column displays any alerts related to interfaces.

• The yellow badge indicates the number of warnings, while the red badge shows the number of errors.

The Switch Usage column contains the number of interfaces for each role:

• Filter
• Delivery
• Filter & Delivery
• Core
• Recorder Node
• Service
• PTP
• MLAG Core
• MLAG Delivery.

Three columns can sort the table:

• Sort the Switch Name column in alphabetical order.
• Sort the Total Usage column by percentage (%) usage (# used interfaces / # total interfaces).
• Sort the Alerts column by the total number of alerts (# warnings + # errors).

The default sort order for this table is the Alerts column in descending order, which ensures the switches with
the highest number of alerts are initially at the top.

34



Introduction to DANZ Monitoring Fabric

On hover, the number of each interface appears.
Figure 1-66: DMF Switch Usage Filter Interfaces Hover Details

While hovering over the warnings or alerts badge, a table appears and displays Warnings for the yellow
badge and Errors for the red badge, and it will also show the switch name.

Each row of the table contains the following:

• Interface name (includes a link to Interfaces/[INTERFACE-NAME] page)
• Interface role
• Alert type (e.g., Down Delivery Interface)
Figure 1-67: DMF Interface Warnings
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When data is unavailable for a switch (C1), there will be a yellow badge under the Switch Name that says
Data Not Available. The Switch Usage column will have an empty usage bar, the Total Usage Column will
show 0 (zero) for the number of currently used interfaces, and the Alerts column will be empty.
Figure 1-68: DMF Switch Usage - Data Not Available

When a switch is down, a red badge appears under the Switch Name that says Switch Not Connected. The
other columns will be empty in the same way as the Data Not Available case.
Figure 1-69: DMF Switch Usage - Switch Not Connected

TCAM Usage
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The TCAM Usage widget displays the current utilization of the TCAMs for each active switch. A switch can
have a TCAM for IPv4, IPv6, or both. Each TCAM has a guaranteed maximum usage and current utilization.
This table compares the current utilization of each TCAM to its guaranteed maximum.
Figure 1-70: DMF Usage (Policy Usage Only)

This widget displays a TCAM Usage chart for each switch:

• The purple bar shows IPv4 Current Utilization and Guaranteed Maximum.
• The cyan bar shows IPv6 Current Utilization and Guaranteed Maximum.
• Each row will display Current Utilization (IPv4 + IPv6 Current Utilization)
• Sort by Switch Name and Current Utilization.
• Sort the Switch Name column alphabetically (descending and ascending).
• Sort the Current Utilization column in descending and ascending order (IPv4 + IPv6 Current Utilization).
• The default sort order for the table is the Current Utilization column in descending order, ensuring the

switches with the highest current utilization display first.

Top DMF Interfaces by Traffic

The visualization shows DMF interface traffic (bit rate and packet rate) color-coded by interface role. The roles
displayed are:

• Core
• Delivery
• Filter
• Filter & Delivery
• MLAG Core
• MLAG Delivery
• Recorder Node
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• Service
Figure 1-71: DMF Top Interfaces by Traffic

For each interface, the chart item shows:

• Interface role
• Traffic direction
• DMF interface name
• Bit rate
• Packet rate

The Show All button directs you to the DMF Interfaces page.

Sort the interfaces by bit rate, which, by default, are sorted in descending bit rate order. Filter interfaces by
interface role using the drop-down.
Figure 1-72: DMF Sort Interfaces by Bit Rate

1.4.5  Policy Health

Policies Usage by Traffic

This widget displays policy traffic. For each policy, the bar chart shows:

• Name of the policy
• Bit rate
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• Packet rate
Figure 1-73: DANZ Monitoring Fabric (DMF) Policies Usage by Traffic

On hover, similar information displays.

Sort policies by Bit Rate.

The Show All button directs you to the Policies page.

Active Interfaces by Policy

The table displays DMF interfaces associated with policies. DMF interfaces that are not associated with a
policy are not displayed.
Figure 1-74: DMF Active Interfaces by Policy

The table contains the following columns:

• DMF Interface Name: The DMF name of the switch interface.
• Role: The role of the interface.
• Policy Name(s): A list of the policies associated with the interface.
• Bit Rate: The bit rate of the interface.
• Packet Rate: The packet rate of the interface.

The Show All button directs you to the DMF Interfaces page.

Sort the table by each column; DMF sorts the items in descending bit rate order by default.
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Two filters, Roles and Interfaces, allow data sorting by interface role and DMF interface name.
Figure 1-75: DMF Active Interfaces by Policy - Roles

Figure 1-76: DMF Active Interfaces by Policy - Interfaces

1.4.6  Smart Node Health

Recorder Node

The Recorder Nodes table displays Recorder Node health and the following columns:

• Recorder Node Name
• IP Address
• MAC Address
• Recording

• Indicates the status of the Recorder Node recording configuration, either Yes or No.
• Storage Utilization
• Index and Packet disk storage utilization % (percentage) using the following colors:

• Red means the utilization percentage is greater than 95%.
• Yellow means the utilization percentage is greater than 70%.
• Green means the utilization percentage is less than 70%.

Figure 1-77: Recorder Nodes

On hover, various details appear depending on the column selected. These include:

• Free and Total Disk Usage
• Backup Storage Utilization
• Index and Packet backup disk storage utilization % (percentage) using the following colors.

• Red means the utilization percentage is greater than 95%.
• Yellow means the utilization percentage is greater than 70%.
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• Green means the utilization percentage is less than 70%.
• Virtual Disk Health
• Status of Index and Packet virtual disks:

• Green means the virtual disk’s health is good.
• Red means the value of the virtual disk’s health is bad.

• Recorder Node Fabric Interface

• Shows the DMF interface name and its status where the Recorder Node connects to the DMF Fabric.
• Switch, Interface, and status
• Zero Touch State
• Alerts
• Errors and warnings for the Recorder Node - Hovering over an error displays additional information about

the errors and warnings.

The following are examples of detailed information when hovering.
Figure 1-78: Example - Index Disk Storage

Figure 1-79: Example - Index Backup Disk Storage

Figure 1-80: Example - Recorder Node Fabric Interface

Figure 1-81: Example - Errors

The View All link takes you to the Recorder Node page.

Service Node

The Service Nodes table displays Service Node health and the following columns:

• Service Node Name
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• IP Address
• Service Node Interface Load
• Zero Touch State
Figure 1-82: DANZ Monitoring Fabric (DMF) Service Nodes

Hovering over the Service Node Interface Load column displays:

• Interface Name
• Service Name
• Action
Figure 1-83: DMF Service Nodes Hover Details

The View All link takes you to the Service Node page.

Analytics Node

The Analytics Node table displays Analytics Node health and the following columns:

• IP Address: The IP address of the configured Analytics Node.

• Clicking on the IP Address opens the Analytics Node UI.
• Redis Status

• Displays the status in green if healthy, along with the last updated timestamp.
• Displays the status in red if unhealthy, along with the latest updated timestamp.

• Replicated Redis Status

• Displays the status in green if healthy, along with the latest updated timestamp.
• Displays the status in red if unhealthy, along with the latest updated timestamp

Figure 1-84: DMF Analytics Node

42



Introduction to DANZ Monitoring Fabric

The View Details link takes you to the Analytics Node details page.

Refreshing Data

Data automatically refreshes every minute, and interface topology data automatically refreshes every 10
seconds.

Manually refresh dashboard data using the Refresh button.

1.4.7  Empty State

When there are no provisioned switches, DANZ Monitoring Fabric (DMF) Interface Utilization and Top DMF
Interfaces by Traffic will display an Empty Component.

Each empty component contains a link to provision a switch. The system prompts the user to create a DMF
interface if there are provisioned switches but no assigned DMF interfaces.
Figure 1-85: DMF Controller Overview - Empty State

Top Policies will display an Empty Component if no policies exist.
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Use the Create Policy button to go to the Create Policy page.
Figure 1-86: DMF Switch Health - Empty State

The Usage Summary components will display Unused or No Switches Connected for the usage bar legend.
Figure 1-87: DMF Policy Health - Empty State

Policies Usage by Traffic displays the same Empty Component as Top Policies.
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Chapter 2

Managing DMF Switches and Interfaces

This chapter describes the basic configuration required to deploy and manage DANZ Monitoring Fabric (DMF)
switches and interfaces.

2.1  Overriding the Default Configuration for a Switch

By default, each switch inherits its configuration from the DANZ Monitoring Fabric (DMF) Controller. Use
the following pages of the Configure Switch dialog to override the following configuration options for a
specific switch.

• Info
• Clock
• SNMP
• SNMP traps
• Logging
• TACACS
• sFlow
• LAG enhanced hash

2.1.1  CLI Configuration

To use the CLI to manage switch configuration, enter the following commands to enter the config-switch
submode.

controller-1(config)# switch <switch-name>

Replace the switch-name with the alias you assigned to each switch during installation, as in the
following example.

controller-1(config)# switch DMF-SWITCH-1
controller-1(config-switch)#

From this submode, you can configure the specific switch and override the default configuration pushed from
the DANZ Monitoring Fabric (DMF) Controller to the switch.

The DANZ Monitoring Fabric 8.5 Deployment Guide provides detailed instructions on overriding the
switch's default configuration..

2.2  DMF Interfaces

To monitor traffic, you assign a role to each of the DANZ Monitoring Fabric (DMF) interfaces, which can be of
the following four types:

• Filter interfaces: ports where traffic enters the DMF. Use filter interfaces to TAP or SPAN ports from
production networks.

• Delivery interfaces: ports where traffic leaves the DMF. Use delivery interfaces to connect to
troubleshooting, monitoring, and compliance tools. These include Network Performance Monitoring (NPM),
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Application Performance Monitoring (APM), data recorders, security (DDoS, Advanced Threat Protection,
Intrusion Detection, etc.), and SLA measurement tools.

• Filter and delivery interfaces: ports with both incoming and outgoing traffic. When placing the port in
loopback mode, use a filter and delivery interface to send outgoing traffic back into the switch for further
processing. To reduce cost, use a filter and delivery interface when transmit and receive cables are
connected to two separate devices.

• Service interfaces: interfaces connected to third-party services or network packet brokers, including any
interface that sends or receives traffic to or from an NPB.

In addition, interfaces connected to managed service nodes and DANZ recorder nodes can be referenced in
the configuration directly without assigning a role explicitly. Also, Inter-Switch Links (ISLs), which interconnect
DANZ monitoring switches, are automatically detected and referred to as core interfaces.

2.2.1  Using the GUI to Configure a DMF Filter or Delivery Interface

To use the DANZ Monitoring Fabric (DMF) GUI to configure a fabric interface as a filter or delivery interface,
complete the following steps:
1. Select Monitoring > Interfaces from the main menu to display the DMF interfaces.

Figure 2-1: DMF Interfaces
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2. Click the provision control (+) in the Interfaces table to configure a new interface.
Figure 2-2: Create Interface

3. Select the Edit option to change the configuration of an already configured interface.
4. Select the switch and interface from the selection lists and click Next.

The system displays the second Configuration page.
5. Assign a name, IP address, and subnet mask to the interface.
6. Select a radio button to assign a role to the interface:

• Filter
• Delivery
• Filter and Delivery
• Service

Note:

• The options available are updated based on the selection.
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For example, when selecting Filter, the system displays the following dialog box.
Figure 2-3: Create Interface: Filter

• Analytics is enabled by default. To disable Analytics for the interface, move the slider to
Disabled. For information about Analytics, refer to the Analytics Node User Guide.

• Optionally, enable the Rewrite VLAN option for a filter or a filter and delivery interface.
• Enable the Rewrite VLAN option when configuring a Filter interface by identifying the VLAN in

the Rewrite VLAN field.

7. Complete the configuration for the specific interface role.
8. Click Save to save the configuration.

2.2.2  Using the CLI to Configure a DANZ Filter or Delivery Interface

To assign a filter or delivery role to an interface, complete the following steps:
1. From the config mode, enter the switch command, identifying the switch having the interface

to configure.

controller-1(config)# switch DMF-FILTER-SWITCH-1
controller-1(config-switch)#

Note:  Identify the switch using the alias if configured. The CLI changes to the config-switch
submode to configure the specified switch.

2. From the config-switch mode, enter the interface command, as in the following example:

controller-1(config-switch)# interface ethernet1
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controller-1(config-switch-if)#

Note:  To view a list of the available interfaces, enter the show switch <switch-name>
interface command or press the Tab key, and the command completion feature displays a
concise list of permitted values. After identifying the interface, the CLI changes to the config-switch-
if mode to configure the specified interface.

3. From the config-switch-if submode, enter the role command to identify the role for the interface.
The syntax for defining an interface role (delivery, filter, filter-and-delivery, or service) is as follows:

[no] role delivery interface-name <name> [strip-customer-vlan] [ip-address
<ip-address>]
[nexthop-ip <ip-address> <subnet> ]
[no] role filter interface-name <name> [ip-address <ip-address>] {[rewrite
vlan <vlan id (1-4094)>]} [no-analytics]
[no] role both-filter-and-delivery interface-name <name> {[rewrite vlan
 <vlan id
(1-4094)>]} [noanalytics]
[no] role service interface-name <name>a

The interface-name command assigns an alias to the current interface, which typically would indicate the
role assigned, as in the following example:

controller-1(config-switch-if)# role delivery interface-name TOOL-PORT-1

Note:  An interface can have only one role, and the configured interface name must be unique
within the DANZ Monitoring Fabric.

The following examples show the configuration for filter, delivery, and service interfaces:

• Filter Interfaces

controller-1 (config)# switch DMF-FILTER-SWITCH-1
controller-1(config-switch)# interface ethernet1
controller-1(config-switch-if)# role filter interface-name TAP-PORT-1
controller-1(config-switch-if)# interface ethernet2
controller-1(config-switch-if)# role filter interface-name TAP-PORT-2

• Delivery Interfaces

controller-1(config-switch-if)# switch DMF-DELIVERY-SWITCH-1
controller-1(config-switch-if)# interface ethernet1
controller-1(config-switch-if)# role delivery interface-name TOOL-PORT-1
controller-1(config-switch-if)# interface ethernet2
controller-1(config-switch-if)# role delivery interface-name TOOL-PORT-2

• Filter and Delivery Interfaces

controller-1(config-switch-if)# switch DMF-CORE-SWITCH-1
controller-1(config-switch-if)# interface ethernet1
controller-1(config-switch-if)# role both-filter-and-delivery interface-
name loopback-
port-1
controller-1(config-switch-if)# interface ethernet2
controller-1(config-switch-if)# role both-filter-and-delivery interface-
name loopback-
port-2

• Service Interfaces

controller-1(config-switch-if)# switch DMF-CORE-SWITCH-1
controller-1(config-switch-if)# interface ethernet1
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controller-1(config-switch-if)# role service interface-name PRE-SERVICE-P
ORT-1
controller-1(config-switch-if)# interface ethernet2
controller-1(config-switch-if)# role service interface-name POST-SERVICE-
PORT-1

Note:

a. An interface can have only one role, and the configured interface name must be unique within
the DANZ Monitoring Fabric.

b. A delivery interface will show drops under a many-to-one scenario, i.e., multiple filter interfaces
pointing to a single delivery interface as per policy definition. These drops should be accounted
for micro bursts at the egress port. For example, consider a use case of three 10G ingress
ports and one 25G egress port. Even if we send a total of 25Gbps of traffic by calculation from
ingress to egress, each individual ingress port still operates at 10Gbps inside the BCM chip (i.e.,
a total of 30G on ingress, 5Gbps traffic is still running at 10Gbps speed on the wire but with a
bigger inter-frame gap). This means the ingress may oversubscribe the egress due to the 30G
to 25G traffic ratio. For example, if each ingress port receives one packet at the same time, it
causes 30G-to-25G over-subscription or micro-bursting (5Gbps traffic still gets processed at
the ingress port’s native speed of 10Gbps). Because the egress can only process packets up to
25Gbps, one of the packets will not get dequeued promptly and accumulate inside the egress
TX queue. If this pattern continues, the egress queue eventually drops packets due to the TX
buffer becoming full. Therefore, expect this behavior in the case of many-to-one forwarding.
If you reconfigure and use only one 25G ingress port to one 25G egress port, there is no TX
drop problem.

2.2.3  Using the CLI to Identify a Filter Interface using Destination MAC Rewrite

The Destination MAC (D.MAC) Rewrite feature provides an option to identify the Filter interface by overriding
the destination MAC address of the packet received on the filter interface. Use this feature for auto-assigned
and user-configured VLANs in push-per-filter and push-per-policy modes.

Note:  The D.MAC Rewrite feature VLAN preservation applies to switches running SWL OS and does
not apply to 7280R/7280R2 switches running EOS.

Global Configuration

Configure this function at the filter interface level and perform the following steps using the CLI.
1. Select a filter switch and enter the config mode.

(config)# switch filter1

2. Select an interface from the switch acting as the filter interface.

(config-switch)# interface ethernet5

3. Create a filter interface with a name and provide the MAC address to override.

(config-switch-if)# role filter interface-name f1 rewrite dst-mac
 00:00:00:00:00:03

CLI Show Commands

The following show command displays the ingress flow for the filter switch.

In the Entry value column, the filter switch contains dst MAC tlv: EthDst(00:00:00:00:00:03).

(config-policy)# show switch filter1 table ingress-flow-2
# Ingress-flow-2 Device name Entry key                               Entry
 value  
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-|--------------|-----------|---------------------------------------|--------
---------------------------|
1 0              filter1     Priority(6400), Port(5), EthType(34525) Name(p1),
 Data([0, 0, 0, 61]), PushVlanOnIngress(flags=[]), VlanVid(0x1), Port(1),
 EthDst(00:00:00:00:00:03)
2 1              filter1     Priority(6400), Port(5)                 Name(p1),
 Data([0, 0, 0, 62]), PushVlanOnIngress(flags=[]), VlanVid(0x1), Port(1),
 EthDst(00:00:00:00:00:03)
3 2              filter1     Priority(36000), EthType(35020)        
 Name(__System_LLDP_Flow_), Data([0, 0, 0, 56]), Port(controller), QueueId(0)

The core and delivery switch in the Entry value column doesn’t contain dst MAC tlv, as shown in the
following examples.

(config-policy)# show switch core1 table ingress-flow-2
# Ingress-flow-2 Device name Entry key                                         
    Entry value  
-|--------------|-----------|------------------------------------------------
-----|----------------------------|
1 0              core1       Priority(6400), Port(1), EthType(34525),
 VlanVid(0x1) Name(p1), Data([0, 0, 0, 60]), Port(2)
2 1              core1       Priority(6400), Port(1), VlanVid(0x1)             
    Name(p1), Data([0, 0, 0, 59]), Port(2)
3 2              core1       Priority(36000), EthType(35020)              
         Name(__System_LLDP_Flow_), Data([0, 0, 0, 57]), Port(controller),
 QueueId(0)

(config-policy)# show switch delivery1 table ingress-flow-2
# Ingress-flow-2 Device name Entry key                                         
    Entry value  
-|--------------|-----------|------------------------------------------------
-----|----------------------------|
1 0              delivery1   Priority(6400), Port(1), EthType(34525),
 VlanVid(0x1) Name(p1), Data([0, 0, 0, 64]), Port(6)
2 1              delivery1   Priority(6400), Port(1), VlanVid(0x1)             
    Name(p1), Data([0, 0, 0, 63]), Port(6)
3 2              delivery1   Priority(36000), EthType(35020)              
         Name(__System_LLDP_Flow_), Data([0, 0, 0, 58]), Port(controller),
 QueueId(0)

Troubleshooting

To troubleshoot the scenario where the provided destination MAC address is attached incorrectly to the filter
interface. The ingress-flow-2 table above will have a destination MAC rewrite tlv on the filter switch, but no
such tlv appears on the core or delivery switch.

As an alternative, drop into the bash of the filter switch to check the flow and destination MAC rewrite.

Use the following commands for the ZTN CLI of the filter switch.

(config)# connect switch filter1
(ztn-config) debug admin
filter1> enable
filter1# debug bash
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The following command prints the flow table of the filter switch.

root@filter1:~# ofad-ctl gt ING_FLOW2

Figure 2-4: Filter Switch Flow Table

The following command shows the policy flow from the filter switch to the delivery switch. The filter switch will
have the assigned destination MAC in the match-field.

(config)# show policy-flow
# Policy Name Switch                              Pkts Bytes Pri  T Match      
              Instructions            
-|-----------|-----------------------------------|----|-----|----|-|---------
---------------|------------------|
1 p1          core1 (00:00:52:54:00:15:94:88)     0    0     6400 1 eth-type
 ipv6,vlan-vid 1 apply: name=p1 output: max-length=65535, port=2
2 p1          core1 (00:00:52:54:00:15:94:88)     0    0     6400 1 vlan-vid 1 
              apply: name=p1 output: max-length=65535, port=2
3 p1          delivery1 (00:00:52:54:00:00:11:d2) 0    0     6400 1 vlan-vid 1 
              apply: name=p1 output: max-length=65535, port=6
4 p1          delivery1 (00:00:52:54:00:00:11:d2) 0    0     6400 1 eth-type
 ipv6,vlan-vid 1 apply: name=p1 output: max-length=65535, port=6
5 p1          filter1 (00:00:52:54:00:d5:2c:05)   0    0     6400 1          
                apply: name=p1 push-vlan: ethertype=802.1Q (33024),set-field:
 match-field/type=vlan-vid, match-field/vlan-tag=1,output: max-length=65535,
 port=1,set-field: match-field/eth-address=00:00:00:00:00:03 (XEROX), match-
field/type=eth-dst
6 p1          filter1 (00:00:52:54:00:d5:2c:05)   0    0     6400 1 eth-type
 ipv6            apply: name=p1 push-vlan: ethertype=802.1Q (33024),set-field:
 match-field/type=vlan-vid, match-field/vlan-tag=1,output: max-length=65535,
 port=1,set-field: match-field/eth-address=00:00:00:00:00:03 (XEROX), match-
field/type=eth-dst

Considerations

1. The destination MAC rewrite cannot be used on the filter interface where timestamping is enabled.
2. The destination MAC rewrite will not work when the filter interface is configured as a receive-only

tunnel interface.

2.2.4  Using the GUI to Identify a Filter Interface using Destination MAC Rewrite

In the UI, configure the Rewrite Dest. MAC Address for a Filter Interface using one of the two workflows
detailed below. The first workflow uses the Monitoring > Interfaces UI, while the second uses the Fabric >
Interfaces UI. To use the second workflow, proceed to step 6, detailed below.
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Workflow One: Using either the Monitoring > Interfaces (or the Monitoring > Interfaces > Filter
Interfaces) page, proceed to the following workflow:

1. Create Interface
1. Click the table action icon + button to create a filter interface.
2. After selecting the switch interface in the interface tab, use the Configure tab to assign roles.
3. Select the Filter radio button for the interface and use the Rewrite Dest.MAC Address input to configure

the MAC address to override.
Figure 2-5: Create Interface

4. Click Save to continue.
2. Edit Interface
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5. Select the row menu of the filter interface to configure or edit, and select Edit.
Figure 2-6: DANZ Monitoring Fabric (DMF) Interfaces - Edit

6. In the Configure step, use the Rewrite Dest. MAC Address input to configure the MAC address to override.
3. Workflow Two: When using the Fabric > Interfaces page, use the following workflow:
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7. Select the row menu of the switch interface associated with the filter interface you want to configure and
select Configure.
Figure 2-7: Configure Interface
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8. In the DMF tab, select the Rewrite Dest.MAC Address field to enter the MAC address to be overridden.
Figure 2-8: Edit Interface DMF Rewrite Dest. MAC Address

9. Click Save to continue.

2.3  Using Interface Groups

Create an interface group consisting of one or more filter or delivery interfaces. It is often easier to refer to an
interface group when creating a policy than to identify every interface to which the policy applies explicitly.

Use an address group in multiple policies, referring to the IP address group by name in match rules. If no
subnet mask is provided in the address group, it is assumed to be an exact match. For example, in an IPv4
address group, the absence of a mask implies a mask of /32. For an IPv6 address group, the absence of a
mask implies a mask of /128.

Identify only a single IP address group for a specific policy match rule. Address lists with both src-ip and dst-
ip options cannot exist in the same match rule.

2.3.1  Using the GUI to Configure Interface Groups

To create an interface group from the Monitoring > Interfaces table, complete the following steps:
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1. Select the Monitoring > Interfaces option.
Figure 2-9: Creating Interface Groups from Monitoring > Interfaces

2. On the Interfaces table, enable the checkboxes for the interfaces to include in the group.
3. Click the Menu control at the top of the table and select **Group Selected Interfaces.
4. Complete the dialog that appears to assign a descriptive name to the interface group.

Note:  You can also define an interface group using the Monitoring > Interface > Groups option.

2.3.2  Using the CLI to Configure Interface Groups

The following example shows the configuration of two interface groups: a filter interface group TAP-PORT-
GRP, and a delivery interface group TOOL-PORT-GRP.

controller-1(config-switch)# filter-interface-group TAP-PORT-GRP
controller-1(config-filter-interface-group)# filter-interface TAP-PORT-1
controller-1(config-filter-interface-group)# filter-interface TAP-PORT-2
controller-1(config-switch)# delivery-interface-group TOOL-PORT-GRP
controller-1(config-delivery-interface-group)# delivery-interface TOOL-PORT-1
controller-1(config-delivery-interface-group)# delivery-interface TOOL-PORT-2

To view information about the interface groups in the DMF fabric, enter the show filter-interface-
group command, as in the following examples:

Filter Interface Groups

controller-1(config-filter-interface-group)# show filter-interface-group
! show filter-interface-group TAP-PORT-GRP
# Name         Big Tap IF Name            Switch IF Name    Direction  Speed     State   VLAN  Tag
-|------------|--------------------------|-----------------|----------|---------|-------|-----|--------|
1 TAP-PORT-GRP TAP-PORT-1 DMF-CORE-SWITCH-1 ethernet17      rx         100Gbps   up      0
2 TAP-PORT-GRP TAP-PORT-2 DMF-CORE-SWITCH-1 ethernet18      rx         100Gbps   up      0
controller1(config-filter-interface-group)#

Delivery Interface Groups

controller1(config-filter-interface-group)# show delivery-interface-group
! show delivery-interface-group DELIVERY-PORT-GRP
# Name              Big Tap IF Name Switch IF Name        Direction  Speed     Rate   limit     State Strip Forwarding Vlan
-|-----------------|---------------|---------------------|----------|---------|------|---------|-----|---------------------|
1 TOOL-PORT-GRP TOOL-PORT-1 DMF-DELIVERY-SWITCH-1 ethernet15 tx      10Gbps                     up    True
2 TOOL-PORT-GRP TOOL-PORT-2 DMF-DELIVERY-SWITCH-1 ethernet16 tx      10Gbps                     up    True
controller-1(config-filter-interface-group)#
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Chapter 3

Managing DMF Policies

This chapter describes the policies to work and configure in the DANZ Monitoring Fabric (DMF).

3.1  Overview

A policy selects the traffic to be copied from a production network to one or more tools for analysis. To define
a policy, identify the traffic source(s) (filter interfaces), the match rules to select the type of traffic, and the
destination tool(s) (delivery interfaces). The DANZ Monitoring Fabric (DMF) Controller automatically forwards
the selected traffic based on the fabric topology. Define match rules to select interesting traffic for forwarding
to the tools connected to the specified delivery interfaces. Users can also send traffic to be processed by
a managed service, such as time stamping, slicing, or deduplication, on a DMF service node. Forward the
output from the service node to the appropriate tool for analysis.

While policies can be simple, they can also be more complicated when optimizing hardware resources, such
as switching TCAM space. Also, DMF provides different switching modes to optimize policies based on use
cases and switch capabilities. Arista Networks recommends planning the switching mode before configuring
policies in a production deployment.

For further information, refer to the chapter Advanced Policy Configuration.

3.2  DMF Policies Page

Overview

While retaining all information from the previous version, the new policy page features a new layout and
design and offers additional functionality for easier viewing, monitoring, and troubleshooting of policies.
Figure 3-1: DMF Policies
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Header Action Items

• Refresh Button
Figure 3-2: Refresh Button

The page refreshes every 60 seconds automatically. Click the Refresh button to manually refresh the page.

• Create Policy Button
Figure 3-3: Create Policy Button

Click the + Create Policy button to open the policy creation page.

• Clear Stats Button
Figure 3-4: Clear Stats Button

Click the Clear Stats button to clear all DMF interface's runtime stats.

Quick Filters

• Show Quick Filters Button
Figure 3-5: Show Quick Filters

By default, the feature is toggled on and displays four quick filter options. When toggled off, the four quick
filters are no longer displayed.
Figure 3-6: Four Filter Options

Four quick filter cards display the policy counts that meet the filter criteria and the filter name. The quick filter
cards support multi-select.

• Radio Buttons
Figure 3-7: Table View / Interface View

Switch page views between Table View and Interface View. Refer to the Table View and Interface View
sections below for more information.

Table View

The table view is the default landing view of the Policies Page.
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The page displays an empty table with the Create Policy button when no configured policies exist.
Figure 3-8: DMF Policies

Conversely, when configured policies exist, the table view displays the list of policies.
Figure 3-9: List of Policies
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Action Buttons

Several buttons in the policy table provide quick access to corresponding functionality. These are:
Figure 3-10: Action Buttons

Delete Button

• Disabled by default (when no policies are selected).
• Enabled when one or more policies are selected.
• Used to delete selected policies.

Edit Button

• Disabled by default (when no policies are selected).
• Enabled only when a policy is selected.
• Navigate to the editing workflow (the new policy edit workflow).

Duplicate Button

• Disabled by default (when no policy is elected).
• Enabled only when one policy is selected.
• Navigate to the create policy workflow (the new policy create workflow) with an empty name input field

while retaining the same settings from the selected policy.

Table View Filters

Figure 3-11: Filter Views

Click the Filter button to open the filter menu.

Policy Filter(s)

• There are four quick policy filters. The first three filters overlap with the quick filters; thus, enabling or
disabling them will trigger changes to the quick filter button.

DMF Interface Name(s)

• Filters out policies by DMF interfaces that are selected from the drop-down list.
• Searchable
• Allows multiple selections applying OR logic.
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Policies Table

Figure 3-12: Policy Table

The Policy table displays all policies; each column shows the number of interfaces and services
corresponding to that policy.
Figure 3-13: Search

Table Search

The Policy table supports search functionality. Click the magnifying glass icon in the last column to activate
the search input fields and search the results by the context of each column.

Table Search: The Policy table supports search functionality. Click on the magnifying glass icon in the last
column to activate the search input fields. Search results by the context of each column.
Figure 3-14: Table Search

Figure 3-15: Expand Icon

Expand Policy + Icon

Hidden for an unconfigured policy. Click the expand + icon to view the policy's interfaces and
services information.
Figure 3-16: Expanded View Example

Figure 3-17: Expand Group

Interfaces Group Expand + Icon

62



Managing DMF Policies

For policies configured with an interface group, an expand + icon with group displays by default. Click on the
group expand + icon to view the detailed information on the interfaces belonging to that group.

Figure 3-18: Filter Interface Details

Policy Name Tooltip

Hovering over policy names displays the tooltips for the policy, including Configuration / Runtime /
Details state.
Figure 3-19: Tooltip

Policy Error Icon

Figure 3-20: Policy Error Icon

Policies with errors will display this icon after the policy name.
Figure 3-21: Error with Policy Name

Clicking the error icon will display an error window with detailed information.

Figure 3-22: Detailed Error Information

Checkbox

Figure 3-23: Checkbox

Disabled for unconfigured policies. Use the checkbox to select a policy and the applicable function buttons
(described above) as required.

63



 

Table Interaction

• All columns support sorting.
• Clicking on a policy name opens the policy table split view. The table on the left displays the policy

names. The table on the right provides two tabs showing Configuration and Operational Details.
• Select a policy name from the Policy Name list to view its configuration or operational details in the

split view.
•

Use the  icon to view the information in full-screen mode or the X icon to close the split view and return
to the table view.

Figure 3-24: DMF Policies

Configuration Details

Access the Configuration Details tab by selecting a policy in either Table View or Interface View. This tab
displays all of the configured settings for the selected policy.

The top row of the Configuration Details tab displays the selected policy name and an Edit and Delete
button. The Edit button opens the Edit Policy configuration page with policy information prefilled, and the
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Delete button opens a confirmation dialog window before deleting a policy. The default Table View opens
after deleting a policy.
Figure 3-25: Configuration Details

The second component of the Configuration Details is the Quick Facts box. This component displays
the Description, Action, Push VLAN, Priority, Active, Scheduling Start Time, Policy Run Duration, PTP
Timestamping, and Root Switch values.

• Description: An info icon shows the entire description in a tooltip.
• Action: Forward, Drop, Capture, or None.
• Active: Policy active status, Yes or No.

Scheduling Start Time: Either Automatically or the DateTime it is scheduled to start, in terms of the
current Time Zone configured on the DMF. When setting DateTime to Now during policy creation, the time
of creation will be the Scheduling start time.

• Automatic: The policy will always run. There's no expiration.
• Now: The policy starts from now, and duration and packet expiration may apply. The policy runs from

now with no expiration.
Figure 3-26: Start Time

• Run Policy: The duration the policy should run. The default value is Always. Set a time limit (i.e., 4 hours)
or a packet limit (i.e., 1,000 packets) The tooltip explains that the policy will stop running when reaching
either of the limits.
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The third component is the Rules Table, which displays all Match Traffic rules configured for the policy. The
default value is Allow All Traffic. Optionally, configure Deny All Traffic.

Figure 3-27: Allow All Traffic

Figure 3-28: Deny All Traffic

When configuring custom rules, the Rules Table is displayed. The table is horizontally scrollable, and each
column is searchable and sortable. The Edit Policy feature provides rule management, including Edit, Add,
and Delete functionality.

Figure 3-29: Rules Table

The next component is the Interface Info Columns.
Figure 3-30: Information Columns

There are three primary columns: Traffic Sources, Services, and Destination Tools.

• The Traffic Sources column includes Filter Interfaces, vCenters, and CloudVision Portal associated with
the policy.

• The Services column includes Managed Services and Services associated with the policy.
• The Destination Tools column includes Delivery interfaces and RN Fabric Interfaces associated with the

policy.

These columns display the DMF Interface name in the interface card, and the name includes a link to the
Interfaces page. The switch name and physical interface name appear in this format: SWITCH-NAME /

66



Managing DMF Policies

INTERFACE-NAME under the DMF interface name. The bit rate and packet rate operational state data
appear for each interface. Each column is only displayed if the policy has one or more interfaces of that type.
Figure 3-31: Traffic Sources

The services column renders for all policies that have at least one service. The service name appears for
each card, which contains a link to either the Services or Managed Services page. Under the service name,
the service type (Managed Service or Service) appears if the service has a backup name that also appears.
Figure 3-32: Managed Service

There is a special case for policies that have CloudVision port mirroring sessions. To differentiate the
CloudVision source interfaces from the auto-generated DMF filter interfaces, DMF creates two columns:
CloudVision and Filter Interfaces.

The cards in the CloudVision column show the connected CloudVision portal and the number of port mirroring
sessions for each device in the CloudVision portal. Filter Interfaces and vCenters are now in the Filter
Interfaces column. There are no differences between the Services and Destination Tools columns.

The last component only displays for policies with CloudVision port mirroring sessions.
Figure 3-33: Port Mirroring Sessions

The Port Mirroring Session Entries table shows all configured Port Mirroring Sessions for a CloudVision
portal. The Device, Source Interface, Monitor Type, Tunnel Source, Tunnel Endpoint, SPAN Interface,
and Direction columns display the same values configured in the Port Mirroring Table in the Add Traffic
Sources component in the Create Policy flow. Each column is sortable.

For more information on the configuration flow for CloudVision port mirroring, please refer to the
documentation in the Create Policy section.
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Operational Details

Clicking on the Operational Details Tab navigates to the Operational Details view.

Figure 3-34: Operational Details

Figure 3-35: Action Buttons

• Edit: Clicking the Edit button opens the Editing Policy window for making changes to the policy.
• Delete: Clicking the Delete button deletes the policy.
• Edit Layout: Clicking the Edit Layout button opens the editing layout window. Move the widgets by

dragging the components in order of user preference. Click the Save button to save the changes. DMF
preserves the order of the widgets when the same user logs back in.

Figure 3-36: Edit Layout

Widgets

Status / Information

Status and information include basic operational information about the policy.
Figure 3-37: Operational Information

Installed Duration
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Hover over the info icon to see the installed time in the UTC time zone.
Figure 3-38: Install Time

Top Filter and Delivery Interfaces by Traffic

Figure 3-39: Top Filter and Delivery Interfaces by Traffic

Figure 3-40: Select Metric

Click the Metric Drop-down menu and choose the metrics to display in the chart. Only the selected metrics
appear in the Badge, Labels, and Bar Chart.

• Badge: Colored dots and text indicate the content represented by different bars in the bar chart.
• Interface Name

Figure 3-41: Labels

Hover over the interface name to see the full name in the tooltips.

• Labels: Display the number and unit corresponding to the bar.
• Bar Chart: Displays the numerical value of traffic.
• Empty State

• Display title, last updated time, and disabled metric drop-down.
• The Edit Policy button opens the edit policy window.

Top Core Interfaces by Traffic

Figure 3-42: Top Core Interfaces by Traffic
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The Core Interfaces by Traffic chart is similar to Filter Interfaces / Delivery Interfaces by Traffic charts,
which have Metric Drop-down, Badge, Interface Name, Labels, and Bar Charts with similar functionality.

Errors & Dropped Packets

Figure 3-43: Errors

The Errors chart is similar to Filter Interfaces / Delivery Interfaces by Traffic charts, which have Metric
Drop-down, Badge, Interface Name, Labels, and Bar Charts with similar functionality. Hovering over the
bar displays all error counts and rate information.
Figure 3-44: Packets Dropped

The Dropped Packets chart is similar to Filter Interfaces / Delivery Interfaces by Traffic charts, which
have Badge, Interface Name, Labels, and Bar Charts with similar functionality. Hovering over the bar
displays all packet dropped counts and rate information.

Optimized Matches

Displays optimized match rules.
Figure 3-45: Optimized Matches
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Interface View

As a new feature of the DMF Policies page, the Interface view offers an alternative way to view policies,
allowing for an intuitive visualization of all policies-related interfaces.
Figure 3-46: Interface View

Policies Column

Figure 3-47: Policies Column

• A Policies header displaying count. The column shows the total count when no filters are applied, or the
filtered policies count in the format of x Associated.

• The drop-down menu enables data sorting using multiple attributes.
• The Delete button deletes the selected policies.
• The Edit button opens the selected policy in edit mode.
• The Filter drop-down is similar to the table view filters but without an interface filtering option.

Figure 3-48: Filter

• A list of policies with quick facts and user interactions.
• The checkbox enables policy selection for deletion and editing.
• Badges with different colors indicate policy run time status.
• Policy name with tooltip on hover displaying configuration, runtime, and detailed status.
• Current Traffic display in bps.
• Clicking the View Information button highlights the policy:

• Only shows the interfaces associated with the selected policy in the DMF Interfaces tab.
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• Enable Configuration Details and Operational Details.

• Clicking on an active policy card deselects the previously selected policy:

• De-emphasizes the policy and resets card styles and tabs accessibility.
• Reveals all the interfaces in DMF Interfaces.
• Interface card highlights in the DMF Interfaces tab can co-exist, leading to a more granular search.

DMF Interfaces

Figure 3-49: DMF Interfaces

• Active tab by default

• Header Row

• Stat selector: Choose between Utilization, Bit Rate, and Packet Rate to display in the subsequent
interface info cards.

• Sorter selector: Choose between Utilization and interface name to sort the interfaces in ascending or
descending order.

• Filter drop-down:

• Utilization range filter
• Switch name selector
• DMF interface name selector

• Interface Column

• Header: Specifies interface category and count, showing X Associated when filters apply and X Total
otherwise.

• Interface Information Card

• Interface name
• Stat

• Utilization
• Bit Rate
• Packet Rate

• Text: Display detailed information about the selected stat of the current interface.

Interaction

• Selecting one policy card:
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The selected policy card highlights and filters interfaces to only those configured to the policy and hides
interfaces not configured in the selected policy.

Figure 3-50: Policy Card

• Selecting one interface card:

The selected interface card highlights and filters policies to only those configured to the interface and hides
interfaces not configured in the filtered policies mentioned above.

Figure 3-51: Single Interface Card

• Selecting multiple interface cards (any columns):

The selected interface cards highlight and filter policies to only those configured on the selected interfaces
and hide interfaces not configured in the filtered policies mentioned above.

Figure 3-52: Multiple Interface Cards
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Highlighted policy and interface cards can co-exist, leading to a more granular search.
Figure 3-53: Policy and Interface Cards

Configuration Details
The GUI is similar to Table View > Configuration Details. Please refer to the Configuration Details section.

Operational Details
The GUI is similar to Table View > Operational Details. Please refer to the Operational Details section.

3.3  Policy Elements

Each policy includes the following configuration elements:

• Filter interfaces: these identify the ingress ports for analyzing the traffic for this policy. Choose individual
filter interfaces or one or more filter interface groups. Select the Select All Filter Interfaces option,
intended for small-scale deployments.

• Delivery interfaces: these identify the egress ports for analyzing the traffic as part of this policy. Choose
individual delivery interfaces or one or more delivery interface groups. Like filter interfaces, a Select All
Delivery Interfaces option is available for small deployments.

• Action: identifies the policy action applied to the inbound traffic. The following actions are available:

• Forward: forwards matching traffic at filter ports to the delivery ports defined in a given policy. Select at
least one or more filter and delivery interfaces.

• Drop: drops matched traffic at the Filter ports. A policy with a drop action is often used in combination
with another lower-priority policy to forward all traffic except the dropped traffic to tools. Use Drop to
measure the bandwidth of matching traffic without forwarding it to a tool. Select at least one or more
filter interfaces.

• Capture: sends the selected traffic to a physical interface on the controller to be saved in a PCAP file.
This option works only on a hardware Controller appliance, and you must select at least one or more
filter interfaces. A policy with a capture action can only run for a short period. For continuous packet
capture, use the DANZ Monitoring Fabric (DMF) recorder node. Refer to the chapter Using the DMF
Recorder Node for details.

Note:  The policy will not be installed if an action is not selected.

• Match rules: used to select traffic. The selected traffic is treated based on the action, with the most
common action being Forward, i.e., forward-matched traffic to delivery interfaces. If a match rule is
not specified or the match rule is Deny All Traffic, the policy is not installed. One policy can specify
multiple match rules, differentiating each rule by its rule number.

Note:  The rule numbers do not define the order in which the rules will be installed or
processed. The numbering allows a user to list them in order.
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• Managed services (optional): identifies additional operations to perform, such as packet slicing, time
stamping, packet deduplication, packet obfuscation, etc., before sending the traffic to the selected
delivery interfaces.

• Status (optional): enables or disables the policy using the active or inactive sub-command from
the config-policy sub-model. By default, a policy is active when initially configured.

• Priority (optional): unless a user specifies, all policies have a priority of 100. When sharing filter/
ingress ports across policies, a policy with a higher priority will get access to matching traffic first. Traffic
not matched by the policies with the higher priority then gets processed according to policies with lower
priority. Overlapping policies are also not created when two policies have different priorities defined.

• Push VLAN (optional): when a user configures the Auto VLAN Mode push as push-per-policy (i.e., to
Push Unique VLAN on Policies, every policy configured on DMF gets a unique VLAN ID. Typically,
this VLAN ID is in the range of 1-4094 and auto-increments by 1. However, if you want a specific policy
to have a specific VLAN ID, you should first define a smaller VLAN range using the command auto-
vlan-range and then pick a VLAN outside that range to attach to a specific policy. This attachment
of a specific VLAN to a specific policy can be done in the CLI using the CLI command push-vlan or
in the GUI by selecting Push VLAN from the Advanced Options drop-down and then specifying the
VLAN ID.

• Root switch (optional): when a core switch (or core link) goes down, existing policies using that switch
are rerouted using other core switches. When that switch comes back, the policy does not move back.
In some cases, this causes traffic overload. One way to overcome this problem is to specify a root
switch in each policy. The policy is rerouted through other switches when the root switch goes down.
When the root switch comes back, DMF reroutes the policy through the root switch again.

Policies can include multiple filter and delivery interfaces, and services are optional. Traffic that matches the
rules in any policy associated with a filter interface forwards to all the delivery interfaces defined in the policy.

Except for a capture action policy, a policy runs indefinitely once activated. Optionally schedule the policy
by specifying a starting time and period for which the policy should run and specify the number of received
packets in the tool, after which the policy automatically deactivates.

Note:

1. Create and configure all interfaces and service definitions before creating a policy that uses them.
2. Use only existing interfaces and service definitions when creating a policy. When creating a policy

with interfaces or service definitions that do not exist, the policy may enter an inconsistent state.
3. If this happens, delete the policy, create the interfaces and service definitions, and then recreate

the policy.

3.4  Configuring a Policy

3.4.1  Configure a Policy Using the GUI

DANZ Monitoring Fabric (DMF) 8.5 introduces a newly designed Create Policy configuration workflow,
replacing the former workflow page.
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There are two possible entry points for creating a policy. The first is via the Create Policy button continuously
displayed on the top-right corner of the DMF Policies page, or the second is via the Create Policy button,
which appears on the central panel of the same page when no configured policies exist.
Figure 3-54: DMF Policies

Clicking the Create Policy button opens the new Policy Creation configuration page, which supports
moving, minimizing, expanding, collapsing, and closing the window using the respective icons in the menu
bar.
Figure 3-55: Create Policy

Figure 3-56: UI Controls
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Move: Click (and hold) any part of the title section of the window or the  icon to drag and reposition as
required. Moving the window in full-size mode is not possible.

Expand: Click the  icon to enlarge the window.

Minimize: Click the  icon to minimize the window and the  icon to return to the standard view.

Proceed to the following sections for create and manage policies.

3.4.1.1  Create a New Policy

Create a New Policy

To create a new Policy, complete the required fields in the Policy Details section and configure settings under
the Port Selection tab (optional) and the Match Traffic tab (optional). Please refer to the Policy Details, Port
Selection Tab, and Match Traffic Tab sections for more detailed information on configuring settings.

Once configured, click the Create Policy button on the bottom-right corner to save the changes and finish the
policy creation.
Figure 3-57: Create Policy

Policy Details

Figure 3-58: Policy Details

Enter the primary information for the policy:

• Policy Name (must be unique)
• Description
• Policy Action: Capture, Drop, Forward (default)

Note:  The Destination Tools column is not available when Drop and Capture actions are selected.

• Push VLAN
• Priority: By default, set to 100 if no value is specified.
• Active: By default, set to enabled.
• Advanced Options: By default, disabled.

When Advanced Options is enabled, the following configuration settings are available:

Figure 3-59: Advanced Options

• Scheduling: There are four options:
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• Automatic: The policy runs indefinitely.
• Now: The policy starts running immediately; use Run Time to determine when the policy should stop.
• Set Time: Set a specific date and time to start the policy.

Figure 3-60: Scheduling

• Set Delay: Start the policy using relative time options.

Figure 3-61: Set Delay

• Run Time: There are two options:

• Always: (default).
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• For Duration: Selecting For Duration allows using Time Input to set the time number and the Unit
selector to set the time unit. Select the checkbox to use Packet Input and enter the required packet
number (1000, by default).

Figure 3-62: Run Time

• PTP Timestamping: Disabled by default.
• Root Switch: By default, set to a locked state. Click the lock icon to unlock and select a root switch.

Additional Controls

Figure 3-63: Collapse

Figure 3-64: Show

• Collapse and Show: Visually hide or unhide the basic policy configurations to manage the view of the
other configuration fields.
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3.4.1.2  Traffic Sources

The Traffic Sources column displays the associated traffic sources in the policy.

Figure 3-65: Traffic Sources

To add Sources, click on the Add Port(s) button. The page allows adding Filter Interfaces and Groups,
vCenters, or CloudVision Portals.

Note:  The left column has three multiple groups. Select the corresponding type of traffic source
to view the available selections. After making all desired selections, confirm them using the Add N
Sources button.

Figure 3-66: Add Sources

Interfaces can be searched by the available information in the interface tiles using the search bar. Clicking the

 icon reveals sorting and filtering options using Display Data, which includes:

• Sort - By default, DMF sorts the data in descending Bit Rate order. Optionally, sort the data by ascending
Bit Rate order or alphabetically.

• Bit Rate (default), Utilization percentage, or Packet Rate
• Switch Name
• Interface Name(s)
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Figure 3-67: Traffic Sources Display Data
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DMF sorts vCenters and CloudVision Portals alphabetically (A-Z, by default).
Figure 3-68: Sort Traffic Sources

Suppose a Filter Interface has not been created yet, the Create button has two selections: create Filter
Interfaces and Filter Interface Groups.

Figure 3-69: Filter Interfaces / Filter Interface Groups
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Clicking the Create Filter Interface button opens a form to configure a Filter Interface. Enter the required
settings to configure the new Filter Interface.

Figure 3-70: Configure Filter Interface

Alternatively, the left column allows the selection of an existing connected device to pre-populate the Switch
Name and Interface Name fields and to configure a Filter Interface based on a connected device. Click the
Create and Select button to create the Filter Interface and associate it with the current policy.

Figure 3-71: Associate Filter Interface
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To create multiple Filter Interface(s), click the Create another button to create an interface using the current
configuration. This action clears the form to allow the creation of an additional Filter Interface.

Figure 3-72: Add Multiple Filter Interfaces

Note:  The Select (n) interface button associates all created Filter Interfaces to the current policy.

Click the Create Filter Interface Group button to create a group of filter interfaces.

Figure 3-73: Create Filter Interface Group
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Select one or more filter interfaces to create a Filter Interface Group.

Figure 3-74: Add Filter Interfaces

Click the Create Group button to create the Filter Interface Group and associate the group with the
current policy.
Figure 3-75: Create Group
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Expand the group tile to view interfaces within an Interface Group.

Figure 3-76: Expand Details

Note:  Clicking the x icon on the top right of each tile disassociates the Filter Interface from the current
policy. Clicking the Undo button restores the association.

Figure 3-77: Disassociate Filter Interface
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CloudVision Portals

The Create Policy window lists CloudVision Portals connected to DMF and includes the CloudVision
Portal name, the portal hostname, and the current software version. Select a card to add a CloudVision Port
Mirroring Table. The card displays similar information and the default Tunnel Endpoint.

Figure 3-78: CloudVision Portals

An empty port mirroring table initializes to add rows to the table for configuring port mirroring sessions.

Use the following guidelines to configure a port mirroring session:

• Each row must contain a Device and Source Interface. This interface in the CloudVision production
network will mirror traffic to DMF.

• Each interface must select a Monitor Type: GRE Tunnel or SPAN.

Note:  SPAN requires a physical connection from the CloudVision Portal to DMF. The default value
for Tunnel Endpoint is the CloudVision Portal’s Default Tunnel Endpoint.

• Each device must have the same Tunnel Endpoint and Tunnel Source values across the policies. Each
interface on a device must have an identical destination configuration (GRE Tunnel, GRE Tunnel Source,
and SPAN Interface) across the policies.

• The default traffic direction is Bidirectional but configurable to Ingress or Egress.
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• After configuring the Port Mirroring Table, click Add Sources to return to the Main Page of the Create
Policy configuration page.

Figure 3-79: Edit Policy

After configuring Port Mirroring, the card appears in the Traffic Sources section. To edit the Port Mirroring
Table, click the X Entries link.

3.4.1.3  Services

The Services column displays the Services and Managed Services associated with the policy. The Add
Service(s)  button opens a new page to specify additional services.

Figure 3-80: Services Add Services
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View All Services and View All Managed Services open the DMF Services and Managed Services pages,
respectively. The Add Service button opens a configuration panel to specify Service information. If there are
Services associated with this policy, they will be listed and available to edit.

Figure 3-81: View All Services / View All Managed Services

For each Service, specify:

• Service Type: Managed or Unmanaged.
• Service: Name of the Service (required).
• Optional: Whether the Service is optional.
• Backup Service: Name of the backup Service.
• Del. Service: If the Managed Service type is selected, whether to use it as a Delivery Service.

Click the Add Another button to populate a new row to add another Service. The Add (n) Services button
associates the Services with the policy.
Figure 3-82: Add Another Service
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After adding the services, they appear in the Services column. Click the x icon on the Service tile to
disassociate the Service from the policy. While remaining on the page, if required, re-associate the Service by
clicking Undo.

Figure 3-83: Service Added
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3.4.1.4  Destination Tools

The Destination Tools column displays the associated Destination Tool ports to a given policy.

Figure 3-84: Destination Tools

To add additional destinations, click the Add Port(s) button. The configuration page allows adding Delivery
Interfaces/Groups or Recorder Node Fabric Interfaces.

Note:  The left column has two multiple groups. Select the corresponding type of Destination Tools to
see the available selections. After making the desired selections, confirm using the Add (n) Interfaces
button.

Figure 3-85: Add Interfaces

Interfaces can be searched by the available information in the interface tiles using the search bar. Clicking the

 icon reveals sorting and filtering options using Display Data, which includes:

Sort - By default, DMF sorts the data in descending Bit Rate order. Optionally, sort the data by ascending Bit
Rate order or alphabetically.

Bit Rate (default), Utilization percentage, or Packet Rate

Switch Name
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Interface Name(s)

Figure 3-86: Filter Destination Tools
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Sort Recorder Node Fabric Interfaces alphabetically (A-Z, by default) and filter by Bit Rate.
Figure 3-87: Sort Destination Tools

Suppose there is still a need to create Destinations (Delivery Interfaces). In that case, the Create button has
two selections: create Delivery Interfaces and Delivery Interface Groups.

Figure 3-88: Create Delivery Interfaces / Delivery Interface Groups
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Clicking the Delivery Interface button opens a form to configure a Delivery Interface. Enter the required
settings to configure the new Delivery Interface.

Figure 3-89: Configure Delivery Interface

Alternatively, the left column allows the selection of an existing connected device to pre-populate the Switch
Name and Interface Name fields and to configure a Delivery Interface based on a connected device. Click
the Create and Select button to create the Delivery Interface and associate it with the current policy.

Figure 3-90: Associate Delivery Interface
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To create multiple Delivery Interface(s), click the Create another button to create an interface using the
current configuration. This action clears the form to allow the creation of an additional Delivery Interface.

Figure 3-91: Multiple Delivery Interfaces

The Select (n) interface button associates all created Delivery Interfaces to the current policy.

Figure 3-92: Select Number of Interfaces & Associate

95



 

Click the Create Delivery Interface Group button to create a group of delivery interfaces.

Figure 3-93: Create Delivery Interface Group

Select one or more delivery interfaces to create a Delivery Interface Group.

Figure 3-94: Multiple Delivery Interfaces
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Click the Create Group button to create the Delivery Interface Group and associate the group with the
current policy.
Figure 3-95: Associate Delivery Interface Group

Expand the group tile to view interfaces within an Interface Group.

Figure 3-96: Expand Details

3.4.1.5  Stat Picker

Use the Stat: Packet Rate drop-down to select view specific data for the associated interfaces.

Figure 3-97: None

The data options are:
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Utilization

Figure 3-98: Utilization

Bit Rate (default)

Figure 3-99: Bit Rate

Packet Rate

Figure 3-100: Packet Rate

98



Managing DMF Policies

3.4.1.6  Match Traffic and Match Traffic Rules

Match Traffic

Use the Match Traffic tab to configure rules for the current policy.

Figure 3-101: Match Traffic
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There are four options to configure traffic rules.
Figure 3-102: Configuration Options

Select the Allow All Traffic or Deny All Traffic radio button to quickly configure a rule for all traffic.

Navigate to the Rule Details configuration panel using the Configure A Rule button. Refer to the Custom
Rule, Match Rule Shortcut, and Match Rule Group sections for more information.

The Import Rules button opens the import rule configuration dialog and supports importing .txt files using
drag and drop or Browse.

Example Text File

1 match ip
2 match tcp
3 match tcp src-port 80
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4 match tcp dst-port 25

Figure 3-103: Import Rules

Click the Preview button to verify the import result.

Figure 3-104: Preview

While using the Preview Imported Rule table, click the Edit button to open the Edit Rule configuration panel.

Figure 3-105: Edit Rule

Click the Confirm button when finished, and use the Import x Rules button to import the rules.
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Custom Rule

Click the Configure a Rule button to open the Configure A Traffic Rule screen.

Figure 3-106: Configure a Traffic rule

By default, the configuration method is Custom Rule with several fields disabled by default; hover over the
question mark icon to see how to enable an input field.

Figure 3-107: Help Icon

Specific EtherTypes will open an Additional Configurations panel.

Figure 3-108: Additional Configurations
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Click the drop-down icon to display additional configurations (Source, Destination, Offset Match). Hovering
over Offset Match allows viewing requirements to enable the Offset Match.

Figure 3-109: Offset Match

Match Rule Shortcut

To access the Match Rule Shortcut, click the drop-down button and select Match Rule Shortcut.

Figure 3-110: Match Rule Shortcut

Click the Select Rule Shortcut selector and choose the required shortcut rules (supports multi-selection).

Figure 3-111: Shortcut Rule List

After selecting the rule shortcut:

• All selected rules appear as a card in the selector.
• Delete selected rules using the x icons.
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• Click the Customize Shortcut button to edit a rule shortcut.

Figure 3-112: Edit Shortcut

After editing, click the Save Edit button to return to the Match Rule Shortcut view.

Figure 3-113: Save Edits

After configuring the shortcut rules, click the Add (n) Rules button to finish the configuration.

Match Rule Group

To access the Match Rule Group, click the drop-down button and select Match Rule Group.

Figure 3-114: Match Rule Group
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To select a rule group, click the drop-down button under Rule Group. All rule groups appear in the menu.
Select one. There is no multi-select available. Repeat the Match Rule Group steps to add more than one rule
group.
Figure 3-115: Rule Group List

After configuring the rule group, click the Add Rule button to finish the configuration.

Figure 3-116: Add Rule

3.4.1.7  Rules Table

All configured rules appear in the Rules Table.

Figure 3-117: Rules Table

• Import Rules

Figure 3-118: Import Rules

• Similar in function to the Import Rules button on the start page. Refer to Start Page -> Import Rules for
more information.

• Export Select Rules

Figure 3-119: Export Select Rules

• Disabled by default when no rule is selected.
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• Enabled when one or more than one rule is selected.
• Click to export selected rules information as a .txt file.

• Delete

Figure 3-120: Delete

• Disabled by default when no rule is selected.
• Enabled when one or more than one rule is selected.
• Click to delete the selected rules.

• Create New Rule and Create Rule Group buttons

Figure 3-121: Create New Rule / Create Rule Group

• The button will appear as Create New Rule when no rule is selected. Click to open the Create New
Rule screen.

• When one or more rules are selected, the button changes to Create Rule Group. Click to open the
Create Rule Group screen.

Figure 3-122: Create Rule Group

The Rule Group Name is required. Click Create Group to confirm the rule group creation.

• Table Actions

Figure 3-123: Edit / Delete

• Click the Edit button to edit the rule view.
• Click the Delete button to delete the rule.
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• Table Search

Figure 3-124: Table Search

• The Rules Table supports search functionality. Click the magnifying glass icon to activate the search
input fields and search the results by the context of each column.

• Checkbox

Figure 3-125: Checkbox

• Check the box to select a rule and use the function buttons described above.

• Expandable Group Rules

• Group Rules in the Rule Table display as the group's name with an expand button.

Figure 3-126: Expand

• Click the expand button to see the rules included in the group.

Figure 3-127: Expanded Column

3.4.2  Configure a Policy Using the CLI

Before configuring a policy, define the filter interfaces for use in the policy.

To configure a policy, log in to the DANZ Monitoring Fabric (DMF) console or SSH to the IP address assigned
and complete the following steps:
1. From config mode, enter the policy command to name the policy and enter the config-policy submode,

as in the following example:

controller-1(config)# policy POLICY1
controller-1(config-policy)#

This example creates the policy POLICY1 and enters the config-policy submode.
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2. Configure one or more match rules to identify the aggregated traffic from the filter interfaces assigned to
the policy, as in the following example.

controller-1(config-policy)# 10 match full ether-type ip dst-ip 10.0.0.50
 255.255.255.255

This matching rule (10) selects IP traffic with a destination address 10.0.0.50.
3. Assign one or more filter interfaces, which are monitoring fabric edge ports connected to production

network TAP or SPAN ports and defined using the interface command from the config-switch-if
submode.

controller-1(config-policy)# filter-interface TAP-PORT-1

Note:  Define the filter interfaces used before configuring the policy.

To include all monitoring fabric interfaces assigned the filter role, use the all keyword, as in the
following example:

controller-1(config-policy)# filter-interface all

4. Assign one or more delivery interfaces, which monitor fabric edge ports connected to destination tools and
defined using the interface command from the config-switch-if submode.

controller-1(config-policy)# delivery-interface TOOL-PORT-1

Define the delivery interfaces used in the policy before configuring the policy. To include all monitoring
fabric interfaces assigned the delivery role, use the all keyword, as in the following example:

controller-1(config-policy)# delivery-interface all

5. Define the action to take on matching traffic, as in the following example:

controller-1(config-policy)# action forward

• The forward action activates the policy so matching traffic immediately starts being forwarded to the
delivery ports identified in the policy. The other actions are capture and drop.

• A policy is active when the configuration of the policy is complete, and a valid path exists through the
network from a minimum of one of the filter ports to at least one of the delivery ports.

• When inserting a service in the policy, the policy can only become active and begin forwarding when at
least one delivery port is reachable from all the post-service ports defined within the service.

To verify the operational state of the policy enter the show policy command.
controller-1# show policy GENERATE-IPFIX-NETWORK-TAP-1
Policy Name : GENERATE-IPFIX-NETWORK-TAP-1
Config Status : active - forward
Runtime Status : installed
Detailed Status : installed - installed to forward
Priority : 100
Overlap Priority : 0
# of switches with filter interfaces : 1
# of switches with delivery interfaces : 1
# of switches with service interfaces : 0
# of filter interfaces : 1
# of delivery interfaces : 1
# of core interfaces : 0
# of services : 0
# of pre service interfaces : 0
# of post service interfaces : 0
Push VLAN : 3
Post Match Filter Traffic : -
Total Delivery Rate : -
Total Pre Service Rate : -
Total Post Service Rate : -
Overlapping Policies : none
Component Policies : none
~ Match Rules ~
# Rule
-|-----------|
1 1 match any
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~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Filter Interface(s) ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# DMF           IF Switch       IF Name    State Dir Packets   Bytes       Pkt Rate Bit Rate Counter Reset Time
-|-------------|---------------|----------|-----|---|---------|-----------|--------|--------|------------------------------|
1 TAP-TRAFFIC-2 FILTER-SWITCH-1 ethernet16 up    rx  182876967 69995305364 0        -        2022-10-31 23:13:10.177000 PDT
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Delivery Interface(s) ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# DMF           IF Switch       IF Name    State Dir Packets   Bytes       Pkt Rate Bit Rate Counter Reset Time
-|-------------|---------------|----------|-----|---|---------|-----------|--------|--------|------------------------------|
1 TAP-TRAFFIC-1 FILTER-SWITCH-1 ethernet15 up    tx  182876967 69995305364 0        -        2022-10-31 23:13:10.177000 PDT
~ Service Interface(s) ~
None.
~ Core Interface(s) ~
None.
~ Failed Path(s) ~
None.
controller-1#

Note:  If two policies have the same filter and delivery interfaces and the same priority with similar
match conditions, then incorrect statistics can result for one or both policies. To alleviate this issue,
either increase the priority or change the match conditions in one of the policies.

Detailed status in show policy command shows detailed information about a policy status. If for any
reason a policy fails, the detailed status shows why the policy failed. One cause of policy failure is the TCAM
reaching its total capacity. When this happens, the detailed status shows a message like Table ing_flow2
is full <switch_DPID>.

• ing_flow1- used for programming analytics tracking like DNS, DHCP, ICMP, TCP control packets,
and ARP.

• ing_flow2 is the TCAM table used for programming data forwarding.
• To delete an existing policy, use the no policy command and identify the policy to delete, as in the

following example:

controller-1(config-policy)# no policy policy-name-1
Warning: submode exited due to deleted object

• When deleting a policy, DMF deletes all traffic rules associated with the policy.

3.4.3  Define Out-of-band Match Rules Using the CLI

A policy can contain multiple match rules, each assigned a rule number. However, the rule number does
not specify a priority or the sequence in applying the match rule to traffic entering the filter ports included in
a policy. Instead, if the traffic matches any match rules, all actions specified in the policy are applied to all
matching traffic.

The following example adds two match rules to dmf-policy-1.

controller-1(config)# policy dmf-policy-1
controller-1(config-policy)# 10 match full ether-type ip dst-ip 10.0.0.50
 255.255.255.255
controller-1(config-policy)# 20 match udp src-ip 10.0.1.1 255.255.255.0
controller-1(config-policy)# filter-interface filname2
controller-1(config-policy)# delivery-interface delname3
controller-1(config-policy)# action forward

Note:  When changing an existing installed policy by adding or removing match rules, DANZ
Monitoring Fabric (DMF) calculates the change in policy flows and only sends the difference to the
switches in the path for that policy. The unmodified flows for that policy are not affected.

When more than one action applies to the same packet, DMF makes copies of the matched packet. For
details, refer to the chapter Advanced Policy Configuration.

3.4.4  Stop, Start, and Schedule a Policy Using the CLI

Enter the active or inactive command from the config-policy submode to enable or disable a policy.
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To stop an action that is currently active, enter the stop command from the config-policy submode for
the policy, as in the following example:

controller-1(config)# policy policy1
controller-1(config-policy)# stop

By default, if the policy action is forward or drop, the policy is active unless it is manually stopped
or disabled.

To start a stopped or inactive policy immediately, enter the start now command from the config-policy
submode for the policy, as in the following example:

controller-1(config)# policy policy1
controller-1(config-policy)# start now

For a policy with the forward action, the start now command causes the policy to run indefinitely. However,
policies with the capture action run capture for 1 minute unless otherwise specified, after which the policy
becomes inactive. This action prevents a capture from running indefinitely and utilizes the appliance
storage capacity.

You can also use the start command with other options to schedule a stopped or inactive policy. The full
syntax for this command is as follows:

start { now [ duration duration ] [ delivery-count delivery-packet-count ] | automatic | on-date-time
start-time [duration duration ] seconds-from-now start-time [ duration duration ] [ delivery-count
delivery-packet-count ]

The following summarizes the usage of each keyword:

• now: start the action immediately.
• delivery-count: runs until the specified number of packets are delivered to all delivery interfaces.
• seconds: start the action after waiting for the specified number of seconds. For example, 300+ start the

action in 5 minutes.
• date-time: starts the action on the specified date and time. Use the format %Y-%m-%dT%H:%M:%S.
• duration: DANZ Monitoring Fabric (DMF) assigns 60 seconds by default if no duration is specified. A

value of 0 causes the action to run until it is stopped manually. When using the delivery-count keyword
with the capture action, the maximum duration is 900 seconds.

For example, to start a policy with the forward action immediately and run for five minutes, enter the
following command:

controller-1(config-policy)# start now duration 300

The following example starts the action immediately and stops after matching 100 packets:

controller-1(config-policy)# start now delivery-count 100

The following example starts the action after waiting 300 seconds:

controller-1(config-policy)# start 300+

3.4.5  Clear a Policy Using the CLI

To remove a specific DANZ Monitoring Fabric (DMF) policy, use the no keyword before the policy
command, as in the following example:

controller-1(config)# no policy sample_policy
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This command removes the policy sample_policy.

To clear all policies at once, enter the following command:

controller-1(config)# clear-all-configured-policy

3.4.6  View Policies Using the CLI

To display the policies currently configured in the DANZ Monitoring Fabric (DMF) fabric, enter the show
policy command, as in the following example:

This output provides the following information about each policy.

• #: a numeric identifier assigned to the policy.
• Policy Name: name of the policy.
• Action: Forward, Capture, or Drop.
• Runtime Status: a policy is active only when the policy configuration is complete, and a valid path exists

through the network from a minimum of one of the filter ports to at least one of the delivery ports (and
moves on through the service ports if that is specified). When inserting a service in the policy, the policy
can only become active/forwarding when a delivery port is reachable from all the post-service ports of
the service.

• Type: configured or dynamic. Refer to the Configuring Overlapping Policies section for details about
dynamic policies created automatically to support overlapping policies.

• Priority: determines which policy is applied first.
• Overlap Priority: the priority assigned to the dynamic policy applied when policies overlap.
• Push VLAN: a feature that rewrites the outer VLAN tag for a matching packet.
• Filter BW: bandwidth used.
• Delivery BW: bandwidth used.

The following is the full command syntax for the show policy command:

show policy [ name [filter-interfaces | delivery-interfaces | services | core | optimized-match | failed-
paths | drops | match-rules | optimized-match ]]

Use the event history to determine the last time when policy flows were installed or removed. A value of
dynamic for Type indicates the policy was dynamically created for overlapping policies.

3.4.7  Rename a Policy Using the CLI

Policy Renaming Procedure

Note:  A DANZ Monitoring Fabric (DMF) policy must exist to use the renaming feature.

Use the following procedure to rename an existing policy.
1. Use the CLI command policy existing-policy-name to enter the submode of an existing policy and then

enter the show this command.

dmf-controller-1(config)# policy existing-policy-name
dmf-controller-1(config-policy)# show this
! policy
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policy existing-policy-name

2. Enter the rename command with the name of the new policy, as shown in the following example.

dmf-controller-1(config-policy)# rename new-policy-name

Note:  Possible traffic loss may occur when renaming a policy.

3. Verify the policy name change using the show this command.

dmf-controller-1(config-policy)# show this
! policy
policy new-policy-name
dmf-controller-1(config-policy)#

Note:  A user must have permission to update the policy. The new policy name must follow the
requirements for a policy name.

3.5  Using the Packet Capture Action in a Policy

Capture packets into a PCAP file for later processing or analysis. DANZ Monitoring Fabric (DMF) stores the
captured packets on the DMF Controller hardware appliance. This feature provides a quick look at a small
amount of traffic. For continuous packet capture and storage, use the DMF Recorder Node, described in the
chapter Using the DMF Recorder Node.

Note:  Storing PCAP files is supported only with the hardware appliance, as running the Controller in
a virtual machine is impossible. The DMF hardware appliance normally provides 200 GB of storage
capacity, but the hardware appliance is optionally available with 1 TB of storage capacity.

To enable this feature, connect one of the DMF Controller hardware interfaces to a fabric switch interface
defined as a DMF delivery interface.
Figure 3-128: DMF Controller Hardware Appliance
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Table 2:

1 1G Management Port 2 10G Management Port

Figure 3-129: Capturing Packets on the DMF Appliance

To capture packets, define a policy with filter ports and match rules to select the interesting traffic. Specify the
capture action in the policy, then schedule the policy for a duration or packet count. In the illustrated example,
a service exists in the policy to modify the packets before capture, but this is optional.

By default, when the policy action is capture, the policy is only active after scheduling the policy. Packet
captures are always saved on the master (active) Controller. In case of HA failover, previous packet captures
remain on the Controller where they were initially saved.

By default, DMF automatically removes PCAP files after seven days. Change the default value using the
following CLI command with the command option if preferred:

controller-1(config)# packet-capture retention-days <tab-key>
<retention-days> Configure packet capture file retention period in days.
 Default is 7 days
controller-1(config)#

3.6  Define a Policy with a Packet Capture Action Using the CLI

Use the packet-capture-retention-days command to change the number of days to retain PCAP files.
To view the current setting, use the show packet-capture retention-days <retention-days>
command.

To remove PCAP files immediately, use the delete packet-capture files command. Delete the files
associated with a specific policy, as shown in the following example:

controller-1(config-policy)# delete packet-capture files policy capture file
 2022-02-24-07-31-25-34d9a85a.pcapng
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The following command assigns the capture action to the current policy and schedules the packet capture to
start immediately and run for 60 seconds.

controller-1(config-policy)# action capture
controller-1(config-policy)# start now duration 60

For a policy with the forward action, the start now command causes the policy to run indefinitely. However,
policies with the capture action run capture for 1 minute unless otherwise specified, after which the policy
becomes inactive. This action prevents a capture from running indefinitely and utilizes the appliance
storage capacity.

The following command starts the capture immediately and runs until it captures 1000 packets:

controller-1(config-policy)# start now delivery-count 1000

Once the packet capture is complete, the PCAP file can be downloaded via HTTP using the URL displayed
when entering the show packet-capture files command, as shown in the following example.
controller-1(config-policy)# show packet-capture files
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ All Packet Capture Files ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# Policy Name File Name                          File Size Last Modified                  URL
-|-----------|----------------------------------|---------|------------------------------|----------------------------------------------------------------|
1 capture     2022-11-01-03-03-19-c106e6c.pcapng 258MB     2022-11-01 03:04:17.227000 PDT https://10.9.33.2/pcap/capture/2022-11-01-03-03-19-c106e6c.pcapng
controller-1(config-policy)#

To view the storage used and remaining for PCAP files, enter the show pcap-storage command, as in the
following example:

controller-1 > show packet-capture disk-capacity
Disk capacity : 196GB
controller-1> show packet-capture disk-usage
Disk usage : 258MB
controller-1>

To view the number of days PCAP files are retained before deletion, use the show packet-capture
retention-days command as in the following example:

controller-1> show packet-capture retention-days

To view the history of packet captures, enter the following command:
controller-1(config-policy)# show policy capture history
# Time                           Event                           Detail             PCAP File
-|------------------------------|-------------------------------|-----------------|-------------------------------------------------|
1 2022-11-01 03:03:19.382000 PDT installation complete           capturing packets  /pcap/capture/2022-11-01-03-03-19-c106e6c.pcapng
2 2022-11-01 03:04:16.895000 PDT Configuration updated by admin. capturing packets  inactive - outside configured runtime/duration, 
                                                                                    scheduled to be started in 7sec if set active
3 2022-11-01 03:04:17.266000 PDT policy removed                                     inactive - outside configured runtime/duration, 
                                                                                    scheduled to be started in 6sec if set active
controller-1(config-policy)#
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Chapter 4

Viewing Information about Monitoring Fabric and Production
Networks

This chapter describes to view information about the DANZ Monitoring Fabric (DMF) and connected
production networks.

4.1  Monitoring DMF Interfaces

Monitoring DANZ Monitoring Fabric (DMF) Interfaces

4.1.1  Using the GUI to Monitor DMF Interfaces

Click the Menu control to view statistics for the specific interface and select Monitor Stats. The system
displays the following dialog box.
Figure 4-1: Monitor Interface Stats

This window displays statistics for up to four selected interfaces and provides a line graph (sparkline) that
indicates changes in packet rate or bandwidth utilization. The auto-refresh rate for these statistics is ten
seconds—mouse over the sparkline to view the range of values represented. To clear statistics for an
interface, click the Menu control and select Clear Stats.

To view statistics for multiple interfaces, enable the checkbox to the left of the Menu control for each interface,
click the Menu control in table, and select Monitor Selected Stats.
Figure 4-2: Monitoring > Interfaces

To view the interfaces assigned a specific role, use the Monitoring > Interfaces command and select the
Filter, Delivery, or Service sub-option from the menu.

4.1.2  Viewing Oversubscription Statistics

To view peak bit rate statistics used to monitor bandwidth utilization due to oversubscription, click the Menu in
the Interfaces table, select Show/Hide Columns, and enable the Peak Bit Rate checkbox on the dialog box
that appears.
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After enabling the Peak Bit Rate column, a column appears in the Interfaces table that indicates the relative
bandwidth utilization of each interface. When using less than 50% of the bandwidth, the bar appears in green;
50-75% changes the bar to yellow, and over 75% switches the bar color to red.

To display statistics for a specific interface, select Monitor Stats from the Menu control to the left of the row.

To reset the statistics counters, select Clear Stats from the Menu control.

Note:  DANZ Monitoring Fabric (DMF) Controllers generate SNMP traps for link saturation and packet
loss. For more information, please refer to the DMF 8.5 Deployment Guide - SNMP Trap Generation
for Packet Drops and Link Saturation chapter.

4.1.3  Using the CLI to Monitor Interface Configuration

To display the currently configured interfaces, enter the show interface-names command, as shown in
the following example.

Ctrl-2> show interface-names
            
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Filter Interface(s)  ~~~~~~~~~~~~~
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# DMF IF      Switch              IF Name   Dir State Speed  VLAN Tag Analytics
 Ip address Connected Device
-|-----------|-------------------|---------|---|-----|------|--------|-
--------|----------|----------------|
1 Lab-traffic Arista-7050SX3-T3X5 ethernet7 rx  up    10Gbps 0        True
            
~ Delivery Interface(s) ~
None.
            
            
~ Service Interface(s) ~
None.
           
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Recorder Fabric Interface(s)  ~~~~~~~~~~~~~
~~~~~~~~~~~~~~~~~~~
# DMF IF          Switch              IF Name    Dir           State Speed 
 Connected Device
-|---------------|-------------------|----------|-------------|-----|--
----|------------------|
1 PR-NewHW-Intf   Arista-7050SX3-T3X5 ethernet25 bidirectional up    25Gbps PR-
NewHW   ens1f0
2 RMA-CNrail-intf Arista-7050SX3-T3X5 ethernet35 bidirectional up    25Gbps
 RMA-CNrail ens1f0
          

Note:  The name is used when configuring a policy.

To display a summary of the current DANZ Monitoring Fabric (DMF) configuration, enter the show fabric
command, as in the following example.

controller-1# show fabric
~~~~~~~~~~~~~~~~~~~~~ Aggregate Network State ~~~~~~~~~~~~~~~~~~~~~
Number of switches : 3
Inport masking : False
Start time : 2018-03-16 15:42:43.322000 PDT
Number of unmanaged services : 0
Filter efficiency : 0:1
Number of switches with service interfaces : 0
Total delivery traffic (bps) : 168bps
Number of managed service instances : 2
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Number of service interfaces : 0
Match mode : l3-l4-offset-match
Number of delivery interfaces : 6
Max pre-service BW (bps) : 20Gbps
Auto VLAN mode : push-per-policy
Number of switches with delivery interfaces : 2
Number of managed devices : 1
Uptime : 5 hours, 4 minutes
Total ingress traffic (bps) : 160bps
Max filter BW (bps) : 221Gbps
Auto Delivery Interface Strip VLAN : True
Number of core interfaces : 12
Overlap : True
Number of switches with filter interfaces : 2
State : Enabled
Max delivery BW (bps) : 231Gbps
Total pre-service traffic (bps) : 200bps
Track hosts : True
Number of filter interfaces : 5
Number of active policies : 2
Number of policies : 5
~~~~~~~~~~~~~ Aggregate Interface Statistics ~~~~~~~~~~~~~
# Interface Type     Dir Packets Bytes  Pkt Rate Bit Rate
-|------------------|---|-------|------|--------|--------|
1 Filter Interface   rx  2444    455611 0        160bps
2 Delivery Interface tx  4050    421227 0        168bps
---------------------example truncated--------------------
controller-1#
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4.2  Viewing Devices Connected to the Monitoring Fabric

4.2.1  Using the GUI to View Fabric-Connected Devices

To view a display of the devices connected to the Controller, select Fabric > Connected Devices from the
main menu. The system displays the following screen.
Figure 4-3: Connected Devices

The Switch Interfaces table displays the unique devices connected to each out-of-band filter or delivery
switch. It lists each interface's MAC address (Chassis ID) on every device connected to the fabric as a
separate device.

The Unique Device Names table lists all unique device names with a count of interfaces in parentheses.
Clicking a row in this list filters the contents of the Switch Interfaces table.

To view a display of the devices discovered by the Controller through the Link Aggregation Control Protocol
(LACP), select Fabric > Connected LACP from the main menu.
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The system displays the following screen.
Figure 4-4: Connected LACP

This page displays the devices discovered by the Controller through LACP.

4.2.2  Using the CLI to View Switch Configuration

To verify the switch interface configuration, enter the show topology command, as shown in the
following example.

controller> show topology
~~~~~~~~~~~~~~~~~~~~~ Filter Interface(s) ~~~~~~~~~~~~~~~~~~~~~
# DMF IF    Switch IF   Name     state speed   Connected Device
-|---------|-----------|--------|-----|-------|----------------|
1 f1        filter-sw-1 s11-eth1 up    10 Gbps
2 f2        filter-sw-1 s11-eth2 up    10 Gbps
~~~~~~~~~~~~~~~~~~~~ Delivery Interface(s) ~~~~~~~~~~~~~~~~~~~~
# DMF IF    Switch IF   Name     state speed   Connected Device
-|---------|-----------|--------|-----|-------|----------------|
1 d1        filter-sw-2 s12-eth1 up    10 Gbps
2 d2        filter-sw-2 s12-eth2 up    10 Gbps
~~~~~~~~~~~~~~~~~~~~~~~~~ Service Interface(s) ~~~~~~~~~~~~~~~~~~~~~~~~~
# DMF IF           Switch IF Name    Dir state speed   Connected Device
-|----------------|---------|-------|---|-----|-------|----------------|
1 post-serv-intf-1 core-sw-1 s9-eth2     up    10 Gbps
2 pre-serv-intf-1  core-sw-1 s9-eth1     up    10 Gbps
~~~~~~~~~~~~~~~~~~~~~~~~ Core Interface(s) ~~~~~~~~~~~~~~~~~~~~~~~~
# Src Switch    Src IF   Src Speed Dst Switch    Dst IF   Dst Speed
-|-------------|--------|---------|-------------|--------|---------|
1 core-sw-3     s13-eth2 10 Gbps   delivery-sw-2 s15-eth3 10 Gbps
2 core-sw-3     s13-eth1 10 Gbps   delivery-sw-1 s14-eth3 10 Gbps
3 filter-sw-1   s11-eth3 10 Gbps   core-sw-2     s10-eth1 10 Gbps
4 core-sw-2     s10-eth1 10 Gbps   filter-sw-1   s11-eth3 10 Gbps
5 delivery-sw-2 s15-eth3 10 Gbps   core-sw-3     s13-eth2 10 Gbps
6 core-sw-2     s10-eth2 10 Gbps   filter-sw-2   s12-eth3 10 Gbps
7 filter-sw-2   s12-eth3 10 Gbps   core-sw-2     s10-eth2 10 Gbps
8 delivery-sw-1 s14-eth3 10 Gbps   core-sw-3     s13-eth1 10 Gbps
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Statistics ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
#  DMF IF    Switch IF     Role     State   Packets        Bytes  Pkt Rate Bit Rate
--|---------|-------------|--------|--------|-----|-------|------|--------|--------|
1 f1         filter-sw-1   s11-eth1 filter   up    0       0      0        -
2 f2         filter-sw-1   s11-eth2 filter   up    0       0      0        -
3 d1         filter-sw-2   s12-eth1 delivery up    8       600    0        -
4 d2         filter-sw-2   s12-eth2 delivery up    8       600    0        32 bps
6 -          core-sw-3     s13-eth1 core     up    3432    257400 0        32 bps
7 -          delivery-sw-2 s15-eth3 core     up    3431    257325 0        32 bps
8 -          delivery-sw-1 s14-eth3 core     up    3430    257250 0        32 bps
9 -          core-sw-2     s10-eth1 core     up    3429    257175 0        32 bps
10 -         filter-sw-1   s11-eth3 core     up    3431    257325 0        32 bps
11 -         core-sw-3     s13-eth2 core     up    3432    257400 0        32 bps
12 -         filter-sw-2   s12-eth3 core     up    3429    257175 0        32 bps

4.3  Viewing Information about a Connected Production Network

Once the monitoring fabric is set up and connected to packet feeds from the production network, DANZ
Monitoring Fabric (DMF) starts to gather information about the production network. By default, DMF provides
a view of all hosts in the production network visible from the filter interfaces. View this information on the GUI
page under Monitoring > Host Tracker. As shown below, the output displays the host MAC address, IP
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address, when and on which filter interface traffic from the host was seen, and DHCP lease information. To
display this information, enter the show tracked-hosts command, as shown in the following example.
# show tracked-hosts
#   IP Address      MAC Address                                              Host name                           Filter interfaces        VLANs   Last seen
 Extra info
---|---------------|--------------------------------------------------------|-----------------------------------|------------------------|-------|---------|
1   10.0.0.3        40:a6:d9:7c:9f:9f                                        Apple                               wireless-poe-1           0       1 hours
2   10.0.0.6        98:fe:94:1c:37:06                                        Apple                               wireless-poe-1           0       42 min
3   10.0.0.6        dc:2b:61:81:64:45                                        Apple                               wireless-poe-1           0       3 hours
4   10.0.0.7        20:c9:d0:48:f3:3d                                        Apple                               wireless-poe-1           0       2 hours
5   10.0.0.11       60:03:08:9b:4f:48                                        Apple                               wireless-poe-1           0       13 min
6   10.0.1.3        14:10:9f:e4:e6:bf                                        Apple                               wireless-poe-1           0       51 min
--------------------------------------------------------------------output truncated----------------------------------------------------------------------

DMF also tracks the DNS names of hosts by capturing and analyzing packets using several different
protocols. To manage host-name tracking, from config-analytics mode, use the track command, which has
the following syntax:

[no] track { arp | dns | dhcp | icmp }

For example, the following command enables tracking using DNS:

controller-1(config)# analytics
controller-1(config-analytics)# track dns

Note:  DNS traffic will not be included in DMF policies when enabling DNS for tracking.

Exclude host tracking for a specific filter interface using the no-analytics option with the role command.

controller-1(config)# switch DMF-FILTER-SWITCH-1
controller-1(config-switch)# interface ethernet20
controller-1(config-switch-if)# role filter interface-name TAP-PORT-01 no-
analytics

This command disables all host tracking on interface TAP-PORT-01.

4.3.1  Using the CLI to View Connected Devices and LAGs

Some information on devices in the production network, discovered using LLDP and CDP, can be seen using
the show connected-devices command. The data helps determine if filter interfaces are connected to the
intended production device.

The show connected-devicescommand from login mode displays the devices connected to the DANZ
Monitoring Fabric (DMF). This command displays information about devices connected to DMF switch
interfaces. DMF extracts the information from link-level protocol packets such as LLDP, CDP, and UDLD and
ignores expired link-level data.

Users can see the most recent events related to particular connected devices via the CLI command show
connected-devices history device_alias.
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Connecting a DMF switch interface to a SPAN port may result in inaccurate information because some vendor
devices mirror link-level packets to the SPAN port.

To display details about the link aggregation groups connected to the DMF switch interfaces use the show
connected-lacp command. DMF extracts the information from LACP protocol packets and expired LACP
information is ignored. The following is an example.
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Chapter 5

Using the DMF Service Node Appliance

This chapter describes to configure the managed services provided by the DANZ Monitoring Fabric (DMF)
Service Node Appliance.

5.1  Overview

The DANZ Monitoring Fabric (DMF) Service Node has multiple interfaces connected to traffic for processing
and analysis. Each interface can be programmed independently to provide any supported managed-
service actions.

To create a managed service, identify a switch interface connected to the service node, specify the service
action, and configure the service action options.

Configure a DMF policy to use the managed service by name. This action causes the Controller to forward
traffic the policy selects to the service node. The processed traffic is returned to the monitoring fabric using
the same interface and sent to the tools (delivery interfaces) defined in the DMF policy.

If the traffic volume the policy selects is too much for a single service node interface, define an LAG on the
switch connected to the service node, then use the LAG interface when defining the managed service. All
service node interfaces connected to the LAG are configured to perform the same action. The traffic the
policy selects is automatically load-balanced among the LAG member interfaces and distributes the return
traffic similarly.

5.2  Changing the Service Node Default Configuration

Configuration settings are automatically downloaded to the service node from the DANZ Monitoring Fabric
(DMF) Controller to eliminate the need for box-by-box configuration. However, you can override the default
configuration for a service node from the config-service-node submode for any service node.

Note:  These options are available only from the CLI and are not included in the DMF GUI.

To change the CLI mode to config-service-node, enter the following command from config mode on the
Active DMF controller:

controller-1(config)# service-node <service_node_alias>
controller-1(config-service-node)#

Replace service_node_alias with the alias you want to use for the service node. This alias is associated
with the hardware MAC address of the service node using the mac command. The hardware MAC address
configuration is mandatory for the service node to interact with the DMF Controller.

Use any of the following commands from the config-service-node submode to override the default
configuration for the associated service node:

• admin password: set the password to log in to the service node as an admin user.
• banner: set the service node pre-login banner message.
• description: set a brief description.
• logging: enable service node logging to the Controller.
• mac: configure a MAC address for the service node.
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• ntp: configure the service node to override default parameters.
• snmp-server: configure an SNMP trap host to receive SNMP traps from the service node.

5.3  Using SNMP to Monitor DPDK Service Node Interfaces

Directly fetch the counters and status of the service node interfaces handling traffic (DPDK interfaces). The
following are the supported OIDs.

interfaces MIB: #.1.3.6.1.2.1.2#
ifMIBObjects MIB: #.1.3.6.1.2.1.31.1#

Note:  A three-digit number between 101 and 116 identifies SNI DPDK (traffic) interfaces.

In the following example, interface sni5 (105) handles data traffic. To fetch the packet count, use the
following command:

snmpget -v2c -c public 10.106.6.5 .1.3.6.1.2.1.31.1.1.1.6.105
IF-MIB::ifHCInOctets.105 = Counter64: 10008

To fetch the counters for packets exiting the service node interface, enter the following command:

snmpget -v2c -c public 10.106.6.5 .1.3.6.1.2.1.31.1.1.1.10.105
IF-MIB::ifHCOutOctets.105 = Counter64: 42721

To fetch Link Up and Down status, enter the following command:

[root@TestTool anet]# snmpwalk -v2c -c onlonl 10.106.6.6 .1.3.6.1.2.1.
2.2.1.8.109
IF-MIB::ifOperStatus.109 = INTEGER: down(2)
[root@TestTool anet]# snmpwalk -v2c -c onlonl 10.106.6.6 .1.3.6.1.2.1.
2.2.1.8.105
IF-MIB::ifOperStatus.105 = INTEGER: up(1)

5.4  Configuring Managed Services

To view, edit, or create DANZ Monitoring Fabric (DMF) managed services, select the Monitoring > Managed
Services option.
Figure 5-1: Managed Services

This page displays the service node appliance devices connected to the DMF Controller and the services
configured on the Controller.
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5.4.1  Using the GUI to Define a Managed Service

To create a new managed service, complete the following steps:
1. Click the Provision control (+) in the Managed Services table. The system displays the Create Managed

Service dialog, shown in the following figure.
Figure 5-2: Create Managed Service: Info

2. Assign a name to the managed service.
3. (Optional) Provide a text description of the managed service.
4. Select the switch and interface providing the service.

The Show Managed Device Switches Only checkbox, enabled by default, limits the switch selection list
to service node appliances. Enable the Show Connected Switches Only checkbox to limit the display to
connected switches.

5. Select the action from the Action selection list, which provides the following options.

• Application ID
• Deduplication: Deduplicate selected traffic, including NATted traffic.
• GTP Correlation
• Header Strip: Remove bytes of packet starting from zero till selected Anchor and offset bytes
• Header Strip Cisco Fabric Path Header: Remove the Cisco Fabric Path encapsulation header
• Header Strip ERSPAN Header: Remove Encapsulated Remote Switch Port Analyzer Encapsulation

header
• Header Strip Genev1 Header: Remove Generic Network Virtualization Encapsulation header
• Header Strip L3 MPLS Header: Remove Layer 3 MPLS encapsulation header
• Header Strip LISP Header: Remove Locator Separation Protocol Encapsulation header
• Header Strip VXLAN Header: Remove Virtual Extensible LAN Encapsulation header
• IPFIX: Generate IPFIX by selecting matching traffic and forwarding it to specified collectors.
• Mask: Mask sensitive information as specified by the user in packet fields.
• NetFlow: Generate a NetFlow by selecting matching traffic and forwarding it to specified collectors.
• Pattern-Drop: Drop matching traffic.
• Pattern Match: Forward matching traffic.
• Session Slice: Slice TCP sessions.
• Slice: Slice the given number of bytes based on the specified starting point in the packet.
• TCP Analysis
• Timestamp: Identify the time that the service node receives the packet.
• UDP Replication: Copy UDP messages to multiple IP destinations, such as Syslog or

NetFlow messages.
6. (Optional) Identify the starting point for service actions.

Identify the start point for the deduplication, mask, pattern-match, pattern-drop services, or slice services
using one of the keywords listed below.
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• packet-start: add the number of bytes specified by the integer value to the first byte in the packet.
• l3-header-start: add the number of bytes specified by the integer value to the first byte in the Layer

3 header.
• l4-header-start: add the number of bytes specified by the integer value to the first byte in the

layer-4 header.
• l4-payload-start: add the number of bytes specified by the integer value to the first byte in the layer-4

user data.
• integer: specify the number of bytes to offset for determining the start location for the service action

relative to the specified start keyword.
7. To assign a managed service to a policy, enable the checkbox on the Managed Services page of the

Create Policy or Edit Policy dialog.
8. Select the backup service from the Backup Service selection list to create a backup service. The backup

service is used when the primary service is not available.

5.4.2  Using the CLI to Define a Managed Service

Note:  When connecting a LAG interface to the DANZ Monitoring Fabric (DMF) service node
appliance, member links should be of the same speed and can span across multiple service nodes.
The maximum number of supported member links per LAG interface is 32, which varies based on the
switch platform. Please refer to the hardware guide for the exact details of the supported configuration.

To configure a service to direct traffic to a DMF service node, complete the following steps:
1. Define an identifier for the managed service by entering the following command:

controller-1(config)# managed-service DEDUPLICATE-1
controller-1(config-managed-srv)#

This step enters the config-managed-srv submode, where you can configure a DMF-
managed service.

2. (Optional) Configure a description for the current managed service by entering the following command:

controller-1(config-managed-srv)# description “managed service for policy
 DEDUPLICATE-1”

The following are the commands available from this submode:

• description: provide a service description
• post-service-match: select traffic after applying the header strip service
• Action sequence number in the range [1 - 20000]: identifier of service action
• service-interface: associate an interface with the service

3. Use a number in the range [1 - 20000] to identify a service action for a managed service.

The following summarizes the available service actions. See the subsequent sections for details and
examples for specific service actions.

• dedup {anchor-offset | full-packet | routed-packet}
• header-strip {l4-header-start | l4-payload-start | packet-start }[offset]
• decap-cisco-fp {drop}
• decap-erspan {drop}
• decap-geneve {drop}
• decap-l3-mpls {drop}
• decap-lisp {drop}
• decap-vxlan {drop}
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• mask {mask/pattern} [{packet-start | l3-header-start | l4-header-start | l4-payload-start}
mask/offset] [mask/mask-start mask/mask-end]}

• netflow Delivery_interface Name
• ipfix Delivery_interface Name
• udp-replicate Delivery_interface Name
• tcp-analysis Delivery_interface Name

Note:  The IPFIX, NetFlow, and udp-replicate service actions enable a separate submode for
defining one or more specific configurations. One of these services must be the last service applied
to the traffic selected by the policy.

• pattern-drop pattern [{l3-header-start | l4-header-start | packet-start }]
• pattern-match pattern [{l3-header-start | l4-header-start | packet-start }] |
• slice {packet-start | l3-header-start | l4-header-start | l4-payload-start} integer}
• timestamp

For example, the following command enables packet deduplication on the routed packet:

controller-1(config-managed-srv)# 1 dedup routed-packet

4. Optionally, identify the start point for the mask, pattern-match, pattern-drop services, or slice services.
5. Identify the service interface for the managed service by entering the following command:

controller-1(config-managed-srv)# service-interface switch DMF-CORE-SWITCH-1
 ethernet40

Use a port channel instead of an interface to increase the bandwidth available to the managed service.
The following example enables lag-interface1 for the service interface:

controller-1(config-managed-srv)# service-interface switch DMF-CORE-SWITCH-1
 lag1

6. Apply the managed service within a policy like any other service, as shown in the following examples for
deduplication, NetFlow, pattern matching (forwarding), and packet slicing services.

Note:  Multiple DMF policies can use the same managed service, for example, a packet slicing
managed service.

5.4.3  Monitoring Managed Services

To identify managed services bound to a service node interface and the health status of the respective
interface, use the following commands:

controller-1# show managed-service-device <SN-Name> interfaces
controller-1# show managed-service-device <SN-Name> stats

For example, the following command shows the managed services handled by the Service Node Interface
(SNI):
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Note:  The show managed-service-device <SN-Name> stats <Managed-service-name>
command filters the statistics of a specific managed service.

The Load column shows no, low, moderate, high, and critical health indicators. These health indicators are
represented by green, yellow, and red under DANZ Monitoring Fabric > Managed Services > Devices >
Service Stats. They reflect the processor load on the service node interface at that instant but do not show
the bandwidth of the respective data port (SNI) handling traffic, as shown in the following sample snapshot of
the Service Stats output.
Figure 5-3: Service Node Interface Load Indicator

5.5  Deduplication Action

The DANZ Monitoring Fabric (DMF) Service Node enhances the efficiency of network monitoring tools by
eliminating duplicate packets. Duplicate packets can be introduced into the out-of-band monitoring data
stream by receiving the same flow from multiple TAP or SPAN ports spread across the production network.
Deduplication eliminates these duplicate packets and allows more efficient use of passive monitoring tools.

The DMF Service Node provides three modes of deduplication for different types of duplicate packets.

• Full packet deduplication: deduplicates incoming packets that are identical at the L2/L3/L4 layers.
• Routed packet deduplication: as packets traverse an IP network, the mac address changes from

hop to hop. Routed packet deduplication allows the user to match packets from the start of the L3
header onwards.

• Natted packet deduplication: to perform natted deduplication, the service node compares packets in
the configured window that are identical from the start of the L4 payload onwards. To use natted packet
deduplication, complete the following fields as required:

• Anchor: Packet Start, L2 Header Start, L3 Header Start, or L3 Payload Start fields.
• Offset: the number of bytes from the anchor where the deduplication check begins.

The time window in which the service looks for duplicate packets is configurable. Select between 2ms (the
default), 4ms, 6ms, and 8ms.
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GUI Configuration

Figure 5-4: Create Managed Service>Action: Deduplication Action

CLI Configuration

Controller-1(config)# show running-config managed-service MS-DEDUP-FULL-PACKET
! managed-service
managed-service MS-DEDUP-FULL-PACKET
description 'This is a service that does Full Packet Deduplication'
1 dedup full-packet window 8
service-interface switch CORE-SWITCH-1 ethernet13/1
Controller-1(config)#

Controller-1(config)# show running-config managed-service MS-DEDUP-ROUTED-
PACKET
! managed-service
managed-service MS-DEDUP-ROUTED-PACKET
description 'This is a service that does Routed Packet Deduplication'
1 dedup routed-packet window 8
service-interface switch CORE-SWITCH-1 ethernet13/2
Controller-1(config)#

Controller-1(config)# show running-config managed-service MS-DEDUP-NATTED-
PACKET
! managed-service
managed-service MS-DEDUP-NATTED-PACKET
description 'This is a service that does Natted Packet Deduplication'
1 dedup anchor-offset l4-payload-start 0 window 8
service-interface switch CORE-SWITCH-1 ethernet13/3
Controller-1(config)#

Note:  The existing command is augmented to show the deduplication percentage. The command
syntax is show managed-service-device <SN- name> stats <dedup-service-name>
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5.6  Header Strip Action

This action removes specific headers from the traffic selected by the associated DANZ Monitoring Fabric
(DMF) policy. Alternatively, define custom header stripping based on the starting position of the Layer-3
header, the Layer-4 header, the Layer-4 payload, or the first byte in the packet.

Use the following decap actions isolated from the header-strip configuration stanza:

• decap-erspan: remove the Encapsulated Remote Switch Port Analyzer (ERSPAN) header.
• decap-cisco-fabric-path: remove the Cisco FabricPath protocol header.
• decap-l3-mpls: remove the Layer-3 Multi-protocol Label Switching (MPLS) header.
• decap-lisp: remove the LISP header.
• decap-vxlan [udp-port vxlan port]: remove the Virtual Extensible LAN (VXLAN) header.
• decap-geneve: remove the Geneve header.

Note:  For the Header Strip and Decap actions, apply post-service rules to select traffic after stripping
the original headers.

To customize the header-strip action, use one of the following keywords to strip up to the specified location in
each packet:

• l3-header-start
• l4-header-start
• l4-payload-start
• packet-start

Input a positive integer representing the offset from which the strip action begins. When omitting an offset, the
header stripping starts from the first byte in the packet.

GUI Configuration

Figure 5-5: Create Managed Service: Header Strip Action

After assigning the required actions to the header stripping service, click Next or Post-Service Match.
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The system displays the Post Service Match page, used in conjunction with the header strip service action.
Figure 5-6: Create Managed Service: Post Service Match for Header Strip Action

CLI Configuration

The header-strip service action strips the header and replaces it in one of the following ways:

• Add the original L2 src-mac, and dst-mac.
• Add the original L2 src-mac, dst-mac, and ether-type.
• Specify and add a custom src-mac, dst-mac, and ether-type.

The following are examples of custom header stripping:

This example strips the header and replaces it with the original L2 src-mac and dst-mac.

! managed-service
managed-service MS-HEADER-STRIP-1
1 header-strip packet-start 20 add-original-l2-dstmac-srcmac
service-interface switch CORE-SWITCH-1 ethernet13/1

This example adds the original L2 src-mac, dst-mac, and ether-type.

! managed-service
managed-service MS-HEADER-STRIP-2
1 header-strip packet-start 20 add-original-l2-dstmac-srcmac-ethertype
service-interface switch CORE-SWITCH-1 ethernet13/2

This example specifies the addition of a customized src-mac, dst-mac, and ether-type.

! managed-service
managed-service MS-HEADER-STRIP-3
1 header-strip packet-start 20 add-custom-l2-header 00:11:01:02:03:04
 00:12:01:02:03:04
0x800
service-interface switch CORE-SWITCH-1 ethernet13/3

5.6.1  Configuring the Post-service Match

The post-service match configuration option enables matching on inner packet fields after the DANZ
Monitoring Fabric (DMF) Service Node performs header stripping. This option is applied on the post-service
interface after the service node completes the strip service action. Feature benefits include the following:

• The fabric can remain in L3/L4 mode. It is not necessary to change to offset match mode.
• Easier configuration.
• All match conditions are available for the inner packet.
• The policy requires only one managed service to perform the strip service action.
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With this feature enabled, DMF knows exactly where to apply the post-service match. The following is an
example of this configuration.

! managed-service
managed-service MS-HEADER-STRIP-4
service-interface switch CORE-SWITCH-1 interface ethernet1
1 decap-l3-mpls
!
post-service-match
1 match ip src-ip 1.1.1.1
2 match tcp dst-ip 2.2.2.0 255.255.255.0
! policy
policy POLICY-1
filter-interface TAP-1
delivery-interface TOOL-1
use-managed-service MS-HEADER-STRIP-4 sequence 1

5.7  IPFIX and Netflow Actions

IP Flow Information Export (IP FIX), also known as NetFlow v10, is an IETF standard defined in RFC 7011.
The IPFIX generator (agent) gathers and transmits information about flows, which are sets of packets that
contain all the keys specified by the IPFIX template. The generator observes the packets received in each
flow and forwards the information to the IPFIX collector (server) in the form as a flowset.

Starting with the DANZ Monitoring Fabric (DMF)-7.1.0 release, NetFlow v9 (Cisco proprietary) and IPFIX/
NetFlow v10 are both supported. Configuration of the IPFIX managed service is similar to configuration for
earlier versions of NetFlow except for the UDP port definition. NetFlow v5 collectors typically listen over UDP
port 2055, while IFPIX collectors listen over UDP port 4739.

NetFlow records are typically exported using User Datagram Protocol (UDP) and collected using a flow
collector. For a NetFlow service, the service node takes incoming traffic and generates NetFlow records. The
service node drops the original packets, and the generated flow records, containing metadata about each
flow, are forwarded out of the service node interface.

5.7.1  IPFIX Template

The IPXIF template consists of the key element IDs representing IP flow, field element IDs representing
actions the exporter has to perform over IP flows matching key element IDs, the template ID number for
uniqueness, collector information, and eviction timers.

To define a template, configure keys of interest representing the IP flow and fields that identify the values
measured by the exporter, the exporter information, and the eviction timers. To define the template, select the
Monitoring > Managed Service > IPFIX Template option from the DANZ Monitoring Fabric (DMF) GUI or
enter the ipfix-template <template-name> command in config mode, replacing template- name with
a unique identifier for the template instance.

5.7.2  IPFIX Keys

Use an IPFIX key to specify the characteristics of the traffic to monitor, such as source and destination MAC
or IP address, VLAN ID, Layer-4 port number, and QoS marking. The generator includes flows in a flow
set having all the attributes specified by the keys in the template applied. The flowset is updated only for
packets that have all the specified attributes. If a single key is missing, the packet is ignored. To see a listing
of the keys supported in the current release of the DANZ Monitoring Fabric (DMF) Service Node, select the
Monitoring > Managed Service > IPFIX Template option from the DMF GUI or type help key in config-
ipxif-template submode. The following are the keys supported in the current release:

• destination-ipv4-address
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• destination-ipv6-address
• destination-mac-address
• destination-transport-port
• dot1q-priority
• dot1q-vlan-id
• ethernet-type
• icmp-type-code-ipv4
• icmp-type-code-ipv6
• ip-class-of-service
• ip-diff-serv-code-point
• ip-protocol-identifier
• ip-ttl
• ip-version
• policy-vlan-id
• records-per-dmf-interface
• source-ipv4-address
• source-ipv6-address
• source-mac-address
• source-transport-port
• vlan id

Note:  The policy-vlan-id and records-per-dmf-interface keys are Arista Proprietary Flow elements.
The policy-vlan-id key helps to query per-policy flow information at Arista Analytics-node (Collector)
in push-per-policy deployment mode. The records-per-dmf-interface key helps to identify filter
interfaces tapping the traffic. The following limitations apply at the time of IPFIX template creation:

• The Controller will not allow the key combination of source-mac-address and records-per-dmf-
interface in push-per-policy mode.

• The Controller will not allow the key combinations of policy-vlan-id and records-per-dmf-
interface in push-per-filter mode.

5.7.3  IPFIX Fields

A field defines each value updated for the packets the generator receives that match the specified keys.
For example, include fields in the template to record the number of packets, the largest and smallest packet
sizes, or the start and end times of the flows. To see a listing of the fields supported in the current release
of the DANZ Monitoring Fabric (DMF) Service Node, select the Monitoring > Managed Service > IPFIX
Template option from the DMF GUI, or type help in config-ipxif-template submode. The following are the
fields supported:

• flow-end-milliseconds
• flow-end-reason
• flow-end-seconds
• flow-start-milliseconds
• flow-start-seconds
• maximum-ip-total-length
• maximum-layer2-total-length
• maximum-ttl
• minimum-ip-total-length
• minimum-layer2-total-length
• minimum-ttl
• octet-delta-count
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• packet-delta-count
• tcp-control-bits

5.7.4  Active and Inactive Timers

After the number of minutes specified by the active timer, the flow set is closed and forwarded to the IPFIX
collector. The default active timer is one minute. During the number of seconds set by the inactive timer, if no
packets that match the flow definition are received, the flow set is closed and forwarded without waiting for the
active timer to expire. The default value for the inactive time is 15 seconds.

5.7.5  Example Flowset

The following is a Wireshark view of an IPFIX flowset.
Figure 5-7: Example IPFIX Flowset in Wireshark

The following is a running-config that shows the IPFIX template used to generate this flowset.

Example IPFIX Template

! ipfix-template
ipfix-template Perf-temp
template-id 22222
key destination-ipv4-address
key destination-transport-port
key dot1q-vlan-id
key source-ipv4-address
key source-transport-port
field flow-end-milliseconds
field flow-end-reason
field flow-start-milliseconds
field maximum-ttl
field minimum-ttl
field packet-delta-count

5.7.6  Using the GUI to Define an IPFIX Template

To define an IPFIX template, complete the following steps:
1. Select the Monitoring > Managed Services option.
2. On the DMF Managed Services page, select IPFIX Templates.
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The system displays the IPFIX Templates section.
Figure 5-8: IPFIX Templates

3. To create a new template, click the provision (+) icon in the IPFIX Templates section.
Figure 5-9: Create IPFIX Template
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4. To add an IPFIX key to the template, click the Settings control in the Keys section. The system displays
the following dialog.
Figure 5-10: Select IPFIX Keys

5. Enable each checkbox for the keys you want to add to the template and click Select.
6. To add an IPFIX field to the template, click the Settings control in the Fields section. The system displays

the following dialog:
Figure 5-11: Select IPFIX Fields

7. Enable the checkbox for each field you want to add to the template and click Select.
8. On the Create IPFIX Template page, click Save.

The new template is added to the IPFIX Templates table, with each key and field listed in the appropriate
column. You can now use this customized template to apply when defining an IPFIX-managed service.
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5.7.7  Using the CLI to Define an IPFIX Template

1. Create an IPFIX template.

controller-1(config)# ipfix-template IPFIX-IP
controller-1(config-ipfix-template)#

This changes the CLI prompt to the config-ipfix-template submode.
2. Define the keys to use for the current template, using the following command:

[ no ] key { ethernet-type | source-mac-address | destination-mac-address | dot1q-vlan-id | dot1q-
priority | ip-version | ip-protocol-identifier | ip-class-of-service | ip-diff-serv-code-point | ip-ttl |
sourceipv4-address | destination-ipv4-address | icmp-type-code-ipv4 | source-ipv6-address |
destination-ipv6-address | icmp-type-code-ipv6 | source-transport-port | destination-transport-port
}

The keys specify the attributes of the flows to be included in the flowset measurements.
3. Define the fields to use for the current template, using the following command:

[ no ] field { packet-delta-count | octet-delta-count | minimum-ip-total-length | maximum-ip- total-
length | flow-start-seconds | flow-end-seconds | flow-end-reason | flow-start-milliseconds | flow-
end-milliseconds | minimum-layer2-total-length | maximum-layer2-total- length | minimum-ttl |
maximum-ttl }

The fields specify the measurements to be included in the flowset.

Use the template when defining the IPFIX action.

5.7.8  Using the GUI to Define an IPFIX Service Action

Select IPFIX from the Action selection list on the Create Managed Service > Action page.

Figure 5-12: Selecting IPFIX Action in Create Managed Service

Complete the following required configuration:

• Assign a delivery interface.
• Configure the collector IP address.
• Identify the IPFIX template.

The following configuration is optional:
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• Inactive timeout: the interval of inactivity that marks a flow inactive.
• Active timeout: length of time between each IPFIX flows for a specific flow.
• Source IP: source address to use for the IPFIX flowsets.
• UDP port: UDP port to use for sending IPFIX flowsets.
• MTU: MTU to use for sending IPFIX flowsets.

After completing the configuration, click Next, and then click Save.

5.7.9  Using the CLI to Define an IPFIX Service Action

Define a managed service and define the IPFIX action.

controller(config)# managed-service MS-IPFIX-SERVICE
controller(config-managed-srv)# 1 ipfix TO-DELIVERY-INTERFACE
controller(config-managed-srv-ipfix)# collector 10.106.1.60
controller(config-managed-srv-ipfix)# template IPFIX-TEMPLATE

The active-timeout and inactive-timeout commands are optional

To view the running-config for a managed service using the IPFIX action, enter the following command:

controller1# show running-config managed-service MS-IPFIX-ACTIVE
! managed-service
managed-service MS-IPFIX-ACTIVE
service-interface switch CORE-SWITCH-1 ethernet13/1
!
1 ipfix TO-DELIVERY-INTERFACE
collector 10.106.1.60
template IPFIX-TEMPLATE

To view the IPFIX templates, enter the following command:

config# show running-config ipfix-template
! ipfix-template
ipfix-template IPFIX-IP
template-id 1974
key destination-ipv4-address
key destination-ipv6-address
key ethernet-type
key source-ipv4-address
key source-ipv6-address
field flow-end-milliseconds
field flow-end-reason
field flow-start-milliseconds
field minimum-ttl
field tcp-control-bits
------------------------output truncated------------------------

5.8  Packet-masking Action

The packet-masking action can hide specific characters in a packet, such as a password or credit card
number, based on offsets from different anchors and by matching characters using regular (regex)
expressions.

The mask service action applies the specified mask to the matched packet region.
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GUI Configuration

Figure 5-13: Create Managed Service: Packet Masking

CLI Configuration

Controller-1(config)# show running-config managed-service MS-PACKET-MASK
! managed-service
managed-service MS-PACKET-MASK
description "This service masks pattern matching an email address in payload
 with X"
1 mask ([a-zA-Z0-9._-]+@[a-zA-Z0-9._-]+.[a-zA-Z0-9_-]+)
service-interface switch CORE-SWITCH-1 ethernet13/1

5.9  Arista Analytics Node Capability

Arista Analytics Node capabilities are enhanced to handle NetFlow V5/V9 and IPFIX Packets. All these flow
data are represented with the Netflow index.
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Note:  NetFlow flow record generation is enhanced for selecting VxLAN traffic. For VxLAN traffic,
flow processing is based on inner headers, with the VNI as part of the key for flow lookup because IP
addresses can overlap between VNIs.

Figure 5-14: NetFlow Managed Service

NetFlow records are exported using User Datagram Protocol (UDP) to one or more specified NetFlow
collectors. Use the DMF Service Node to configure the NetFlow collector IP address and the destination UDP
port. The default UDP port is 2055.

Note:  No other service action, except the UDP replication service, can be applied after a NetFlow
service action because part of the NetFlow action is to drop the packets.

5.9.1  Configuring the Arista Analytics Node Using the GUI

From the Arista Analytics Node dashboard, apply filter rules to display specific flow information.

The following are the options available on this page:

• Delivery interface: interface to use for delivering NetFlow records to collectors.

Note:  The next-hop address must be resolved for the service to be active.

• Collector IP: identify the IP address of the NetFlow collector.
• Inactive timeout: use the inactive-timeout command to configure the interval of inactivity before

NetFlow times out. The default is 15 seconds.
• Source IP: specify a source IP address to use as the source of the NetFlow packets.
• Active timeout: use active timeout to configure a period that a NetFlow can be generated continuously

before it is automatically terminated. The default is one minute.
• UDP port: change the UDP port number used for the NetFlow packets. The default is 2055.
• Flows: specify the maximum number of NetFlow packets allowed. The allowed range is 32768 to 1048576.

The default is 262144.
• Per-interface records: identify the filter interface where the NetFlow packets were originally received. This

information can be used to identify the hop-by-hop path from the filter interface to the NetFlow collector.
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• MTU: change the Maximum Transmission Unit (MTU) used for NetFlow packets.
Figure 5-15: Create Managed Service: NetFlow Action

5.9.2  Configuring the Arista Analytics Node Using the CLI

Use the show managed-services command to display the ARP resolution status.

Note:  The DANZ Monitoring Fabric (DMF) Controller resolves ARP messages for each NetFlow
collector IP address on the delivery interface that matches the defined subnet. The subnets defined on
the delivery interfaces cannot overlap and must be unique for each delivery interface.

Enter the 1 netflow command and identify the configuration name and the submode changes to the
config-managed-srv-netflow mode for viewing and configuring a specific NetFlow configuration.

The DMF Service Node replicates NetFlow packets received without changing the source IP address.
Packets that do not match the specified destination IP address and packets that are not IPv4 or UDP are
passed through. To configure a NetFlow-managed service, complete the following steps:
1. Configure the IP address on the delivery interface.

This IP address should be the next-hop IP address from the DANZ Monitoring Fabric towards the
NetFlow collector.

CONTROLLER-1(config)# switch DMF-DELIVERY-SWITCH-1
CONTROLLER-1(config-switch)# interface ethernet1
CONTROLLER-1(config-switch-if)# role delivery interface-name NETFLOW-DELIV
ERY-PORT ip-address 172.43.75.1 nexthop-ip 172.43.75.2 255.255.255.252

2. Configure the rate-limit for the NetFlow delivery interface.

CONTROLLER-1(config)# switch DMF-DELIVERY-SWITCH-1
CONTROLLER-1(config-switch)# interface ethernet1
CONTROLLER-1(config-switch-if)# role delivery interface-name NETFLOW-DELIV
ERY-PORT ip-address 172.43.75.1 nexthop-ip 172.43.75.2 255.255.255.252
CONTROLLER-1(config-switch-if)# rate-limit 256000

Note:  The rate limit must be configured when enabling Netflow. When upgrading from a version of
DMF before release 6.3.1, the Netflow configuration is not applied until a rate limit is applied to the
delivery interface.
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3. Configure the NetFlow managed service using the 1 netflow command followed by an identifier for the
specific NetFlow configuration.

CONTROLLER-1(config)# managed-service MS-NETFLOW-SERVICE CONTROLLER-1
(config-managed-srv)# 1 netflow NETFLOW-DELIVERY-PORT CONTROLLER-1
(config-managed-srv-netflow)#

The following commands are available in this submode:

• active-timeout: configure the maximum length of time the NetFlow is transmitted before it is ended
(in minutes).

• collector: configure the collector IP address, and change the UDP port number or the MTU.
• inactive-timeout: configure the length of time that the NetFlow is inactive before it is ended

(in seconds).
• max-flows: configure the maximum number of flows managed.

An option exists to limit the number of flows or change the inactivity timeout using the max-flows or active
timeout, or inactive timeout commands.

4. Configure the IP address of the NetFlow collector using the following command:

collector <ip4-address>[udp-port<integer>][mtu <integer>][records-per-int
erface]

The IP address, in IPV4 dotted-decimal notation, is required. The MTU and UDP port are required
when changing these parameters from the defaults. Enable the records-per-interface option to allow
identification of the filter interfaces from which the Netflow originated. Configure the Arista Analytics Node
to display this information, as described in the DMF User Guide.

The following is an example of changing the Netflow UDPF port to 9991.

collector 10.181.19.31 udp-port 9991

Note:  The IP address must be in the same subnet as the configured next hop and unique. It
cannot be the same as the Controller, service node, or any monitoring fabric switch IP address.

5. Configure the DMF policy with the forward action and add the managed service to the policy.

Note:  A DMF policy does not require any configuration related to a delivery interface for NetFlow
policies because the DMF Controller automatically assigns the delivery interface.

The example below shows the configuration required to implement two NetFlow service instances (MS-
NETFLOW-1 and MS-NETFLOW-1).

! switch
switch DMF-DELIVERY-SWITCH-1
!
interface ethernet1
role delivery interface-name NETFLOW-DELIVERY-PORT-1 ip-address 10.3.1.1
nexthop-ip 10.3.1.2 255.255.255.0
interface ethernet2
role delivery interface-name NETFLOW-DELIVERY-PORT-2 ip-address 10.3.2.1
nexthop-ip 10.3.2.2 255.255.255.0
! managed-service
managed-service MS-NETFLOW-1
service-interface switch DMF-CORE-SWITCH-1 interface ethernet11/1
!
1 netflow NETFLOW-DELIVERY-PORT-1
collector-ip 10.106.1.60 udp-port 2055 mtu 1024
managed-service MS-NETFLOW-2
service-interface switch DMF-CORE-SWITCH-2 interface ethernet12/1
!
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1 netflow NETFLOW-DELIVERY-PORT-1
collector-ip 10.106.2.60 udp-port 2055 mtu 1024
! policy
policy GENERATE-NETFLOW-1
action forward
filter-interface TAP-INTF-DC1-1
filter-interface TAP-INTF-DC1-2
use-managed-service MS-NETFLOW-1 sequence 1
1 match any
policy GENERATE-NETFLOW-2
action forward
filter-interface TAP-INTF-DC2-1
filter-interface TAP-INTF-DC2-2
use-managed-service MS-NETFLOW-2 sequence 1
1 match any

5.10  Pattern-drop Action

The pattern-drop service action drops matching traffic.

Pattern matching allows content-based filtering beyond Layer-2, Layer-3, or Layer-4 Headers. This
functionality allows filtering on the following packet fields and values:

• URLs and user agents in the HTTP header
• patterns in BitTorrent packets
• encapsulation headers for specific parameters, including GTP, VXLAN, and VN-Tag
• subscriber device IP (user-endpoint IP)

Pattern matching allows Session-aware Adaptive Packet Filtering (SAPF) to identify HTTPS transactions on
non-standard SSL ports. It can filter custom applications and separate control traffic from user data traffic.

Pattern matching is also helpful in enforcing IT policies, such as identifying hosts using unsupported operating
systems or dropping unsupported traffic. For example, the Windows OS version can be identified and filtered
based on the user-agent field in the HTTP header. The user-agent field may appear at variable offsets, so a
regular expression search is used to identify the specified value wherever it occurs in the packet.

GUI Configuration

Figure 5-16: Create Managed Service: Pattern Drop Action

CLI Configuration

Controller-1(config)# show running-config managed-service MS-PACKET-MASK
! managed-service
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managed-service MS-PACKET-MASK
description "This service drops traffic that has an email address in its
 payload"
1 pattern-drop ([a-zA-Z0-9._-]+@[a-zA-Z0-9._-]+.[a-zA-Z0-9_-]+)
service-interface switch CORE-SWITCH-1 ethernet13/1

5.11  Pattern-match Action

The pattern-match service action matches and forwards matching traffic and is similar to the pattern-drop
service action.

Pattern matching allows content-based filtering beyond Layer-2, Layer-3, or Layer-4 Headers. This
functionality allows filtering on the following packet fields and values:

• URLs and user agents in the HTTP header
• patterns in BitTorrent packets
• encapsulation headers for specific parameters including, GTP, VXLAN, and VN-Tag
• subscriber device IP (user-endpoint IP)
• Pattern matching allows Session Aware Adaptive Packet Filtering and can identify HTTPS transactions

on non-standard SSL ports. It can filter custom applications and can separate control traffic from user
data traffic.

Pattern matching allows Session-aware Adaptive Packet Filtering (SAPF) to identify HTTPS transactions on
non-standard SSL ports. It can filter custom applications and separate control traffic from user data traffic.

Pattern matching is also helpful in enforcing IT policies, such as identifying hosts using unsupported operating
systems or dropping unsupported traffic. For example, the Windows OS version can be identified and filtered
based on the user-agent field in the HTTP header. The user-agent field may appear at variable offsets, so a
regular expression search is used to identify the specified value wherever it occurs in the packet.

GUI Configuration

Figure 5-17: Create Managed Service: Pattern Match Action

CLI Configuration

Use the pattern-match pattern keyword to enable the pattern-matching service action. Specify the pattern to
match for packets to submit to the packet slicing operation.
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The following example matches traffic with the string Windows NT 5.(0-1) anywhere in the packet and
delivers the packets to the delivery interface TOOL-PORT-TO-WIRESHARK-1. This service is optional and is
applied to TCP traffic to destination port 80.

! managed-service
managed-service MS-PATTERN-MATCH
description 'regular expression filtering'
1 pattern-match 'Windows\\sNT\\s5\\.[0-1]'
service-interface switch CORE-SWITCH-1 ethernet13/1
! policy
policy PATTERN-MATCH
action forward
delivery-interface TOOL-PORT-TO-WIRESHARK-1
description 'match regular expression pattern'
filter-interface TAP-INTF-FROM-PRODUCTION
priority 100
use-managed-service MS-PATTERN-MATCH sequence 1 optional
1 match tcp dst-port 80

5.12  Slice Action

The slice service action slices the given number of packets based on the specified starting point in the
packet. Packet slicing reduces packet size to increase processing and monitoring throughput. Passive
monitoring tools process fewer bits while maintaining each packet's vital, relevant portions. Packet slicing can
significantly increase the capacity of forensic recording tools. Apply packet slicing by specifying the number of
bytes to forward based on an offset from the following locations in the packet:

• Packet start
• L3 header start
• L4 header start
• L4 payload start
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GUI Configuration

Figure 5-18: Create Managed Service: Slice Action

This page allows inserting an additional header containing the original header length.

CLI Configuration

Use the slice keyword to enable the packet slicing service action and insert an additional header containing
the original header length, as shown in the following example:

! managed-service
managed-service my-service-name
1 slice l3-header-start 20 insert-original-packet-length
service-interface switch DMF-CORE-SWITCH-1 ethernet20/1

The following example truncates the packet from the first byte of the Layer-4 payload, preserving just the
original Ethernet header. The service is optional and is applied to all TCP traffic from port 80 with the
destination IP address 10.2.19.119

! managed-service
managed-service MS-SLICE-1
description 'slicing service'
1 slice l4-payload-start 1
service-interface switch DMF-CORE-SWITCH-1 ethernet40/1
! policy
policy slicing-policy
action forward
delivery-interface TOOL-PORT-TO-WIRESHARK-1
description 'remove payload'
filter-interface TAP-INTF-FROM-PRODUCTION
priority 100
use-managed-service MS-SLICE-1 sequence 1 optional
1 match tcp dst-ip 10.2.19.119 255.255.255.255 src-port 80
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5.13  Packet Slicing on the 7280 Switch

This feature removes unwanted or unneeded bytes from a packet at a configurable byte position (offset).
This approach is beneficial when the data of interest is situated within the headers or early in the packet
payload. This action reduces the volume of the monitoring stream, particularly in cases where payload data is
not necessary.

Another use case for packet slicing (slice action) can be removing payload data to ensure compliance with the
captured traffic.

Within the DANZ Monitoring Fabric (DMF) fabric, two types of slice-managed services (packet slicing service)
now exist. These types are distinguished based on whether installing the service on a service node or on an
interface of a supported switch. The scope of this document is limited to the slice-managed service configured
on a switch. The managed service interface is the switch interface used to configure this service.

All DMF 8.4 compatible 7280 switches support this feature. Use the show switch all property
command to check which switch in DMF fabric supports this feature. The feature is supported if the Min
Truncate Offset and Max Truncate Offset properties have a non-zero value.

# show switch all property
# Switch Min Truncate Offset  ...  Max Truncate Offset
-|------|-------------------| ... |---------------------------------
1 7280   100                  ...  9236
2 core1                       ... 

Note:  The CLI output example above is truncated for illustrative purposes. The actual output
will differ.

5.13.1  Using the CLI to Configure Packet Slicing - 7280 Switch

Configure a slice-managed service on a switch using the following steps.

1. Create a managed service using the managed-service service name command.
2. Add slice action with packet-start anchor and an offset value between the supported range as

reported by the show switch all property command.
3. Configure the service interface under the config-managed-srv submode using the service-interface

switch switch-name interface-name command as shown in the following example.

> enable
# config
(config)# managed-service slice-action-7280-J2-J2C
(config-managed-srv)# 1 slice packet-start 101
(config-managed-srv)# service-interface switch 7280-J2-J2C Ethernet10/1

1. This feature requires the service interface to be in MAC loopback mode.
4. To set the service interface in MAC loopback mode, navigate to the config-switch-if submode and

configure using the loopback-mode mac command, as shown in the following example.

(config)# switch 7280-J2-J2C
(config-switch)# interface Ethernet10/1
(config-switch-if)# loopback-mode mac

2. Once a managed service for slice action exists, any policy can use it.
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5. Enter the config-policy submode, and chain the managed service using the use-managed-service
service same sequence sequence command.

(config)# policy timestamping-policy
(config-policy)# use-managed-service slice-action-7280-J2-J2C sequence 1

Key points to consider while configuring the slice action on a supported switch:

1. Only the packet-start anchor is supported.
2. Offset should be within the Min/Max truncate size bounds reported by the show switch all property

command. If the configured value is beyond the bound, then we choose the closest value of the range.

For example, if a user configures the offset as 64, and the min truncate offset reported by switch properties
is 100, then the offset used is 100. If the configured offset is 10,000 and the max truncate offset reported
by the switch properties is 9236, then the offset used is 9236.

3. A configured offset for slice-managed service includes FCS when programmed on a switch interface,
which means an offset of 100 will result in a packet size of 96 bytes (accounting for 4-byte FCS).

4. Configuring an offset below 17 is not allowed.
5. The same service interface cannot chain multiple managed services.
6. The insert-original-packet-length option is not applicable for switch-based slice-managed service.

CLI Show Commands

Use the show policy policy name command to see the runtime state of a policy using the slice-
managed service. The command shows the service interface information and stats.

Controller# show policy packet-slicing-policy
Policy Name            : packet-slicing-policy
Config Status          : active - forward
Runtime Status         : installed
Detailed Status        : installed - installed to forward
Priority               : 100
Overlap Priority       : 0
# of switches with filter interfaces   : 1
# of switches with delivery interfaces : 1
# of switches with service interfaces  : 1
# of filter interfaces : 1
# of delivery interfaces               : 1
# of core interfaces   : 0
# of services          : 1
# of pre service interfaces            : 1
# of post service interfaces           : 1
Push VLAN              : 1
Post Match Filter Traffic              : -
Total Delivery Rate    : -
Total Pre Service Rate : -
Total Post Service Rate: -
Overlapping Policies   : none
Component Policies     : none
Runtime Service Names  : packet-slicing-7280
Installed Time         : 2023-08-09 19:00:40 UTC
Installed Duration     : 1 hour, 17 minutes
~ Match Rules ~
# Rule
-|-----------|
1 1 match any

~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Filter Interface(s) ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# DMF IF Switch IF Name     State Dir Packets Bytes Pkt Rate Bit Rate Counter Reset Time
-|------|------|-----------|-----|---|-------|-----|--------|--------|------------------------------|
1 f1     7280   Ethernet2/1 up    rx  0       0     0        -        2023-08-09 19:00:40.305000 UTC

~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Delivery Interface(s) ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# DMF IF Switch IF Name     State Dir Packets Bytes Pkt Rate Bit Rate Counter Reset Time
-|------|------|-----------|-----|---|-------|-----|--------|--------|------------------------------|
1 d1     7280   Ethernet3/1 up    tx  0       0     0        -        2023-08-09 19:00:40.306000 UTC

~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Service Interface(s) ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# Service name        Role Switch IF Name      State Dir Packets Bytes Pkt Rate Bit Rate Counter Reset Time
-|-------------------|----|------|------------|-----|---|-------|-----|--------|--------|------------------------------|
1 packet-slicing-7280 pre  7280   Ethernet10/1 up    tx  0       0     0        -        2023-08-09 19:00:40.305000 UTC
2 packet-slicing-7280 post 7280   Ethernet10/1 up    rx  0       0     0        -        2023-08-09 19:00:40.306000 UTC

~ Core Interface(s) ~
None.

~ Failed Path(s) ~
None.
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Use the show managed-services command to view the status of all the managed services, including the
packet-slicing managed service on a switch.

Controller# show managed-services
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Managed-services ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
~~~~~~~~
# Service Name        Switch Switch Interface Installed Max Post-Service BW Max Pre-Service BW Total Post-Service BW Total Pre-
Service BW
-|-------------------|------|----------------|---------|-------------------|------------------|---------------------|----------
----------|
1 packet-slicing-7280 7280   Ethernet10/1     True      400Gbps             400Gbps            80bps 80bps

~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Actions of Service Names ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# Service Name        Sequence Service Action Slice Anchor Insert original packet length Slice Offset
-|-------------------|--------|--------------|------------|-----------------------------|------------|
1 packet-slicing-7280 1        slice          packet-start False         101

            

5.13.2  Using the GUI to Configure Packet Slicing - 7820 Switch

Perform the following steps to configure or edit a managed service.

Managed Service Configuration

1. To configure or edit a managed service, navigate to the DMF Managed Services page from the
Monitoring menu and click Managed Services.
Figure 5-19: DANZ Monitoring Fabric (DMF) Managed Services

Figure 5-20: DMF Managed Services Add Managed Service
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2. Configure a managed service interface on a switch that supports packet slicing. Make sure to deselect the
Show Managed Device Switches Only checkbox.
Figure 5-21: Create Managed Service

3. Configure a new managed service action using Add Managed service action. The action chain supports
only one action when configuring packet slicing on a switch.
Figure 5-22: Add Managed service action

4. Use Action > Slice with Anchor > Packet Start to configure the packet slicing managed service on
a switch.
Figure 5-23: Configure Managed Service Action
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5. Click Append to continue. The slice action appears on the Managed Services page.
Figure 5-24: Slice Action Added

1. Interface Loopback Configuration

The managed service interface used for slice action must be in MAC loopback mode.
6. Configure the loopback mode in the Fabric > Interfaces page by clicking on the configuration icon of the

interface.
Figure 5-25: Interfaces

Note:  The image above has been edited for documentation purposes. The actual output will differ.
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7. Enable the toggle for MAC Loopback Mode (set the toggle to Yes).
Figure 5-26: Edit Interface

8. After all configuration changes are done Save the changes.
2. Policy Configuration
9. Create a new policy from the DMF Policies page.

Figure 5-27: DMF Policies Page

151



 

10. Add the previously configured packet slicing managed service.
Figure 5-28: Create Policy

152



Using the DMF Service Node Appliance

11. Select Add Service under the + Add Service(s) option shown above.
Figure 5-29: Add Service

Figure 5-30: Service Type - Service - slice action
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12. Click Add 1 Service and the slice-managed service (packet-slicing-policy) appears in the Create Policy
page.
Figure 5-31: Manage Service Added

13. Click Create Policy and the new policy appears in DMF Policies.
Figure 5-32: DMF Policy Configured

Note:  The images above have been edited for documentation purposes. The actual outputs
may differ.

5.13.3  Troubleshooting Packet Slicing

The show switch all property command provides upper and lower bounds of packet slicing action’s
offset. If bounds are present, the feature is supported; otherwise, the switch does not support the packet
slicing feature.
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The show fabric errors managed-service-error command provides information when DANZ
Monitoring Fabric (DMF) fails to install a configured packet slicing managed service on a switch.

The following are some of the failure cases:
1. The managed service interface is down.
2. More than one action is configured on a managed service interface of the switch.
3. The managed service interface on a switch is neither a physical interface nor a LAG port.
4. A non-slice managed service is configured on a managed service interface of a switch.
5. The switch does not support packet slicing managed service, and its interface is configured with

slice action.
6. Slice action configured on a switch interface is not using a packet-start anchor.
7. The managed service interface is not in MAC loopback mode.

Use the following commands to troubleshoot packet-slicing issues.

Controller# show fabric errors managed-service-error
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Managed Service related error  ~~~~~~~~~~~~~~~~~~~~~~~~~~
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# Error     Service Name
-|---------------------------------------------------------------------------------------------------------------------------
------------------|-------------------|
1 Pre-service interface 7280-Ethernet10/1-to-managed-service on switch 7280 is inactive; Service interface Ethernet10/1 on switch
 7280 is down  packet-slicing-7280
2 Post-service interface 7280-Ethernet10/1-to-managed-service on switch 7280 is inactive; Service interface Ethernet10/1 on switch
 7280 is down packet-slicing-7280

The show switch switch name interface interface name dmf-stats command provides Rx
and Tx rate information for the managed service interface.

Controller# show switch 7280 interface Ethernet10/1 dmf-stats
# Switch DPID Name         State Rx Rate Pkt Rate Peak Rate Peak Pkt Rate TX Rate Pkt Rate Peak Rate Peak Pkt Rate Pkt Drop Rate
-|-----------|------------|-----|-------|--------|---------|-------------|-------|--------|---------|-------------|-------------|
1 7280        Ethernet10/1 down  -       0        128bps    0 -       0        128bps    0 0

The show switch switch name interface interface name stats command provides Rx and Tx
counter information for the managed service interface.

Controller# show switch 7280 interface Ethernet10/1 stats
# Name         Rx Pkts Rx Bytes Rx Drop Tx Pkts Tx Bytes Tx Drop
-|------------|-------|--------|-------|-------|--------|-------|
1 Ethernet10/1 22      843477   0       5140    845937   0

Considerations

1. Managed service action chaining is not supported when using a switch interface as a managed service
interface.

2. When configured for a supported switch, the managed service interface for slice action can only be a
physical interface or a LAG.

3. When using packet slicing managed service, packets ingressing on the managed service interface are
not counted in the ingress interface counters, affecting the output of the show switch switch name
interface interface name stats and show switch switch name interface interface
name dmf-stats commands. This issue does not impact byte counters; all byte counters will show the
original packet size, not the truncated size.

5.14  Session-slice Action

The session-slice action tracks the state of a TCP session (distinguished by its source IP address, source
port, destination IP address, and destination port) and counts the number of packets sent in both directions
(client-to-server and server-to-client). After recognizing the session, the action transmits a user-configured
number of packets to the tool node.

155



 

A session is usually identified by tracking the packets of the three-way TCP handshake that establishes the
session. However, observing the three-way handshake is unnecessary since DANZ Monitoring Fabric (DMF)
creates a new session for any TCP packet that does not match an existing session.

Once a TCP session has been recognized and the session-slice action is applied, the service node tracks
packets in both directions and drops them after the counts in both directions meet a threshold configured by
the user on the Controller.

Note:  The count of packets in one direction may exceed the user-configured threshold because fewer
packets have arrived in the other direction. Counts in both directions must be greater than or equal to
the threshold before dropping packets.

A maximum of 512K IPv4 and 512K IPv6 sessions can be tracked and sliced simultaneously per service-
node interface.

GUI Configuration

Figure 5-33: Create Managed Service: Slice Action

This page provides the option to configure the number of packets the service node accounts for.

CLI Configuration

Use the session-slice keyword to enable TCP the session-slice service action.

The following example allows the service node to account for a new TCP session followed with 10 packets.
Additional packets received from this TCP session are dropped.

! managed-service
managed-service SESSION-SLICE
!
1 session-slice
slice-after 10
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5.15  Timestamp Action

The timestamp service action identifies and timestamps every packet it receives with the time the service
node receives the packet for matching traffic.

GUI Configuration

Figure 5-34: Create Managed Service: Timestamp Action

CLI Configuration

! managed-service
managed-service MS-TIMESTAMP-1
1 timestamp
service-interface switch CORE-SWITCH-1 ethernet15/3

5.16  UDP-replication Action

The UDP-replication service action copies UDP messages, such as Syslog or NetFlow messages, and sends
the copied packets to a new destination IP address.

Configure a rate limit when enabling UDP replication. When upgrading from a version of DANZ Monitoring
Fabric (DMF) before release 6.3.1, the UDP-replication configuration is not applied until a rate limit is applied
to the delivery interface.

The following is an example of applying a rate limit to a delivery interface used for UDP replication:

CONTROLLER-1(config)# switch DMF-DELIVERY-SWITCH-1
CONTROLLER-1(config-switch)# interface ethernet1
CONTROLLER-1(config-switch-if)# role delivery interface-name udp-delivery-1
CONTROLLER-1(config-switch-if)# rate-limit 256000

Note:  No other service action can be applied after a UDP-replication service action.
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GUI Configuration

Use the UDP-replication service to copy UDP traffic, such as Syslog messages or NetFlow packets, and send
the copied packets to a new destination IP address. This function sends traffic to more destination syslog
servers or NetFlow collectors than would otherwise be allowed.

Enable the checkbox for the destination for the copied output, or click the provision control (+) and add the IP
address in the dialog that appears.
Figure 5-35: Configure Output Packet Destination IP

For the header-strip service action only, configure the policy rules for matching traffic after applying the
header-strip service action. After completing pages 1-4, click Append and enable the checkbox to apply
the policy.

Click Save to save the managed service.

CLI Configuration

Enter the 1 udp-replicate command and identify the name of the configuration, the submode
changes to the config-managed-srv-udp-replicate submode, to view and configure a specific UDP-
replication configuration.

controller-1(config)# managed-service MS-UDP-REPLICATE-1
controller-1(config-managed-srv)# 1 udp-replicate DELIVERY-INTF-TO-COLLECTOR
controller-1(config-managed-srv-udp-replicate)#
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From this submode, define the destination address of the packets to copy and the destination address for
sending the copied packets.

controller-1(config-managed-srv-udp-replicate)# in-dst-ip 10.1.1.1
controller-1(config-managed-srv-udp-replicate)# out-dst-ip 10.1.2.1

5.17  Redundancy of Managed Services in Same DMF Policy

In this method, users can use a second managed service as a backup service in the same DANZ Monitoring
Fabric (DMF) policy. The backup service is activated only when the primary service becomes unavailable. The
backup service can be on the same service node or core switch or a different service node and core switch.

Note:  Transitioning from active to backup managed service requires reprogramming switches
and associated managed appliances. This reprogramming, done seamlessly, will result in a slight
traffic loss.

5.17.1  Using the GUI to Configure a Backup Managed Service

To assign a managed service as a backup service in a DANZ Monitoring Fabric (DMF) policy, complete the
following steps:
1. Select Monitoring > Policies and click the Provision control (+) to create a new policy.
2. Configure the policy as required. From the Services section, click the Provision control (+) in the

Managed Services table.
Figure 5-36: Policy with Backup Managed Service

3. Select the primary managed service from the Managed Service selection list.
4. Select the backup service from the Backup Service selection list and click Append.

5.17.2  Using the CLI to Configure a Backup Managed Service

To implement backup-managed services, complete the following steps:
1. Identify the first managed service.

managed-service MS-SLICE-1
1 slice l3-header-start 20
service-interface switch CORE-SWITCH-1 lag1

2. Identify the second managed service.

managed-service MS-SLICE-2
1 slice l3-header-start 20
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service-interface switch CORE-SWITCH-1 lag2

3. Configure the policy referring to the backup managed service.

policy SLICE-PACKETS
action forward
delivery-interface TOOL-PORT-1
filter-interface TAP-PORT-1
use-managed-service MS-SLICE-1 sequence 1 backup-managed-service MS-SLICE-2
1 match ip

5.18  Application Identification

The DMF Application Identification feature allows monitoring of applications identified from packets taken from
filter interfaces and sent through the fabric by sending IPFIX reports to a collector. The feature provides a
filtering function by forwarding or dropping packets from specific applications before sending the packet to the
analysis tools.

Note:  Application identification is supported on R640 Service Nodes (DCA-DM-SC and DCA-DM-
SC2) and R740 Service Nodes (DCA-DM-SDL and DCA-DM-SEL).

5.18.1  Using the CLI to Configure Application Identification

Configure the feature through the Controller in managed services.

There are two application identification services to configure:

• app-id
• app-id-filter
• app-id and app-id-filter combined

5.18.2  Using the CLI to Configure app-id

Perform the following steps to configure app-id.
1. Create a managed service and enter the service interface.
2. Choose the app-id managed service using the <seq num> app-id command.

Note:  The above command should enter the app-id submode, which supports two configuration
parameters: collector and l3-delivery-interface. Both are required.

3. To configure the IP address of the IPFIX collector, enter the following command: collector ip-
address.
The UDP port and MTU parameters are optional; the default values are 4739 and 1500, respectively.

4. Enter the command: l3-delivery-interface delivery interface name to configure the
delivery interface.

Below is an example of app-id configuration that sends IPFIX application records to the collector (analytics
node) at IP address 192.168.1.1 over the configured delivery interface named app-to-analytics:

managed-service ms
service-interface switch core1 ethernet2
!
1 app-id
collector 192.168.1.1
l3-delivery-interface app-to-analytics
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After configuring the app-id, refer to the analytics node for application reports and visualizations. For instance,
a flow is classified internally with the following tuple: ip, tcp, http, google, and google_maps. Consequently,
the analytics node displays the most specific app ID for this flow as google_maps under appName.

On the Analytics Node, there are AppIDs 0-4 representing applications according to their numerical IDs. 0 is
the most specific application identified in that flow, while 4 is the least. In the example above, ID 0 would be
the numerical ID for google_maps, ID 1 google, ID 2 http, ID 3 tcp, and ID 4 IP address. Use the
appName in place of these since these require an ID to name mapping to interpret.

5.18.3  Using the CLI to Configure app-id-filter

Perform the following steps to configure app-id-filter:
1. Create a managed service and enter the service interface.
2. Choose the app-id managed service using the <seq num> app-id-filter command.

Note:  The above command should enter the app-id-filter submode, which supports three
configuration parameters: app, app-category, and filter-mode. The category app is required,
while app-category and filter-mode are optional. The option filter-mode has a default
value of forward.

3. Enter the command: app application name to configure the application name.

Tip:  Press the Tab key after entering the app keyword to see all possible application names. Type
in a partial name and press the Tab to see all possible choices to auto-complete the name. The
application name provided must match a name in this list of app names. A service node must be
connected to the Controller for this list to appear. Any number of apps can be entered one at a
time using the app application-name command. The following is an example of a (partial) list
of names:

dmf-controller-1 (config-managed-srv-app-id-filter)# app ibm
ibm     ibm_as_central   ibm_as_dtaq  ibm_as_netprt ibm_as_srvmap
 ibm_iseries ibm_tsm
ibm_app ibm_as_database  ibm_as_file  ibm_as_rmtcmd ibm_db2      
 ibm_tealeaf

4. Filter applications by category using the app-category category name command. Currently, the
applications contained in these categories are not displayed.

dmf-controller-1(config-managed-srv-app-id-filter)# app-category
<Category>         <String> :  <String>
aaa                Category selection
adult_content      Category selection
advertising        Category selection
aetls              Category selection
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analytics          Category selection
anonymizer         Category selection
audio_chat         Category selection
basic              Category selection
blog               Category selection
cdn                Category selection
certif_auth        Category selection
chat               Category selection
classified_ads     Category selection
cloud_services     Category selection
crowdfunding       Category selection
cryptocurrency     Category selection
db                 Category selection
dea_mail           Category selection
ebook_reader       Category selection
education          Category selection
email              Category selection
enterprise         Category selection
file_mngt          Category selection
file_transfer      Category selection
forum              Category selection
gaming             Category selection
healthcare         Category selection
im_mc              Category selection
iot                Category selection
map_service        Category selection
mm_streaming       Category selection
mobile             Category selection
networking         Category selection
news_portal        Category selection
p2p                Category selection
payment_service    Category selection
remote_access      Category selection
scada              Category selection
social_network     Category selection
speedtest          Category selection
standardized       Category selection
transportation     Category selection
update             Category selection
video_chat         Category selection
voip               Category selection
vpn_tun            Category selection
web                Category selection
web_ecom           Category selection
web_search         Category selection
web_sites          Category selection
webmail            Category selection

5. The filter-mode parameter supports two modes: forward and drop. Enter filter-mode forward
to allow the packets to be forwarded based on the configured applications. Enter filter-mode drop to
drop these packets.
An example of an app-id-filter configuration that drops all Facebook and IBM Tealeaf packets:

managed-service MS
 service-interface switch CORE-SWITCH-1 ethernet2
 !
 1 app-id-filter
  app facebook
  app ibm_tealeaf
filter-mode drop
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CAUTION:  The app-id-filter configuration filters based on flows. For example, if a session is internally
identified with the following tuple: ip, tcp, http, google, or google_maps, adding any of these
parameters to the filter list permits or drops all the packets matching after determining classification
(e.g., adding tcp to the filter list permits or blocks packets from the aforementioned 5-tuple flow as
well as all other tcp flows). Use caution when filtering using the lower-layer protocols and apps. Also,
when forwarding an application, packets will be dropped at the beginning of the session until the
application is identified. When dropping, packets at the beginning of the session will be passed until
the application is identified.

5.18.4  Using the CLI to Configure app-id and app-id-filter Combined

Follow the configuration steps described in the services above to configure app-id-filter and app-id
together. However, in this case, app-id should use a higher seq num than app-id-filter. Thus, the
traffic is processed through the app-id-filter policy first, then through app-id.

This behavior can be helpful to monitor certain types of traffic. The following is an example of a combined
app-id-filter and app-id configuration.

! managed-service
managed-service MS1
service-interface switch CORE-SWITCH-1 ethernet2
!
!
1 app-id-filter
app facebook
filter-mode forward
!
2 app-id
collector 1.1.1.1
l3-delivery-interface L3-INTF-1

Note:  The two drawbacks of this configuration are app-id dropping all traffic except facebook, and
this type of service chaining can cause a performance hit and high memory utilization.

5.18.5  Using the GUI to Configure app-id and app-id-filter

App ID and App ID Filter are in the Managed Service workflow. Perform the following steps to complete
the configuration.
1. Navigate to the Monitoring  > Managed Services page. Click the table action + icon button to add a new

managed service.
Figure 5-37: DANZ Monitoring Fabric (DMF) Managed Services
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2. Configure the Name, Switch, and Interface inputs in the Info step.
Figure 5-38: Info Step

3. In the Actions step, click the + icon to add a new managed service action.
Figure 5-39: Add App ID Action
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4. To Add the App ID Action, select App ID from the action selection input:
Figure 5-40: Select App ID

5. Fill in the Delivery Interface, Collector IP, UDP Port, and MTU inputs and click Append to include the
action in the managed service:
Figure 5-41: Delivery Interface
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6. To Add the App ID Filter Action, select App ID Filter from the action selection input:
Figure 5-42: Select App ID Filter

7. Select the Filter input as Forward or Drop action:
Figure 5-43: Select Filter Input

8. Use the App Names section to add app names.
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a. Click the + button to open a modal pane to add an app name.
b. The table lists all app names. Use the text search to filter out app names. Select the checkbox for app

names to include and click Append Selected.
c. Repeat the above step to add more app names as necessary.
Figure 5-44: Associate App Names
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9. The selected app names are now listed. Use the - icon button to remove any app names, if necessary:
Figure 5-45: Application Names

10. Click the Append button to add the action to the managed service and Save to save the managed service.

For existing managed services, add App ID or App ID Filter using the Edit workflow of a managed service.

5.18.6  Dynamic Signature Updates (Beta Version)

This beta feature allows the app-id and app-id-filter services to classify newly supported applications at
runtime rather than waiting for an update in the next DANZ Monitoring Fabric (DMF) release. Perform such
runtime service updates during a maintenance cycle. There can be issues with backward compatibility if
attempting to revert to an older bundle. Adopt only supported versions. In the Controller’s CLI, perform the
following recommended steps:
1. Remove all policies containing app-id or app-id-filter. Remove the app-id and app-id-filter managed

services from the policies using the command: no use-managed-service in policy config.
Arista Networks recommends this step to avoid errors and service node reboots during the update
process. A warning message is printed right before confirming a push. Proceeding without this step may
work but is not recommended as there is a risk of service node reboots.

Note:  Arista Networks provides the specific update file in the command example below.

2. To pull the signature file onto the Controller node, use the command:

dmf-controller-1(config)# app-id pull-signature-file user@host:path to
 file.tar.gz
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Password:
file.tar.gz       5.47MB 1.63MBps 00:03

3. Fetch and validate the file using the command:

dmf-controller-1(config)# app-id fetch-signature-file file://file.tar.gz
Fetch successful.
Checksum   : abcdefgh12345
Fetch time : 2023-08-02 22:20:49.422000 UTC
Filename   : file.tar.gz

4. To view files currently saved on the Controller node after the fetch operation is successful, use the
following command:

dmf-controller-1(config)# app-id list-signature-files
# Signature-file     Checksum     Fetch time
-|-----------------|-----------------|------------------------------|
1 file.tar.gz   abcdefgh12345   2023-08-02 22:20:49.422000 UTC

Note:  Only the files listed by this command can be pushed to service nodes.

5. Push the file from the Controller to the service nodes using the following command:

dmf-controller-1(config)# app-id push-signature-file file.tar.gz
App ID update: WARNING: This push will affect all service nodes
App ID update: Remove policies configured with app-id or app-id-filter
 before continuing to avoid errors
App ID update: Signature file: file.tar.gz
App ID update: Push app ID signatures to all Service Nodes? Update ("y" or
 "yes" to continue): yes
Push successful.

Checksum     : abcdefgh12345
Fetch time   : 2023-08-02 22:20:49.422000 UTC
Filename     : file.tar.gz
Sn push time : 2023-08-02 22:21:49.422000 UTC

6. Add the app-id and app-id-filter managed services back to the policies.
As a result of adding app-id, service nodes can now identify and report new applications to the
analytics node.
After adding back app-id-filter, new application names should appear in the app-id-filter Controller app list.
To test this, enter app-id-filter submode and press the Tab to see the full list of applications. New
identified applications should appear in this list.

7. To delete a signature file from the Controller, use the command below.

Note:  DMF only allows deleting a signature file that is not actively in use by any service node,
which needs to keep a working file in case of issues—attempting to delete an active file causes the
command to fail.

dmf-controller-1(config)# app-id delete-signature-file file.tar.gz
Delete successful for file: file.tar.gz

Useful Information

The fetch and delete operations are synced with standby controllers as follows:

• fetch: after a successful fetch on the active Controller, it invokes the fetch RPC on the standby Controller
by providing a signed HTTP URL as the source. This URL points to an internal REST API that provides the
recently fetched signature file.

• delete: the active Controller invokes the delete RPC call on the standby controllers.
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The Controller stores the signature files in this location: /var/lib/capture/appidsignatureupdate.

On a service node, files are overwritten and always contain the complete set of applications.

Note:  An analytics node cannot display these applications in the current version.

This step is only for informational purposes:

• Verify the bundle version on the service node by entering the show service-node app-id-bundle-
version command in the service node CLI, as shown below.
Figure 5-46: Before Update

Figure 5-46: After Update

5.18.7  CLI Show Commands

In the service node CLI, use the following show command:

show service-node app-id-bundle-version

This command shows the version of the bundle in use. An app-id or app-id-filter instance must be
configured, or an error message is displayed.

dmf-servicenode-1# show app-id bundle-version
Name : bundle_version
Data : 1.680.0-22 (build date Sep 26 2023)
dmf-servicenode-1#

5.18.8  Syslog Messages

Syslog messages for configuring the app-id and app-id-filter services appear in a service node’s
syslog through journalctl.

A Service Node syslog registers events for the app-id add, modify, and delete actions.

These events contain the keywords dpi and dpi-filter, which correspond to app-id and app-id-filter.

For example:

Adding dpi for port, 
Modifying dpi for port, 
Deleting dpi for port,
Adding dpi filter for port, 
Modifying dpi filter for port, 
Deleting dpi filter for port, 
App appname does not exist - An invalid app name was entered.

The addition, modification, or deletion of app names in an app-id-filter managed-service in the
Controller node’s CLI influences the policy refresh activity, and these events register in floodlight.log.
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5.18.9  Scale

• Max concurrent sessions are currently set to permit less than 200,000 active flows per core. Performance
may drop the more concurrent flows there are. This value is a maximum value to prevent the service from
overloading. Surpassing this threshold may cause some flows not to be processed, and the new flows will
not be identified or filtered. Entries for inactive flows will time out after a few minutes for ongoing sessions
and a few seconds after the session ends.

• If there are many inactive sessions, DMF holds the flow contexts, reducing the number of available flows
used for DPI. The timeouts are approximately 7 minutes for TCP sessions and 1 minute for UDP.

• Heavy application traffic load degrades performance.

5.18.10  Troubleshooting and Considerations

Troubleshooting

• If IPFIX reports do not appear on an analytics node or collector, ensure the UDP port is correctly
configured and verify the analytics node is receiving traffic.

• If the app-id-filter app list does not appear, ensure a service node is connected using the show
service-node command on the Controller.

• Be aware a flow may contain other IDs and protocols when using app-id-filter. For example, the specific
application for a flow may be google_maps, but there may be protocols or broader applications under it,
such as ssh, http, or google. Adding google_maps will filter this flow. However, adding ssh will also
filter this flow. Therefore, adding any of these to the filter list will cause packets of this flow to be forwarded
or dropped.

• During a dynamic signature update, if a Service Node reboot occurs, it will likely boot up with the correct
version. To avoid issues of traffic loss, perform the update during a maintenance window. Also, during an
update, the Service Node will temporarily not send LLDP packets to the controller and disconnect for a
short while.

• After a dynamic signature update, do not change configurations or push another signature file for several
minutes. The update will take some time to process. If there are any VFT changes, it may lead to warning
messages in floodlight, such as:

Sync job 2853: still waiting after 50002 ms 
                        Stuck switch update: R740-25G[00:00:e4:43:4b:bb
:38:ca], duration=50002ms, stage=COMMIT

These messages may also be seen when configuring DPI on a large number of ports.

Considerations

• If using a drop filter, a small amount of packets may slip through the filter before determining an application
ID for a flow. When using a forward filter, a few packets may not be forwarded, estimated to be between 1
and 6 packets at the beginning of a flow.

• If using a drop filter, add the unknown app ID to the filter list to drop any unidentified traffic if these
packets are unwanted.

• The Controller must be connected to a service node for the app-id-filter app list to appear. If the
list does not appear and the application names are unknown, use the app-id to send reports to the
analytics node and use the listed application names to configure an app-id-filter. The name must
match exactly.

• Since app-category does not currently show the applications included in that category, do not use it
when targeting specific apps. Categories like basic, which include all basic networking protocols like TCP
and UDP, may affect all flows.

• For app-id, a report is only generated for a flow once that flow has been fully classified. Therefore, the
number of reported applications may not match the total number of flows. DANZ Monitoring Fabric (DMF)
sends these reports after identifying enough applications on the service node. If DMF identifies numerous
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applications, it dispatches the reports quickly. However, DMF sends these reports every 10 seconds when
identifying only a few applications.

• DMF treats a bidirectional flow as part of the same n-tuple. As such, generated reports contain the client's
source IP address and the server's destination IP address.

• While configuring many ports with the app-id, there may occasionally be a few RX drops on the 16 port
machines at a high traffic rate in the first few seconds.

• The app-id and app-id-filter services are more resource-intensive than other services. Combining
them in a service chain or configuring many instances of them may lead to degradation in performance.

• At scale, such as configuring 16 ports on the R740 DCA-DM-SEL, app-id may take a few minutes to set
up on all these ports. This is also true when doing a dynamic signature update.

5.19  Redundancy of Managed Services Using Two DMF Policies

In this method, users can employ a second policy with a second managed service to provide redundancy. The
idea here is to duplicate the policies but assign a lower policy priority to the second DANZ Monitoring Fabric
(DMF) policy. In this case, the backup policy (and, by extension, the backup service) will always be active but
only receive relevant traffic once the primary policy goes down. This method provides true redundancy at the
policy, service-node, and core switch levels but uses additional network and node resources.

Example

! managed-service
managed-service MS-SLICE-1
1 slice l3-header-start 20
service-interface switch CORE-SWITCH-1 lag1
!
managed-service MS-SLICE-2
1 slice l3-header-start 20
service-interface switch CORE-SWITCH-1 lag2
! policy
policy ACTIVE-POLICY
priority 101
action forward
delivery-interface TOOL-PORT-1
filter-interface TAP-PORT-1
use-managed-service MS-SLICE-1 sequence 1
1 match ip
!
policy BACKUP-POLICY
priority 100
action forward
delivery-interface TOOL-PORT-1
filter-interface TAP-PORT-1
use-managed-service MS-SLICE-2 sequence 1
1 match ip

5.20  Cloud Services Filtering

The DANZ Monitoring Fabric (DMF) supports traffic filtering to specific services hosted in the public cloud
and redirecting filtered traffic to customer tools. DMF achieves this functionality by reading the source and
destination IP addresses of specific flows, identifying the Autonomous System number they belong to, tagging
the flows with their respective AS numbers, and redirecting them to customer tools for consumption.

The following is the list of services supported:

• amazon: traffic with src/dst IP belonging to Amazon
• ebay: traffic with src/dst IP belonging to eBay

172



Using the DMF Service Node Appliance

• facebook: traffic with src/dst IP belonging to FaceBook
• google: traffic with src/dst IP belonging to Google
• microsoft: traffic with src/dst IP belonging to Microsoft
• netflix: traffic with src/dst IP belonging to Netflix
• office365: traffic for Microsoft Office365
• sharepoint: traffic for Microsoft Sharepoint
• skype: traffic for Microsoft Skype
• twitter: traffic with src/dst IP belonging to Twitter
• default: traffic not matching other rules in this service. Supported types are match or drop.

The option drop instructs the DMF Service Node to drop packets matching the configured application.

The option match instructs the DMF Service Node to deliver packets to the delivery interfaces connected to
the customer tool.

A default drop action is auto-applied as the last rule, except when configuring the last rule as match
default. It instructs the DMF Service Node to drop packets when either of the following conditions occurs:

• The stream's source IP address or destination IP address doesn't belong to any AS number.
• The stream's source IP address or destination IP address is associated with an AS number but has no

specific action set.

5.20.1  Cloud Services Filtering Configuration

Managed Service Configuration

Controller(config)# managed-service <name>
Controller(config-managed-srv)#

Service Action Configuration

Controller(config-managed-srv)# 1 app-filter
Controller(config-managed-srv-appfilter)#

Filter Rules Configuration

Controller(config-managed-srv-appfilter)# 1 drop sharepoint
Controller(config-managed-srv-appfilter)# 2 match google
Controller(config-managed-srv-appfilter)# show this
! managed-service
managed-service sf3
service-interface switch CORE-SWITCH-1 ethernet13/1
!
1 service- app-filter
1 drop sharepoint
2 match google

A policy having a managed service with app-filter as the managed service, but with no matches specified will
fail to install. The example below shows a policy incomplete-policy having failed due to the absence
of a Match/Drop rule in the managed service incomplete-managed-service.

Controller(config)# show running-config managed-service incomplete-managed-
service
! managed-service
managed-service incomplete-managed-service
1 app-filter
Controller(config)# show running-config policy R730-sf3
! policy
policy incomplete-policy
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action forward
delivery-interface TOOL-PORT-1
filter-interface TAP-PORT-1
use-managed-service incomplete-managed-service sequence 1
1 match any

Controller(config-managed-srv-appfilter)# show policy incomplete-policy
Policy Name : incomplete-policy
Config Status : active - forward
Runtime Status : one or more required service down
Detailed Status : one or more required service down - installed to
forward
Priority : 100
Overlap Priority : 0

5.21  Multiple Services Per Service Node Interface

The service-node capability is augmented to support more than one service action per service-node interface.
Though this feature is economical regarding per-interface cost, it could cause packet drops in high-volume
traffic environments. Arista Networks recommends using this feature judiciously.

Example

controller-1# show running-config managed-service Test
! managed-service
managed-service Test
service-interface switch CORE-SWITCH-1 ethernet13/1
1 dedup full-packet window 2
2 mask BIGSWITCH
3 slice l4-payload-start 0
!
4 netflow an-collector
collector 10.106.6.15 udp-port 2055 mtu 1500

This feature replaces the service-action command with sequential numbers. The allowed range of
sequence numbers is 1 -20000. In the above example, the sequence numbering impacts the order in which
the managed services influence the traffic.

Note:  After upgrading to DANZ Monitoring Fabric (DMF) release 8.1.0 and later, the service-action
CLI is automatically replaced with sequence number(s).

Specific managed service statistics can be viewed via the following CLI command:

When using the DMF GUI, view the above information in Monitoring > Managed Services > Devices >
Service Stats.

Note:  The following limitations apply to this mode of configuration:

• The NetFlow/IPFIX-action configuration should not be followed by the timestamp service action.

174



Using the DMF Service Node Appliance

• The UDP-replication action configuration should be the last service in the sequence.
• The header-stripping service with post-service-match rule configured should not be followed by the

NetFlow, IPFIX, udp-replication, timestamp and TCP-analysis services.

5.22  Sample Service

The Service Node forwards packets based on the max-tokens and tokens-per-refresh parameters
using the DANZ Monitoring Fabric (DMF) Sample Service feature. The sample service uses one token to
forward one packet.

After consuming all the initial tokens from the max-tokens bucket, the system drops subsequent packets
until the max-tokens bucket refills using the tokens-per-refresh counter at a recurring predefined time
interval of 10ms. Packet sizes do not affect this service.

Arista Networks recommends keeping the tokens-per-refresh value at or below max-tokens. For
example, max-tokens = 1000 and tokens-per-refresh = 500.

Setting the max-tokens value to 1000 means that the initial number of tokens is 1000, and the maximum
number of tokens stored at any time is 1000.

The max-tokens bucket will be zero when the Service Node has forwarded 1000 packets before the first 10
ms period ends, leading to a situation where the Service Node is no longer forwarding packets. After every
10ms time interval, if the tokens-per-refresh value is set to 500, the max-tokens bucket is refilled using
the tokens-per-refresh configured value, 500 tokens in this case, to pass packets the service tries to
use immediately.

Suppose the traffic rate is higher than the refresh amount added. In that case, available tokens will eventually
drop back to 0, and every 10ms, only 500 packets will be forwarded, with subsequent packets being dropped.

If the traffic rate is lower than the refresh amount added, a surplus of tokens will result in all packets passing.
Since the system only consumes some of the tokens before the next refresh interval, available tokens will
accumulate until they reach the max-tokens value of 1000. After 1000, the system does not store any
surplus tokens above the max-tokens value.

To estimate the maximum possible packets passed per second (pps), use the calculation (1000ms/10ms)
* tokens-per-refresh and assume the max-tokens value is larger than tokens-per-refresh. For
example, if the tokens-per-refresh value is 5000, then 500000 pps are passed.

The Sample Service feature can be used as a standalone Managed Service or chained with other Managed
Services.

Use Cases and Compatibility

• Applies to Service Nodes
• Limit traffic to tools that cannot handle a large amount of traffic.
• Use the Sample Service before another managed service to decrease the load on that service.
• The Sample Service is applicable when needing only a portion of the total packets without specifically

choosing which packets to forward.

5.22.1  Sample Service CLI Configuration

1. Create a managed service and enter the service interface.
2. Choose the sample managed service with the seq num sample command.

a. There are two required configuration values: max-tokens and tokens-per-refresh. There are no
default values, and the service requires both values.

b. The max-tokens value is the maximum size of tokens in the token bucket. The service will start with
the number of tokens specified when first configured. Each packet passed consumes one token. If no
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tokens remain, packet forwarding stops. Configure the max-tokens value from a range of 1 to the
maximum uint64 (unsigned integer) value of 9,223,372,036,854,775,807.

c. DMF refreshes the token bucket every 10 ms. The tokens-per-refresh value is the number of
tokens added to the token bucket on each refresh. Each packet passed consumes one token, and
when the number of tokens drops to zero, the system drops all subsequent packets until the next
refresh. The number of tokens in the bucket cannot exceed the value of max-tokens. Configure
the tokens-per-refresh value from a range of 1 to the maximum uint64 (unsigned integer) value of
9,223,372,036,854,775,807.

The following example illustrates a typical Sample Service configuration

dmf-controller-1(config-managed-srv-sample)# show this
! managed-service
managed-service MS
!
3 sample
max-tokens 50000
tokens-per-refresh 20000

3. Add the managed service to the policy.

Show Commands

Use the show running-config managed-service sample_service_name command to view
pertinent details. In this example, the sample_service_name is techpubs.

DMF-SCALE-R450> show running-config managed-service techpubs

! managed-service
managed-service techpubs
  !
  1 sample
    max-tokens 1000
    tokens-per-refresh 500
DMF-SCALE-R450>

5.22.2  Sample Service GUI Configuration

Use the following steps to add a Sample Service.
1. Navigate to the Monitoring > Managed Services page.

Figure 5-48: DMF Managed Services
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2. Under the Managed Services section, click the + icon to create a new managed service. Go to the
Actions, and select the Sample option in the Action drop-down. Enter values for Max tokens and
Tokens per refresh.
Figure 5-49: Configure Managed Service Action

3. Click Append and then Save.

5.22.3  Troubleshooting Sample Service

Troubleshooting

• If the number of packets forwarded by the Service Node interfaces is few, the max-tokens and tokens-
per-refresh values likely need to be higher.

• If fewer packets than the tokens-per-refresh value forward, ensure the max-tokens value is larger
than the tokens-per-refresh value. The system discards any surplus refresh tokens above the max-
tokens value.

• When all traffic forwards, the initial max-tokens value is too large, or the tokens refreshed by tokens-
per-refresh are higher than the packet rate.

• When experiencing packet drops after the first 10ms post commencement of traffic, it may be due to a low
tokens-per-refresh value. For example, calculate the minimum value of max-tokens and tokens-
per-refresh that would lead to forwarding all packets.
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Calculation Example

Traffic Rate : 400 Mbps
Packet Size - 64 bytes
400 Mbps = 400000000 bps
400000000 bps = 50000000 Bps
50000000 Bps = 595238 pps (Includes 20 bytes of inter packet gap in addition to
 the 64 bytes)
1000 ms = 595238 pps
1 ms = 595.238 pps
10 ms = 5952 pps
max-tokens : 5952 (the minimum value)
tokens-per-refresh : 5952 ( the minimum value)

5.22.4  Limitations

• In the current implementation, the Service Sample action is bursty. The token consumption rate is not
configured to withhold tokens over time, so a large burst of incoming packets can immediately consume
all the tokens in the bucket. There is currently no way to select what traffic is forwarded or dropped; it only
depends on when the packets arrive concerning the refresh interval.

• Setting the max-tokens and tokens-per-refresh values too high will forward all packets. The
maximum value is 9,223,372,036,854,775,807, but Arista Networks recommends staying within the
maximum values stated under the description section.

5.23  Latency and Drop Analysis (Beta Version)

Latency and drop information help determine if there is a loss in a particular flow and where the loss occurred.
A Service Node action configured as a DANZ Monitoring Fabric (DMF) managed service has two separate
taps or spans in the production network and can measure the latency of a flow traversing through these two
points. It can also detect packet drops between two points in the network if the packet only appears on one
point within a specified time frame, currently set to 100ms.

Latency and drop analysis require PTP time-stamped packets. The DMF PTP timestamping feature can
do this as the packets enter the monitoring fabric, or the production network switches can also timestamp
the packet.

The Service Node accumulates latency values by flow and sends IPFIX data records with each flow's 5-
tuple and ingress and egress identifiers. It sends IPFIX data records to the Analytics Node after collecting
a specified number of values for a flow or when a timeout occurs for the flow entry. The threshold count is
10,000, and the flow timeout is 4 seconds.

Note:  Only basic statistics are available: min, max, and mean. Use the Analytics Node to build
custom dashboards to view and check the data.

5.23.1  Configure Latency and Drop Analysis Using the CLI

Configure this feature through the Controller as a Service Node action in managed services. There is one new
managed service action: latency.

Latency configuration configures two distinct tap points, identified by the filter interface, policy name, or a
user-configured VLAN tag. Based on the latency configuration, configuring the Service Node with traffic
metadata tells the Service Node where to look for tap point information, timestamps, and the IPFIX collector.

Configure appropriate DMF Policies such that traffic tapped from two distinct tap points in the network is
delivered to the configured Service Node interface for analysis.
1. Create a managed service and enter the service interface.
2. Choose the latency service action with the command: seq num latency
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Note:  The above command should enter the latency submode, which supports four configuration
parameters: collector, l3-delivery-interface, and left and right tap points. These all are
required parameters.

3. Configure the IP address of the IPFIX collector by entering the following command: collector ip-
address (the UDP port and MTU parameters are optional; the default values are 4739 and 1500,
respectively).

4. Configure the delivery interface by entering the command l3-delivery-interface delivery
interface name.

5. Configure the points for latency and drop analysis using left-point and right-point parameters as
specified in the following section.

dmf-controller-1(config)# managed-service managed_service_1
dmf-controller-1(config)# service-interface switch delivery1 ethernet1
dmf-controller-1(config)# 1 latency
dmf-controller-1(config)# collector 192.168.1.1
dmf-controller-1(config)# l3-delivery-interface l3-iface-1
dmf-controller-1(config)# left filter-interface left-point-f1
dmf-controller-1(config)# right filter-interface right-point-f1

5.23.2  Configuring Tap Points

Configure tap points using left and right point parameters in the latency submode specifying three
identifiers: filter interface name, policy name, and user-configured vlan tag.

dmf-controller-1(config-managed-srv-latency)# left <tab>
filter-interface         policy-name              user-configured-vlan-id

Both left and right point must use the same identifier; for example, if the left uses the filter-
interface option to define a tap point, the right must also use the filter-interface.

Delete the previous configuration when changing the identifier type for the left and right point;
otherwise, validation will fail.

The user-configured-vlan-id, as the name suggests, is the VLAN tag configured by a user. It
doesn’t support the fabric-applied VLAN tags. The best way to know what values will be accepted is to use
suggestions provided by DMF when using the Tab key after entering the command, as shown below:

dmf-controller-1(config-managed-srv-latency)# left user-configured-vlan-id
 <tab>
115  125

There are several caveats on what is accepted based on the VLAN mode:

Push per Filter

• Use the filter-interface option to provide the filter interface name.
• The user-configured-vlan-id refers to the VLAN tag of the filter interface configured by a user

outside the auto-vlan-range.
• The policy-name identifier is invalid in this mode.

Push per Policy

• Accepts a policy-name identifier as a tap point identifier.
• The filter-interface identifier is invalid in this mode.
• The user-configured-vlan-id refers to the VLAN tag of the policy configured by a user outside the

auto-vlan-range.
• Policies configured as left and right tap points must not overlap.
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5.23.3  Configuring Policy

Irrespective of the VLAN mode, configure a policy or policies so that the same packet can be tapped from two
independent points in the network and then sent to the Service Node.

After creating a policy, add the managed service with latency action as shown below:

dmf-controller-1 (config-policy)# use-managed-service service name sequence 1

There are several things to consider while configuring policies depending on the VLAN mode:

Push per Filter

• Only one policy can contain the Latency service action.
• A policy should have both filter interfaces configured as tap points in the latency configuration and must

not have any other filter interface.
• When using the user-configured-vlan-id option to configure tap points, ensure the filter interfaces have

rewrite-vlan configured to match what’s in the latency configuration.

Push per Policy

• Multiple policies can contain the Latency service action; however, adding more than two should not be
required.

• Add the latency service to two policies when using policy-name or user-configured-vlan-id as
left and right identifiers. In this case, there are no restrictions on how many filter interfaces a policy
can have.

• When using the user-configured-vlan-id option to configure tap points, ensure the policies have
push-vlan configured to match what’s in the latency configuration.

• A policy configured as one of the tap points will fail if it overlaps with the other policy or if the other policy
does not exist.

In both VLAN modes, policies must have PTP timestamping enabled. To do so, use the following command:

dmf-controller-1 (config-policy)# use-timestamping

Configuring PTP Timestamping

This feature depends on configuring PTP timestamping for the packet stream going through the tap points.
Refer to the Resources section for more information on how to set up PTP timestamping functionality.

5.23.4  Show Commands

The following show commands provide helpful information.

The show running-config managed-service managed service command helps check whether the
latency configuration is complete.

dmf-controller-1(config)# show running-config managed-service Latency 
! managed-service
managed-service Latency
service-interface switch DCS-7050CX3-32S ethernet2/4
!
1 latency
collector 192.168.1.1
l3-delivery-interface AN-Data
left policy-name LATENCY-1
right policy-name LATENCY-2
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The show managed-services managed service command provides status information about
the service.
dmf-controller-1(config)# show managed-services Latency 
# Service Name Switch          Switch Interface Installed Max Post-Service BW Max Pre-Service BW Total Post-Service BW Total Pre-
Service BW 
-|------------|---------------|----------------|---------|-------------------|------------------|---------------------|----------
----------|
1 Latency      DCS-7050CX3-32S ethernet2/4      True      25Gbps              25Gbps             624Kbps               432Mbps

The show running-config policy policy command checks whether the policy latency service exists,
whether use-timestamping is enabled, and the use of the correct filter interfaces.

The show policy policy command provides detailed information about a policy and whether any errors
are related to the latency service. The Service Interfaces tab section shows the packets transmitted to the
Service Node and IPFIX packets received from the Service Node.

Note:  Regarding two policies (one left and one right), only one policy will show stats about packets
received from the Service Node. This output is by design, as only a single VLAN exists for the IPFIX
packets transmitted from the Service Node, so there can only be one policy.

dmf-controller-1 (config)# show policy LATENCY-1
Policy Name    : LATENCY-1
Config Status  : active - forward
Runtime Status : installed
Detailed Status: installed - installed to forward
Priority       : 100
Overlap Priority           : 0
# of switches with filter interfaces   : 1
# of switches with delivery interfaces : 1
# of switches with service interfaces  : 1
# of filter interfaces     : 1
# of delivery interfaces   : 1
# of core interfaces       : 4
# of services  : 1
# of pre service interfaces: 1
# of post service interfaces           : 1
Push VLAN      : 2
Post Match Filter Traffic  : 215Mbps
Total Delivery Rate        : -
Total Pre Service Rate     : 217Mbps
Total Post Service Rate    : -
Overlapping Policies       : none
Component Policies         : none
Runtime Service Names      : Latency
Installed Time : 2023-11-16 18:15:27 PST
Installed Duration         : 19 minutes, 45 secs
~ Match Rules ~
# Rule        
-|-----------|
1 1 match any
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Filter Interface(s) ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# DMF IF Switch   IF Name    State Dir Packets  Bytes       Pkt Rate Bit Rate Counter Reset Time             
-|------|--------|----------|-----|---|--------|-----------|--------|--------|------------------------------|
1 BP1    7280SR3E Ethernet25 up    rx  24319476 27484991953 23313    215Mbps  2023-11-16 18:18:18.837000 PST
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Delivery Interface(s) ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# DMF IF  Switch    IF Name    State Dir Packets Bytes  Pkt Rate Bit Rate Counter Reset Time             
-|-------|---------|----------|-----|---|-------|------|--------|--------|------------------------------|
1 AN-Data 7050SX3-1 ethernet41 up    tx  81      117222 0        -        2023-11-16 18:18:18.837000 PST
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Service Interface(s) ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
~~~~~
# Service name Role         Switch          IF Name     State Dir Packets  Bytes       Pkt Rate Bit Rate Counter Reset Time        
     
-|------------|------------|---------------|-----------|-----|---|--------|-----------|--------|--------|------------------------
------|
1 Latency      pre-service  DCS-7050CX3-32S ethernet2/4 up    tx  23950846 27175761734 23418    217Mbps  2023-11-16 18:18:18.837000
 PST
2 Latency      post-service DCS-7050CX3-32S ethernet2/4 up    rx  81       117546      0        -        2023-11-16 18:18:18.837000
 PST
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Core Interface(s) ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# Switch          IF Name    State Dir Packets  Bytes       Pkt Rate Bit Rate Counter Reset Time             
-|---------------|----------|-----|---|--------|-----------|--------|--------|------------------------------|
1 7050SX3-1       ethernet7  up    rx  23950773 27175675524 23415    217Mbps  2023-11-16 18:18:18.837000 PST
2 7050SX3-1       ethernet56 up    rx  81       117222      0        -        2023-11-16 18:18:18.837000 PST
3 7050SX3-1       ethernet56 up    tx  23950773 27175675524 23415    217Mbps  2023-11-16 18:18:18.837000 PST
4 7280SR3E        Ethernet7  up    tx  24319476 27484991953 23313    215Mbps  2023-11-16 18:18:18.837000 PST
5 DCS-7050CX3-32S ethernet28 up    tx  81       117546      0        -        2023-11-16 18:18:18.837000 PST
6 DCS-7050CX3-32S ethernet28 up    rx  23950846 27175761734 23418    217Mbps  2023-11-16 18:18:18.837000 PST
~ Failed Path(s) ~

181



 

5.23.5  Troubleshooting

Controller

Policies dictate how and what packets are directed to the Service Node. Policies must be able to stream
packets from two distinct tap points so that the same packet gets delivered to the Service Node for latency
and drop analysis.

Possible reasons for latency and drop analysis not working are:

• Latency action only exists in one policy in push-per-policy mode.
• Latency action exists in a policy that does not have precisely two filter interfaces in push-per-filter

mode.

A policy programmed to use latency service action can fail for multiple reasons:

• The Latency configuration is incomplete, left or right tap points are missing, or using a policy-
name identifier in push-per-filter or filter-interface in push-per-policy mode.

• In push-per-filter mode, the policy has a filter interface that doesn’t match with the left or right
tap point.

• In the push-per-policy mode, the policy doesn’t match with the left or right tap point.
• Policy names configured as tap points overlap or do not exist.
• When using a user-configured-vlan-id, the fabric created the VLAN ID, not the user.
• The policy (push-vlan) or filter interface (rewrite-vlan) configuration changed without updating the

Latency configuration to point to the correct user-configured-vlan-id.

Reasons for failure are available in the runtime state of the policy and viewed using the show policy
policy name command.

Once verifying the correct configuration of the policy and latency action, enabling the log debug mode and
reviewing the floodlight logs (use the fl-log command in bash mode) should show the ipfix-collector, traffic-
metadata, and latency gentable entries sent to the Service Node.

5.23.6  Limitations

• Only one left and one right tap point can be configured.
• Hardware RSS firmware in the Service Node currently cannot parse L2 header timestamps, so packets for

all will be sent to the same lcore; however, RSS does distribute packets correctly to multiple lcores if src-
mac timestamping is used.

• PTP timestamping doesn’t allow rewrite-dst-mac, so filter interfaces cannot be used as tap points in
push-per-policy mode.

• The following parameters are not configurable in this release:

• gentable size, the default is large.
• packet entry timeout, the default is 100ms.
• flow timeout, the default is 4s.
• count threshold at which an IPFIX data record is generated; the default is 10000.

• Each packet from the L3 header and onwards gets hashed to a 64-bit value; if two packets hash to the
same value, we assume the underlying packets are the same.

• Currently, the latency action in the Service Node assumes it will only receive two copies of the same
packet, storing the timestamp and identifier of the first packet and computing latency upon receipt of the
second packet; if packets are duplicated so that N copies of the same packet are received:

• N-1 latencies will be computed.
• The ingress identifier will be that of the first packet; the egress identifier will be that of the Kth packet.

• Timestamps are reported as unsigned 32-bit values, with the maximum timestamp being 2^32-1,
corresponding to ~4.29 seconds.

182



Using the DMF Service Node Appliance

• Only min, mean, max latencies are currently reported.

5.23.7  Resources

• PTP Timestamping (https://www.arista.com/en/support/toi/dmf-8-4-0/18066-ptp-timestamping-on-7280-
switches)
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Chapter 6

Using the DMF Recorder Node

This chapter describes how to configure the DANZ Monitoring Fabric (DMF) Recorder Node to record packets
from DMF filter interfaces. For related information, refer to the following:

• Installing and configuring DMF Recorder Node: DANZ Monitoring Fabric Deployment Guide
• Integrating DMF Recorder Node with Analytics: Arista Analytics User Guide
• Stenographer Queries: Stenographer Reference for DMF Recorder Node
• DMF Recorder Node REST API: DMF Recorder Node REST APIs

6.1  Overview

The DANZ Monitoring Fabric (DMF) Recorder Node is integrated with the DANZ Monitoring Fabric for single-
pane-of-glass monitoring. A single DMF Controller can manage multiple Recorder Nodes, delivering packets
for recording through Out-of-Band policies. The DMF Controller also provides central APIs for packet queries
across one or multiple recorder nodes and for viewing errors, warnings, statistics, and the status of connected
recorder nodes.

A DMF out-of-band policy directs matching packets to be recorded to one or more recorder nodes. A recorder
node interface identifies the switch and port used to attach the recorder node to the fabric. A DMF policy
treats these as delivery interfaces and adds them to the policy so that flows matching the policy are delivered
to the specified recorder node interfaces.

6.2  Configuration Summary

At a high level, follow the below three steps to use the recorder node.

Step 1: Define a recorder node.

Step 2: Define a DANZ Monitoring Fabric (DMF) policy to select the traffic to forward to the recorder node.

Step 3: View and analyze the recorded traffic.

The recorder node configuration on the DMF Controller includes the following:

• Name: Each recorder node requires a name that is unique among recorder nodes in the connected fabric.
If the name is removed, all configuration for the given recorder node is removed.

• Management MAC address: Each recorder node must have a management MAC address that is unique
in the connected fabric.

• Packet removal policy: This defines the behavior when the recorder node disks reach capacity. The
default policy causes the earliest recorded packets to be overwritten by the most recent packets. The other
option is to stop recording and wait until space is available.

• Record enable or Record disable: Recording of packets is enabled by default, but it can be enabled or
disabled for a specific recorder node.

• Static auth tokens: Static auth tokens are pushed to each recorder node as an alternative form of
authentication in headless mode, when the DMF Controller is unreachable, or by third-party applications
that do not have or do not need DMF Controller credentials.

• Controller auth token: The recorder node treats the controller as an ordinary client and requires it to
present valid credentials in the form of an authentication token. The DMF Controller authentication token is
automatically generated but can be reset upon request.
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• Pre-buffer: This buffer, which is defined in minutes, is used for proactive network monitoring without
recording and retaining unnecessary packets. Once the buffer is full, the oldest packets are deleted.

• Maximum disk utilization: This defines the maximum disk utilization in terms of a percentage between
5% and 95%. When the configured utilization is reached, the packet removal policy is enforced. The
default maximum disk utilization is 95%.

• Maximum packet age: This defines the maximum age in minutes of any packet in the recorder node. It
can be used in combination with the packet removal policy to control when packets are deleted based on
age rather than disk utilization alone. When not set, the maximum packet age is not enforced and packets
are kept until the maximum disk utilization is reached.

6.3  Indexing Configuration

The recorder node indexing configuration defines the fields that can be used to query packets on the recorder
node. By default, all indexing fields are enabled in the indexing configuration. You can selectively disable
indexing fields you do not wish to use in recorder node queries.

Disabling indexing fields has two advantages. First, it reduces the index space required for each packet
recorded. Second, it improves query performance by reducing unnecessary overhead. It is recommended that
unnecessary indexing fields be disabled.

The recorder node supports the following indexing fields:

• MAC Source
• MAC Destination
• VLAN 1: Outer VLAN ID
• VLAN 2: Inner/Middle VLAN ID
• VLAN 3: Innermost VLAN ID
• IPv4 Source
• IPv4 Destination
• IPv6 Source
• IPv6 Destination
• IP protocol
• Port Source
• Port Destination
• MPLS
• Community ID
• MetaWatch Device ID
• MetaWatch Port ID

Note:  The Outer VLAN ID indexing field must be enabled in order to query the recorder node using a
DANZ Monitoring Fabric (DMF) policy name or a DMF filter interface name.

To understand how indexing configuration can be leveraged to your advantage, consider the
following examples:

Example 1: To query packets based on applications defined by unique transport ports, disable all indexing
fields except source and destination transport ports. This results in only transport ports being saved as meta
data for each packet recorded. This greatly reduces per-packet index space consumption and also increases
the speed of recorder-node queries.

However, you will not be able to effectively query on any other indexing field because that meta data was not
saved when the packets were recorded.

Example 2: The recorder node supports community ID indexing, which is a hash of IP addresses, IP protocol,
and transport ports that can be used to identify a flow of interest. If the recorder node use case is to query
based on community ID, it might be redundant to index on IPv4 source and destination addresses, IPv6
source and destination addresses, IP protocol, and transport port source and destination addresses.
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6.4  Pre-buffer Configuration and Events

The recorder node pre-buffer is a circular buffer in which packets to be recorded are received. When enabled,
the pre-buffer feature allows for retention of the packets received by the recorder node for a specified length
of time prior to an event that triggers recording of buffered and future packets to disk. In the absence of an
event, the recorder node will record into this buffer, deleting the oldest packets in the buffer when the buffer
reaches capacity. When a recorder node event is triggered, the packets in the pre-buffer are saved to disk,
and the packets received from the time of the event trigger to the time of the event termination are saved
directly to disk upon termination of the event, received packets are received and retained in the pre-buffer
until the next event. By default, the pre-buffer feature is disabled, indicated by a value of zero minutes.

For example, if you configure the pre-buffer to thirty minutes, up to thirty minutes of packets will be received
by the buffer. When you trigger an event, the packets currently in the buffer are recorded to disk, and packets
newly received by the recorder node bypass the buffer and are written directly to disk until the event is
terminated. When you terminate the event, the pre-buffer resets, accumulating received packets for up to the
defined thirty-minute pre-buffer size.

The packets associated with an event can be queried, replayed, or analyzed using any type of recorder node
query. Each triggered event is identified by a unique, user-supplied name, which can be used in the query to
reference packets recorded in the pre-buffer prior to and during the event itself.

6.5  Using an Authentication Token

When using a DANZ Monitoring Fabric (DMF) Controller authentication token, the recorder node treats the
DMF Controller as an ordinary client and requires it to present valid credentials either in the form of an HTTP
basic username and password or an authentication token.

Static authentication tokens are pushed to each recorder node as an alternative form of authentication in
headless mode, when the DMF Controller is unreachable, or by third-party applications that do not have or do
not need Controller credentials.

6.6  Using the GUI to Add a Recorder Device

To configure a recorder node or update the configuration of an existing recorder node, follow the steps below:
1. Select Monitoring > Recorder Nodes from the main menu bar of the DANZ Monitoring Fabric (DMF) GUI.
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The system displays the page shown below.
Figure 6-1: Recorder Nodes

2. To add a new recorder node, click the provision control (+) in the Recorder Nodes Devices table.
Figure 6-2: Provision Recorder Node

3. Complete the following required fields:

• Assign a name to the recorder node.
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• Set the MAC address of the recorder node. Obtain the MAC address from the chassis ID of the
connected device, using the Fabric > Connected Devices option.

4. Configure the following options as needed:

• Recording: Recording is enabled by default. To disable recording on the recorder node, move the
Recording slide ball to Off. When recording is enabled, the recorder node records the matching traffic
directed from the filter interface defined in a DMF policy.

• Disk Full Policy: Change the Disk Full Policy to Stop and Wait if required. The default packet
removal policy is Rolling FIFO (First In First Out), which means the oldest packets will be deleted to
make room for newer packets. This occurs only when the recorder node disks are full. The alternative
removal policy is Stop and Wait, which causes the recorder node to stop recording when the disks are
full and wait until disk space becomes available. Disk space can be made available by leveraging the
recorder node delete operation to remove all or selected time ranges of recorded packets.

• Backup Disk Policy: Specify the disk backup policy to as desired. This is a mandatory field while
creating a new recorder. Select from one of the three following options:

• No Backup: This is the default option and is also the recommended option when no extra disk is
available. It is also a continuation of the behavior supported in previous releases.

• Remote Extend: In this option, recording is performed on the local disks. When full, the recording
continues on a remote Isilon cluster mounted over NFS. In this mode, the remote disks are called
backup disks. With regard to the Disk Full Policy, if set to:

• Stop and Wait: Recording stops when both local and remote disks become full.
• Rolling FIFO: When the configured threshold is reached, the oldest files from both disks are

removed until the disk usage returns below the threshold number.
• Local Fallback: In this option, recording is performed on a remote Isilon cluster mounted over

NFS. If the connection between the Recorder Node and the remote cluster fails, the recording is
performed on the local disks until the failure is resolved. In this mode, the local disks are called
backup disks. With regard to the Disk Full Policy, if set to:

• Stop and Wait: Recording stops when the remote disks become full.
• Rolling FIFO: When the configured threshold is reached, the oldest files from both disks are

removed until the disk usage returns below the threshold number.

Note:  A connection failure should not occur due to a misconfiguration of the NFS server on the
DMF Controller. In such cases, the recording stops until the Controller’s configuration is fixed.

• Max Packet Age: Change the Max Packet Age to set the maximum number of minutes that recorded
packets will be kept on the recorder node. Packets recorded are discarded after the specified number
of minutes. This defines the maximum age in minutes of any packet in the recorder node. It can be
used in combination with the Disk Full Policy to control when packets are deleted based on age rather
than disk utilization alone. When unset, Max Packet Age is not enforced.

• Pre-Buffer: Assign the number of minutes the recorder node pre-buffer allows for windowed retention
of packets received by the recorder node for a specified length of time. By default, the Pre-Buffer is
set to zero minutes (disabled). With a nonzero Pre-Buffer setting, when you trigger a recorder event,
any packets in the pre-buffer are saved to disk, and any packets received by the recorder after the
trigger are saved directly to disk. When you terminate an ongoing recorder event, a new pre-buffer is
established in preparation for the next event.

• Max Disk Utilization: Specify the maximum utilization allowed on the index and packet disks. The Disk
Full Policy will be enforced at this limit. If left unset, then the disks space will be used to capacity.

• Parse MetaWatch Trailer: Determine when the MetaWatch trailer should be parsed.

• Off: When set to Off, the recorder node will not parse the MetaWatch trailer, even if it is present in
incoming packets.

• Auto: When set to Auto, the recorder node will look for a valid timestamp in the last 12 bytes of
the packet. If it matches the system timestamp closely enough, the trailer will be parsed by the
recorder node.
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• Force: When set to Force, recorder node will assume the last 12 bytes of packet is a MetaWatch
trailer and parse it, even if it did not find a valid timestamp.

5. Click Save to save and close the configuration page or click NEXT to continue with the configuration.
Displays the Indexing tab of the Provision Recorder Node page.
Figure 6-3: Provision Recorder Node-Indexing

6. All the indexing options are enabled by default. To disable any of the indexing behaviors, move the sliding
ball of the respective item to the left. For more details, see the Indexing Configuration section.

189



 

7. Click Save to save and close the configuration page or click NEXT to continue with the configuration.
Displays the Network tab of the Provision Recorder Node page.
Figure 6-4: provision_recorder_nodes_network1

• By default, the Auxiliary NIC Configuration is set to No. This option is selected while configuring a
node for local storage. For details, see the Configuring a Node to Use Local Storage section. Move
the sliding ball to Yes when configuring a node for external storage. For details, see the Configuring a
Node to Use External Storage section.

6.6.1  Configuring a Node to Use Local Storage

1. To configure a node to use local storage, use the following steps:
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1. Network: To use local storage, set the Auxiliary NIC Configuration to default (No) as shown in the
figure below.
Figure 6-5: Network Provisioning

2. Storage: To use local storage, set the Index Disk Configuration and Packet Disk Configuration to
default (No) as shown in the figure below.
Figure 6-6: Configure to Use Local Storage

3. Click Save to add the recorder node configuration to the Controller.
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6.6.2  Configuring a Node to Use External Storage

To store packets on external storage with an NFS mount, the auxiliary interface of the recorder node has to be
connected to the network and subnet where the NFS storage is located as displayed in the figure below.
Figure 6-7: Topology to Use External Storage

Note:  Volume for index and packet on the NFS storage should be created first. Refer to vendor-
specific NFS storage documentation about how to create the volume (or path).

To configure a recorder node for external NFS storage, update the configuration of an existing recorder node
or add a new node with the following steps:

Note:  For release 7.2, only Isilon NFS storage is supported.

1. Network: For external NFS storage, such as Isilon, the auxiliary interface of the recorder node should be
connected to a network and subnet which has reachability to Isilon NFS storage. Set the Auxiliary NIC
Configuration slide to YES and assign an IP address to the auxiliary interface as shown in the figure
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below. Ensure the IP address for the auxiliary interface is not in the same subnet as the recorder node
management IP address.
Figure 6-8: Provision External Storage

2. Storage: To specify the location of the external NFS storage, configure the following options:

• Index Disk Configuration and Packet Disk Configuration are disabled by default (slide set to No).
Set the slide for both Index Disk Configuration and Packet Disk Configuration to Yes.

• NFS Server [Index Disk Configuration and Packet Disk Configuration]: assign the IP address or
host name for the NFS Server (e.g., Isilon Smart Connect host name).

• Transport Port of NFS Service [Index Disk Configuration and Packet Disk Configuration]: if no
value is specified, default will be used (2049). Specify a value if the NFS storage has been configured
to use something other than the default value.

• Transport Port of Mounted Service [Index Disk Configuration and Packet Disk Configuration]:
if no value is specified, the default will be used. Specify a value for this if the NFS storage mounted
service has been configured to use something other than the default value.
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• Volume: [Index Disk Configuration and Packet Disk Configuration] - Specify the location or path on
the NFS server where the index and packets should be stored.

Figure 6-9: Provision External Storage

3. Click Save to add the recorder node configuration to the Controller.

Note:  If the configuration of a previously added packet recorder is edited to use external storage
from local storage or vice versa, then the packet recorder must be rebooted.

6.7  Configuring a Recorder Node Interface

To record packets to a recorder node using a DANZ Monitoring Fabric (DMF) policy, configure a DMF
Recorder Node interface that defines the switch and interface in the monitoring fabric where the recorder
node is connected. The DMF Recorder Node interface is referenced by name in the DMF policy as the
destination for traffic matched by the policy. To configure a DMF Recorder Node interface, complete the
following steps:
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1. Click the provision control (+) at the top of the Recorder Node Interfaces table. The system displays the
following page:
Figure 6-10: Create DMF Recorder Node Interface

2. Assign a name for the DMF Recorder Node interface in the Name field.
3. Select the switch containing the interface that connects the recorder node to the monitoring fabric.
4. Select the interface that connects the recorder node to the monitoring fabric.
5. (Optional) Type information about the interface in the Description field.
6. Click Save to add the configuration to the DMF Controller.

6.8  Using the GUI to Assign a Recorder Interface to a Policy

To forward traffic to a recorder node, include one or more recorder node interfaces as a delivery interface in a
DANZ Monitoring Fabric (DMF) policy.
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When creating a new policy or editing an existing policy, select the recorder node interfaces from the
Monitoring > Policies dialog, as shown in the following screen.
Figure 6-11: DMF Policies

Note:  To create a Recorder Node interface, proceed to the Monitoring > Recorder Nodes page and
click the + in the Interface section.
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To create a policy select Destination Tools > Add Ports(s) and use the RN Fabric Interface to select a
previously configured Recorder Node interface. Select or drag the interfaces or Recorder Nodes to add
Destination Tools.
Figure 6-12: Recorder Node - Create Policy

Figure 6-13: Add Recorder Nodes
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Note:  The Recorder Node interface can only be selected and not created in the create
policy dialogue.

6.9  Using the GUI to Define a Recorder Query

The recorder node records all the packets received on a filter interface that match the criteria defined in a
DANZ Monitoring Fabric (DMF) policy. Recorded packets can be recalled from or analyzed on the recorder
node using a variety of queries. Use the options in the recorder node Query section to create a query and
submit it to the recorder node for processing. The following queries are supported:

• Window: Retrieves the timestamps of the oldest and most recent packets recorded on the recorder.
• Size: Provides the number of packets and their aggregate size in bytes that match the filter

criteria specified.
• Application: Performs deep packet inspection to identify applications communicating with the packets

recorded and that match the filter criteria specified.
• Packet-data: Retrieves all the packets that match the filter criteria specified.
• Packet-object: The packet object query extracts unencrypted HTTP objects from packets matching the

given stenographer filter.
• HTTP, HTTP Request, and HTTP Stat: Analyzes HTTP packets, extracting request URLs, response

codes, and statistics.
• DNS: Analyzes any DNS packets, extracting query and response meta data.
• Replay: Replays selected packets and transmits them to the specified delivery interface.
• IPv4: Identifies and dissects distinct IPv4 flows.
• IPv6: Identifies and dissects distinct IPv6 flows.
• TCP: Identifies and dissects distinct TCP flows.
• TCP Flow Health: Analyzes TCP flows for information such as maximum RTT, retransmissions,

throughput, etc.
• UDP: Identifies and dissects distinct UDP flows.
• Hosts: Identifies all the unique hosts that match the filter criteria specified.
• RTP Stream: Characterizes the performance of Real Time Protocol streaming packets.
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After making a selection from the Query Type list, the system displays additional fields that can be used to
filter the retrieved results, as shown below:
Figure 6-14: Packet Recorder Node Query

Use the following options to specify the packets to include in the query:

• Relative Time: A time range relative to the current time in which look for packets.
• Absolute Time: A specific time range in which to look for packets.
• Any IP: Include packets with the specified IP address in the IP header (either source or destination).
• Directional IP: Include packets with the specified source and/or destination IP address in the IP header.
• Src Port: Include packets with the specified protocol port number in the Src Port field in the IP header.
• Dst Port: Include packets with the specified protocol port number in the Dst Port field in the IP header.
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• IP Protocol: Select the IP protocol from the selection list or specify the numeric identifier of the protocol.
• Community ID: Select packets with a specific BRO community ID string.
• Src Mac: Select packets with a specific source MAC address.
• Dst Mac: Select packets with a specific destination MAC address.
• VLAN: Select packets with a specific VLAN ID.
• Filter Interfaces: Click the provision (+) control and, in the dialog that appears, enable the checkbox for

one or more filter interfaces to which the query should be restricted. To add interfaces to the dialog, click
the provision (+) control on the dialog and select the interfaces from the list that is displayed.

• Policies: Click the provision (+) control and, in the dialog that appears, enable the checkbox for one or
more policies to which the query should be restricted. To add policies to the dialog, click the provision (+)
control on the dialog and select the policies from the list that is displayed.

• Max Bytes: This option is only available for packet queries. Specify the maximum number of bytes
returned by a packet query in a PCAP file.

• Max Packets: This option is only available for packet queries. Specify the maximum number of packets
returned by a packet query in a PCAP file.

• MetaWatch Device ID: Filter packets with the specified MetaWatch device ID.
• MetaWatch Port ID: Filter packets with the specified MetaWatch port ID.

Alternatively, Global Query Configuration can be used to set the byte limit on packet query results.
Figure 6-15: Global Query Configuration

6.10  Viewing Query History

You can view the queries that have been submitted to the recorder node using the GUI or CLI.

To use the DANZ Monitoring Fabric (DMF) GUI to view the query history, select Monitoring > Recorder
Nodes and scroll down to the Query History section.
Figure 6-16: Monitoring > Recorder Nodes > Query History

The Query History section displays the queries submitted to each recorder node and the status of the query.

To download the query results, select Download Results from the Menu control for a specific query. To
export the query history, click the Export control at the top of the table (highlighted in the figure above, to the
right of the Refresh control).

To display query history using the CLI, enter the following command:
controller-1> show recorder-node query-history
#   Packet Recorder Query                                                                   Type                     Start                        Duration
---|---------------|-----------------------------------------------------------------------|------------------------|----------------------------|--------|
1   HW-PR-2         after 10m ago                                                           analysis-hosts           2019-03-20 09:52:38.021000 PDT 3428
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2   HW-PR-1         after 10m ago                                                           analysis-hosts           2019-03-20 09:52:38.021000 PDT 3428
3   HW-PR-2         after 10m ago                                                           abort                    2019-03-20 09:52:40.439000 PDT 711
4   HW-PR-1         after 10m ago                                                           abort                    2019-03-20 09:52:40.439000 PDT 711
---------------------------------------------------------------------output truncated---------------------------------------------------------------------

6.11  Using the CLI to Manage the DMF Recorder Node

6.11.1  Basic Configuration

To perform basic recorder node configuration, complete the following steps:
1. Assign a name to the recorder node device.

controller-1(config)# recorder-node device rn-alias

2. Set the MAC address of the recorder node.

controller-1(config-recorder-node)# mac 18:66:da:fb:6d:b4

If the management MAC is unknown, it can be determined from the chassis ID of connected devices.

3. Define the recorder node interface name.

controller-1(config)# recorder-fabric interface Intf-alias
controller-1(config-pkt-rec-intf)#

Any alphanumeric identifier can be assigned for the name of the recorder node interface, which changes
the submode to config-pkt-rec-intf, where an optional description can be provided. This submode allows
you to specify the switch and interface where the recorder node is connected.

4. Provide an optional description and identify the switch interface connected to the recorder node.

controller-1(config-pkt-rec-intf)# description 'Delivery point for recorder-
node'
controller-1(config-pkt-rec-intf)# recorder-interface switch Switch-z9100
 ethernet37

5. (Optional) Recording: Recording is enabled by default. To disable recording, enter the
following commands:

controller-1(config)# recorder-node device rn-alias
controller-1(config-recorder-node)# no record

6. (Optional) Disk Full Policy: By default, Disk Full Policy is set to rolling-fifo, which means
oldest packets will be deleted to make room for newer packets when recorder node disks are full. This
configuration can be changed to stop-and-wait, which will allow the recorder node to stop recording
until disk space becomes available. Enter the commands below to configure Disk Full Policy to stop-
and-wait.

controller-1(config)# recorder-node device rn-alias
controller-1(config-recorder-node)# when-disk-full stop-and-wait

7. Backup Disk Policy: Define the backup disk policy to indicate to the Recorder Node which disk should be
used as a secondary volume and for what purpose. The following three options are available:

controller-1(config-recorder-node)# backup-volume
local-fallback Set local disk as backup when remote disk is unreachable
no-backup      Do not use any backup volume (default selection)

201



 

remote-extend  Set remote volume to extend local main disk

The no-backup mode is the default mode. The other two modes require that the Recorder Node have
a set of disks for recording as well as be connected to an Isilon cluster mounted via NFS. This remote
storage must be configured from the DMF Controller.

8. (Optional) Max Packet Age: This defines the maximum age in minutes of any packet in the recorder
node. By default, Max Packet Age is not set, which means no limit is enforced. When Max Packet Age
is set, packets recorded on the recorder node will be discarded after the specified number of minutes. To
set the maximum number of minutes that recorded packets will be kept on the recorder node, enter the
following commands:

controller-1(config)# recorder-node device rn-alias
controller-1(config-recorder-node)# max-packet-age 30

This sets the maximum time to keep recorded packets to 30 minutes.

Note:  Max Packet Age can be used in combination with the packet removal policy to control when
packets are deleted based on age rather than disk utilization alone.

9. (Optional) Max Disk Utilization: This defines the maximum disk utilization in terms of a percentage
between 5% and 95%. When this utilization is reached, the Disk Full Policy (rolling-fifo or
stop-and-wait) is enforced. If unset, the default maximum disk utilization is 95%; however, it can be
configured using the following commands:

controller-1(config)# recorder-node device rn-alias
controller-1(config-recorder-node)# max-disk-utilization 80

10. (Optional) Disable any indexing configuration fields that will not be used in subsequent recorder node
queries. All indexing fields are enabled by default. To disable a specific indexing option, enter the following
commands from the config-recorder-node-indexing submode. To re-enable a disabled option, enter the
command without the no prefix.
Use the following command enter the recorder node indexing submode:

controller-1(config-recorder-node)# indexing
controller-1(config-recorder-node-indexing)#

Then use the following commands to disable any fields that will not be used in subsequent queries:

• Disable MAC Source indexing: no mac-src
• Disable MAC Destination indexing: no mac-dst
• Disable outer VLAN ID indexing: no vlan-1
• Disable inner/middle VLAN ID indexing: no vlan-2
• Disable innermost VLAN ID indexing: no vlan-3
• Disable IPv4 Source indexing: no ipv4-src
• Disable IPv4 Destination indexing: no ipv4-dst
• Disable IPv6 Source indexing: no ipv6-src
• Disable IPv6 Destination indexing: no ipv6-dst
• Disable IP Protocol indexing: no ip-proto
• Disable Port Source indexing: no port-src
• Disable Port Destination indexing: no port-dst
• Disable MPLS indexing: no mpls
• Disable Community ID indexing: no community-id
• Disable MetaWatch Device ID: no mw-device-id
• Disable MetaWatch Port ID: no mw-port-id
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For example, the following command disables indexing for the destination MAC address:

controller-1(config-recorder-node-indexing)# no mac-src

11. Identify the recorder node interface by name in an out-of-band policy.

controller-1(config)# policy RecorderNodePolicy
controller-1(config-policy)# use-recorder-fabric-interface intf-1
controller-1(config-policy)#

12. Configure the DANZ Monitoring Fabric (DMF) policy to identify the traffic to send to the recorder node.

controller-1(config-policy)# 1 match any
controller-1(config-policy)# # filter-interface FilterInterface1
controller-1(config-policy)# # action forward

This example forwards all traffic received in the monitoring fabric on filter interface FilterInterface1 to
the recorder node interface. The following is the running-config for this example configuration:

recorder-fabric interface intf-1
description 'Delivery point for recorder-node'
recorder-interface switch 00:00:70:72:cf:c7:cd:7d ethernet37
policy RecorderNodePolicy
action forward
filter-interface FilterInterface1
use-recorder-fabric intf-1
1 match any

6.11.2  Authentication Token Configuration

Static authentication tokens are pushed to each recorder node as an alternative form of authentication
in headless mode, when the DANZ Monitoring Fabric (DMF) Controller is unreachable, or by third-party
applications that do not have or do not need DMF controller credentials in order to query the recorder node.

To configure the recorder node with a static authentication token, use the following commands:
controller-1(config)# recorder-node auth token mytoken
Auth : mytoken
Token : some_secret_string <--- secret plaintext token displayed once here
controller-1 (config)# show running-config recorder-node auth token
! recorder-node
recorder-node auth token mytoken $2a$12$cwt4PvsPySXrmMLYA.Mnyus9DpQ/bydGWD4LEhNL6xhPpkKNLzqWS <---hashed token shows in running
 config

The DMF Controller uses its own hidden authentication token to query the recorder node. To regenerate the
Controller authentication token, use the following command:

controller-1(config)# recorder-node auth generate-controller-token

6.11.3  Configuring the Pre-buffer

To enable the pre-buffer or change the time allocated, enter the following commands:

controller-1(config)# recorder-node device <name>
controller-1(config-recorder-node)# pre-buffer <minutes>

Replace name with the name of the recorder node. Replace minutes with the number of minutes to allocate
to the pre-buffer.
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6.11.4  Triggering a Recorder Node Event

To trigger an event for a specific recorder node, enter the following command from enable mode:

controller-1# trigger recorder-node <name> event <event-name>

Replace name with the name of the recorder node and replace event-name with the name to assign to the
current event.

6.11.5  Terminating a Recorder Node Event

To terminate a recorder node event, use the following command:

controller-1# terminate recorder-node <name> event <event-name>

Replace name with the name of the recorder node and replace event-name with the name of the recorder
node event to terminate.

6.11.6  Viewing Recorder Node Events

To view recorder node events, enter the following command from enable mode:
controller-1# show recorder-node events
# Packet Recorder Time                           Event
-|---------------|------------------------------|-------------------------------------------------------------------|
1 pkt-rec-740     2018-02-06 16:21:37.289000 UTC Pre-buffer event my-event1 complete. Duration 3 minute(s)
2 pkt-rec-740     2018-02-06 20:23:59.758000 UTC Pre-buffer event event2 complete. Duration 73 minute(s)
3 pkt-rec-740     2018-02-07 22:39:15.036000 UTC Pre-buffer event event-02-7/event3 complete. Duration 183 minute(s)
4 pkt-rec-740     2018-02-07 22:40:15.856000 UTC Pre-buffer event event5 triggered
5 pkt-rec-740     2018-02-07 22:40:16.125000 UTC Pre-buffer event event4/event-02-7 complete. Duration 1 minute(s)
6 pkt-rec-740     2018-02-22 06:53:10.216000 UTC Pre-buffer event triggered

6.12  Using the CLI to Run Recorder Node Queries

Note:  The DANZ Monitoring Fabric (DMF) Controller prompt is displayed immediately after entering a
query or replay request, but the query continues in the background. If you try to enter another replay or
query command before the previous command is completed, an error message is displayed.

6.12.1  Packet Replay

To replay the packets recorded by a recorder node, enter the replay recorder-node command from
enable mode.

controller-1# replay recorder-node <name> to-delivery <interface> filter
 <stenographer-query>
[realtime | replay-rate <bps> ]

The following are the options available with this command.

• name: Specify the recorder node for which you wish to replay the recorded packets from.
• interface: The name of the DMF delivery interface to which the packets should be delivered.
• stenographer-query: The filter used to look up desired packets.
• (Optional) real-time: Replay the packets at the original rate recorded by the specified recorder node. The

absence of this parameter will result in a replay up to the line rate of the recorder node interface.
• (Optional) replay-rate bps: Specify the number of bits per second to be used for replaying the packets

recorded by the specified recorder node. The absence of this parameter will result in a replay up to the line
rate of the recorder node interface.
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The following command shows an example of a replay command using the to-delivery option.

controller-1# replay recorder-node packet-rec-740 to-delivery eth26-del filter
 'after 1m ago'
controller-1#
Replay policy details:
controller-1# show policy-flow | grep replay
1 __replay_131809296636625 packet-as5710-2 (00:00:70:72:cf:c7:cd:7d) 0 0 6400 1
in-port 47 apply: name=__replay_131809296636625 output: max-length=65535,
 port=26

6.12.2  Packet Data Query

You can use a packet query to search the packets recorded by a specific recorder node. The operation uses
a Stenographer query string to filter only the interesting traffic. The query returns a URL that can be used to
download and analyze the packets using Wireshark or other packet-analysis tools.

From enable mode, enter the query recorder-node command.

switch # query recorder-node <name> packet-data filter <stenographer-query>

The following is the meaning of each parameter:

• name: Identify the recorder instance.
• packet-data filter stenographer-query: Look up only the packets that match the specified Stenographer

query.

The following example shows the results returned:

6.12.3  Packet Object Query

The packet object query extracts unencrypted HTTP objects from packets matching the given stenographer
filter. To run a packet object query, run the following query command:

switch# query recorder-node bmf-integrations-pr-1 packet-object filter 'after
 5m ago'

The following example shows the results returned:

switch# query recorder-node bmf-integrations-pr-1 packet-object filter 'after 1m ago'
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Packet Object Query Results ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
Coalesced URL     : /pcap/__packet_recorder__/coalesced-bmf-2022-11-21-14-27-56-67a73ea9.tgz
Individual URL(s) : /pcap/__packet_recorder__/bmf-integrations-pr-1-2022-11-21-14-27-55-598f5ae7.tgz

Untar the folder to extract the HTTP objects.
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6.12.4  Size Query

You can use a size query to analyze the number of packets and the total size of the packets recorded by a
specific recorder node. The operation uses a Stenographer query string to filter only the interesting traffic.

To run a size query, enter the query recorder-node command from enable mode.

# query recorder-node <name> size filter <stenographer_query>

The following is the meaning of each parameter:

• name: Identify the recorder node.
• size filter stenographer-query: Analyze only the packets that match the specified Stenographer query.

The following example shows the results returned:

switch# query recorder-node <hq-bmf-packet-recorder-1> size filter "after 1m
 ago and src host 8.8.8.8"
~ Summary Query Results ~
# Packets : 66
Size      : 7.64KB
~ Error(s) ~
None.

6.12.5  Window Query

You can use a window query to analyze the oldest available packet and most recent available packet
recorded by a specific recorder node.

To run a window query, enter the query recorder-node command from enable mode.

switch# query recorder-node <name> window

The following is the meaning of each parameter:

• name: Identify the recorder node.

The following example shows the results returned:

switch# query recorder-node hq-bmf-packet-recorder-1 window
~~~~~~~~~~~~~ Window Query Results ~~~~~~~~~~~~~
Oldest Packet Available : 2020-07-30 05:01:08 PDT
Newest Packet Available : 2020-10-19 08:14:21 PDT
~ Error(s) ~
None.

6.12.6  Stopping a Query

You can use the abort recorder-node command to stop the current query running on the specified
recorder. From enable mode, enter the following command:

controller-1# abort recorder-node <name> filter <string>

Replace name with the name of the recorder node, and use the filter keyword to identify the specific filter
used to submit the query. If the specific query being run is unknown, an empty-string filter of “” can be used to
terminate any running query.

controller-1# abort recorder-node hq-bmf-packet-recorder-1 filter ""
Abort any request with the specified filter? This cannot be undone. enter
 "yes" (or "y") to continue:
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yes
Result : Success
~ Error(s) ~
None.

6.13  Using RBAC to Manage Access to the DMF Recorder Node

You can use Role-Based Access Control (RBAC) to manage access to the DANZ Monitoring Fabric (DMF)
Recorder Node by associating a recorder node with an RBAC group.

To restrict access for a specific recorder to a specific RBAC group, use the CLI or GUI as described below.

6.13.1  RBAC Configuration Using the CLI

1. Identify the group to which you want to associate the recorder node.
Enter the following command from config mode on the active DANZ Monitoring Fabric (DMF) controller:

controller-1(config)# group test
controller-1(config-group)#

2. Associate one or more recorder nodes with the group.

Enter the following CLI command from the config-group submode:

controller-1(config-group)# associate recorder-node <device-name>

Replace device-name name with the name of the recorder node, as in the following example:

controller-1(config-group)# associate recorder-node HW-PR-1

6.13.2  RBAC Configuration Using the GUI

1. Select Security > Groups, and select Edit from the Actions and click + Create Group.
Figure 6-17: Create Security Group
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2. Enter a Group Name.
Figure 6-18: Create Group

3. Under the Role Based Access Control section select Add Recorder Node.
4. Select the Recorder Node from the selection list, and assign the permissions required.

• Read: The user can view recorded packets.
• Use: The user can define and run queries.
• Configure: The user can configure packet recorder instances and interfaces.
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• Export: The user can export packets to a different device.

Figure 6-19: Associate Recorder Node

5. Click Create.

6.14  Using the CLI to View Information About a Recorder Node

This section describes how to monitor and troubleshoot recorder node status and operation. The recorder
node stores packets on the main hard disk and the indices on the SSD volumes.

6.14.1  Viewing the Recorder Node Interface

To view information about the recorder node interface information, use the following command:

controller-1(config)# show topology recorder-node
# DMF IF       Switch IF  Name       State Speed  Rate Limit
-|------------|----------|----------|-----|------|----------|
1 RecNode-Intf Arista7050 ethernet1  up    25Gbps -

6.14.2  Viewing Recorder Node Operation

controller-1# show recorder-node device packet-rec-740 interfaces stats
Packet Recorder Name Rx Pkts       Rx BytesRx Drop  Rx Errors Tx Pkts  Tx Bytes   Tx Drop Tx Errors
---------------|----|-------------|---------------|--------|---------|--------|----------|-------|---------|
packet-rec-740  pri1 2640908588614 172081747460802 84204084 0 24630503 3053932660 0       0

Information about a recorder node interface used as a delivery port in a DANZ Monitoring Fabric (DMF)
out-of-band policy is displayed in a list. Recorder node interfaces are listed as dynamically-added
delivery interfaces.
Ctrl-2(config)# show policy PR-policy 
Policy Name                            : PR-policy
Config Status                          : active - forward
Runtime Status                         : installed
Detailed Status                        : installed - installed to forward
Priority                               : 100
Overlap Priority                       : 0
# of switches with filter interfaces   : 1
# of switches with delivery interfaces : 1
# of switches with service interfaces  : 0
# of filter interfaces                 : 1
# of delivery interfaces               : 1
# of core interfaces                   : 0
# of services                          : 0
# of pre service interfaces            : 0
# of post service interfaces           : 0
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Push VLAN                              : 1
Post Match Filter Traffic              : 1.51Gbps
Total Delivery Rate                    : 1.51Gbps
Total Pre Service Rate                 : -
Total Post Service Rate                : -
Overlapping Policies                   : none
Component Policies                     : none
Installed Time                         : 2023-09-22 12:16:55 UTC
Installed Duration                     : 3 days, 4 hours
~ Match Rules ~
# Rule        
-|-----------|
1 1 match any

~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Filter Interface(s)  ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# DMF IF      Switch              IF Name   State Dir Packets     Bytes          Pkt Rate Bit Rate Counter Reset Time             
-|-----------|-------------------|---------|-----|---|-----------|--------------|--------|--------|------------------------------|
1 Lab-traffic Arista-7050SX3-T3X5 ethernet7 up    rx  97831460642 51981008309480 382563   1.51Gbps 2023-09-22 12:16:55.738000 UTC

~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Delivery Interface(s) ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# DMF IF          Switch              IF Name    State Dir Packets     Bytes          Pkt Rate Bit Rate Counter Reset Time             
-|---------------|-------------------|----------|-----|---|-----------|--------------|--------|--------|------------------------------|
1 PR-intf Arista-7050SX3-T3X5 ethernet35 up    tx  97831460642 51981008309480 382563   1.51Gbps 2023-09-22 12:16:55.738000 UTC

~ Service Interface(s) ~
None.

~ Core Interface(s) ~
None.

~ Failed Path(s) ~
None.
Ctrl-2(config)# 

6.14.3  Viewing Errors and Warnings

The following table lists the errors and warnings that may be displayed by a recorder node. In the CLI, these
errors and warnings can be displayed by entering the following commands:

• show fabric errors
• show fabric warnings
• show recorder-node errors
• show recorder-node warnings

Table 3: Errors and Warnings

Type Condition Cause Resolution

Error Recorder Node (RN)
management link
down

RN has not received controller
LLDP

Wait 30s if the recorder node
is newly configured. Verify it
is not connected to a switch
port that is a DANZ Monitoring
Fabric (DMF) interface.

Error RN fabric link down Controller has not received RN
LLDP

Wait 30s if recorder node is
newly configured. Check it is
online otherwise.

Warning Disk/RAID health
degraded

Possible hardware
degradation

Investigate specific
warning reported. Could be
temperature issue. Possibly
replace indicated disk soon.

Warning Low disk space Packet or index disk space
has risen above threshold

Prepare for disk full soon

Warning Disk full Packet or index disk space
is full. Packets are being
dropped or rotated depending
on removal policy.

Do nothing if removal policy
is rolling-FIFO. Consider
erasing packets to free up
space otherwise.

Warning Recorder
misconfiguration on
a DMF interface

A recorder node has been
detected in the fabric on
a switch interface that is
configured as a filter or
delivery interface.

Remove the conflicting
interface configuration, or re-
cable the recorder node to a
switch interface not defined as
a filter or delivery interface.
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6.15  Using the GUI to view Recorder Node Statistics

Recorder node statistics can be viewed by clicking on the recorder node alias from the Monitoring >
Recorder Nodes page.

Figure 6-20: DANZ Monitoring Fabric (DMF) List of Connected Recorder Nodes
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Click a Recorder Node to display the available recorder node statistics. All statistics are disabled/ hidden
by default.
Figure 6-21: Available Recorder Node Statistics
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Statistics can be enabled/viewed by simply clicking on them. Selected statistics are highlighted in blue.
Figure 6-22: Selected Recorder Node Statistics

The recorder node shows health statistics for the following:

CPU: CPU health displays the compute resource utilization of the recorder node.

Figure 6-23: Recorder Node CPU Health Statistics

Memory: Memory related stats are displayed, such as total memory, used, free, available, etc.

Figure 6-24: Recorder Node Memory Statistics
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Storage: Storage health displays the storage utilization percentage along with total and available capacity of
Index and Packet virtual disks.
Figure 6-25: Recorder Node Storage Statistics

Time-based Disk Utilization Statistics: Time-based Disk Utilization Statistics provides an estimated
time period until the Index and Packet virtual disks reach full storage capacity. This estimate is calculated
based on data points (incoming data rate) collected periodically from recorder node for a certain time
duration. Note that if the collected data points are insufficient to calculate the disk-full estimate, it will show
inaccurate. However, once a sufficient number of data points are collected, the estimate will be calculated and
displayed automatically.
Figure 6-26: Time-based Disk Utilization Statistics

Virtual Disks: Virtual Disks health stats displays the Index and Packet virtual disks size, state, health and
RAID level configuration.
Figure 6-27: Recorder Node Virtual Disk Details
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Click on the drop-down arrow next to the virtual disk name to obtain information regarding participating
physical disks, such as slot numbers, type, size, state, temperature and Dell’s Self Monitoring Analysis and
Report Technology (SMART) stats, such as errors and failures, if any.
Figure 6-28: Recorder Node Virtual Disk Statistics

File Descriptors: the File Descriptor section displays the following:

• File Descriptors (current): Current number of files open in the entire system.
• Max System File Descriptors: Highest number of open files allowed on the entire system.
• Max Stenographer File Descriptors: Highest number of open files allowed for Stenographer application.

Figure 6-29: Recorder Node File Descriptors Statistics
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Mount: Mount section displays the Index and Packet disk mount information, such as volume name, mount
point, file system type and mount health.
Figure 6-30: Recorder Node Mount Information

Stenographer: Stenographer Statistics are displayed as follows:

Figure 6-31: Recorder Node Stenographer Statistics

• Initialized: Displays the Stenographer application running state. A green check mark indicates that the
application was initialized successfully. When the Stenographer application is starting up, a red x mark is
expected. During this time, recording and querying is disallowed.

• Tracked Files: Tracked files are the total number of files stored under each CPU instance thread.
• Cached Files: Cached files are the number of files that are open and have a file descriptor.
• Max Cached Files: Maximum cached files is the total number of files that are allowed to be open.

These numbers are further divided and displayed for each recording thread and can be viewed in the
Recording Threads table:
Figure 6-32: Recorder Node Max Cached Files Statistics
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Recording: Recording stats displays packet stats, such as dropped packets, total packets and collection time
for each CPU core.
Figure 6-33: Recorder Node Statistics

The following displays packet size distribution stats.
Figure 6-34: Recorder Node Packet Size Distribution Statistics

The following displays interface errors, such as CRC errors, frame length errors and back pressure errors:
Figure 6-35: Recorder Node Interface Errors

6.16  Changing the Recorder Node Default Configuration

Configuration settings are automatically downloaded to the recorder node from the DANZ Monitoring Fabric
(DMF) Controller, which eliminates the need for box-by-box configuration. However, you can override the
default configuration for a recorder node from the config-recorder-node submode for any recorder node.

Note:  In the current release, these options are available only from the CLI, and are not included in the
DMF controller GUI.

To change the CLI mode to config-recorder-node, enter the following command from config mode on the
active DMF controller:

controller-1(config)# recorder-node device <instance>
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Replace instance with the alias you want to use for the recorder node. This alias is associated with the MAC
hardware address, using the mac command.

Use any of the following commands from config-recorder-node submode to override the default configuration
for the associated recorder node:

• banner: Set the recorder node pre-login banner message
• mac: Configure the MAC address for the recorder node

Additionally, the below configurations can be overridden to use values specific to the recorder node or can
also be used in a merge-mode along with the configuration inherited from the DMF controller:

• ntp: Configure recorder node to override default timezone and NTP parameters.
• snmp-server: Configure recorder node SNMP parameters and traps.
• logging: Enable recorder node logging to Controller.
• tacacs: Set TACACS defaults, server IP address(es), timeouts and keys.

The following commands can be used, from the config-recorder-node submode, to change the default
configuration on the recorder node:

• ntp override-global: Override global time configuration with recorder node time configuration.
• snmp-server override-global: Override global SNMP configuration with recorder node

SNMP configuration.
• snmp-server trap override-global: Override global SNMP trap configuration with recorder node

SNMP trap configuration.
• logging override-global: Override global logging configuration with packet recorder

logging configuration.
• tacacs override-global: Override global TACACS configuration with recorder node

TACACS configuration.

To configure the recorder node to work in a merge mode by merging its specific configuration with that of the
DMF Controller, execute the following commands in the config-recorder-node submode:

• ntp merge-global: Merge global time configuration with recorder node time configuration.
• snmp-server merge-global: Merge global SNMP configuration with recorder node

SNMP configuration.
• snmp-server trap merge-global: Merge global SNMP trap configuration with recorder node SNMP

trap configuration.
• logging merge-global: Merge global logging configuration with recorder node logging configuration.

TACACS configuration does not have a merge option. It can either be inherited completely from the DMF
Controller or overridden to use only the recorder node specific configuration.

6.17  Large PCAP Queries

To run large PCAP queries to the recorder node, access the recorder node via a web browser. This allows
you to run packet queries directly to the recorder node without specifying the maximum byte or packet limit for
the PCAP file (which is required if the query is executed from the DANZ Monitoring Fabric (DMF) Controller).

To access the recorder node directly, use the URL https://RecorderNodeIP in a web browser, as
shown below:
Figure 6-36: URL to Recorder Node
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The following page will be displayed:
Figure 6-37: Recorder Node Page

• Recorder Node IP Address: Enter the IP address of the target recorder node.
• DMF Controller Username: Provide the DMF Controller username.
• DMF Controller Password: Provide the password for authentication.
• Stenographer Query Filter: The query filter can be used to filter the query results to look for specific

packets. For example, to search for packets with a source IP address of 10.0.0.145 in the last 10 minutes,
use the following filter:

after 10m ago and src host 10.0.0.145

• Stenographer Query ID: Starting in DMF 8.0, a Universally Unique Identifier (UUID) is required to run
queries. To generate a UUID, run the following command on any Linux machine and use the result as the
Stenographer query ID:

$ uuidgen
b01308db-65f2-4d7c-b884-bb908d111400

• Save pcap as: Provide the file name to be used for this PCAP query result.
• Submit Request: Click on Submit Request. This will send a query to the specified recorder node, and it

will save the PCAP file with the provided file name to the default download location for the browser.

6.18  Recorder Node Management Migration L3ZTN

After the first boot (initial configuration) is completed, the recorder node can be removed from the old
Controller, and it can be pointed to a new Controller via the CLI in the case of a Layer-3 topology mode.

Note:  In order for appliances to connect to the DANZ Monitoring Fabric (DMF) Controller in Layer-3
Zero Touch Network (L3ZTN) mode, the DMF Controller deployment mode must be configured as
pre-configure.

To migrate management to a new Controller, follow the steps below:
1. Remove the recorder node and switch from the old Controller using the commands below:

controller-1(config)# no recorder-node device <RecNode>

controller-1(config)# no switch <Arista7050>

2. Add the switch to the new Controller.
3. SSH to the recorder node and configure the new Controller IP using the zerotouch l3ztn

controller-ip command:

controller-1(config)# zerotouch l3ztn controller-ip 10.2.0.151

4. After pointing the recorder node to use the new Controller, reboot the recorder node.

219



 

5. Once the recorder node is back online, the DMF Controller should receive the ZTN request.

6. After the DMF Controller has received a ZTN request from the recorder node, it can be added to the DMF
Controller running-configuration using the below command:

controller-1(config)# recorder-node device RecNode
controller-1(config-recorder-node)# mac 24:6e:96:78:58:b4

7. The recorder node should now be added to the new DMF Controller. It can be verified using the
command below:

6.19  Recorder Node CLI

The following commands are available from the recorder node:

The show version command can be used to view the version and image information that recorder node is
running on.

RecNode(config)# show version
Controller Version : DMF Recorder Node 8.1.0 (bigswitch/enable/dmf-8.1.x #5)
RecNode(config)#

The show controllers command can be used to view the connected DANZ Monitoring Fabric (DMF)
controllers to the recorder node. Note that if the recorder node is connected to a DMF Controller cluster, then
all the cluster nodes should be listed in the command output:

RecNode(config)# show controllers
controller            Role   State     Aux
---------------------|------|---------|---|
tcp://10.106.8.2:6653 master connected 0
tcp://10.106.8.3:6653 slave  connected 0
tcp://10.106.8.3:6653 slave  connected 1
tcp://10.106.8.3:6653 slave  connected 2
tcp://10.106.8.2:6653 master connected 1
tcp://10.106.8.2:6653 master connected 2
RecNode(config)#

6.20  Multiple Queries

The GUI can be used to run multiple recorder node queries

To run queries on recorded packets by the recorder node, navigate to the Monitoring >  Recorder Nodes
page.
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Under the Query section, click on the Query Type drop-down to select the type of analysis that you would
like to run on the recorded packets as shown below:
Figure 6-38: Query Type
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After selecting the query type, you can use filters to limit or narrow the search to obtain specific results.
Providing specific filters also helps to complete the query analysis faster. In the following example, the query
result for the TCP query type will return the results for IP address 10.240.30.24 for the past 10 minutes.
Figure 6-39: Query - IP Address and Time

After entering the desired filters, click on the Submit button. The Progress dialog will be displayed, showing
the Elapsed Time and Progress percentage of the running query:
Figure 6-40: Query Progress

While a query is in progress, another query can be initiated from a new DANZ Monitoring Fabric (DMF)
Controller web session. The query progress can be viewed under the Active Queries section:
Figure 6-41: Active Queries

6.21  Ability to Deduplicate Packets - Query from Recorder Node

For Recorder Node queries, the recorded packets matching a specified query filter may contain duplicates
when packet recording occurs at several different TAPs within the same network; i.e., as a packet moves
through the network, it may be recorded multiple times. The dedup feature removes duplicate packets from
the query results. By eliminating redundant information, packet deduplication improves query results' clarity,
accuracy, and conciseness. Additionally, the dedup feature significantly reduces the size of query results
obtained from packet query types.
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6.21.1  Using the CLI to Deduplicate Packets

In the DANZ Monitoring Fabric (DMF) Controller CLI, packet deduplication is available for the packet data,
packet object, size, and replay query types. Deduplication is turned off by default for these queries. To enable
deduplication, “dedup” must be added to the end of the query command after all optional values have been
selected (if any).

The following are command examples of enabling deduplication.

Enabling deduplication for a size query:

controller# query recorder-node rn size filter “before 5s ago” dedup

Enabling deduplication for a packet data query specifying a limit for the size of the PCAP file returned in
bytes:

controller# query recorder-node rn packet-data filter “before 5s ago” limit-
bytes 2000 dedup

Enabling deduplication for a replay query:

controller# replay recorder-node rn to-delivery dintf filter “before 5s ago”
 dedup

Enabling deduplication for a replay query specifying the replay rate:

controller# replay recorder-node rn to-delivery dintf filter “before 5s ago”
 replay-rate 100 dedup

A time window (in milliseconds) can also be specified for deduplication. The time window defines the time
required between timestamps of identical packets to no longer be considered duplicates of each other. For
example, for a time window of 200 ms, two identical packets with timestamps that are 200 ms (or less) apart
are duplicates of each other. In contrast, if the two identical packets had timestamps more than 200 ms apart,
they would not be duplicates of each other.

The time window must be an integer between 0 and 999 (inclusive) with a default time window of 200 ms
when deduplication is enabled and no set time window value.

To configure a time window value, dedup-window must be added after dedup and followed by an integer
value for the time window.

controller# query recorder-node rn size filter “before 5s ago” dedup dedup-
window 150

6.21.2  Using the GUI to Deduplicate Packets

In the DANZ Monitoring Fabric (DMF) Controller GUI, packet deduplication is available for the packet data,
packet object, size, replay, application, and analysis query types. Deduplication is not enabled by default for
these queries. To enable deduplication perform the following steps:
1. Set the toggle switch deduplication to Yes in the query submission window.
2. Specify an optional time window (in milliseconds) as required by entering an integer between 0 and 999

(inclusive) into the Deduplication Time Window field. The time window will default to 200 ms if no time
window value is set.

3. Click Submit to continue.

Note:  If a time window value is specified, but deduplication is not toggled, packet deduplication will
not occur.
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The following is an example of enabling deduplication for a size query specifying a time window value.
Figure 6-42: Query

6.21.3  Limitations

Expect a query with packet deduplication enabled to take longer to complete than with packet deduplication
disabled. Hence, packet deduplication, by default, is disabled.

The maximum time window value permitted is 999 ms to ensure that TCP retransmissions are not regarded
as duplicates, assuming that the receive timeout value for TCP retransmissions (of any kind) is at least 1
second. If the receive timeout value is less than 1 second (particularly, exactly 999 ms or less), then it is
possible for TCP retransmissions to be regarded as duplicates when the time window value used is larger
than the receive timeout value.
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Due to memory constraints, removing some duplicates may not occur as expected. This scenario is likely to
occur if a substantial amount of packets match the query filter, which all have timestamps within the specified
time window from each other. We refer to this scenario as the query having exceeded the packet window
capacity. To mitigate this from occurring, decrease the time window value or use a more specific query filter to
reduce the number of packets matching the query filter at a given time.

6.22  Enabling Egress sFlow on Recorder Node Interfaces

The egress sFlow feature is available from the DANZ Monitoring Fabric (DMF) 8.5 release onward. Enable
egress sFlow to send sampled packets collected on the Recorder Node switch attachment point to a
configured sFlow collector. Examining these sampled packets enables the identification of post-match-rule
flows recorded by the DMF Recorder Nodes (RNs) without performing a query against the RNs. While not
explicitly required, Arista Networks highly recommends using the DMF Analytics Node (AN) as the configured
sFlow collector because it can automatically identify packets sampled utilizing this feature.

Use the CLI or GUI to enable or disable the feature.

6.22.1  Using the CLI to Enable Egress sFlow

The egress sFlow feature requires a configured sFlow collector. After configuring the sFlow collector, enter the
following command from the config mode to enable the feature:

Controller-1(config)# recorder-node sflow

To disable the feature, enter the command:

Controller-1(config)# no recorder-node sflow
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6.22.2  Using the GUI to Enable Egress sFlow

Using the GUI

After configuring the fabric for sFlow and setting up the sFlow collector, navigate to the Monitoring >
Recorder Node page. Under the Global Configuration section, click the Configure global settings button.

Figure 6-43: Configure Global Settings

In the Configure Global Settings pop-up window, enable the sFlow setting and click Submit.

Figure 6-44: Enable sFlow

Analytics Node

When using a DMF Analytics Node as the sFlow collector, it has a dashboard to display the results from this
feature. To access the results:
1. Navigate to the sFlow dashboard from the Fabric dashboard.
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2. Select the disabled RN Flows filter.
3. Select the option to Re-enable the filter, as shown below.

Figure 6-45: Re-enable sFlow

6.22.3  Troubleshooting Egress SFlow Configurations

Switches not associated with a sFlow collector (either a global sFlow collector or a switch-specific sFlow
collector) do not have an active feature even if the feature is enabled. Ensure the fabric has been configured
for sFlow and a sFlow collector has been configured. To verify that a configured global sFlow collector exists,
use the command:

Controller-1# show sflow default 

A configured collector appears as an entry in the table under the column labeled collector. Alternatively, to
verify a configured collector exists for a given switch, use the command:

Controller-1#  show switch <switch-name> table sflow-collector

This command displays a table with one entry per configured collector.

A feature-unsupported-on-device warning appears when connecting an EOS switch to an RN. The feature
do not sample packets passing to an RN from an EOS switch. View any such warnings using the GUI or using
the following CLI command:

Controller-1#  show fabric warnings feature-unsupported-on-device

To verify the feature is active on a given switch, use the command:

Controller-1#  show switch <switch-name> table sflow-sample
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If the feature is enabled, the entry values associated with the ports connected to an RN would include an
EgressSamplingRate(number) with a number greater than 0. The following example shows Port(1) on
<switch-name> connecting to an RN.

Controller-1# show switch <switch-name> table sflow-sample
#  Sflow-sample Device name    Entry key Entry value                                                                  
--|------------|---------------|---------|----------------------------------------------------------------------------------|
53  52           <switch-name>  Port(1)   SamplingRate(0), EgressSamplingRate(10000), HeaderSize(128), Interval(10000)

6.22.4  Guidelines and Limitations for Enabling Egress sFlow

Below are the guidelines and limitations to consider while enabling Egress sFlow :

• The Egress sFlow support for the Recorder Nodes (RN) feature requires a configured sFlow collector in a
fabric configured to allow sFlows.

• If a packet enters a switch through a filter interface with sFlow enabled and exits through a port connected
to an RN while the feature is enabled, only one sFlow packet (i.e. the ingress sFlow packet) is sent to
the collector.

• The Egress sFlow feature does not identify which RN has recorded a given packet in a fabric when there
are multiple RNs. This is fine in a normal case as the queries are issued to the RNs in aggregate rather
than to individual RNs and hence the information that any RN has received a packet is sufficient. In
some cases, it may be possible to make that determination from the outport of the sFlow packet, but that
information may not be available in all cases. This is an inherent limitation of egress sFlow.

• In DMF 8.5.0, an enabled egress sFlow feature captures the packets sent to the RN regardless of whether
the RN is actively recording or not.
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Chapter 7

Link Aggregation

This chapter describes how to configure link aggregation groups between switches, between switches and
tools, or between switches and taps.

7.1  Configuring Link Aggregation

Link aggregation lets you combine multiple LAN links and/or cables in parallel. Link aggregation provides a
high level of redundancy and higher transmission speed.

Note:  When connecting a Link Aggregation Group (LAG) to a DMF Service Node appliance, member
links can be connected to multiple DMF Service Node appliances with data ports of the same speed.

DMF provides a configurable method of hashing for load distribution among the members of a LAG. The
enhanced hashing algorithm automatically assigns the best hashing type for the switch and traffic. This setting
also lets you manually select the packet types and fields used for load distribution among the members
of a port-channel interface. For the supported switch platforms, enhanced mode and symmetric hashing
are enabled by default. With symmetric hashing, bidirectional traffic between two hosts going out on a port
channel is distributed on the same member port.

The default hashing option uses the best available packet header field that applies to each packet and that is
supported by the switch. These fields can include the following:

• IPv4
• IPv6
• MPLS (disabled by default)
• L2GRE packet

If none of these headers can be used, Layer-2 header fields (source MAC address, destination MAC address,
VLAN-ID, and ethertype) are used to distribute traffic among the LAG member interfaces. Hashing on the
following packet header fields is enabled by default:

• hash l2 dst-mac eth-type src-mac vlan-id
• hash ipv4 dst-ip src-ip
• hash ipv6 dst-ip src-ip
• hash l2gre inner-l3 dst-ip src-ip
• hash symmetric

Note:  VN-tagged packets and QinQ packets are treated as L2 packets and Layer-2 headers are used
to distribute traffic among LAG member interfaces for these packets:

7.1.1  Using the GUI to Configure Link Aggregation Groups

To view, manage, or create Link Aggregation Groups (LAGs) in the monitoring fabric, complete the
following steps:
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1. Select Fabric > LAGs from the main menu.
Figure 7-1: Link Aggregation Groups

2. To create a new LAG, click the provision control (+) at the upper left corner of the table.
Figure 7-2: Create LAG

3. Enter a name for the LAG.
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4. Select the switch where you want to create the LAG.
Figure 7-3: Create LAG

5. Select the interfaces to include in the LAG and click Submit.

7.1.2  Using the CLI to Configure Link Aggregation Groups

1. Use the lag-interface command to enter the config-switch-lag-if submode, where you can define the
LAG member interfaces and specify the type of load distribution (hashing) to use for the LAG.

2. Use the member command to add an interface to a LAG. Enter this command for each interface you want
to add to the LAG. To remove an interface, use the no member version of the command.
For example, the following commands add two interfaces to a LAG named my-lag.

controller-1(config)# switch DMF-FILTER-SWITCH-1
controller-1(config-switch)# lag-interface mylag
controller-1(config-switch-lag-if)# member ethernet13
controller-1(config-switch-lag-if)# member ethernet14

3. To configure multiple delivery interfaces as a LAG, complete the following steps:
a. Assign a name to the LAG and enter config-switch-lag-if submode.

controller-1(config)# switch DMF-DELIVERY-SWITCH-1
controller-1(config-switch)# lag-interface lag1
controller-1(config-switch-lag-if)#
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b. Assign members to the LAG.

controller-1(config-switch-lag-if)# member ethernet39
controller-1(config-switch-lag-if)# member ethernet40

c. To view the configured LAGs, enter the show lag command, as in the following example:

controller-1> show lag

7.1.3  Configuring Hashing Fields

To configure the hashing fields manually via the CLI, use the lag-enhanced-hash command to enter
config-switch-hash mode as in the following example:

controller1(config)# switch DMF-FILTER-SWITCH-1
controller1(config-switch)# lag-enhanced-hash
controller1(config-switch-hash)#

The hash commands have the following syntax:

• To hash on GTP fields, pick one of the following options:

controller1(config-switch-hash)# hash gtp
header-first-byte Configure fields to identify GTP traffic
port-match Configure UDP tunnel port match entry

• To hash on IPv4 fields, pick one of the following options:

controller1(config-switch-hash)# hash ipv4
<cr>
dst-ip Destination IPv4 address (optional)
l4-dst-port TCP/UDP destination port (optional)
l4-src-port TCP/UDP source port (optional)
protocol IP protocol (optional)
src-ip Source IPv4 address (optional)
vlan-id Vlan Id (optional)

• To hash on IPv6 fields, pick one of the following options

controller1(config-switch-hash)# hash ipv6
<cr>
dst-ip Collapsed destination IPv6 address (optional)
l4-dst-port TCP/UDP destination port (optional)
l4-src-port TCP/UDP source port (optional)
nxt-hdr Next Header (optional)
src-ip Collapsed source IPv6 address (optional)
vlan-id Vlan Id (optional)

• To hash on Layer-2 fields, pick one of the following options:

controller1(config-switch-hash)# hash l2
dst-mac Destination xMAC address
eth-type Ethernet Type
src-mac Source MAC address
vlan-id Vlan Id

• To hash on L2GRE fields, pick one of the following options:

controller1(config-switch-hash)# hash l2gre
inner-l2 Use inner L2 fields for hash computation (optional)
inner-l3 Use inner L3 fields for hash computation (optional)
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• To hash on MPLS labels, pick one of the following options:

controller1(config-switch-hash)# hash mpls
<cr>
label-1 Lower 16 bits of MPLS label 1 (optional)
label-2 Lower 16 bits of MPLS label 2 (optional)
label-3 Lower 16 bits of MPLS label 3 (optional)
label-hi-bits Higher 4 bits of MPLS Labels 1,2 and 3 (optional)

• To manually configure the hash seeds:

controller1(config-switch)# hash seeds
<First hash seed> Configure seed1 for hash computation
controller1(config-switch-hash)# hash seeds 3809
<cr>
<Second hash seed> Configure seed2 for hash computation (optional)
controller1(config-switch-hash)# hash seeds 3809 90901
<cr>

• To enable/disable symmetric hashing

controller1(config-switch-hash)# hash symmetric
<cr>
disable Disable symmetric hashing
enable Enable symmetric hashing

7.1.4  L2 GRE Key Hashing

The L2 GRE Key-based hashing feature introduced in DMF 8.4 allows the L2 GRE packets to hash based on
the L2 GRE (Tunnel) Key on Core DMF switches.

Previously, L2 GRE payload-based hashing (InnerL2 or InnerL3) applied only to L2 GRE packets terminated
at DMF delivery or filter switches. If a user wanted to hash L2 GRE packets transiting a DMF core switch,
the L2 GRE payload-based hashing across port-channel interfaces would not have been functional as the L2
GRE tunnel was not terminating on the core DMF switch.

With the L2 GRE Key-based hashing feature, users can now hash L2 GRE packets based on the L2 GRE
Key on core DMF switches.

Note:  The L2 GRE Key-based hashing feature applies to switches running SWL OS and does not
apply to switches running EOS.

CLI Configuration

L2 GRE Key-based hashing is supported only for the IPv4-based packets with L2 GRE payload. This feature
does NOT support the IPv6 packets with L2 GRE payloads.

Enable the L2 GRE Key hashing by setting the l2-gre-key parameter as shown in the following example.

Controller-Active# show running-config switch DMF-SWITCH-1
! switch
switch DMF-SWITCH-1
mac c0:d6:82:17:fd:5a
!
lag-enhanced-hash
hash ipv4 l2-gre-key
hash symmetric disable

GUI Configuration
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1. Configure the L2 GRE Key Hashing in the UI for a switch in the Fabric > Switches page using the table
row menu action Configure  option.
Figure 7-4: Fabric Switch Configure Menu

2. Enable the L2 GRE Key for the IPv4 packets in the LAG Enhanced Hash step.
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Note:  The L2 GRE Key is unsupported for IPv6 and VxLAN Inner L3.

Figure 7-5: Configure Switch L2 GRE Key

3. Click the Submit button to save the configuration.

CLI Commands

Use the following CLI commands to verify settings and to troubleshoot any issues that may arise.

# show lag-enhanced-hash

While logged into a switch use the following commands to troubleshoot this feature.

root@DMF-SWITCH-1:~# ofad-ctl gt PORT_CHANNEL_ENHANCED_HASH_FIELD
Hash Field Configs:
-------------------
Symmetric Hashing:
Disabled
L2GRE Key Hashing:
Enabled
L2 Fields:
IPv4 Fields:
DSTL4 SRCL4
IPv6 Fields:
MPLS Fields:
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L2GRE L2 Fields:
L2GRE L3 Fields:
VXLAN L2 Fields:
VXLAN L3 Fields:

root@DMF-SWITCH-1:~# ofad-ctl bshell getreg RTAG7_HASH_CONTROL_L2GRE_MASK_A
RTAG7_HASH_CONTROL_L2GRE_MASK_A.ipipe0[1][0x6a001900]=0xffffffff
: <L2GRE_TUNNEL_GRE_KEY_MASK_A=0xffffffff>

root@DMF-SWITCH-1:~# ofad-ctl bshell getreg RTAG7_HASH_CONTROL_L2GRE_MASK_B
RTAG7_HASH_CONTROL_L2GRE_MASK_B.ipipe0[1][0x6a001a00]=0xffffffff
: <L2GRE_TUNNEL_GRE_KEY_MASK_B=0xffffffff>

root@s5248f-1:~# ofad-ctl bshell getreg RTAG7_L2GRE_PAYLOAD_L2_HASH_FIELD_BMAP
RTAG7_L2GRE_PAYLOAD_L2_HASH_FIELD_BMAP.ipipe0[1][0x6a001b00]=0: <
L2GRE_PAYLOAD_L2_BITMAP_B=0,L2GRE_PAYLOAD_L2_BITMAP_A=0>

root@s5248f-1:~# ofad-ctl bshell getreg RTAG7_L2GRE_PAYLOAD_L3_HASH_FIELD_BMAP
RTAG7_L2GRE_PAYLOAD_L3_HASH_FIELD_BMAP.ipipe0[1][0x6a001c00]=0: <
L2GRE_PAYLOAD_L3_BITMAP_B=0,L2GRE_PAYLOAD_L3_BITMAP_A=0>
root@DMF-SWITCH-1:~# 

Note:  The L2GRE_KEY offset is the same as the SRCL4 and DSTL4 offset in hardware. Hence, the
hardware requires setting SRCL4 and DSTL4 hash fields and the L2GRE_KEY hash field to hash the
packets using the L2GRE_KEY.

7.1.5  VxLAN Hashing

VxLAN hashing enables hashing on a VxLAN payload, including hashing on the Inner L3 Source IP, Inner L3
Destination IP, Inner L2 Source MAC, and inner L2 Destination MAC. This only applies to terminated cases.

Symmetric hashing works with VxLAN packet Inner L3 Source IP/Destination IP, Inner L4 Source Port/
Destination Port, and Outer L3 Source IP/Destination IP.

Note:  VxLAN hashing applies to switches running SWL OS.

CLI Configuration

VxLAN hashing includes hashing on L2 and L3 and the setting of at least one parameter enabled under the
switch construct on Controller CLI:

# lag-enhanced-hash
hash vxlan inner-l2 dst-mac 
hash vxlan inner-l3 dst-ip

UI Configuration
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1. Configure the VxLAN Hashing in the UI for a switch in the Fabric > Switches page using the table row
menu action Configure option.
Figure 7-6: Fabric Switch Configure Menu

2. In the LAG Enhanced Hash step, configure the following fields depending on your requirements:

• L2 VxLAN Inner L2 fields
• VxLAN Inner L3 fields

Note:

• L2 GRE Key is not supported for VxLAN hash fields.
• Cannot simultaneously specify enhanced hash for L2 GRE Inner L2 and Inner L3.
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• Cannot simultaneously specify enhanced hash for VxLAN Inner L2 and Inner L3.
Figure 7-7: Configure Switch LAG Enhanced Hash

3. Click the Submit button to save the configuration.

CLI Commands

Use the following CLI commands to verify settings and to troubleshoot any issues that may arise.

# show lag-enhanced-hash

Use the following commands to troubleshoot this feature. For example, when the hashing happens on VxLAN
payload inner L3 Src IP.

root@DMF-SWITCH-1:~# root@mrv1:~# ofad-ctl gt PORT_CHANNEL_ENHANCED_HASH_FIELD
Hash Field Configs:
-------------------
Symmetric Hashing:
Disabled
L2 Fields:
IPv4 Fields:
IPv6 Fields:
MPLS Fields:
L2GRE L2 Fields:
L2GRE L3 Fields:
VXLAN L2 Fields:
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VXLAN L3 Fields:
IP4SRC_LO IP4SRC_HI

root@mrv1:~# ofad-ctl bshell getreg RTAG7_HASH_CONTROL_4
RTAG7_HASH_CONTROL_4.ipipe0[1][0x6a000700]=3:
<VXLAN_PAYLOAD_HASH_SELECT_B=1,VXLAN_PAYLOAD_HASH_SELECT_A=1,DISABLE_H
ASH_VXLAN_B=0,DISABLE_HASH_VXLAN_A=0>
    
root@mrv1:~# ofad-ctl bshell getreg RTAG7_VXLAN_PAYLOAD_L2_HASH_FIELD_BMAP
RTAG7_VXLAN_PAYLOAD_L2_HASH_FIELD_BMAP.ipipe0[1][0x6a001d00]=0: <
VXLAN_PAYLOAD_L2_BITMAP_B=0,VXLAN_PAYLOAD_L2_BITMAP_A=0>

root@mrv1:~# ofad-ctl bshell getreg RTAG7_VXLAN_PAYLOAD_L3_HASH_FIELD_BMAP
RTAG7_VXLAN_PAYLOAD_L3_HASH_FIELD_BMAP.ipipe0[1][0x6a001e00]=0x1800c00
: <VXLAN_PAYLOAD_L3_BITMAP_B=0xc00,VXLAN_PAYLOAD_L3_BITMAP_A=0xc00>
            

7.1.6  MLAG RTAG7 Hash Computation for Unbalanced Load Balancing

In DANZ Monitoring Fabric (DMF), all SWL OS switches with the same underlying ASIC have the same
RTAG7 hash parameters configured by default. After configuring MLAG to load balance traffic from filter
to delivery switches, and when the number of interfaces in the MLAG and LAG in the delivery switch is the
same, the traffic will not be load balanced in the delivery switch because of hash polarization.

Use the feature to avoid LAG hash polarization by choosing different hash algorithms in separate switches.
The other option is using a different packet field set in each switch.

The feature supports using different hash algorithms by choosing different hash seed values.

Note:  MLAG RTAG7 hash computation for unbalanced load balancing only applies to switches
running SWL OS and does not apply to switches running EOS and is only supported on select
Broadcom® switch ASICs that run SWL OS.

CLI Configuration

Configure the feature on each switch using the following CLI commands:

(config)# switch S4048T
(config-switch)# lag-enhanced-hash
(config-switch)# hash symmetric enable
(config-switch-hash)# hash seeds 1234 3456
(config-switch-hash)# hash l2 dst-mac
(config-switch-hash)# hash l2 src-mac
(config-switch-hash)# hash l2 eth-type
(config-switch-hash)# hash l2 vlan-id

Use the following show command to view the configured hash seed.

R450-C1# show lag-enhanced-hash switch S4048T
~~~~~~~~~~~~~~~~~~~~~~~~~ L2 Enhanced Hash  ~~~~~~~~~~~~~~~~~~~~~~~~~
# Switch DPID Dst mac Eth type Src mac Vlan id Seed1 Seed2 Symmetric
-|-----------|-------|--------|-------|-------|-----|-----|---------|
1 S4048T      True    True     True    True    1234  3456  True

Note:  The CLI example above illustrates an L2 configuration.

GUI Configuration

From the home page, select the switches using Fabric > Switches.
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A list of available switches displays.

Choose the required switch for configuring the hash seeds. Hash seeds are integers which are used in
generating random numbers in the RTAG7 hash algorithm.

Select Actions from the menu.
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On the Configure Switch page, select LAG Enhanced Hash.
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Toggle on the following:

• Options

• Symmetric
• L2 Fields

• Src. MAC
• Dst. MAC
• Ether-Type
• VLAN ID

and enter the hash Seed 1 and Seed 2 values in the LAG Enhanced Hash window.

Click Submit.

Note:  The GUI example above illustrates an L2 configuration.

Optional: Use the CLI, and the following show command to view the configured hash seed.

R450-C1# show lag-enhanced-hash
~~~~~~~~~~~~~~~~~~~~~~~~~~~ L2 Enhanced Hash  ~~~~~~~~~~~~~~~~~~~~~~~~~~~
# Switch DPID     Dst mac Eth type Src mac Vlan id Seed1 Seed2 Symmetric
-|---------------|-------|--------|-------|-------|-----|-----|---------|
1 A-7050SX3-48YC8 True    True     True    True    1234  3456  True

7.1.6.1  Troubleshooting a Configured Hash Seed

To ensure the configured hash seed is correctly applied on the switch use the following procedure.
1. Log in to the switch using the connect switch switch_name command.
2. Use the ofad-ctl gt PORT_CHANNEL_ENHANCED_HASH_SEED command to print the seed values and

the hash algorithm.
3. Ensure the hash algorithms differ in the switches where hash polarization occurs.
4. Configure the hash seeds such that the hash algorithms are different.

Example

R450-C1(config)# connect switch A-7050SX3-48YC8
Switch Light OS SWL-OS-DMF-8.6.x(0), 2023-12-07.09:17-42d8658
Linux A-7050SX3-48YC8 4.19.296-OpenNetworkLinux #1 SMP Thu Dec 7 09:28:30 UTC
 2023 x86_64
SwitchLight ZTN Manual Configuration. Type help or ? to list commands.
(ztn-config) debug bash
*****************************  WARNING  ******************************
Any/All activities within bash mode are UNSUPPORTED
This is intended ONLY for additional debugging ONLY by Arista TAC.
Please type "exit" or Ctrl-D to return to the CLI
*****************************  WARNING  ******************************
root@A-7050SX3-48YC8:~# ofad-ctl gt PORT_CHANNEL_ENHANCED_HASH_SEED
GENTABLE : port_channel_enhanced_hash_seed
GENTABLE ID : 0x0006
hash_seed_valid: true
HASH_SEED1=0x000004d2
HASH_SEED2=0x000004d2
computed hash algorithm from seed: CRC32LO
root@A-7050SX3-48YC8:~#
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7.2  Pseudo Multi-Chassis Link Aggregation

Currently in DMF, we support Link Aggregation Groups (LAGs) that allow 2 or more physical interfaces on the
same DMF switch to be aggregated into 1 logical interface to increase the aggregate bandwidth and provide
link redundancy against link failure. This feature works well if all the tools are connected to the same DMF
delivery switch, which is typically the case when customer tools are co-located in the same physical location.
However, in cases where tools are located in different data centers or physical locations, where a single DMF
switch cannot connect to all the tools, load-balancing across two DMF delivery switches is required.

A pseudo Multi-chassis Link Aggregation Group (MLAG) provides delivery switch redundancy where each
delivery switch is connected to a multi-homed tool. With MLAG, traffic is hashed on the upstream DMF switch
across two active-active links toward the delivery switches. In case one of the switches fails, the traffic will be
switched over to the healthy switch.
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7.3  MLAG Components

• MLAG Domain: An MLAG domain is a logical grouping of two delivery switches that will participate in
an MLAG.

• Peer Switch: Member switches added into the MLAG domain.
• MLAG Interface: An MLAG interface, configured under the MLAG domain, is a logical binding of two

physical interfaces or LAG interfaces, one from each peer switch.
• Core MLAG Link: A fabric-facing MLAG link. A core switch LAG interface, whose members connect to the

two peer switches participating in the MLAG domain.
• Delivery MLAG Link: An MLAG interface that is assigned the delivery interface role. This interface is used

in a policy as a delivery interface.
• MLAG Member Interface: A physical interface or a LAG interface added into an MLAG interface.
• DMF Policy: A user-configured DMF policy that contains at least one MLAG delivery interface.
• Dynamic MLAG Domain Policy: Dynamically configured policies that follow the naming convention

_mlag_<DMF- policy>_<DeliverySwitch>. For one user-configured MLAG policy, a policy that
uses at least one MLAG delivery interface, two dynamic MLAG domain policies are created, one for each
peer switch.

7.4  MLAG Limitations

• An MLAG domain cannot have more than two switches.
• A switch can only be a part of one MLAG domain.
• An MLAG interface can only have two member interfaces.
• An MLAG interface can only have one interface (physical interface or LAG interface) from each

peer switch.
• Tunnel interfaces are not supported as members in MLAG interface configuration.
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7.5  Configuring an MLAG via the CLI

To configure an MLAG, use the following steps:
1. Configure an MLAG domain by specifying an alias, and add peer switches that will be participating in

the MLAG.

Controller-1(config)# mlag-domain MLAG-Domain1
Controller-1(config-mlag-domain)# peer-switch DeliverySwitch-1
Controller-1(config-mlag-domain)# peer-switch DeliverySwitch-2

2. Configure the core MLAG interface.

Controller-1(config-mlag-domain)# mlag-interface MLAG-Core-Intf
Controller-1(config-mlag-domain-if)# member switch DeliverySwitch-1
 interface ethernet50
Controller-1(config-mlag-domain-if)# member switch DeliverySwitch-2
 interface ethernet50

The above MLAG interface configuration selects one physical interface from each peer switch
added into the MLAG domain. This MLAG interface is fabric-facing, which means that ethernet50 of
DeliverySwitch-1 and ethernet50 of DeliverySwitch-2 are connected to the DMF core switch, where
traffic hashing is performed.

3. Configure the core LAG interface, a LAG interface on the core switch. The members of the LAG interface
are connected to the peer switches in the MLAG domain. This configuration ensures that the traffic will be
hashed toward the two connected delivery switches.

Controller-1(config)# switch CoreSwitch-1
Controller-1(config-switch)# lag-interface Core-LAG
Controller-1(config-switch-lag-if)# member ethernet10
Controller-1(config-switch-lag-if)# member ethernet20

4. Configure the delivery MLAG interface by specifying an interface alias and selecting one member from
each delivery switch.

Controller-1(config-mlag-domain-if)# mlag-interface MLAG-Del-Intf
Controller-1(config-mlag-domain-if)# member switch DeliverySwitch-1
 interface ethernet1
Controller-1(config-mlag-domain-if)# member switch DeliverySwitch-2
 interface ethernet1
Controller-1(config-mlag-domain-if)# role delivery interface-name MLAG-
Tool-1

The above MLAG interface configuration selects one physical interface from each peer switch added into
the MLAG domain. The members of this MLAG interface, ethernet1 of DeliverySwitch-1 and ethernet1
of DeliverySwitch-2, are connected to multi-homed tools. Note that unlike the core MLAG interface, the
delivery MLAG interface is assigned the delivery role and its interface name is configured, so that it can be
used in DMF policies as a delivery interface.

5. Configure a DMF policy by following the procedure shown below:

Controller-1(config)# policy Policy-1
Controller-1(config-policy)# action forward
Controller-1(config-policy)# 1 match any
Controller-1(config-policy)# filter-interface Filter-1
Controller-1(config-policy)# delivery-interface MLAG-Tool-1
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The above policy is configured using the MLAG-Tool-1 interface configured in Step 4. Configuring the
policy to use an MLAG delivery interface will result in two dynamic policies, one for each peer switch.
Refer to the following topology for the policy breakdown.
Figure 7-8: MLAG Policy Breakdown

As seen in the topology above:

• The user-configured policy delivers traffic from the filter switch to the core switch LAG interface.
• Dynamic Policy 1 delivers traffic to delivery switch 1.
• Dynamic Policy 2 delivers traffic to delivery switch 2.

The following output displays the three policies as configured on the DMF controller:

Below are the details for each policy:

Policy: Policy-1 Interfaces

• Filter Interface(s) section lists the filter interface configured for the policy, Policy-1.
• Core Interface(s) section lists the interfaces that connect the filter switch and the core switch selected for

the policy.
• MLAG Core Interface(s) section displays the core LAG interface that hashes the traffic towards the

peer switches.
• MLAG Delivery Interface(s) section lists the delivery MLAG interface members.

Policy: _mlag_Policy-1_DeliverySwitch-1 Interfaces

• Filter Interfaces(s) section lists the dynamically configured interface name on DeliverySwitch1 to which
the core switch is connected.

• MLAG Delivery Interface(s) section lists the delivery MLAG interface member on DeliverySwitch1.

Policy: _mlag_Policy-1_DeliverySwitch-2 Interfaces

• Filter Interfaces(s) section lists the dynamically configured interface name on DeliverySwitch2 to which
the core switch is connected.
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• MLAG Delivery Interface(s) section lists the delivery MLAG interface member on DeliverySwitch2.

7.6  MLAG Link Discovery

Link Layer Discovery Protocol (LLDP) is used to discover MLAG links. When the DMF Controller receives an
LLDP message, it looks for the switch and interface names. If the switch is a part of an MLAG domain, and
the reported interface corresponds to the MLAG interface, then it is classified as an MLAG link.

Controller-1(config)# show link all link-type mlag-member
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Links ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# Active State Src switch        Src IF Name Dst switch        Dst IF Name Link Type   Since
-|------------|-----------------|-----------|-----------------|-----------|-----------|-----------------------|
1 active       CoreSwitch-1      ethernet10  DeliverySwitch-1  ethernet50  mlag-member 2022-11-11 21:54:28 UTC
2 active       CoreSwitch-1      ethernet20  DeliverySwitch-2  ethernet50  mlag-member 2022-11-11 21:54:28 UTC
3 active       DeliverySwitch-1  ethernet50  CoreSwitch-1      ethernet10  mlag-member 2022-11-11 21:54:28 UTC
4 active       DeliverySwitch-2  ethernet50  CoreSwitch-1      ethernet20  mlag-member 2022-11-11 21:54:13 UTC
Controller-1(config)#

7.7  Configure MLAG via GUI

To configure an MLAG domain from the GUI, go to the Fabric > MLAGs tab.

Figure 7-9: Fabric –> MLAGs page

Figure 7-10: Create MLAG page
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Click on Create MLAG Domain and enter the following:

• Domain Name: Enter the MLAG domain alias.

• Peer Switch 1: From the drop-down, select the first switch that will be participating in the
MLAG domain.

• Peer Switch 2: From the drop-down, select the second switch that will be participating in the
MLAG domain.

• MLAG Interfaces: Enter an alias for the fabric-facing MLAG interface. This interface connects the core
switch to the peer switches in the MLAG domain.

• Peer Switch 1 and Peer Switch 2: After selecting peer switches under the domain name, the peer
switches under the MLAG interface will automatically be selected.

• Interface 1: Select the member interface that connects the core switch to DeliverySwitch-1
• Interface 2: Select the member interface that connects the core switch to DeliverySwitch-2.

• MLAG Delivery Interfaces: Enter an alias for each MLAG delivery interface.

• DMF Interface Name: Enter the DMF interface name for the MLAG delivery interface. This alias will be
used to identify the delivery interface while configuring the DMF policy.

• Strip VLAN on Egress: Select the strip VLAN configuration for the MLAG delivery interface
• Peer Switch 1 and Peer Switch 2: These will be automatically selected based on the peer switches

selected under the domain name.
• Interface 1: Select the member interface on Peer Switch 1.
• Interface 2: Select the member interface on Peer Switch 2.

Click on the Create button to save the above configuration.
Figure 7-11: MLAG Domain State

Figure 7-12: MLAG Domain Expanded View

The above screenshot displays the MLAG domain status. Click on the + button to expand the MLAG domain
configuration and status of each MLAG interface.
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7.8  Create MLAG Policy from GUI

To configure an MLAG policy, go to the Monitoring > Policies page.
Figure 7-13: Configure MLAG Policy

Select + Create Policy to add a new policy.

Click + Add Ports in Destination Tools and select or drag the MLAG interface to associate with the policy.
Figure 7-14: Add MLAG Interface

Click Add 1 Interface and enter the following to configure the policy association.

• Name: Assign a unique name to the policy.
• Description: A description for the policy.
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• Action: Forward (default), None, Capture, or Drop.
• Priority: 100 (default), or enter a value.
• Scheduling: Automatic (default), Now, Set Time, or Set Delay.
• Port Selection > Traffic Sources > + Add Port(s): Select the filter interface (traffic source) for the policy.
• Match Traffic > Allow All Traffic / Deny All Traffic or Configure A Rule: Specify the traffic rule for

the policy.

Click Create Policy.

7.9  Viewing Policy Statistics in the GUI

Once the MLAG policy is configured, it can be viewed under Monitoring > Policies along with the dynamic
policies created as part of the MLAG policy.
Figure 7-15: MLAG Policy
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To view the policy statistics, rollover a Policy Name or click on the MLAG Policy Name. The following
screens appear.
Figure 7-16: MLAG Policy - Interface Statistics

Figure 7-17: MLAG Policy - Operational Details
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7.10  Viewing MLAG Links in the GUI

To view the MLAG links, go to Fabric > Links > MLAG Member Links tab.
Figure 7-18: MLAG Member Links

The above screenshot shows the MLAG links established between the core switch and the peer switches that
are part of the MLAG domain. The links are discovered via LLDP message exchange.

7.11  Using LAG Interfaces as Members in MLAG Interfaces

MLAG interface members can be physical interfaces or LAG interfaces to increase bandwidth. To add a LAG
member to an MLAG interface, use the following procedure:
1. Configure the LAG interface on Peer Switch 1.

Controller-1(config)# switch DeliverySwitch-1
Controller-1(config-switch)# lag-interface LAG-peer-switch-1
Controller-1(config-switch-lag-if)# member ethernet11
Controller-1(config-switch-lag-if)# member ethernet12

2. Configure the LAG interface on Peer Switch 2.

Controller-1(config)# switch DeliverySwitch-2
Controller-1(config-switch)# lag-interface LAG-peer-switch-2
Controller-1(config-switch-lag-if)# member ethernet11
Controller-1(config-switch-lag-if)# member ethernet12

3. Add the configured LAG interfaces as members into the MLAG interface.

Controller-1(config)# mlag-domain Domain1
Controller-1(config-mlag-domain)# mlag-interface MLAG-LAG-Del-Intf
Controller-1(config-mlag-domain-if)# member switch DeliverySwitch-1
 interface LAG-peer-switch-1
Controller-1(config-mlag-domain-if)# member switch DeliverySwitch-2
 interface LAG-peer-switch-2
Controller-1(config-mlag-domain-if)# role delivery interface-name MLAG-LAG-
Tool-1

4. Configure the DMF policy using the delivery interface MLAG-LAG-Tool-1.

Controller-1(config)# policy Policy-1
Controller-1(config-policy)# action forward
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Controller-1(config-policy)# 1 match any
Controller-1(config-policy)# filter-interface Filter-1
Controller-1(config-policy)# delivery-interface MLAG-LAG-Tool-1

Note:  Traffic will not hash toward tools if the core switch LAG has the same number of member
interfaces as the LAG on the peer switches of MLAG delivery.

Workaround:

• Ensure that the hash fields on the core switch and MLAG peer switches are different, OR
• Ensure that the number of member interfaces in the LAG interface configured on the core switch

is different from the number of members in the LAG interface configured on peer switches.

7.12  Overlapping Policies in LAGs

An overlapping policy is dynamically configured if two configured policies share at least one filter interface,
and at least one of the delivery interfaces is different.

When two DMF policies that are configured to use an MLAG interface as a delivery interface overlap, the
following policies are created:
1. Policy-1 is configured to use the filter interface Filter-1, and the delivery interface MLAG-Tool-1.
2. Policy-2 is configured to use the filter interface Filter-1, and the delivery interface MLAG-Tool-2.
3. The above two policies will result in a overlapping policy. An overlapping policy will be configured following

the naming convention _Policy-1_o_Policy-2.

Once the overlapping policy is calculated for the two user configured policies, two dynamic policies will
be configured: one policy for each peer switch in the MLAG domain and one for each of the three policies
listed above.

Table 4: Dynamic Policies

MLAG Dynamic Policy Parent Policy Delivery Switch/Peer switch

_mlag_Policy-1_DeliverySwitch-1 Policy-1 DeliverySwitch-1

_mlag_Policy-1_DeliverySwitch-2 Policy-1 DeliverySwitch-2

_mlag_Policy-2_DeliverySwitch-1 Policy-2 DeliverySwitch-1

_mlag_Policy-2_DeliverySwitch-2 Policy-2 DeliverySwitch-2

_mlag Policy-1_o_Policy-2_DeliverySwitch-1 _Policy-1_o_Policy-2 DeliverySwitch-1

_mlag Policy-1_o_Policy-2_DeliverySwitch-2 _Policy-1_o_Policy-2 DeliverySwitch-2

The following policies, Policy-1 and Policy-2, share the same filter interface, Filter-1, but they are configured
to use different delivery interfaces, MLAG-Tool-1 and MLAG-Tool-2. No priority is configured; therefore,
these policies will be using the same default priority.

Policy-1 Configuration

policy Policy-1
action forward
delivery-interface MLAG-Tool-1
filter-interface Filter-1
1 match ip src-ip 200.200.0.0 255.255.255.0

Policy-2 Configuration

policy Policy-2
action forward
delivery-interface MLAG-Tool-2
filter-interface Filter-1
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1 match ip dst-ip 100.100.0.0 255.255.255.0

The above two policies will result in an overlapping policy.
Controller-1(config)# show policy
# Policy Name            Action  Runtime Status Type       Priority Overlap Priy Push VLAN Filter BW Delivery BW Post Match Filt Traff Del Traffic Services
-|----------------------|-------|--------------|----------|--------|------------|---------|---------|-----------|----------------------|----------|--------|
1 Policy-1               forward installed      Configured      100            0         1    25Gbps      80Gbps                314Mbps    315Mbps
2 Policy-2               forward installed      Configured      100            0         3    25Gbps      80Gbps                314Mbps    315Mbps
3 _Policy-1_o_Policy-2   forward installed      Dynamic         100            1         5    25Gbps      80Gbps                314Mbps    315Mbps

• Policy-1: User-configured policy to forward packets matching source IP 200.200.0.0/24 to MLAG-Tool-1.
• Policy-2: User-configured policy to forward packets matching destination IP 100.100.0.0/24 to MLAG-

Tool-2.
• _Policy-1_o_Policy-2: A dynamically configured overlapping policy with higher Overlap Priority to ensure

that if a packet matches rules from both the policies (source IP of 200.200.0.1 and destination IP of
100.100.0.1) it will be forwarded to both MLAG-Tool-1 and MLAG-Tool-2.

Following are the dynamic policies configured for each delivery switch in the MLAG Domain.

Policy-1 Dynamic Policies

• _mlag_Policy-1_DeliverySwitch-1: MLAG dynamic policy for Policy-1 for DeliverySwitch-1.
• _mlag_Policy-1_DeliverySwitch-2: MLAG dynamic policy for Policy-1 for DeliverySwitch-2.

Policy-2 Dynamic Policies

• _mlag_Policy-2_DeliverySwitch-1: MLAG dynamic policy for Policy-2 for DeliverySwitch-1.
• _mlag_Policy-2_DeliverySwitch-2: MLAG dynamic policy for Policy-2 for DeliverySwitch-2.

_Policy-1_o_Policy-2 Dynamic Policies

The following policies have higher Overlap Priority as compared to the rest of the policies. This is to prioritize
the overlapping traffic to be forwarded to both DeliverySwitch-1 and DeliverySwitch-2.

• _mlag Policy-1_o_Policy-2_DeliverySwitch-1: MLAG dynamic policy for overlapping policy for
DeliverySwitch-1.

• _mlag Policy-1_o_Policy-2_DeliverySwitch-2: MLAG dynamic policy for overlapping policy for
DeliverySwitch-2.
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Chapter 8

Tunneling Between Data Centers

This chapter describes how to establish Generic Routing Encapsulation (GRE) and/or Virtual Extensible
LAN (VxLAN) tunnels between DMF switches in different locations or between a DMF switch and a third-
party device.

8.1  Understanding Tunneling

DMF can forward traffic between two DMF switches controlled by the same Controller over a tunnel. This
feature can be used to extend a DMF deployment across multiple data centers or branch offices over
networks connected by Layer-3 networks. This feature supports centralization or distribution of tools and taps
across multiple locations when they cannot be cabled directly.

Note:  For a list of the switches that support tunneling, refer to the DANZ Monitoring Fabric 8.5
Hardware Compatibility List. The DANZ Monitoring Fabric 8.4 Verified Scale Guide indicates
the number of tunnels supported by each supported switch (Verified Scalability Values/encap tunnels/
decap tunnels).

When enabling tunneling between DMF switches, keep the following in mind:

• Connect switch ports in the main data center and the remote location to the appropriate WAN routers, and
ping each interface to make sure that IP connectivity is established.

• Create tunnel endpoints and configure the tunnel attributes on each end of the tunnel.
• The CRC Check option must be enabled if tunneling is enabled, which it is by default. If CRC checking

has been disabled, re-enable it before configuring a tunnel.
• In case of GRE tunnels, the optional gre-key-decap value on the receiving end must match the GRE

key value of the sender. You can set multiple values on the same tunnel to decapsulate traffic with
different keys.

• Multiple tunnels can be initiated from a single switch. For each tunnel (transmit-only or bidirectional), a
separate encap-loopback-interface must be configured.
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• The loopback-mode must be set to mac on the encap-loopback-interface.

Figure 8-1: Connecting DMF Switches Using a Layer-2 GRE Tunnel

Note:  For EOS switches running DMF 8.5: L2GRE tunneling is supported on Arista 7280R3 switches
only and subject to the following limitations:

• L2GRE tunnels are not supported on DMF 7280R and 7280R2 switches.
• DSCP configuration is not supported.
• Traffic steering for traffic arriving on an L2GRE tunnel will only allow for matching based on inner

src/dst IP, IP protocol, and inner L4 src/dst port.
• Packets may only be redirected to a single L2GRE tunnel.
• Packets may not be load-balanced across multiple L2GRE tunnels.
• Only IPv4 underlays in the default VRF are supported.
• Matching on inner IPv6 headers may not be supported.
• The maximum number of tunnels on EOS Jericho switches is 32.
• There is no bi-directional tunnel support. The parent/uplink router-facing interface is used for either

encapsulation or decapsulation, but not simultaneously.
• When using tunnel-as-a-filter, there is no inner L3/L4 matching support immediately after

decapsulation in the same switch pass. Using a loopback may potentially work around
this limitation.

• VxLAN tunnels are currently NOT supported on 7280 switches.

8.2  Encapsulation Type

DMF supports VxLAN tunnel type along with Level-2 Generic Routing Encapsulation (L2GRE). Tunnel type is
a per-switch configuration, which means that the switch pipeline can either be set to VxLAN or L2GRE. Once
the switch pipeline is set, all tunnels configured on the switch will use the same tunnel type.
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The encapsulation type can be configured in the GUI while adding a new switch into the DMF Controller as
shown in the figure below:

The encapsulation type can be edited for an existing switch from the Fabric > Switches > Configure Switch
page as shown in the figure below:

The encapsulation type can also be configured or edited from the CLI in configuration mode:

Ctrl-1(config)# switch Switch-1
Ctrl-1(config-switch)# tunnel-type
gre Select GRE as the tunnel type of the switch. (default selection)
vxlan Select VxLAN as the tunnel type of the switch.

The switch pipeline mode can be viewed from the CLI using the following command:
Ctrl-1(config)# show switch
# Switch Name         IP Address                  State     Pipeline Mode
-|-------------------|---------------------------|---------|----------------------------------|
1 Switch-1            fe80::d6af:f7ff:fef9:e2b0%9 connected l3-l4-offset-match-push-vlan-vxlan
2 Switch-2            fe80::e6f0:4ff:fe69:6aee%9  connected l3-l4-offset-match-push-vlan
3 Switch-3            fe80::e6f0:4ff:fe78:1ffe%9  connected l3-l4-offset-match-push-vlan-vxlan
Ctrl-1(config)#
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In the above CLI output, Switch-1 and Switch-3 are using the VxLAN tunnel type as seen in the Pipeline
Mode column. Switch-2 is using the L2GRE tunnel type.

8.3  Using Tunnels in Policies

Tunnels can be used as a core link, as a filter interface, or as a delivery interface. The most common use
case is for linking multiple sites, in which case the tunnel is treated as a core link. If used as a core link, DMF
automatically discovers the link as if it was a physical link and determines connectivity (link-state) in the same
manner. If the tunnel goes down for any reason, DMF treats the failure as it would a physical link failure.

Another typical use case for the tunnel is as A filter interface to decapsulate L2 GRE/VxLAN tunneled
production traffic, or a tunnel initiated by another DMF instance managed by a different DMF Controller.
Tunnel endpoint can also be used as a delivery interface to encapsulate filtered monitoring traffic to send to
analysis tools or to send to another DANZ Monitoring Fabric managed by a different DMF Controller.

Note:  By default, sFlow and other Arista Analytics meta data cannot be generated for decapsulated
L2 GRE/VxLAN tunneled production traffic on a tunnel interface configured as a filter interface. In
order to generate this meta data, create a policy with a filter interface as a tunnel interface and send
the decapsulated traffic to a MAC loopback port configured in a filter-and-delivery role. Now create a
second policy with the filter interface as the MAC loopback port and the delivery interface going to the
tools. The sFlow and meta data will now be generated for the decapsulated tunnel traffic.

8.4  Using the GUI to Configure a GRE Tunnel

To configure a VxLAN tunnel, complete the following steps:
1. Select Fabric > Switch.
2. On the Switches page, click the Menu control to the left of the switch or interface to include in the tunnel

and select Create Tunnel.

Alternatively, tunnels can be configured from the Fabric > Interfaces page by clicking on the top Menu
Control > Create Tunnel option. The system displays the dialog as shown in the figure below:
Figure 8-2: Configure VxLAN Tunnel
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3. Complete the fields on this page, as described below.

• Switch: From the drop down, select the DMF switch.
• Encapsulation Type: The encapsulation type will automatically be selected based on the pipeline

mode of the selected switch.
• Name: Name of the tunnel, beginning with the word tunnel.
• Rate Limit (Optional): Packets entering the tunnel can be rate limited to restrict the bandwidth usage of

the tunnel. This can help ensure that a WAN link is not saturated with monitoring traffic being tunneled
between sites. This setting is applicable on the tunnel encapsulation side.

• Direction: Direction can be bidirectional, transmit-only or receive-only. For bidirectional tunnels, the
tunnel direction should be bidirectional on both ends. For uni-directional tunnels from remote to main
datacenter, the tunnel direction is transmit-only on the remote datacenter switch and receive-only on
the main data center switch.

• Local IP: Local IP address and subnet mask in CIDR format (/nn).
• Gateway IP: IP address of the default (next-hop) gateway.
• Remote IP: This is the IPv4 address of the other end (remote end) of the tunnel.
• Parent Interface: Physical port or port-channel interface associated with the tunnel. This is the

destination interface for the tunnel.
• Loopback Interface: A physical interface on each switch with a transmit-only or a bidirectional tunnel

endpoint. This physical interface will be used for tunnel encapsulation purposes, and cannot be used
for any other DMF purpose, such as a filter, delivery, service, or core interface.

• DSCP (Optional): Mark the tunnel traffic with the specified DSCP value.
4. After configuring the appropriate options, click Submit.

Note:  This procedure should be configured on both switches, at each end of the tunnel. The Auto
VLAN mode must be set to Push Per Policy or Push Per Filter Interface.

8.5  Using the CLI to Configure a GRE Tunnel

To configure a GRE tunnel using the CLI, complete the following steps:
1. Connect switch ports (on remote and main datacenter) to their respective WAN routers and ensure that

they can communicate via IP.
2. Enable tunneling on the DMF network by entering the following command from config mode:

controller-1(config)# tunneling
Tunneling is an Arista Licensed feature. Please ensure that you have
 purchased the license
for tunneling before using this feature. enter "yes" (or "y") to continue:
 yes
controller-1(config)#

3. Configure the MAC loopback mode, as shown in the following example:

controller-1(config)# switch DMF-CORE-SWITCH
controller-1(config-switch)# interface ethernet7
controller-1(config-switch-if)# loopback-mode mac

4. Create tunnel endpoints.

The following CLI example configures a bi-directional tunnel from remote-dc1-filter-sw to main-dc-delivery-
sw:

!
switch remote-dc1-filter-sw
gre-tunnel-interface tunnel1
remote-ip 192.168.200.50
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gre-key-decap 4097 === 4097 is the VPN key used for the tunnel ID
parent-interface ethernet6
local-ip 192.168.100.50 mask 255.255.255.0 gateway-ip 192.168.100.1
direction bidirectional encap-loopback-interface ethernet38
!
switch main-dc-delivery-sw
gre-tunnel-interface tunnel1
remote-ip 192.168.100.50
gre-key-decap 4097 === 4097 is the VPN key used for the tunnel ID
parent-interface ethernet5
local-ip 192.168.200.50 mask 255.255.255.0 gateway-ip 192.168.200.1
direction bidirectional encap-loopback-interface ethernet3

The following CLI example configures a uni-directional tunnel from remote-dc1-filter-sw to main-dc-
delivery-sw:

!
switch remote-dc1-filter-sw
gre-tunnel-interface tunnel1
remote-ip 192.168.200.50
gre-key-decap 4097 === 4097 is the VPN key used for the tunnel ID
interface parent-interface ethernet6
local-ip 192.168.100.50 mask 255.255.255.0 gateway-ip 192.168.100.1
direction transmit-only encap-loopback-interface ethernet38
!
switch main-dc-delivery-sw
gre-tunnel-interface tunnel1
remote-ip 192.168.100.50
gre-key-decap 4097 === 4097 is the VPN key used for the tunnel ID
parent-interface ethernet5
local-ip 192.168.200.50 mask 255.255.255.0 gateway-ip 192.168.200.1
direction receive-only

8.5.1  Using the CLI to Rate Limit the Packets on a GRE Tunnel

Packets entering the GRE tunnel can be rate limited to limit bandwidth usage by the tunnel and help ensure
that a WAN link is not saturated with monitoring traffic being tunneled between sites. This setting is applicable
on the tunnel encapsulation side.

Note:  The minimum recommended value for rate limiting on the tunnel interface is 25 kbps. If you set
a value below this, the switch will still set the rate limit value to 25 kbps.

switch DMF-CORE-SWITCH-1
gre-tunnel-interface tunnel1
direction bidirectional encap-loopback-interface ethernet10
------------------------------example truncated------------
interface ethernet10
rate-limit 1000

8.5.2  Using the CLI to View GRE Tunnel Interfaces

All CLI show commands for regular interfaces can be used for GRE tunnel interfaces, and the show
running-config command can be used to view the configuration of tunnel interfaces.

Enter the show tunnel command to see the configuration parameters as well as runtime state for a
tunnel interface.
controller-1# show tunnel
# Switch DPID               Tunnel Name Tunnel Status     Direction     Src IP       Dst IP       Parent Name  Loopback Name
-|-------------------------|-----------|------------------|-------------|------------|------------|------------|-------------|
1 DMF-CORE-SWITCH-1         tunnel1     ESTABLISHED_TUNNEL bidirectional 198.82.215.1 216.47.143.1 ethernet5:1 ethernet6
2 DMF-CORE-SWITCH-2         tunnel1     ESTABLISHED_TUNNEL bidirectional 216.47.143.1 198.82.215.1 ethernet11:3 ethernet5
3 DMF-CORE-SWITCH-2         tunnel2     ESTABLISHED_TUNNEL bidirectional 192.168.43.1 192.168.42.1 ethernet11:4 ethernet17
4 DMF-CORE-SWITCH-3         tunnel2     ESTABLISHED_TUNNEL bidirectional 192.168.42.1 192.168.43.1 ethernet6 ethernet33
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controller-1# show tunnel switch DMF-CORE-SWITCH-2
# Switch DPID               Tunnel Name Tunnel Status     Direction     Src IP       Dst IP       Parent Name  Loopback Name
-|-------------------------|-----------|------------------|-------------|------------|------------|------------|-------------|
1 DMF-CORE-SWITCH-2         tunnel1     ESTABLISHED_TUNNEL bidirectional 216.47.143.1 198.82.215.1 ethernet11:3 ethernet5
2 DMF-CORE-SWITCH-2         tunnel2     ESTABLISHED_TUNNEL bidirectional 192.168.43.1 192.168.42.1 ethernet11:4 ethernet17

controller-1# show tunnel switch DMF-CORE-SWITCH-2 tunnel1
# Switch DPID               Tunnel Name Tunnel Status     Direction     Src IP       Dst IP       Parent Name  Loopback Name
-|-------------------------|-----------|------------------|-------------|------------|------------|------------|-------------|
1 DMF-CORE-SWITCH-2         tunnel1     ESTABLISHED_TUNNEL bidirectional 216.47.143.1 198.82.215.1 ethernet11:3 ethernet5
controller-1#

8.6  Using the GUI to Configure a VxLAN Tunnel

To configure a VxLAN tunnel using the GUI, complete the following steps:
1. Select Fabric > Switch.
2. On the Switches page, click the Menu control to the left of the switch or interface to include in the tunnel

and select Create Tunnel.

Alternatively, tunnels can be configured from the Fabric > Interfaces page by clicking on the top Menu
Control > Create Tunnel option. The system displays the dialog as shown in the figure below:
Figure 8-3: Configure VxLAN Tunnel

3. Complete the fields on this page, as described below:

• Switch: From the drop down, select the DMF switch.
• Encapsulation Type: Encapsulation type will automatically be selected based on the pipeline mode of

the selected switch.
• Name: Name of the tunnel, beginning with the word tunnel.
• Rate Limit (Optional): Packets entering the tunnel can be rate limited to restrict bandwidth usage of

the tunnel. This can help ensure that a WAN link is not saturated with monitoring traffic being tunneled
between sites. This setting is applicable on the tunnel encap side.

• Direction: bidirectional, transmit-only or receive-only. For bidirectional tunnels, tunnel-direction should
be bidirectional on both ends. For uni-directional tunnels from remote to main datacenter, tunnel-
direction is transmit only on the remote datacenter switch and the tunnel-direction is receive-only on the
main data center switch.

• Local IP: Local IP address and subnet mask in CIDR format (/nn).
• Gateway IP: IP address of the default (next-hop) gateway.
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• Remote IP: This is the IPv4 address of the other end (remote end) of the tunnel.
• Parent Interface: Physical port or port-channel interface associated with the tunnel. This is the

destination interface for the tunnel.
• Loopback Interface: A physical interface on each switch with a transmit-only or a bidirectional tunnel

endpoint. This physical interface will be used for tunnel encapsulation purposes, and cannot be used
for any other DMF purpose, such as a filter, delivery, service, or core interface.

• DSCP (Optional): Mark the tunnel traffic with the specified DSCP value.
4. After configuring the appropriate options, click Submit.

Note:  This procedure should be configured on both switches, at each end of the tunnel. The Auto
VLAN mode must be set to Push Per Policy or Push Per Filter Interface.

8.7  Using the CLI to Configure a VxLAN Tunnel

To configure a VxLAN tunnel using the CLI, complete the following steps:
1. Connect switch ports (on remote and main datacenter) to their respective WAN routers and ensure that

they can communicate via IP.
2. Enable tunneling on the DMF network by entering the following command from config mode:

controller-1(config)# tunneling
Tunneling is an Arista Licensed feature. Please ensure that you have
 purchased the license
for tunneling before using this feature. enter "yes" (or "y") to continue:
 yes
controller-1(config)#

3. Configure the MAC loopback mode, as shown in the following example:

controller-1(config)# switch DMF-CORE-SWITCH
controller-1(config-switch)# interface ethernet7
controller-1(config-switch-if)# loopback-mode mac

4. Create tunnel endpoints.

The following CLI example configures a bi-directional tunnel from remote-dc1-filter-sw to main-dc-delivery-
sw:

!
switch remote-dc1-filter-sw
vxlan-tunnel-interface tunnel1
remote-ip 192.168.200.50
parent-interface ethernet6
local-ip 192.168.100.50 mask 255.255.255.0 gateway-ip 192.168.100.1
direction bidirectional encap-loopback-interface ethernet38
!
switch main-dc-delivery-sw
vxlan-tunnel-interface tunnel1
remote-ip 192.168.100.50
parent-interface ethernet5
local-ip 192.168.200.50 mask 255.255.255.0 gateway-ip 192.168.200.1
direction bidirectional encap-loopback-interface ethernet3

The following CLI example configures a uni-directional tunnel from remote-dc1-filter-sw to main-dc-
delivery-sw:

!
switch remote-dc1-filter-sw
vxlan-tunnel-interface tunnel1
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remote-ip 192.168.200.50
interface parent-interface ethernet6
local-ip 192.168.100.50 mask 255.255.255.0 gateway-ip 192.168.100.1
direction transmit-only encap-loopback-interface ethernet38
!
switch main-dc-delivery-sw
vxlan-tunnel-interface tunnel1
remote-ip 192.168.100.50
parent-interface ethernet5
local-ip 192.168.200.50 mask 255.255.255.0 gateway-ip 192.168.200.1
direction receive-only

8.7.1  Using the CLI to Rate Limit the Packets on a VxLAN Tunnel

Packets entering the VxLAN tunnel can be rate limited to limit bandwidth usage by the tunnel and help ensure
that a WAN link is not saturated with monitoring traffic being tunneled between sites. This setting is applicable
on the tunnel encapsulation side.

Note:  The minimum recommended value for rate limiting on the tunnel interface is 25 kbps. If you set
a value below this, the switch will still set the rate limit value to 25 kbps.

switch DMF-CORE-SWITCH-1
vxlan-tunnel-interface tunnel1
direction bidirectional encap-loopback-interface ethernet10
<snip>
interface ethernet10
rate-limit 1000

8.7.2  Using the CLI to View VxLAN Tunnel Interfaces

All CLI show commands for regular interfaces can also be used for tunnel interfaces. The show running-
config command can be used to display the configuration of tunnel interfaces.

Enter the show tunnel command to see the configuration parameters as well as runtime state for a VxLAN
tunnel interface.
controller-1# show tunnel
# Switch DPID Tunnel Name Tunnel Status Direction Src IP Dst IP Parent Name Loopback
Name
-|-------------------------|-----------|-----------------|-------------|------------|------------|------------|-------------|
1 DMF-CORE-SWITCH-1 tunnel1 ESTABLISHED_TUNNEL bidirectional 198.82.215.1 216.47.143.1 ethernet5:1 ethernet6
2 DMF-CORE-SWITCH-2 tunnel1 ESTABLISHED_TUNNEL bidirectional 216.47.143.1 198.82.215.1 ethernet11:3 ethernet5
3 DMF-CORE-SWITCH-2 tunnel2 ESTABLISHED_TUNNEL bidirectional 192.168.43.1 192.168.42.1 ethernet11:4 ethernet17
4 dMF-CORE-SWITCH-3 tunnel2 ESTABLISHED_TUNNEL bidirectional 192.168.42.1 192.168.43.1 ethernet6 ethernet33
controller-1#
controller-1# show tunnel switch DMF-CORE-SWITCH-2
# Switch DPID Tunnel Name Tunnel Status Direction Src IP Dst IP Parent Name Loopback Name
-|-----------------------|-----------|------------------|-------------|------------|------------|------------|-------------|
1 DMF-CORE-SWITCH-2 tunnel1 ESTABLISHED_TUNNEL bidirectional 216.47.143.1 198.82.215.1 ethernet11:3 ethernet5
2 DMF-CORE-SWITCH-2 tunnel2 ESTABLISHED_TUNNEL bidirectional 192.168.43.1 192.168.42.1 ethernet11:4 ethernet17
controller-1#
controller-1# show tunnel switch DMF-CORE-SWITCH-2 tunnel1
# Switch DPID Tunnel Name Tunnel Status Direction Src IP Dst IP Parent Name Loopback Name
-|-----------------------|-----------|------------------|-------------|------------|------------|------------|-------------|
1 DMF-CORE-SWITCH-2 tunnel1 ESTABLISHED_TUNNEL bidirectional 216.47.143.1 198.82.215.1 ethernet11:3 ethernet5
controller-1#

8.8  Viewing or Modifying Existing Tunnels

To view or modify the configuration of an existing tunnel, use the Fabric > Interfaces option. To view the
tunnel configuration, expand the interface. DMF displays the tunnel configuration as illustrated in the following
figure.
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Tip:  When multiple interfaces are present, use the Filter feature to locate tunnel interfaces after
typing the first few letters of the word tunnel.

Figure 8-4: Tunnel Interfaces

The expanded row displays the status and other properties of the tunnel configured for the selected interface.
Use the Menu control and select Configure Tunnel to modify the tunnel configuration. Select Delete Tunnel
to remove the tunnel.

8.9  Using a Tunnel with User-defined Offsets

With an L2-GRE or VxLAN tunnel, matching traffic on a user-defined offset results in dropping interesting
traffic. The offset calculation is thrown off by the tunnel header, and traffic that you want to select may be
dropped. This behavior is due to the way switch hardware calculates the anchor and offset with respect
to incoming packets. When the core link is a tunnel, the anchor and offset calculation is different when
encapsulating packets compared to when decapsulating.

There are two ways to work around this issue:

• Avoid matching on user-defined offsets on tunnel interfaces
• Avoid using a tunnel as a core link when matching on a user-defined offset

You can avoid matching on user-defined offsets when the ingress filter interface is a tunnel by filtering on
the user-defined offset before the traffic enters a tunnel used as a filter interface. This preserves the LLDP
messaging on the core tunnel link, but it requires an extra physical loopback interface on the encapsulating
switch. Figure below illustrates both of these workarounds. In either case, a UDF match is applied to the
ingress traffic on filter interface F. For example, the policy might apply a match at offset 20 after the start of
the L4 header. In both workarounds, the policy has been split into two policies:

P1: F to D1, match on user-defined offset P2: F1 to D, match any.
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In the example on the left, the ingress interface on the decapsulating switch, which is included in a core tunnel
link, no longer has to calculate the user-defined offset. This solution preserves LLDP messages on the tunnel
link, but requires an extra loopback interface.
Figure 8-5: Using Tunnels with User-Defined Offsets

In the example on the right, the tunnel endpoints are configured as filter and delivery interfaces. This solution
avoids using the tunnel as a core link and does not require an extra physical loopback interface. However,
LLDP updates are lost on the tunnel link.

8.10  Wildcard Tunnels on SAND Platforms

The Wildcard tunneling feature allows the DANZ Monitoring Fabric (DMF) to decapsulate L2GRE-based
tunneled traffic from any remote source. This feature, supported on SwitchLight OS (SWL) based DMF
switches in prior releases, now allows wildcard tunnels on Arista EOS-based DMF switches.

Platform Compatibility

EOS switches with Jericho2 or higher ASICs compatible with DMF 8.5.0 that support L2GRE tunneling.
L2GRE tunneling on EOS SAND platforms is only supported on Arista 7280R3 switches.

8.10.1  Configuring Wildcard Tunnels Using the CLI

Perform the following steps to configure the tunnels.
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1. Enable the tunneling feature before configuring tunnels on a switch using the tunneling command. Enter
yes, when prompted to continue.

dmf-controller-1(config)# tunneling
Tunneling is an Arista Licensed feature. 
Please ensure that you have purchased the license for tunneling before using
 this feature.
Enter "yes" (or "y") to continue: y
dmf-controller-1(config)#

2. Configure a tunnel by using the remote-ip as 0.0.0.0.

dmf-controller-1(config)# switch main-dc-delivery-sw
dmf-controller-1(config-switch)# gre-tunnel-interface tunnel1
dmf-controller-1(config-switch)# remote-ip 0.0.0.0 === this is to enable wildcard tunnel
dmf-controller-1(config-switch)# gre-key-decap 4097
dmf-controller-1(config-switch)# parent-interface ethernet5
dmf-controller-1(config-switch)# local-ip 192.168.200.50 mask 255.255.255.0 gateway-ip 192.168.200.1
dmf-controller-1(config-switch)# direction receive-only

Please refer to the Tunneling Between Data Centers chapter for more information on using L2GRE tunnels in
DANZ Monitoring Fabric (DMF).

Show Commands

All CLI show commands for regular interfaces apply to GRE tunnel interfaces. Use the show running-
config command to view the configuration of tunnel interfaces.

Enter the show tunnel command to view a tunnel interface's configuration parameters and runtime state.

Example

dmf-controller-1# show tunnel
# Switch DPID       Tunnel Name Tunnel Status      Direction     Src IP       Dst IP       Parent Name  Loopback
 Name
-|-----------------|-----------|------------------|-------------|------------|------------|------------|--------
-----|
1 DMF-CORE-SWITCH-1 tunnel1     ESTABLISHED_TUNNEL bidirectional 198.82.215.1 216.47.143.1 ethernet5:1 
 ethernet6
2 DMF-CORE-SWITCH-2 tunnel1     ESTABLISHED_TUNNEL bidirectional 216.47.143.1 198.82.215.1 ethernet11:3
 ethernet5
3 DMF-CORE-SWITCH-2 tunnel2     ESTABLISHED_TUNNEL bidirectional 192.168.43.1 192.168.42.1 ethernet11:4
 ethernet17
4 DMF-CORE-SWITCH-3 tunnel2     ESTABLISHED_TUNNEL bidirectional 192.168.42.1 192.168.43.1 ethernet6   
 ethernet33

8.10.2  Configuring Wildcard Tunnels Using the GUI

In the DANZ Monitoring Fabric (DMF) UI, enable Tunneling by navigating to the DMF Features page and
clicking on the gear icon in the navigation bar.

Figure 8-6: DMF Navigation Menu

Locate the Tunneling card feature on the page.
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Tip:  Use the search bar to quickly locate the feature.

Figure 8-7: DMF Features

Turn on the toggle switch to enable the Tunneling feature on DMF.

Steps to Enable Wildcard Tunnels

1. Locate the Switches tab on the Fabric > Switches page.
Figure 8-8: Fabric > Switches
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2. Click the Create Tunnel option from the table menu.
Figure 8-9: Create Tunnel
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3. Create a Tunnel (select Encapsulation Type as GRE) by entering the required fields. To enable wildcard
support, enter the Remote IP input with data as shown below.
Figure 8-10: Configure Tunnel

4. Click Submit to save the tunnel configuration.
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Chapter 9

Integrating vCenter with the DANZ Monitoring Fabric

This chapter describes integrating VMware vCenter with the DANZ Monitoring Fabric (DMF) and monitoring
Virtual Machines (VM) in the vCenter.

9.1  Overview

The DANZ Monitoring Fabric (DMF) allows the integration and monitoring of VMs in a VMware vCenter
cluster. After integrating a vCenter with the DMF fabric, use DMF policies to select different types of
traffic from specific VMs and apply managed services, such as deduplication or header slicing, to the
selected traffic.

Currently, DMF supports the following versions of VMware vCenter for monitoring:

• vCenter Server 6.5.0
• vCenter Server 6.7.0
• vCenter Server 7.0.0
• vCenter Server 8.0.0

The DANZ Monitoring Fabric provides two options to monitor a VMware vCenter cluster:

• Monitoring using span ports: This method monitors VMware vCenter clustering using a separate
monitoring network. The advantage of this configuration is that it has no impact on the production network
and has a minimal effect on compute node CPU performance. However, in this configuration, each
compute node must have a spare NIC to monitor traffic.

The following figure illustrates the topology used for local SPAN configuration:
Figure 9-1: Mirroring on a Separate SPAN Physical NIC (SPAN)

• Monitoring using ERPAN/L2GRE tunnels: Use Remote SPAN (ERSPAN) to monitor VMs running
on the ESX hosts within a vCenter instance integrated with DMF. ERSPAN monitors traffic to and from
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VMs anywhere in the network and does not require a dedicated physical interface card on the ESX host.
However, ERSPAN can affect network performance, especially when monitoring VMs connected to the
DMF Controller over WAN links or production networks with high utilization.

9.2  Using SPAN to Monitor VMs

This section describes the configuration required to integrate the DANZ Monitoring Fabric (DMF) Controller
with one or more vCenter instances and to monitor traffic from VMs connected to the VMware vCenter
after integration.

The following figure illustrates the topology required to integrate a vCenter instance with the monitoring
fabric and deliver the traffic selected by DMF policies to specified delivery ports connected to different
monitoring tools.
Figure 9-2: VMware vCenter Integration and VM Monitoring

When integrated with vCenter, the DMF Controller uses Link Layer Discovery Protocol (LLDP) to
automatically identify the available filter interfaces connected to the vCenter instance.

9.3  Using ERSPAN to Monitor VMs

Use Remote SPAN (ERSPAN) to monitor VMs running on the ESX hosts within a VMware vCenter instance
integrated with the DANZ Monitoring Fabric (DMF). ERSPAN lets you monitor traffic to and from VMs
anywhere in the network and does not require a dedicated physical interface card on the ESX host. However,
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ERSPAN can affect network performance, especially if you monitor VMs connected to the DMF Controller
over WAN links or production networks with high utilization.
Figure 9-3: Using ERSPAN to Monitor VMs

The procedure for deploying ERSPAN is similar to SPAN but requires an additional step to define the tunnel
endpoints used on the DMF network to terminate the ERSPAN session.

9.3.1  Configuration Summary for vCenter Integration

The following procedure summarizes the high-level steps required to integrate the vCenter and monitor traffic
to or from selected VMs:
1. (For ERSPAN only) Define the tunnel endpoint.

Identify a fabric interface connected to the vCenter instance for the tunnel endpoint by entering the
tunnel-endpoint command in config mode. To define the tunnel endpoint, refer to the Defining a
Tunnel Endpoint section.

2. Provide the vCenter address and credentials.

The vSphere extension on the DANZ Monitoring Fabric (DMF) Controller discovers an inventory of VMs
and the associated details for each VM.

3. Select the VMs to monitor on the DMF Controller.

The DMF Controller uses APIs to invoke the vSphere vCenter instance.

vSphere calls the DVS to create a SPAN session. The preferred option is to SPAN on a separate physical
NIC. However, you can also use ERSPAN by tunneling to the remote interface.

4. Create policies in DMF to filter, replicate, process, and redirect traffic to tools.

When using tunnels with ERSPAN, DMF terminates the tunnels using the specified tunnel endpoint. A
DMF policy for monitoring VM traffic using a SPAN session must include the required information regarding
the vCenter configuration. All match conditions, including User-Defined ofFsets (UDFs), are supported.

The policy for selecting VM traffic to monitor is similar to other DMF policies, except that the filtering
interfaces are orchestrated automatically (filter interfaces are auto-discovered and cannot be specified
manually). All managed-service actions are supported.

9.4  Defining a Tunnel Endpoint

Predefine the tunnel endpoints for creating tunnels when monitoring VMware vCenter traffic using either the
GUI or the CLI.
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GUI Procedure

To manage tunnel endpoints in the GUI, select Monitoring > Tunnel Endpoints.

Figure 9-4: Monitoring > Tunnel Endpoints

This page lists the tunnel endpoints that are already configured and provides information about
each endpoint.

To create a new tunnel endpoint, click the provision (+) control in the Tunnel Endpoints table.
Figure 9-5: Create Tunnel Endpoint

To create the tunnel endpoint, complete the following information on this dialog and click Save:

• Name: Type a descriptive name for the endpoint.
• Switch: Select the DMF switch from the selection list for the configured endpoint interface.
• Interface: Select the interface from the selection list for the endpoint.
• Gateway: Type the address of the default gateway.
• IP Address: Type the IP address of the endpoint.
• Mask: Type the subnet mask for the endpoint.

CLI Procedure

To configure a tunnel endpoint using the CLI, enter the tunnel-endpoint command from config mode
using the following syntax:

controller-1(config)# tunnel-endpoint <name> switch <switch> <interface> ip-
address <address> mask
<mask> gateway <address>

For example, the following command defines ethernet24 on F-SWITCH-1 as a tunnel endpoint named
OSEP1:

controller-1(config)# tunnel-endpoint ERSPAN switch CORE-SWITCH ethernet7 ip-
address 172.27.1.1
mask 255.255.255.0 gateway 172.27.1.2

The IP address assigned to this endpoint is 172.27.1.1, and the next hop address for connecting to the
vCenter via ERSPAN is 172.27.1.2.
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9.5  Using the GUI to Integrate a vCenter Instance

To integrate a vCenter instance with DANZ Monitoring Fabric (DMF) to begin monitoring VMs, select
Integration > vCenter from the DMF menu bar.
Figure 9-6: Integration > vCenter

This page displays information about the vCenter instances integrated with DMF. To add a vCenter instance
for integration with DMF, complete the following steps:
1. Click the provision control (+) in the table.

Figure 9-7: Create vCenter: Info

2. Type an alphanumeric identifier for the vCenter instance, and (optionally) add a description in the fields
provided.

3. Identify the vCenter hostname to be integrated.
4. Enter the vCenter username and password for authenticating to the vCenter instance.

These credentials are used by the DMF Controller when communicating with the vCenter host.
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5. Click Next.
Figure 9-8: Create vCenter: Options (page 2)

This page defines the mirror type as SPAN or ERSPAN. When selecting ERSPAN, the following additional
fields complete the ERSPAN configuration:

• Cluster Tunnel Endpoints (optional)
• Default Tunnel Endpoint (required)
• Sampling Rate (optional)
• Mirrored Packet Length (optional)
• Create Wildcard Tunnels (optional)

Use Cluster Tunnel Endpoints to specify a common tunnel endpoint for all the ESXi hosts in the cluster.
Use Default Tunnel Endpoint to specify a common tunnel endpoint for all the ESXi hosts regardless of
the cluster. When configuring both cluster and default tunnel endpoints, all hosts in clusters form tunnels
using the cluster-specific configuration, and all the other hosts that are not a part of any cluster use the
default configuration to form tunnels.
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6. Click Next.
Figure 9-9: Create vCenter/VMs

7. To add a VM for monitoring, click the provision control (+).
Figure 9-10: Configure vCenter VM

Select VMs from the selection list after integrating vCenter and discovering the VMs, or manually add the
VM hostname.

8. After identifying the VM to monitor, click Append.
9. On the VMs of the Create vCenter dialog, click Save.

276



Integrating vCenter with the DANZ Monitoring Fabric

9.5.1  Using a vCenter Instance as the Traffic Source in a DMF Policy

To identify a vCenter instance integrated with the DANZ Monitoring Fabric (DMF) Controller as the traffic
source for a DMF policy, click the VMware vCenter tab on the Integration page. Locate the name of the
vCenter instance.
Figure 9-11: VMware vCenter Name

Proceed to the Monitoring > Policies page.

Figure 9-12: DMF Policies
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Click the + Create Policy button to add a policy.
Figure 9-13: Create Policy

Enter a Name and Description for the vCenter policy. From the Traffic Sources column, select + Add
Ports(s).
Figure 9-14: Traffic Sources - Add Ports
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Click vCenters.
Figure 9-15: vCenters

279



 

Available vCenter instances display. Select the required vCenter instance which then appears in the Selected
traffic Sources panel.
Figure 9-16: vCenter Instance

Click Add 1 Source. The vCenter instance appears in the Traffic Sources column.
Figure 9-17: vCenter Traffic Sources
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From the Destination Tools column, select + Add Ports(s). Select the interface under Destination Tools.
Figure 9-18: Destination Tools - Add Ports

Click the Add 1 Interface button. The interface appears under the Destination Tools column.
Figure 9-19: Add Interface

281



 

Click Create Policy. The new vCenter policy appears in the DMF Policies dashboard.
Figure 9-20: Create vCenter Policy

9.6  Using the CLI to Integrate a vCenter Instance

To configure the DMF Controller for monitoring VMs on a locally connected vCenter instance, complete the
following steps:
1. Add the vCenter instance details by entering the following commands:

controller-1(config)# vcenter vc-1
controller-1(config-vcenter)# host-name 10.8.23.70
controller-1(config-vcenter)# password 094e470e2a121e060804
controller-1(config-vcenter)# user-name root

2. Specify the mirror type by entering the following commands:

controller-1(config-vcenter)# mirror-type span | erspan
controller-1(config-vcenter)# sampling-rate 60
controller-1(config-vcenter)# mirrored-packet-length 60

The sampling-rate and mirrored-packet-length commands are optional.
3. ERSPAN mirroring requires a tunnel endpoint configuration. Use the cluster command to specify a

common tunnel endpoint for all the ESXi hosts in the cluster. Use the default-tunnel-endpoint
command to specify a common tunnel endpoint for all the ESXi hosts regardless of the cluster. When
using both the cluster and default-tunnel-endpoint commands, all hosts in clusters form tunnels
using the cluster-specific configuration, and all the other hosts not a part of any cluster use the default
configuration to form tunnels.

controller-1(config-vcenter)# default-tunnel-endpoint VCEP1
controller-1(config-vcenter)# cluster <cluster-name> tunnel-endpoint
 <tunnel-endpoint-name>

Using the tab auto-complete feature with the cluster suggests existing cluster names associated with
the vCenter.

4. Add the VMs you want to monitor by entering the following commands:

controller-1(config-vcenter)# vm-monitoring
controller-1(config-vcenter-vm-monitoring)# vm vm-2001
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controller-1(config-vcenter-vm-monitoring)# vm vm-2002

5. To view the vCenter configuration, enter the show running-config vcenter command as in the
following example:

controller-1# show running-config vcenter
! vcenter
vcenter vc-1
hashed-password 752a3a3211040e0200090409090611
host-name 10.8.23.70
mirror-type span
mirrored-packet-length 60
sampling-rate 60
user-name administrator@vsphere.local
!
vm-monitoring
vm vm-2001
vm vm-2002

6. Configure the policies specifying the match rules and delivery interfaces.

controller-1(config)# policy dmf-policy-with-vcenter
controller-1(config-policy)# action forward
controller-1(config-policy)# vcenter vc-1
controller-1(config-policy)# 1 match any
controller-1(config-policy)# delivery-interface TOOL-PORT-03

LLDP automatically learns the filter interfaces. All the hosts belonging to vc-1 that have physical
connections to DMF switches become the filter interfaces. If new connections are made later (or existing
connections are changed), policies will be recomputed with the new interfaces.

7. To view the automatically assigned filter interfaces, enter the show running-config policy
command, as in the following example:

controller-1# show running-config policy dmf-policy-with-vcenter
! policy
policy dmf-policy-with-vcenter
action forward
delivery-interface TOOL-PORT-03
filter-interface vc-filter-1 origination vc-10-9-19-7--filter-interface
filter-interface vc-filter-3 origination vc-10-9-19-7--filter-interface
filter-vcenter vc-1
1 match any

8. To configure the DMF Controller for monitoring VMs on a second locally connected vCenter instance,
add the VMs you want to monitor and configure the DMF policies to specify the match rules and
delivery interfaces.

(config)# vcenter vc-2
(config-vcenter)# host-name 10.8.23.71
(config-vcenter)# password 094e470e2a121e060804
(config-vcenter)# user-name root
(config-vcenter)# mirror-type span
(config-vcenter)# sampling-rate 60
(config-vcenter)# mirrored-packet-length 60
(config-vcenter)# vm-monitoring
(config-vcenter-vm-monitor)# vm vm-1001
(config-vcenter-vm-monitor)# vm vm-1002

9. Configure the policy for the second vCenter instance.

(config)# policy dmf-policy-with-vcenter-2
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(config-policy)# vcenter vc-2
(config-policy)# 1 match any
(config-policy)# delivery-interface TOOL-PORT-02

9.7  Using the GUI to View vCenter Configuration

After integrating a vCenter instance, click the link in the Name column in the vCenter table to view
vCenter activity.
Figure 9-21: VMware vCenter Instance Name

DANZ Monitoring Fabric (DMF) displays the vCenter Info page.

Figure 9-22: VMware vCenter Configuration

The Info page displays information about the configuration of the vCenter instance. To view information about
vCenter resources, scroll down to the following sections:

• Hosts
• Virtual Switches
• Physical Connections
• Virtual Machines
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• Network Host Connection Details

Figure 9-23: Hosts, Virtual Switches, and Physical Connections

Figure 9-24: Virtual Machines and Network Host Connection Details

9.8  Using the CLI to View vCenter Configuration

To view the vCenter configuration in the CLI, use the show vcenter command, as in the
following examples:
controller-1# show vcenter
#  vCenter Name vCenter Host Name or IP Last vCenter Update Time       Detail State                 vSphere Version
--|------------|-----------------------|------------------------------|----------------------------|---------------|
1  vc-10-9-0-75 10.9.0.75 2017-09-09    18:02:35.980000 PDT            Connected and authenticated. 6.5.0
2  vc-10-9-0-76 10.9.0.76 2017-09-09    18:02:36.488000 PDT            Connected and authenticated. 6.5.0
3  vc-10-9-0-77 10.9.0.77 2017-09-09    18:02:35.908000 PDT            Connected and authenticated. 6.0.0
4  vc-10-9-0-78 10.9.0.78 2017-09-09    18:02:33.507000 PDT            Connected and authenticated. 6.5.0
5  vc-10-9-0-79 10.9.0.79 2017-09-09    18:02:32.248000 PDT            Connected and authenticated. 6.5.0
6  vc-10-9-0-80 10.9.0.80 2017-09-09    18:02:32.625000 PDT            Connected and authenticated. 6.0.0
7  vc-10-9-0-81 10.9.0.81 2017-09-09    18:02:34.672000 PDT            Connected and authenticated. 6.0.0
8  vc-10-9-0-82 10.9.0.82 2017-09-09    18:02:33.008000 PDT            Connected and authenticated. 6.0.0
9  vc-10-9-0-83 10.9.0.83 2017-09-09    18:02:30.011000 PDT            Connected and authenticated. 6.0.0
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10 vc-10-9-0-84 10.9.0.84 2017-09-09    18:02:33.024000 PDT            Connected and authenticated. 6.5.0
11 vc-10-9-0-85 10.9.0.85 2017-09-09    18:02:34.827000 PDT            Connected and authenticated. 6.0.0
12 vc-10-9-0-86 10.9.0.86 2017-09-09    18:02:35.164000 PDT            Connected and authenticated. 6.0.0
13 vc-10-9-0-87 10.9.0.87 2017-09-09    18:02:38.042000 PDT            Connected and authenticated. 6.5.0
14 vc-10-9-0-88 10.9.0.88 2017-09-09    18:02:37.212000 PDT            Connected and authenticated. 6.0.0
15 vc-10-9-0-89 10.9.0.89 2017-09-09    18:02:33.436000 PDT            Connected and authenticated. 6.5.0
controller-1#

controller-1# show vcenter vc-10-9-0-75
#  vCenter Name vCenter Host Name or IP Last vCenter Update Time       Detail State                 vSphere Version
--|------------|-----------------------|------------------------------|----------------------------|---------------|
1  vc-10-9-0-75 10.9.0.75 2017-09-09    18:02:44.698000 PDT            Connected and authenticated. 6.5.0
controller-1#

controller-1# show vcenter vc-10-9-0-75 detail
vCenter Name : vc-10-9-0-75
vCenter Host Name or IP : 10.9.0.75
Last vCenter Update Time : 2017-09-09 18:02:49.463000 PDT
Detail State : Connected and authenticated.
vSphere Version : 6.5.0
controller-1#

controller-1# show vcenter vc-10-9-0-75 error
vCenter Name : vc-10-9-0-75
vCenter Host Name or IP : 10.9.0.75
State : connected
Detail State : Connected and authenticated.
Detailed Error Info :
controller-1#

9.9  Wildcard Tunnels for VMware vCenter Monitoring

The current implementation of VMware vCenter creates one tunnel interface from every ESXi host to DMF.

Using a wildcard tunnel on DMF for VMware vCenter reduces the number of tunnels created.

Platform Compatibility

This feature is only compatible with switches that support wildcard tunneling.

9.9.1  Configuration

Configure wildcard tunnels using the CLI or the GUI.

9.9.2  Using the CLI to Create Wildcard Tunnels

The CLI construct wildcard-tunnels is available as a configuration option when configuring a VMware
vCenter in DANZ Monitoring Fabric (DMF), as shown below:
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Table 5: Commands

cluster Configure tunnel-endpoint for cluster

default-tunnel-endpoint Configure tunnel endpoints

description Describe this vCenter

hashed-password Set the vCenter password (to log into vCenter)

host-name Set the vCenter hostname

mirror-type Set the vCenter vm monitoring mode

mirrored-packet-length Set the mirrored packet length

password Set the vCenter password (to log into vCenter)

sampling-rate Set the packet sampling rate

user-name Set the vCenter user name (to log into vCenter)

vm-monitoring Enter vm-monitoring config submode

wildcard-tunnels Enable wildcard tunnels

Enable wildcard tunnels by setting the above leaf parameter, as shown in the following example of vCenter
configuration on the Controller node.

dmf-controller-1(config)# vcenter VC1
dmf-controller-1(config-vcenter)# wildcard-tunnels 
dmf-controller-1(config-vcenter)# show this
! vcenter
vcenter VC1
wildcard-tunnels
dmf-controller-1(config-vcenter)# 
        

Similarly, disable wildcard tunnels by issuing the no command as shown below:

dmf-controller-1(config-vcenter)# show this
! vcenter
vcenter VC1
wildcard-tunnels
dmf-controller-1(config-vcenter)# no wildcard-tunnels 
dmf-controller-1(config-vcenter)# show this
! vcenter
vcenter VC1
dmf-controller-1(config-vcenter)#

Show Commands

There is no specific show command for wildcard tunnels; however, check them in the vCenter running config.
In addition, the show tunnels command shows the tunnels created for the selected vCenter configuration
with a wildcard remote IP address.

Troubleshooting

Verify errors and warnings are clear using the show fabric errors and show fabric warnings
commands. The show tunnels command displays tunnels created based on the vCenter configuration on
the Controller with a wildcard remote IP address. Use the show switch <name> table gre-tunnel
command to display tunnels programmed on the switch.
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9.9.3  Using the GUI to Create Wildcard Tunnels

Use the DANZ Monitoring Fabric (DMF) GUI to create wildcard tunnels as outlined below.

Navigate to the Integration > VMware vCenter page.
Figure 9-25: VMware vCenter Add/Edit

Click the Menu icon.

As part of the Options step of the Add/Edit vCenter workflow, enable wildcard tunnels using the Create
Wildcard Tunnels toggle input. By default, the feature is disabled.
Figure 9-26: VMware vCenter Create vCenter Options

9.9.4  Limitations

Select Broadcom® switch ASICs support wildcard tunnels; ensure your switch model supports this feature
before configuring it for vCenter.

Please refer to the Platform Compatibility section for more information.

9.10  Minimum Permissions for Non-admin Users

For a non-admin user to add, remove, edit, or monitor a vCenter via the DANZ Monitoring Fabric (DMF),
the privilege level assigned to the non-admin user should be VSPAN operation. To assign VSPAN operation
privileges to a user, perform the following steps:
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1. From the vCenter GUI, navigate to Menu > Administration.
2. Once on the page, click on the Users and Groups link in the navigation bar on the left.

Figure 9-27: Users and Groups

3. Click on the Users tab and ensure the appropriate domain is selected (in this case, the domain is
vsphere.local).
Figure 9-28: Domain Selection
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4. Next, click on the ADD USER link and create the desired user. (In the example below, a user called dmf-
aliceis created.)
Figure 9-29: Add a New User

5. Verify that the newly created user is on the Users and Groups page.
Figure 9-30: Verify User Created
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6. After creating the desired user, create and assign a role to this user. Click on Roles under Access
Control in the navigation bar on the left. Next, click on the + sign to add a new role.
Figure 9-31: Add a New Role
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7. In the New Role pop-up dialog, select Distributed Switch from the left and then scroll down to find and
select VSPAN operation as the role. Click Next and give the new role a new name. (In the example below
the new role monitor-dmf is created.) Click Finish to create the new role.
Figure 9-32: Select Role Type

Figure 9-33: Save New Role
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8. Verify the creation of the new role on the Roles page.
Figure 9-34: Verify New Role Created

9. To assign the new role to the new user, click the Global Permissions link in the navigation bar on the left.
Next, click on the + sign to assign the new role.
Figure 9-35: Global Permissions

10. In the Add Permission dialog, type the newly created username and select the newly created role, as
shown in the figure below.
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Note:  Do not forget to check mark the Propagate to children checkbox.

Figure 9-36: Assign Role to User

11. Verify assigning the newly created role to the newly created user.
Figure 9-37: Verify Role Assignment to User

9.11  Monitor VMware vCenter Traffic by VM Names

Match VMware vCenter-specific information in the policy. Specifically, this feature matches traffic
using VMware vCenter Virtual Machine (VM) names and requires DANZ Monitoring Fabric (DMF)
vCenter integration.
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9.11.1  Using the CLI to Monitor vCenter Traffic by VM Names

Configuration

This feature works with vCenter integration; therefore, configure vCenter Integration in DANZ Monitoring
Fabric (DMF). Configure vCenter mapping in the policy, then define a policy match using VM names in the
vCenter. The following is an example configuration:

dmf-controller-1(config)# policy v1
dmf-controller-1(config-policy)# action forward
dmf-controller-1(config-policy)# filter-interface filter-interface
dmf-controller-1(config-policy)# delivery-interface delivery-interface
dmf-controller-1(config-policy)# filter-vcenter vcenter-name
dmf-controller-1(config-policy)# 1 match ip src-vm-name vm-name dst-vm-name vm-
name
dmf-controller-1(config-policy)# 2 match ip6 src-vm-name vm-name

Show Commands

Enter the show running-config policy policy name command to display the configuration.

dmf-controller-1# show running-config policy v1
                
! policy
policy v1
action forward
delivery-interface delivery-interface
filter-interface filter-interface
filter-vcenter vcenter-name
1 match ip src-vm-name vm-name dst-vm-name vm-name
2 match ip6 src-vm-name vm-name

The show policy policy name command displays the policy information, including stats.

dmf-controller-1# show policy v2
Policy Name        : v2
Config Status      : active - forward
Runtime Status     : installed
Detailed Status    : installed - installed to forward
Priority           : 100
Overlap Priority   : 0
# of switches with filter interfaces   : 1
# of switches with delivery interfaces : 1
# of switches with service interfaces  : 0
# of filter interfaces                 : 1
# of delivery interfaces               : 1
# of core interfaces                   : 0
# of services      : 0
# of pre service interfaces            : 0
# of post service interfaces           : 0
Push VLAN          : 5
Post Match Filter Traffic              : -
Total Delivery Rate: -
Total Pre Service Rate                 : -
Total Post Service Rate                : -
Overlapping Policies                   : none
Component Policies : none
Installed Time     : 2023-12-21 19:00:39 UTC
Installed Duration : 50 minutes, 11 secs
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Match Rules ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
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# Rule
-|--------------------------------------------------------------------------|
1 1 match ip src-vm-name DMF-RADIUS-SERVER-1 dst-vm-name DMF-TACACS-SERVER-1

~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Filter Interface(s) 
 ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# DMF IF           Switch     IF Name    State Dir Packets Bytes Pkt Rate Bit
 Rate Counter Reset Time
-|----------------|----------|----------|-----|---|-------|-----|--------
|--------|------------------------------|
1 span_from_arista DELL-S4048 ethernet20 up    rx  0       0     0        -    
    2023-12-21 19:00:39.941000 UTC

~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Delivery Interface(s) 
 ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# DMF IF       Switch     IF Name      State Dir Packets Bytes Pkt Rate Bit
 Rate Counter Reset Time
-|------------|----------|------------|-----|---|-------|-----|--------|-
-------|------------------------------|
1 ubuntu-tools DELL-S4048 ethernet50/2 up    tx  0       0     0        -      
  2023-12-21 19:00:39.941000 UTC            
~ Service Interface(s) ~
None.            
~ Core Interface(s) ~
None.            
~ Failed Path(s) ~
None.

The show vcenter vcenter name endpoint command displays the vCenter VM information,
including networks.

dmf-controller-1# show vcenter vcenter1 endpoint 
#  vCenter Name VM Name   ESXi Host Name Network Interface Name MAC Address    
            IP Address                                 Virtual Switch Portgroup
     Power State 
--|------------|---------|--------------|----------------------|-------------
-------------|------------------------------------------|--------------|------
-------|-----------|
1  vcenter1     ub-11-216 10.240.155.216 Network adapter 1      00:50:56:8b:4
d:03 (VMware) 1.1.11.216/24, fe80::250:56ff:fe8b:4d03/64 DVS-DMF        vlan11 
       powered-on
2  vcenter1     ub-12-216 10.240.155.216 Network adapter 1      00:50:56:8b:7
2:a0 (VMware) 1.1.12.216/24, fe80::250:56ff:fe8b:72a0/64 DVS-DMF        vlan12 
       powered-on
3  vcenter1     ub-13-216 10.240.155.216 Network adapter 1      00:50:56:8b:c
0:06 (VMware) 1.1.13.216/24, fe80::250:56ff:fe8b:c006/64 DVS-DMF        vlan-10
       powered-on
4  vcenter1     ub-14-216 10.240.155.216 Network adapter 1      00:50:56:8b:d
1:d9 (VMware) 1.1.14.216/24, fe80::250:56ff:fe8b:d1d9/64 DVS-DMF        vlan-10
       powered-on

9.11.2  Using the GUI to Monitor vCenter Traffic by VM Names

Configure vCenter VM name matches under the DANZ Monitoring Fabric (DMF) policies match rules section.
For example:
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1. In the DMF GUI, navigate to the Monitoring > Policies page.
Figure 9-38: DMF Policies

2. Click Create Policy to create a new policy or edit an existing one by selecting a row from the Policies
Table and clicking Edit.
Figure 9-39: Create / Edit Policy
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3. Navigate to the Match Traffic tab.
Figure 9-40: Match Traffic
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4. Click Configure a Rule to configure a custom match rule.
Figure 9-41: Configure a Rule

5. Set the EtherType to IPv4 or IPv6.
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6. Add the Source IP address as the vCenter VM name. Select the Virtual Machine option from the Source
IP Address drop-down and select a virtual machine from the VM Name drop-down.
Figure 9-42: Source IP VM
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7. Add the Destination IP address as the vCenter VM name. Select the Virtual Machine option from the
Destination IP Address drop-down and select a virtual machine from the VM Name drop-down.
Figure 9-43: Destination IP VM

Note:  If the VM Name drop-down shows No Data, ensure only one vCenter is associated with the
policy (under Traffic Sources).

8. Click Add Rule to add the match rule to the policy.
9. After entering other inputs as required, click Create Policy (or Save Policy) to save the configuration.

9.11.3  Troubleshooting

Fabric errors and warnings are very useful for troubleshooting this feature.

The following validation message displays when the vCenter integration cannot resolve the IP address for the
VM name used in the policy.

dmf-controller-1# show fabric warnings
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Policy related warning 
 ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# Policy Name Warning
-|-----------|--------------------------------------------------------
----------------------------------------------------|
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1 v1          No IP found for VMs [ub-15-216, ub-216-multinic, ub-217-vlan10,
 ub-14-216, ub-11-216] associated with policy

The following validation message displays when vCenter is not associated with the policy, but the VM names
used match in the policy.

dmf-controller-1# show fabric warnings 
~~~~~~~~~~~~~~~~~~~ Policy related warning ~~~~~~~~~~~~~~~~~~~
# Policy Name Warning                                         
-|-----------|-----------------------------------------------|
1 v1          No vCenter associated to policy with VM matches

9.11.4  Limitations

• This feature only works with vCenter integration and a direct SPAN from customer switch with ESXi traffic.
• VM interface IP addresses connected to dvs will be added to policy matches.
• May use extra TCAM entries in case the management network uses dvs.
• Vmkernal names cannot be matched in the policy.
• Extra TCAM entries may be used for the removed/modified IP addresses when the VM IP addresses are

updated in the vCenter.
• TCAM entry will be added for all the IP addresses when a VM Name with multiple vNIC (multiple IP

addresses) matches in the policy.
• VM Names cannot be matched with the MAC option in the policy.
• If the vCenter becomes disconnected, policies associated with the VM names may not get correct matches

or traffic.
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Chapter 10

Advanced Fabric Settings

This chapter describes fabric-wide configuration options required in advanced use cases for deploying
DMF policies.

10.1  Configuring Advanced Fabric Settings

Overview

Before the DMF 8.4 release, the fabric-wide settings, specifically the Features section, as shown below, were
available on the home page after logging in.
Figure 10-1: DMF Legacy Page (pre 8.4)

Beginning with DMF 8.4, a newly designed Dashboard replaces the former home page. The Features section
is now the new DMF Features page. To navigate the DMF Features Page, click on the gear icon in the
navigation bar.
Figure 10-2: Gear Icon
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Page Layout

All fabric-wide configuration settings required in advanced use cases for deploying DMF policies appear in the
new DMF Features Page.
Figure 10-3: DMF Features Page

Each card on the page corresponds to a feature set.
Figure 10-4: Feature Set Card Example

The UI displays the following:

• Feature Title
• A brief description
• View / Hide detailed information link
• Current Setting
• Edit Link - Use the Edit configuration button (pencil icon) to change the value.

The fabric-wide options used with DMF policies include the following:
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Table 6: Feature Set

Auto VLAN Mode Auto VLAN Range

Auto VLAN Strip CRC Check

Custom Priority Device Deployment Mode

Inport Mask Match Mode

Policy Overlap Limit Policy Overlap Limit Strict

PTP Timestamping Retain User Policy VLAN

Tunneling VLAN Preservation

10.2  Managing VLAN Tags in the Monitoring Fabric

Analysis tools often use VLAN tags to identify the filter interface receiving traffic. How VLAN IDs are assigned
to traffic depends on which auto-VLAN mode is enabled. The system automatically assigns the VLAN ID from
a configurable range of VLAN IDs, from 1 to 4094 by default. Available auto-VLAN modes behave as follows:

• push-per-policy (default): Automatically adds a unique VLAN ID to all traffic selected by a specific policy.
This setting enables tag-based forwarding.

• push-per-filter: Automatically adds a unique VLAN ID from the default auto-VLAN range (1-4094) to each
filter interface. A custom VLAN range can be specified using the auto-vlan-range command. Manually
assign any VLAN ID not in the auto-VLAN range to a filter interface.

The VLAN ID assigned to policies or filter interfaces remains unchanged after controller reboot or failover.
However, it changes if the policy is removed and added back again. Also, when the VLAN range is changed,
existing assignments are discarded, and new assignments are made.

The push-per-filter feature preserves the original VLAN tag, but the outer VLAN tag is rewritten with the
assigned VLAN ID if the packet already has two VLAN tags.

The following table summarizes how VLAN tagging occurs with the different auto-VLAN modes:

Table 7: VLAN Tagging Across VLAN Modes

Traffic with VLAN
tag type

push-per-policy Mode (Applies
to all supported switches)

push-per-filter Mode (Applies to
all supported switches)

Untagged Pushes a single tag Pushes a single tag

Single tag Pushes an outer (second) tag Pushes an outer (second) tag

Two tags Pushes an outer (third) tag. Except
on T3-based switches, it rewrites
the outer tag. Due to this outer
customer VLAN is replaced by
DMF policy VLAN.

Rewrites the outer tag. Due to this
outer customer VLAN is replaced
by DMF filter VLAN.

Note:  When enabling push-per-policy, the auto-delivery-interface-vlan-strip feature
is enabled (if disabled) before enabling push-per-policy. When enabling push-per-filter, the global
delivery strip option is not enabled if previously disabled.

The following table summarizes how different auto-VLAN modes affect the applications and
services supported.

Note:  Matching on untagged packets cannot be applied to DMF policies when in push-per-
policy mode.
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Table 8: Auto-VLAN Mode Comparison

Auto-VLAN Mode Supported
Platform

TCAM
Optimization
in the Core

L2 GRE
Tunnels
Support

Q-in-Q
Packets
Preserve Both
Original Tags

Support DMF
Service Node
Services

Manual Tag
to Filter
Interface

Push-per-policy (default) All Yes Yes Yes All Policy tag
overwrites
manual

Push-per-filter All No Yes No All Configuration
not allowed

Note:  Tunneling is supported with full-match or offset-match modes but not with l3-l4-match mode.

Tag-based forwarding, which improves traffic forwarding and reduces TCAM utilization on the monitoring
fabric switches, is enabled only when you choose the push-per-policy option.

When the mode is push-per-filter, the VLAN that is getting pushed or rewritten can be displayed using the
show interface-names command as shown below:
controller-1> show interface-names
~~~~~~~~~~~~~~~~~~~~~~~~ Filter Interface(s) ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
#  DMF IF                      Switch IF     Name         Dir State Speed  VLAN Tag Analytics Ip address Connected Device
--|---------------------------|-------------|------------|---|-----|------|--------|---------|----------|----------------|
1  TAP-PORT-eth1               FILTER-SW1    ethernet1    rx  up    10Gbps 5        True
2  TAP-PORT-eth10              FILTER-SW1    ethernet10   rx  up    10Gbps 10       True
3  TAP-PORT-eth12              FILTER-SW1    ethernet12   rx  up    10Gbps 11       True
4  TAP-PORT-eth14              FILTER-SW1    ethernet14   rx  up    10Gbps 12       True
5  TAP-PORT-eth16              FILTER-SW1    ethernet16   rx  up    10Gbps 13       True
6  TAP-PORT-eth18              FILTER-SW1    ethernet18   rx  up    10Gbps 14       True
7  TAP-PORT-eth20              FILTER-SW1    ethernet20   rx  up    10Gbps 16       True
8  TAP-PORT-eth22              FILTER-SW1    ethernet22   rx  up    10Gbps 17       True

10.3  Auto VLAN Mode

Analysis tools often use VLAN tags to identify the filter interface receiving traffic. How VLAN IDs are assigned
to traffic depends on which auto-VLAN mode is enabled. The system automatically assigns the VLAN ID from
a configurable range of VLAN IDs from 1 to 4094 by default. Available auto-VLAN modes behave as follows:

• Push per Policy (default): Automatically adds a unique VLAN ID to all traffic selected by a specific policy.
This setting enables tag-based forwarding.

• Push per Filter: Automatically adds a unique VLAN ID from the default auto-vlan-range (1-4094) to each
filter interface. A new vlan range can be specified using the auto-vlan-range command. Manually assign
any VLAN ID not in the auto-VLAN range to a filter interface.

The following table summarizes how VLAN tagging occurs with the different Auto VLAN modes.

Traffic with VLAN tag type push-per-policy Mode

(Applies to all supported switches)

push-per-filter Mode

(Applies to all supported switches)

Untagged Pushes a single tag Pushes a single tag

Single tag Pushes an outer (second) tag Pushes an outer (second) tag

Two tags Pushes an outer (third) tag. Except
on T3-based switches, it rewrites
the outer tag. Due to this outer
customer VLAN is replaced by DMF
policy VLAN.

Rewrites the outer tag. Due to this
outer customer VLAN is replaced by
DMF filter VLAN.
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Note:  When enabling push-per-policy, the auto-delivery-interface-vlan-strip feature
is enabled (if disabled) before enabling push-per-policy. When enabling push-per-filter, the global
delivery strip option is not enabled if previously disabled.

The following table summarizes how different Auto VLAN modes affect supported applications and services.

Note:  Matching on untagged packets cannot be applied to DMF policies when in push-per-
policy mode.

Auto-VLAN
Mode

Supported
Platform

TCAM
Optimization
in the Core

L2 GRE
Tunnels
Support

Q-in-Q
Packets
Preserve
Both Original
Tags

Supported
DMF Service
Node
Services

Manual Tag
to Filter
Interface

Push per
Policy
(default)

All Yes Yes Yes All Policy tag
overwrites
manual

Push per Filter All No Yes No All Configuration
not allowed

Tag-based forwarding, which improves traffic forwarding and reduces TCAM utilization on the monitoring
fabric switches, is only enabled when choosing the push-per-policy option.

Use the CLI or the GUI to configure Auto VLAN Mode as described in the following topics.

• Configuring Auto VLAN Mode using the CLI
• Configuring Auto VLAN Mode using the GUI

10.3.1  Configuring Auto VLAN Mode using the CLI

To set the auto VLAN mode, complete the following steps:
1. When setting the auto VLAN mode to push-per-filter, define the range of automatically assigned VLAN IDs

by entering the following command from config mode:

auto-vlan-range vlan-min <start> vlan-max <end>

Replace start and end with the first and last VLAN ID in the range. For example, the following command
assigns a range of 100 VLAN IDs from 3994 to 4094:

controller-1(config)# auto-vlan-range vlan-min 3994 vlan-max 4094

2. Select the VLAN mode using the following command from config mode:

auto-vlan-mode command { push-per-filter | push-per-policy }

Find details of the impact of these options in the Managing VLAN Tags in the Monitoring Fabric section.

For example, the following command adds a unique outer VLAN tag to each packet received on each
filter interface:

controller-1(config)# auto-vlan-mode push-per-filter
Switching to auto vlan mode would cause policies to be re-installed. Enter
 "yes" (or "y")
to continue: y

3. To display the configured VLAN mode, enter the show fabric command, as in the following example:

controller-1# show fabric
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~~~~~~~~~~~~~~~~~~~~~ Aggregate Network State ~~~~~~~~~~~~~~~~~~~~~
Number of switches                          : 5
Inport masking                              : True
Start time                                  : 2018-11-02 23:42:29.183000 UTC
Number of unmanaged services                : 0
Filter efficiency                           : 1:1
Number of switches with service interfaces  : 0
Total delivery traffic (bps)                : 411Kbps
Number of managed service instances         : 0
Number of service interfaces                : 0
Match mode                                  : full-match
Number of delivery interfaces               : 13
Max pre-service BW (bps)                    : -
Auto VLAN mode                              : push-per-filter
Number of switches with delivery interfaces : 4
Number of managed devices                   : 1
Uptime                                      : 2 days, 19 hours
Total ingress traffic (bps)                 : 550Kbps
Max overlap policies (0=disable)            : 10
Auto Delivery Interface Strip VLAN          : False
Number of core interfaces                   : 219
Max filter BW (bps)                         : 184Gbps
Number of switches with filter interfaces   : 5
State                                       : Enabled
Max delivery BW (bps)                       : 53Gbps
Total pre-service traffic (bps)             : -
Track hosts                                 : True
Number of filter interfaces                 : 23
Number of active policies                   : 3
Number of policies                          : 25
------------------------output truncated------------------------

4. To display the VLAN IDs assigned to each policy, enter the show policy command, as in the
following example:

controller-1> show policy
# Policy Name Action Runtime Status Type Priority Overlap Priority
˓→Push VLAN Filter BW Delivery BW Post Match Filter Traffic Delivery Traffic
 Services
-|--------------------------|-------|--------------|----------|------
--|----------------|--
˓→-------|---------|-----------|-------------------------|----------
------|----------------
˓→-----|
1 GENERATE-NETFLOW-RECORDS forward installed Configured 100 0 4
˓→ 100Gbps 10Gbps - - DMF-OOB-NETFLOWSERVICE
2 P1 forward inactive Configured 100 0 1
˓→ - 1Gbps - -
3 P2 forward inactive Configured 100 0 3
˓→ - 10Gbps - -
4 TAP-WINDOWS10-NETWORK forward inactive Configured 100 0 2
˓→ 21Gbps 1Gbps - -
5 TIMESTAMP-INCOMING-PACKETS forward inactive Configured 100 0 5
˓→ - 100Gbps - - DMF-OOB-TIMESTAMPINGSERVICE
controller -1>)#

Note:  The strip VLAN option, when enabled, removes the outer VLAN tag, including the VLAN ID
applied by any rewrite VLAN option.
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10.3.2  Configuring Auto VLAN Mode using the GUI

Auto VLAN Mode

1. Control the configuration of this feature using the Edit icon by locating the corresponding card and clicking
on the pencil icon.
Figure 10-5: Auto VLAN Mode Config

2. A confirmation edit dialogue window appears, displaying the corresponding prompt message.
Figure 10-6: Edit VLAN Mode
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3. To configure different modes, click the drop-down arrow to open the menu.
Figure 10-7: Drop-down Example

4. From the drop-down menu, select and click on the desired mode.
Figure 10-8: Push Per Policy

5. Alternatively, you can directly input the desired mode name in the input area.
Figure 10-9: Push Per Policy
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6. Click the Submit button to confirm the configuration changes or the Cancel button to discard the changes.
Figure 10-10: Submit Button

7. After successfully setting the configuration, the current configuration status displays next to the edit button.
Figure 10-11: Current Configuration Status

The following feature sets work in the same manner as the Auto VLAN Mode feature described above.

• Device Deployment Mode
• Match Mode

10.4  Auto VLAN Range

Auto VLAN Range

The range of automatically generated VLANs only applies when setting Auto VLAN Mode to push-per-filter.
VLANs are picked from the range 1 - 4094 when not specified.
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1. Control the configuration of this feature using the Edit icon by locating the corresponding card and clicking
on the pencil icon.
Figure 10-12: Edit Auto VLAN Range

2. A configuration edit dialogue window pops up, displaying the corresponding prompt message. The Auto
VLAN Range defaults to 1 - 4094.
Figure 10-13: Edit Auto VLAN Range
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3. Click on the Custom button to configure the custom range.
Figure 10-14: Custom Button

4. Adjust range value (minimum value: 1, maximum value: 4094). There are three ways to adjust the value of
a range:

• Directly enter the desired value in the input area, with the left side representing the minimum value of
the range and the right side representing the maximum value.

• Adjust the value by dragging the slider using a mouse. The left knob represents the minimum value of
the range, while the right knob represents the maximum value.

• Use the up and down arrow buttons in the input area to adjust the value accordingly. Pressing the up
arrow increments the value by 1, while pressing the down arrow decrements it by 1.

5. Click the Submit button to confirm the configuration changes or the Cancel button to discard the changes.
6. After successfully setting the configuration, the current configuration status displays next to the edit button.

Figure 10-15: Configuration Change Success

Configuring Auto VLAN Range using the CLI

To set the Auto VLAN Range, complete the following:

auto-vlan-range vlan-min start vlan-max end

To set the Auto VLAN Range, complete the following steps. Replace start and end with the first and last
VLAN ID in the desired range. For example, the following command assigns a range of 100 VLAN IDs from
3994 to 4094:

controller-1(config)# auto-vlan-range vlan-min 3994 vlan-max 4094

10.5  Auto VLAN Strip

The strip VLAN option removes the outer VLAN tag before forwarding the packet to a delivery interface. Only
the outer tag is removed if the packet has two VLAN tags. If it has no VLAN tag, the packet is not modified.
Users can remove the VLAN ID on traffic forwarded to a specific delivery interface globally for all delivery
interfaces. The strip VLAN option removes any VLAN ID applied by the rewrite VLAN option.
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The strip vlan option removes the VLAN ID on traffic forwarded to the delivery interface. The following are the
two methods available:

• Remove VLAN IDs fabric-wide for all delivery interfaces. This method removes only the VLAN tag added
by DMF Fabric.

• On specific delivery interfaces. This method has four options:

• Keep all tags intact. Preserves the VLAN tag added by DMF Fabric and other tags in the traffic using
strip-no-vlan option during delivery interface configuration.

• Remove only the outer VLAN tag the DANZ Monitoring Fabric added using the strip-one-vlan option
during delivery interface configuration.

• Remove only the second (inner) tag. Preserves the VLAN (outer) tag added by DMF Fabric and
removes the second (inner) tag in the traffic using the strip-second-vlan option during delivery
interface configuration.

• Remove two tags. Removes the outer VLAN tag added by DMF fabric and inner vlan tag in the traffic
using the strip-two-vlan option during delivery interface configuration.

Note:  The strip vlan command for a specific delivery interface overrides the fabric-wide strip
vlan option.

By default, the VLAN ID is stripped when DMF adds it to enable the following options:

• Push per Policy
• Push per Filter
• Rewrite VLAN under filter-interfaces

Tagging and stripping VLANs as they ingress and egress DMF differs depending on whether the switch is a
Trident 3-based.

Use the CLI or the GUI to configure Auto VLAN Strip as described in the following topics.

• Auto VLAN Strip using the CLI
• Auto VLAN Strip using the GUI

10.5.1  Auto VLAN Strip using the CLI

The strip VLAN option removes the outer VLAN tag before forwarding the packet to a delivery interface. Only
the outer tag is removed if the packet has two VLAN tags. If it has no VLAN tag, the packet is not modified.
Users can remove the VLAN ID on traffic forwarded to a specific delivery interface or globally for all delivery
interfaces. The strip VLAN option removes any VLAN ID applied by the rewrite VLAN option.

The following are the two methods available:

• Remove VLAN IDs fabric-wide for all delivery interfaces: This method removes only the VLAN tag
added by the DMF Fabric.

• Remove VLAN IDs only on specific delivery interfaces: This method has four options:

• Keep all tags intact. Preserves the VLAN tag added by DMF Fabric and other tags in the traffic using
strip-no-vlan option during delivery interface configuration.

• Remove only the outer VLAN tag the DANZ Monitoring Fabric added using the strip-one-vlan option
during delivery interface configuration.

• Remove only the second (inner) tag. Preserves the VLAN (outer) tag added by DMF and
removes the second (inner) tag in the traffic using the strip-second-vlan option during delivery
interface configuration.

• Remove two tags. Removes the outer VLAN tag added by DMF fabric and the inner VLAN tag in the
traffic using the strip-two-vlan option during delivery interface configuration.

Note:  The strip vlan command for a specific delivery interface overrides the fabric-wide
strip VLAN option.

By default, the VLAN ID is stripped when DMF adds it as a result of enabling the following options:
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• push-per-policy
• push-per-filter
• rewrite vlan under filter-interfaces

To view the current auto-delivery-interface-vlan-strip configuration, enter the
following command:

controller-1> show running-config feature details
! deployment-mode
deployment-mode pre-configured
! auto-delivery-interface-vlan-strip
auto-delivery-interface-vlan-strip
! auto-vlan-mode
auto-vlan-mode push-per-policy
! auto-vlan-range
auto-vlan-range vlan-min 3200 vlan-max 4094
! crc
crc
! match-mode
match-mode full-match
! tunneling
tunneling
! allow-custom-priority
allow-custom-priority
! inport-mask
no inport-mask
! overlap-limit-strict
no overlap-limit-strict
! overlap-policy-limit
overlap-policy-limit 10
! packet-capture
packet-capture retention-days 7

To view the current auto-delivery-interface-vlan-strip state, enter the following command:

controller-1> show fabric
~~~~~~~~~~~~~~~~~~~~~ Aggregate Network State ~~~~~~~~~~~~~~~~~~~~~
Number of switches : 5
Inport masking : True
Start time : 2018-10-16 22:30:03.345000 UTC
Number of unmanaged services : 0
Filter efficiency : 3005:1
Number of switches with service interfaces : 0
Total delivery traffic (bps) : 232bps
Number of managed service instances : 0
Number of service interfaces : 0
Match mode : l3-l4-match
Number of delivery interfaces : 24
Max pre-service BW (bps) : -
Auto VLAN mode : push-per-policy
Number of switches with delivery interfaces : 5
Number of managed devices : 1
Uptime : 21 hours, 53 minutes
Total ingress traffic (bps) : 697Kbps
Max overlap policies (0=disable) : 10
Auto Delivery Interface Strip VLAN : True

To disable this global command, enter the following command:

controller-1(config-switch-if)# no auto-delivery-interface-vlan-strip
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The delivery interface level command to strip the VLAN overrides the global auto-delivery-interface-
vlan-strip command. For example, when global VLAN stripping is disabled or when you want to override
the default strip option on a delivery interface use the below options:

When you want to strip the VLAN added by DMF fabric on a specific delivery interface, use the
following command:

controller-1(config-switch-if)# role delivery interface-name TOOL-PORT-1 strip-
one-vlan

When global VLAN stripping is enabled, it strips only the outer VLAN ID. If you want to remove outer VLAN ID
that was added by DMF as well as the inner VLAN ID, enter the following command:

controller-1(config-switch-if)# role delivery interface-name TOOL-PORT-1 strip-
two-vlan

To strip only the inner VLAN ID and preserve the outer VLAN ID that DMF added, use the following command:

controller-1(config-switch-if)# role delivery interface-name TOOL-PORT-1 strip-
second-vlan

To preserve the VLAN tag added by DMF and other tags in the traffic, use the following command:

controller-1(config-switch-if)# role delivery interface-name TOOL-PORT-1 strip-
no-vlan

Note:  For all modes VLAN ID stripping is supported at both the global and delivery interface levels.
The rewrite-per-policy and rewrite-per-filter options have been removed in DMF Release 6.0
because the push-per-policy and push-per-filter options now support the related use cases.

The syntax for the strip VLAN ID feature is as follows:

controller-1(config-switch-if)# role delivery interface-name <name> [strip-no-
vlan | strip-onevlan | strip-second-vlan | strip-two-vlan]

You can use the option to leave all VLAN tags intact, remove the outermost tag, remove the second (inner)
tag, or remove the outermost two tags.

By default, VLAN stripping is enabled and the outer VLAN added by DMF is removed.

To preserve the outer VLAN tag, enter the strip-no-vlan command, as in the following example, which
preserves the outer VLAN ID for traffic forwarded to the delivery interface TOOL-PORT-1:

controller-1(config-switch-if)# role delivery interface-name TOOL-PORT-1 strip-
no-vlan

When global VLAN stripping is disabled, the following commands remove the outer VLAN tag, added by DMF,
on packets transmitted to the specific delivery interface ethernet20 on DMF-DELIVERY-SWITCH-1:

controller-1(config)# switch DMF-DELIVERY-SWITCH-1
controller-1(config-switch)# interface ethernet20
controller-1(config-switch-if)# role delivery interface-name TOOL-PORT-1 strip-
one-vlan

To restore the default configuration, which is to strip the VLAN IDs from traffic to every delivery interface, enter
the following command:

controller-1(config)# auto-delivery-interface-vlan-strip
This would enable auto delivery interface strip VLAN feature. 
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Existing policies will be re-computed. Enter “yes” (or “y”) to continue: yes

As mentioned earlier, tagging and stripping VLANs as they ingress and egress DMF differs based on whether
the switch uses a Trident 3 chipset. The following scenarios show how DMF behaves in different VLAN
modes with various knobs set.
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Scenario 1

• VLAN mode: Push per Policy
• Filter interface on any switch except a Trident 3 switch
• Delivery interface on any switch
• Global VLAN stripping is enabled

Table 9: Behavior of Traffic as It Egresses with Different Strip Options on a Delivery Interface

VLAN tag type No
Configuration

strip-no-VLAN strip-one-VLAN strip-second-
VLAN

strip-two-VLAN

DMF policy
VLAN is
stripped
automatically
on delivery
inter- face using
default global
strip VLAN
added by DMF

DMF policy
VLAN and
customer VLAN
preserved

Strips the
outermost VLAN
that is DMF
policy VLAN

DMF policy
VLAN is
preserved
and outermost
customer VLAN
is removed

Strip two
VLANs, DMF
policy VLAN and
customer outer
VLAN removed

Untagged Packets
exit DMF as
untagged
packets

Packets exit
DMF as singly
tagged packets.
VLAN in the
packet is DMF
policy VLAN.

Packets
exit DMF as
untagged packets.

Packets exit
DMF as single-
tagged traffic.
VLAN in the
packet is DMF
policy VLAN.

Packets
exit DMF as
untagged traffic.

Singly Tagged Packets
exit DMF as
single-tagged
traffic with
customer VLAN.

Packets
exit DMF as
doubly tagged
packets. Outer
VLAN in the
packet is DMF
policy VLAN.

Packets
exit DMF as
single-tagged
traffic with
customer VLAN.

Packets exit
DMF as single-
tagged traffic.
VLAN in the
packet is DMF
policy VLAN.

Packets
exit DMF as
untagged traffic.

Doubly Tagged Packet exits
DMF as doubly
tagged traffic.
Both VLANs are
customer VLANs.

Packet exits
DMF as triple-
tagged packets.
Outermost
VLAN in
the packet
is the DMF
policy VLAN.

Packet exits
DMF as doubly
tagged traffic.
Both VLANs are
customer VLANs.

Packet exits
DMF as double-
tagged packets.
Outer VLAN
is DMF policy
VLAN, inner
VLAN is inner
customer
VLAN in the
original packet.

Packet exits
DMF as singly
tagged traffic.
VLAN in
the packet
is the inner
customer VLAN.
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Scenario 2

• VLAN Mode: Push per Policy
• Filter interface on any switch except a Trident 3 switch
• Delivery interface on any switch
• Global VLAN strip is disabled

Table 10: Behavior of Traffic as It Egresses with Different Strip Options on a Delivery Interface

VLAN tag type No
Configuration

strip-no-VLAN strip-one-VLAN strip-second-
VLAN

strip-two-
VLANs

DMF policy
VLAN and
customer VLAN
are preserved

DMF policy
VLAN and
customer VLAN
are preserved

Strips only the
outermost VLAN
that is DMF
policy VLAN

DMF policy
VLAN is
preserved and
outer most
customer VLAN
is removed

Strip two
VLANs, DMF
policy VLAN and
customer outer
VLAN removed

Untagged Packet exits
DMF as singly
tagged packets.
VLAN in the
packet is DMF
policy VLAN.

Packet exits
DMF as singly
tagged packets.
VLAN in the
packet is DMF
policy VLAN.

Packet exits
DMF as
untagged packets.

Packet exits
DMF as single-
tagged traffic.
VLAN in the
packet is DMF
policy VLAN.

Packet exits
DMF as
untagged traffic.

Singly Tagged Packet exits
DMF as doubly
tagged packets.
Outer VLAN in
packet is DMF
policy VLAN
and inner VLAN
is customer
outer VLAN.

Packet exits
DMF as
doubly tagged
packets. Outer
VLAN in the
packet is DMF
policy VLAN.

Packet exits
DMF as
single-tagged
traffic with
customer VLAN.

Packet exits
DMF as single-
tagged traffic.
VLAN in the
packet is DMF
policy VLAN.

Packets
exits DMF as
untagged traffic.

Doubly Tagged Packet exits
DMF as triple-
tagged packets.
Outermost
VLAN in
the packet
is the DMF
policy VLAN.

Packet exits
DMF as triple-
tagged packets.
Outermost
VLAN in
the packet
is the DMF
policy VLAN.

Packet exits
DMF as doubly
tagged traffic.
Both VLANs are
customer VLANs.

Packet exits
DMF as doubly
tagged packets.
Outer VLAN
is DMF policy
VLAN, inner
VLAN is inner
customer
VLAN in the
original packet.

Packet exits
DMF as singly
tagged traffic.
VLAN in the
packets is
the inner
customer VLAN.
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Scenario 3

• VLAN Mode - Push per Policy
• Filter interface on a Trident 3 switch
• Delivery interface on any switch
• Global VLAN strip is enabled

Table 11: Behavior of traffic as it egresses with different strip options on a delivery interface

VLAN tag type No
Configuration

strip-no-VLAN strip-one-VLAN strip-second-
VLAN

strip-two-VLAN

DMF policy
VLAN is
stripped
automatically
on delivery
interface using
default global
strip VLAN
added by DMF

DMF policy
VLAN and
customer VLAN
preserved

Strips the
outermost VLAN
that is DMF
policy VLAN

DMF policy
VLAN is
preserved
and outermost
customer VLAN
is removed

Strip two
VLANs , DMF
policy VLAN and
customer outer
VLAN removed

Untagged Packet exits
DMF as
untagged packets.

Packet exits
DMF as singly
tagged packets.
VLAN in the
packet is DMF
policy VLAN.

Packet exits
DMF as
untagged packets.

Packet exits
DMF as single-
tagged traffic.
VLAN in the
packet is DMF
policy VLAN.

Packet exits
DMF as
untagged traffic.

Singly Tagged Packet exits
DMF as
single-tagged
traffic with
customer VLAN.

Packet exits
DMF as
doubly tagged
packets. Outer
VLAN in the
packet is DMF
policy VLAN.

Packet exits
DMF as
single tagged
traffic with
customer VLAN.

Packet exits
DMF as single-
tagged traffic.
VLAN in the
packet is DMF
policy VLAN.

Packet exits
DMF as
untagged traffic.

Doubly Tagged Packet exits
DMF as singly
tagged traffic.
VLAN in the
packet is the
inner customer
VLAN

Packet exits
DMF as
doubly tagged
traffic. Outer
customer VLAN
is replaced
by DMF
policy VLAN.

Packet exits
DMF as singly
tagged traffic.
VLAN in
the packet
is the inner
customer VLAN.

Packet exits
DMF as singly
tagged traffic.
VLAN in
the packet
is the DMF
policy VLAN.

Packet exits
DMF as
untagged traffic.
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Scenario 4

• VLAN Mode - Push per Filter
• Filter interface on any switch
• Delivery interface on any switch
• Global VLAN strip is enabled

Table 12: Behavior of Traffic as It Egresses with Different Strip Options on a Delivery Interface

VLAN tag type No
Configuration

strip-no-VLAN strip-one-VLAN strip-second-
VLAN

strip-two-VLAN

DMF filter VLAN
is stripped
automatically
on delivery
interface using
global strip
VLAN added
by DMF.

DMF filter VLAN
and customer
VLAN preserved.

Strips the
outermost VLAN
that is DMF
filter VLAN.

DMF filter VLAN
is preserved
and outermost
customer VLAN
is removed.

Strip two
VLANs, DMF
filter interface
VLAN and
customer outer
VLAN removed.

Untagged Packet exits
DMF as
untagged packets.

Packet exits
DMF as singly
tagged packets.
VLAN in the
packet is
DMF filter
interface VLAN.

Packet exits
DMF as
untagged packets.

Packet exits
DMF

as single tagged
traffic. VLAN in
the packet is
DMF filter inter-
face VLAN.

Packet exits
DMF as
untagged traffic.

Singly Tagged Packet exits
DMF as singly
tagged traffic.
VLAN in the
packet is the
customer VLAN.

Packet exits
DMF as doubly
tagged packets.
Outer VLAN
in the packet
is DMF filter
interface VLAN.

Packet exits
DMF as singly
tagged traffic.
VLAN in the
packet is the
customer VLAN.

Packet exits
DMF as singly
tagged traffic.
VLAN in the
packet is
DMF filter
interface VLAN.

Packet exits
DMF as
untagged traffic.

Doubly Tagged Packet exits
DMF as
singly tagged
traffic. VLAN
in the policy
is the inner
customer VLAN.

Packet exits
DMF as
doubly tagged
traffic. Outer
customer VLAN
is replaced
by DMF filter
interface VLAN.

Packet exits
DMF as
singly tagged
traffic. VLAN
in the policy
is the inner
customer VLAN.

Packet exits
DMF as singly
tagged traffic.
VLAN in the
policy is the
DMF filter
interface VLAN.

Packet exits
DMF as
untagged traffic.
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Scenario 5

• VLAN Mode - Push per Filter
• Filter interface on any switch
• Delivery interface on any switch
• Global VLAN strip is disabled

Table 13: Behavior of Traffic as It Egresses with Different Strip Options on a Delivery Interface

VLAN tag type No
Configuration

strip-no-VLAN strip-one-VLAN strip-second-
VLAN

strip-two-VLAN

DMF filter VLAN
is stripped
automatically
on delivery
interface using
global strip
VLAN added
by DMF.

DMF filter VLAN
and customer
VLAN preserved.

Strips the
outermost VLAN
that is DMF
filter VLAN.

DMF filter VLAN
is preserved
and outermost
customer VLAN
is removed.

Strip two
VLANs, DMF
filter interface
VLAN and
customer outer
VLAN removed.

Untagged Packet exits
DMF as singly
tagged packets.
VLAN in the
packet is
DMF filter
interface VLAN.

Packet exits
DMF as singly
tagged packets.
VLAN in the
packet is
DMF filter
interface VLAN.

Packet exits
DMF as
untagged packets.

Packet exits
DMF as singly
tagged traffic.
VLAN in the
packet is
DMF filter
interface VLAN.

Packet exits
DMF as
untagged traffic.

Singly Tagged Packet exits
DMF as doubly
tagged traffic.
Outer VLAN
in the packet
is DMF filter
VLAN and inner
VLAN is the
customer VLAN.

Packet exits
DMF as doubly
tagged packets.
Outer VLAN
in the packet
is DMF filter
interface VLAN.

Packet exits
DMF as single
tagged traffic.
VLAN in the
packet is the
customer VLAN.

Packet exits
DMF as singly
tagged traffic.
VLAN in the
packet is
DMF filter
interface VLAN.

Packet exits
DMF as
untagged traffic.

Doubly Tagged Packet exits
DMF as
doubly tagged
traffic. Outer
customer VLAN
is replaced
by DMF filter
interface VLAN.

Packet exits
DMF as
doubly tagged
traffic. Outer
customer VLAN
is replaced
by DMF filter
interface VLAN.

Packet exits
DMF as
singly tagged
traffic. VLAN
in the policy
is the inner
customer VLAN.

Packet exits
DMF as singly
tagged traffic.
VLAN in the
policy is the
DMF filter
interface VLAN.

Packet exits
DMF as
untagged traffic.
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10.5.2  Auto VLAN Strip using the GUI

Auto VLAN Strip

1. A toggle button controls the configuration of this feature. Locate the corresponding card and click the
toggle switch.
Figure 10-16: Toggle Switch

2. A confirm window pops up, displaying the corresponding prompt message. Click the Enable button to
confirm the configuration changes or the Cancel button to cancel the configuration. Conversely, to disable
the configuration, click Disable.
Figure 10-17: Confirm / Enable

3. Review any warning messages that appear in the confirmation window during the configuration process.
Figure 10-18: Warning Message - Changing

The following feature sets work in the same manner as the Auto VLAN Strip feature described above.

• CRC Check
• Custom Priority
• Inport Mask
• Policy Overlap Limit Strict
• Retain User Policy VLAN
• Tunneling
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10.6  CRC Check

If the Switch CRC option is enabled, which is the default, each DMF switch drops incoming packets that enter
the fabric with a CRC error. The switch generates a new CRC if the incoming packet was modified using an
option that modifies the original CRC checksum, which includes the push VLAN, rewrite VLAN, strip VLAN,
and L2 GRE tunnel options.

Note:  Enable the Switch CRC option to use the DMF tunneling feature.

If the Switch CRC option is disabled, DMF switches do not check the CRC of incoming packets and do not
drop packets with CRC errors. Also, switches do not generate a new CRC if the packet is modified. This mode
is helpful if packets with CRC errors need to be delivered to a destination tool unmodified for analysis. When
disabling the Switch CRC option, ensure the destination tool does not drop packets having CRC errors. Also,
recognize that CRC errors will be caused by modification of packets by DMF options so that these CRC errors
are not mistaken for CRC errors from the traffic source.

Note:  When the Switch CRC option is disabled, packets going to the Service Node or Recorder Node
are dropped because a new CRC is not calculated when push-per-policy or push-per-filter adds a
VLAN tag.

Enable and disable CRC Check using the steps described in the following topics.

• CRC Check using the CLI
• CRC Check using the GUI

10.6.1  CRC Check using the CLI

If the Switch CRC option is enabled, which is the default, each DMF switch drops incoming packets that enter
the fabric with a CRC error. The switch generates a new CRC if the incoming packet was modified using one
option that modifies the original CRC checksum, which includes the push VLAN, rewrite VLAN, strip VLAN,
and L2 GRE tunnel options.

Note:  Enable the Switch CRC option to use the DMF tunneling feature.

If the Switch CRC option is disabled, DMF switches do not check the CRC of incoming packets and do not
drop packets with CRC errors. Also, switches do not generate a new CRC if the packet is modified. This mode
is helpful if packets with CRC errors need to be delivered to a destination tool unmodified for analysis. If you
disable the Switch CRC option, ensure the destination tool does not drop packets having CRC errors. Also,
recognize that CRC errors will be caused by modification of packets by DMF options so that these CRC errors
are not mistaken for CRC errors from the traffic source.

To disable the Switch CRC option, enter the following command from config mode:

controller-1(config)# no crc
Disabling CRC mode may cause problems to tunnel interface. Enter “yes” (or “y”)
 to continue: y

In the event the Switch CRC option is disabled, re-enable the Switch CRC option using the following
command from config mode:

controller-1(config)# crc
Enabling CRC mode would cause packets with crc error dropped. Enter "yes" (or
 "y
") to continue: y

Tip:  To enable or disable the CRC through the GUI, refer to the chapter, Check CRC using the GUI.
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Note:  When the Switch CRC option is disabled, packets going to the service node or recorder node
are dropped because a new CRC is not calculated when push-per-policy or push-per-filter adds a
VLAN tag.

10.6.2  CRC Check using the GUI

From the DMF Features page, proceed to the CRC Check feature card and perform the following steps to
enable the feature.
1. Select the CRC Check card.

Figure 10-19: CRC Check Disabled

2. Toggle the CRC Check to On.
3. Confirm the activation by clicking Enable or Cancel to return to the DMF Features page.

Figure 10-20: Enable CRC Check

4. CRC Check is running.
Figure 10-21: CRC Check Enabled

5. To disable the feature, toggle the CRC Check to Off. Click Disable and confirm.
Figure 10-22: Disable CRC Check
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The feature card updates with the status.
Figure 10-23: CRC Check Disabled

10.7  Custom Priority

When custom priorities are allowed, non-admin users may assign policy priorities between 0 and 100
(the default value). However, when custom priorities are not allowed, the default priority of 100 will be
automatically assigned to non-admin users' policies.

Enable and disable Custom Priority using the steps described in the following topics.

• Custom Priority using the CLI
• Custom Priority using the GUI

10.7.1  Configuring Custom Priority using the GUI

From the DMF Features page, proceed to the Custom Priority feature card and perform the following steps to
enable the feature.
1. Select the Custom Priority card.

Figure 10-24: Custom Priority Disabled

2. Toggle the Custom Priority to On.
3. Confirm the activation by clicking Enable or Cancel to return to the DMF Features page.

Figure 10-25: Enable Custom Priority

4. Custom Priority is running.
Figure 10-26: Custom Priority Enabled
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5. To disable the feature, toggle the Custom Priority to Off. Click Disable and confirm.
Figure 10-27: Disable Custom Priority

The feature card updates with the status.
Figure 10-28: Custom Priority Disabled

10.7.2  Configuring Custom Priority using the CLI

To enable the Custom Priority, enter the following command:

controller-1(config)# allow-custom-priority

To disable the Custom Priority, enter the following command:

controller-1(config)# no allow-custom-priority

10.8  Device Deployment Mode

Complete the fabric switch installation in one of the following two modes:

• Layer 2 Zero Touch Fabric (L2ZTF, Auto-discovery switch provisioning mode)

In this mode, which is the default, Switch ONIE software automatically discovers the Controller via IPv6
local link addresses and downloads and installs the appropriate Switch Light OS image from the Controller.
This installation method requires all the fabric switches and the DMF Controller to be in the same Layer 2
network (IP subnet). Also, suppose the fabric switches need IPv4 addresses to communicate with SNMP
or other external services. In that case, users must configure IPAM, which provides the controller with a
range of IPv4 addresses to allocate to the fabric switches.

• Layer 3 Zero Touch Fabric (L3ZTF, Preconfigured switch provisioning mode)

When fabric switches are in a different Layer 2 network from the Controller, log in to each switch
individually to configure network information and download the ZTF installer. Subsequently, the switch
automatically downloads Switch Light OS from the Controller. This mode requires communication between
the Controller and the fabric switches using IPv4 addresses, and no IPAM configuration is required.

The following table summarizes the requirements for installation using each mode:
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Requirement Layer 2 mode Layer 3 mode

Any switch in a different subnet from
the controller

No Yes

IPAM configuration for SNMP and
other IPv4 services

Yes No

IP address assignment IPv4 or IPv6 IPv4

Refer to this section (in User Guide) Using L2 ZTF (Auto-Discovery)
Provisioning Mode

Changing to Layer 3 (Pre-
Configured) Switch Provisioning
Mode

All the fabric switches in a single fabric must be installed using the same mode. If users have any fabric
switches in a different IP subnet than the Controller, users must use Layer 3 mode for installing all the
switches, even those in the same Layer 2 network as the Controller. Installing switches in mixed mode, with
some switches using ZTF in the same Layer 2 network as the Controller, while other switches in a different
subnet are installed manually or using DHCP is unsupported.

10.8.1  Configuring Device Deployment Mode using the GUI

From the DMF Features page, proceed to the Device Deployment Mode feature card and perform the
following steps to manage the feature.
1. Select the Device Deployment Mode card.

Figure 10-29: Device Deployment Mode - Auto Discovery

2. Enter the edit mode using the pencil icon.
Figure 10-30: Configure Device Deployment Mode
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3. Change the switching mode as required using the drop-down menu. The default mode is Auto Discovery.
Figure 10-31: Device Deployment Mode Options

Figure 10-31: Device Deployment Mode - Pre-Configured Option

4. Click Submit and confirm the operation when prompted.
5. The Device Deployment Mode status updates.

Figure 10-33: Device Deployment Mode - Status Update

10.8.2  Configuring Device Deployment Mode using the CLI

Device Deployment Mode has two options: select the desired option, either auto-discovery or pre-configured,
as shown below:

controller-1(config)# deployment-mode auto-discovery
                
Changing device deployment mode requires modifying switch configuration. Enter
 "yes" (or "y") to continue: y

controller-1(config)# deployment-mode pre-configured

Changing device deployment mode requires modifying switch configuration. Enter
 "yes" (or "y") to continue: y
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10.9  Inport Mask

Enable and disable Inport Mask using the steps described in the following topics.

• Configure Inport Mask using the CLI
• Configure Inport Mask using the GUI

10.9.1  InPort Mask using the CLI

DANZ Monitoring Fabric implements multiple flow optimizations to reduce the number of flows programmed in
the DMF switch TCAM space. This feature enables effective usage of TCAM space, and it is on by default.

When this feature is off, TCAM rules are applied for each ingress port belonging to the same policy. For
example, in the following topology, if a policy was configured with 10 match rules and filter-interface as F1 and
F2, then 20 (10 for F1 and 10 for F2) TCAM rows were consumed.
Figure 10-34: Simple Inport Mask Optimization

With inport mask optimization, only 10 rules are consumed. This feature optimizes TCAM usage at every level
(filer, core, delivery) in the DMF network.

Consider the more complex topology illustrated below:
Figure 10-35: Complex Inport Mask Optimization

In this topology, if a policy has N rules without in-port optimization, the policy will consume 3N at Switch 1, 3N
at Switch 2, and 2N at Switch 3. With the in-port optimization feature enabled, the policy consumes only N
rules at each switch.

330



Advanced Fabric Settings

However, this feature loses granularity in the statistics available because there is only one set of flow mods
for multiple filter ports per switch. Statistics without this feature are maintained per filter port per policy.

With inport optimization enabled, the statistics are combined for all input ports sharing rules on that switch.
You can obtain filter port statistics for different flow mods for each filter port. However, this requires disabling
inport optimization, which is enabled by default.

To disable the inport optimization feature, enter the following command from config mode:

controller-1(config)# controller-1(config)# no inport-mask

10.9.2  Inport Mask using the GUI

From the DMF Features page, proceed to the Inport Mask feature card and perform the following steps to
enable the feature.
1. Select the Inport Mask card.

Figure 10-36: Inport Mask Disabled

2. Toggle the Inport Mask to On.
3. Confirm the activation by clicking Enable or Cancel to return to the DMF Features page.

Figure 10-37: Enable Inport Mask

4. Inport Mask is running.
Figure 10-38: Inport Mask Enabled

5. To disable the feature, toggle the Inport Mask to Off. Click Disable and confirm.
Figure 10-39: Disable Inport Mask
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The feature card updates with the status.
Figure 10-40: Inport Mask Disabled

10.10  Match Mode

Switches have finite hardware resources available for packet matching on aggregated traffic streams. This
resource allocation is relatively static and configured in advance. The DANZ Monitoring Fabric supports three
allocation schemes, referred to as switching (match) modes:

• L3-L4 mode (default mode): With L3-L4 mode, fields other than src-mac and dst-mac can be used
for specifying policies. If no policies use src-mac or dst-mac, the L3-L4 mode allows more match rules
per switch.

• Full-match mode: With full-match mode, all matching fields, including src-mac and dst-mac, can be
used while specifying policies.

• L3-L4 Offset mode: L3-L4 offset mode allows matching beyond the L4 header up to 128 bytes from the
beginning of the packet. The number of matches per switch in this mode is the same as in full-match
mode. As with L3-L4 mode, matches using src-mac and dst-mac are not permitted.

Note:  Changing switching modes causes all fabric switches to disconnect and reconnect with
the Controller. Also, all existing policies will be reinstalled. The switching mode applies to all DMF
switches in the DANZ Monitoring Fabric. Switching between modes is possible, but any match rules
incompatible with the new mode will fail.

10.10.1  Setting the Match Mode Using the CLI

To use the CLI to set the match mode, enter the following command:

controller-1(config)# match-mode {full-match | l3-l4-match | l3-l4-offset-
match}

For example, the following command sets the match mode to full-match mode:

controller-1(config)# match-mode full-match

10.10.2  Setting the Match Mode Using the GUI

From the DMF Features page, proceed to the Match Mode feature card and perform the following steps to
enable the feature.
1. Select the Match Mode card.

Figure 10-41: L3-L4 Match Mode
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2. Enter the edit mode using the pencil icon.
Figure 10-42: Configure Switching Mode

3. Change the switching mode as required using the drop-down menu. The default mode is L3-L4 Match.
Figure 10-43: L3-L4 Match Options

4. Click Submit and confirm the operation when prompted.

Note:  An error message is displayed if the existing configuration of the monitoring fabric is
incompatible with the specified switching mode.

10.11  Retain User Policy VLAN

Enable and disable Retain User Policy VLAN using the steps described in the following topics.

• Retain User Policy VLAN using the CLI
• Retain User Policy VLAN using the GUI

10.11.1  Retain User Policy VLAN using the CLI

This feature will send traffic to a delivery interface with the user policy VLAN tag instead of the overlap
dynamic policy VLAN tag for traffic matching the dynamic overlap policy only. This feature is supported only
in push-per-policy mode. For example, policy P1 with filter interface F1 and delivery interface D1, and policy
P2 with filter interface F1 and delivery interface D2, and overlap dynamic policy P1_o_P2 is created when the
overlap policy condition is met. In this case, the overlap dynamic policy is created with filter interface F1 and
delivery interfaces D1 and D2. The user policy P1 assigns a VLAN (VLAN 10) and P2 assigns a VLAN (VLAN
20) when it is created, and the overlap policy also assigns a VLAN (VLAN 30) when it is dynamically created.
When this feature is enabled, traffic forwarded to D1 will have a policy VLAN tag of P1 (VLAN 10) and D2 will
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have a policy VLAN tag of policy P2 (VLAN 20). When this feature is disabled, traffic forwarded to D1 and D2
will have the dynamic overlap policy VLAN tag (VLAN 30). By default, this feature is disabled.

Feature Limitations:

• An overlap dynamic policy will fail when the overlap policy has filter (F1) and delivery interface (D1) on the
same switch (switch A) and another delivery interface (D2) on another switch (switch B).

• Post-to-delivery dynamic policy will fail when it has a filter interface (F1) and a delivery interface (D1) on
the same switch (switch A) and another delivery interface (D2) on another switch (switch B).

• Overlap policies may be reinstalled when a fabric port goes up or down when this feature is enabled.
• Double-tagged VLAN traffic is not supported and will be dropped at the delivery interface.
• Tunnel interfaces are not supported with this feature.
• Only IPv4 traffic is supported; other non-IPv4 traffic will be dropped at the delivery interface.
• Delivery interfaces with IP addresses (L3 delivery interfaces) are not supported.
• This feature is not supported on EOS switches (Arista 7280 switches).
• Delivery interface statistics may not be accurate when displayed using the sh policy command.

This will happen when policy P1 has F1, D1, D2 and policy P2 has F1, D2. In this case, overlap policy
P1_o_P2 will be created with delivery interfaces D1, D2. Since D2 is in both policies P1 and P2, overlap
traffic will be forwarded to D2 with both the P1 policy VLAN and the P2 policy VLAN. The sh policy
<policy_name> command will not show this doubling of traffic on delivery interface D2. Delivery interface
statistics will show this extra traffic forwarded from the delivery interface.

To enable this feature, enter the following command:

controller-1(config)# retain-user-policy-vlan
This will enable retain-user-policy-vlan feature. Non-IP packets will be
 dropped at delivery. Enter
"yes" (or "y") to continue: yes

To see the current Retain Policy VLAN configuration, enter the following command:

controller-1> show fabric
~~~~~~~~~~~~~~~~~~~~~~~~~ Aggregate Network State ~~~~~~~~~~~~~~~~~~~~~~~~~
Number of switches : 14
Inport masking : True
Number of unmanaged services : 0
Number of switches with service interfaces : 0
Match mode : l3-l4-offset-match
Number of switches with delivery interfaces : 11
Filter efficiency : 1:1
Uptime : 4 days, 8 hours
Max overlap policies (0=disable) : 10
Auto Delivery Interface Strip VLAN : True
Number of core interfaces : 134
State : Enabled
Max delivery BW (bps) : 2.18Tbps
Health : unhealthy
Track hosts : True
Number of filter interfaces : 70
Number of policies : 101
Start time : 2022-02-28 16:18:01.807000 UTC
Number of delivery interfaces : 104
Retain User Policy Vlan : True

This feature can be used with the strip-second-vlan option during delivery interface configuration to preserve
the outer DMF fabric policy VLAN, strip the inner VLAN of traffic forwarded to a tool, or the strip-no-vlan
option during delivery interface configuration.
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10.11.2  Retain User Policy VLAN using the GUI

From the DMF Features page, proceed to the Retain User Policy VLAN feature card and perform the following
steps to enable the feature.
1. Select the Retain User Policy VLAN card.

Figure 10-44: Retain User Policy VLAN Disabled

2. Toggle the Retain User Policy VLAN to On.
3. Confirm the activation by clicking Enable or Cancel to return to the DMF Features page.

Figure 10-45: Enable Retain User Policy VLAN

4. Retain User Policy VLAN is running.
Figure 10-46: Retain User Policy VLAN Enabled

5. To disable the feature, toggle the Retain User Policy VLAN to Off. Click Disable and confirm.
Figure 10-47: Disable Retain User Policy VLAN
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The feature card updates with the status.
Figure 10-48: Retain User Policy VLAN Disabled

10.12  Tunneling

For more information about Tunneling please refer to the Understanding Tunneling section.

Enable and disable Tunneling using the steps described in the following topics.

• Configure Tunneling using the GUI
• Configure Tunneling using the CLI

10.12.1  Configuring Tunneling using the GUI

From the DMF Features page, proceed to the Tunneling feature card and perform the following steps to
enable the feature.
1. Select the Tunneling card.

Figure 10-49: Tunneling Disabled

2. Toggle Tunneling to On.
3. Confirm the activation by clicking Enable or Cancel to return to the DMF Features page.

Figure 10-50: Enable Tunneling

Note:  CRC Check must be running before attempting to enable Tunneling. An error message
displays if CRC Check is not enabled. Proceeding to click Enable results in a validation error
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message. Refer to the CRC Check section for more information on configuring the CRC
Check feature.
Figure 10-51: CRC Check Warning Message

4. Tunneling VLAN is running.
Figure 10-52: Tunneling Enabled

5. To disable the feature, toggle Tunneling to Off. Click Disable and confirm.
Figure 10-53: Disable Tunneling

The feature card updates with the status.
Figure 10-54: Tunneling VLAN Disabled

10.12.2  Configuring Tunneling using the CLI

To enable the Tunneling, enter the following command:

controller-1(config)# tunneling 

Tunneling is an Arista Licensed feature. 
Please ensure that you have purchased the license for tunneling before using
 this feature. 
Enter "yes" (or "y") to continue: y
controller-1(config)#
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To disable the Tunneling, enter the following command:

controller-1(config)# no tunneling 
This would disable tunneling feature? Enter "yes" (or "y") to continue: y
controller-1(config)#

10.13  VLAN Preservation

In DANZ Monitoring Fabric (DMF), metadata is appended to the packets forwarded by the fabric to a tool
attached to a delivery interface. This metadata is encoded primarily in the outer VLAN tag of the packets.

By default (using the auto-delivery-strip feature), this outer VLAN tag is always removed on egress upon
delivery to a tool.

The VLAN preservation feature introduces a choice to selectively preserve a packet's outer VLAN tag instead
of stripping or preserving all of it.

VLAN preservation works in both push-per-filter and push-per-policy mode for auto-assigned and user-
configured VLANs.

Note:  VLAN preservation applies to switches running SWL OS and does not apply to switches
running EOS.

This functionality only supports 2000 VLAN IDs and port combinations per switch.

Support for VLAN preservation is on select Broadcom® switch ASICs. Ensure your switch model
supports this feature before attempting to configure it.

10.13.1  Using the CLI to Configure VLAN Preservation

Configure VLAN preservation at two levels: global and local. A local configuration can override the
global configuration.

Global Configuration

Enable VLAN preservation globally using the vlan-preservation command from the config submode to apply a
global configuration.

(config)# vlan-preservation

Two options exist while in the config-vlan-preservation submode:

• preserve-user-configured-vlans
• preserve-vlans

Use the help function to list the options by entering a ? (question mark).

(config-vlan-preservation)# ?
Commands:
preserve-user-configured-vlans     Preserve all user-configured VLANs for all
 delivery interfaces
preserve-vlan                      Configure VLAN ID to preserve for all
 delivery interfaces

Use the preserve-user-configured-vlans option to preserve all user-configured VLANs. The packets
with the user-configured VLANs will have their fabric-applied VLAN tags preserved even after leaving the
respective delivery interface.

(config-vlan-preservation)# preserve-user-configured-vlans
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Use the preserve-vlan option to specify and preserve a particular VLAN ID. Any VLAN ID may be provided.
In the following example, the packets with VLAN ID 100 or 200 will have their fabric-applied VLAN tags
preserved upon delivery to the tool.

(config-vlan-preservation)# preserve-vlan 100
(config-vlan-preservation)# preserve-vlan 200

Local Configuration

This feature applies to delivery and both-filter-and-delivery interface roles.

Fabric-applied VLAN tag preservation can be enabled locally on each delivery interface as an alternative
to the global VLAN preservation configuration. To enable this functionality locally, enter the following
configuration submode using the if-vlan-preservation command to specify either one of the two
available options. Use the help function to list the options by entering a ? (question mark).

(config-switch-if)# if-vlan-preservation
(config-switch-if-vlan-preservation)# ?
Commands:
preserve-user-configured-vlans     Preserve all user-configured VLANs for all
 delivery interfaces
preserve-vlan                      Configure VLAN ID to preserve for all
 delivery interfaces

Use the preserve-user-configured-vlans option to preserve all user-configured VLAN IDs in push-per-
policy or push-per-filter mode on a selected delivery interface. All packets egressing such delivery
interface will have their user-configured fabric VLAN tags preserved.

(config-switch-if-vlan-preservation)# preserve-user-configured-vlans

Use the preserve-vlan option to specify and preserve a particular VLAN ID. For example, if any packets with
VLAN ID 100 or 300 egress the selected delivery interface, VLAN IDs 100 and 300 will be preserved.

(config-switch-if-vlan-preservation)# preserve-vlan 100
(config-switch-if-vlan-preservation)# preserve-vlan 300

Note:  Any local vlan-preservation configuration overrides the global configuration for the selected
interfaces by default.

On an MLAG delivery interface, the local configuration follows the same model, as shown below.

(config-mlag-domain-if)# if-vlan-preservation member role                 
(config-mlag-domain-if)# if-vlan-preservation 
(config-mlag-domain-if-vlan-preservation)# preserve-user-configured-vlans
 preserve-vlan

To disable selective VLAN preservation for a particular delivery or both-filter-and-delivery interface, use the
following command to disable the feature's global and local configuration for the selected interface:

(config-switch-if)# role delivery interface-name del 
<cr>                 no-analytics          strip-no-vlan         strip-second-
vlan
ip-address            no-vlan-preservation  strip-one-vlan        strip-two-vla
n
(config-switch-if)# role delivery interface-name del no-vlan-preservation
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CLI Show Commands

The following show command displays the name of the device on which VLAN preservation is enabled and
the information about which VLAN is preserved on specific selected ports. Use the data in this table primarily
for debugging purposes.

# show switch all table vlan-preserve 
# Vlan-preserve Device name Entry key              
-|-------------|-----------|----------------------|
1 0             delivery1   VlanVid(0x64), Port(6)
2 0             filter1     VlanVid(0x64), Port(6)
3 0             core1       VlanVid(0x64), Port(6)

10.13.2  Using the GUI to Configure VLAN Preservation

VLAN preservation can be configured at global and local levels. A local configuration can override the
global configuration. Follow the steps outlined below to configure a Global Configuration (steps 1 - 4), Local
Configuration (steps 5-7), or an MLAG Delivery Interface configuration within an MLAG domain (step 8).
1. Global Configuration
1. To view or edit the global configuration, navigate to the DANZ Monitoring Fabric (DMF) Features page by

clicking the gear icon in the top right of the navigation bar.
Figure 10-55: DMF Menu Bar

The DMF Feature allows for managing fabric-wide settings for DMF.
2. Scroll to the VLAN Preservation card.

Figure 10-56: DMF Features Page

Figure 10-57: VLAN Preservation Card
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3. Click the Edit button (pencil icon) to configure or modify the global VLAN Preservation feature settings.
Figure 10-58: Edit VLAN Preservation Configuration

The edit screen has two input sections:

• Toggle on or off the Preserve User Configured VLANs.
• Enter the parameters for VLAN Preserve using the following functions:

• Use the Add VLAN button to add VLAN IDs.
• Select the Single VLAN type drop-down to add a single VLAN ID.
• Select the Range VLAN type drop-down to add a continuous VLAN ID range.
• Use the Trash button (delete) to delete a single VLAN ID or a VLAN ID range.

4. Click the Submit button to save the configuration.
2. Local Configuration
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5. The VLAN Preservation configuration can be applied per-delivery interface while configuring or editing a
delivery or filter-and-delivery interface in the Monitoring Interfaces page and Monitoring Interfaces >
Delivery Interfaces page.
Figure 10-59: Monitoring Interfaces Delivery Interface Create Interface

6. The following inputs are available for the local feature configuration:

• Toggle the Preserve User Configured VLANs button to on. Use this option to preserve all user-
configured VLAN IDs in push-per-policy or push-per-filter mode on a selected delivery interface. The
packets with the user-configured VLANs will have their fabric-applied VLAN tags preserved even after
leaving the respective delivery interface.

• VLAN Preserve. Use the + and - icon buttons to add and remove VLAN IDs.
• Toggle the VLAN Preservation button to on. Disabling this option will ignore this feature configuration

given globally/locally for this delivery interface. VLAN Preservation is enabled by default.
7. Click the Save button to save the configuration.
3. VLAN Preservation for MLAG Delivery Interfaces
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8. Configure VLAN preservation for MLAG delivery interfaces using the Fabric > MLAGs page while
configuring an MLAG Domain toggling the VLAN Preservation and Preserve User Configured VLANs
switches to on (as required).
Figure 10-60: Create MLAG Domain

Figure 10-61: MLAG VLAN Preservation & Preserve User Configured VLANs (expanded view)

10.13.3  Troubleshooting

Use the following commands to troubleshoot the scenario in which a tool attached to a delivery interface
expects a packet with a preserved VLAN tag, but instead, there is no tag attached to it; double-check
the following.
1. A partial policy installation may occur if any delivery interface fails to preserve the VLAN tag. This can

happen when exceeding the 2000 VLAN ID/Port combination limit. Use the show policy policy-name
command to obtain a detailed status, as shown in the following example:

(config)# show policy vlan-999
Policy Name                            : vlan-999
Config Status                          : active - forward
Runtime Status                         : installed but partial failure
Detailed Status                        : installed but partial failure - 
                                         Failed to preserve VLAN's on some/
all 
                                         delivery interfaces, see warnings
 for details
Priority                               : 100
Overlap Priority                       : 0
# of switches with filter interfaces   : 1
# of switches with delivery interfaces : 1
# of switches with service interfaces  : 0
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# of filter interfaces                 : 1
# of delivery interfaces               : 1
# of core interfaces                   : 2
# of services                          : 0
# of pre service interfaces            : 0
# of post service interfaces           : 0
Push VLAN                              : 999
Post Match Filter Traffic              : -
Total Delivery Rate                    : -
Total Pre Service Rate                 : -
Total Post Service Rate                : -
Overlapping Policies                   : none
Component Policies                     : none
Installed Time                         : 2023-11-06 21:01:11 UTC
Installed Duration                     : 1 week

2. Verify the running config and review if the VLAN preservation configuration is enabled for that VLAN ID
and on that delivery interface.

(config-vlan-preservation)# show running-config | grep "preserve"
! vlan-preservation
vlan-preservation
preserve-vlan 100

3. Verify the show switch switch-name table vlan-preserve output. It displays the ports and
VLAN ID combinations that are enabled.

(config-policy)# show switch core1 table vlan-preserve
# Vlan-preserve Device name Entry key              
-|-------------|-----------|----------------------|
1 0             core1       VlanVid(0x64), Port(6)

4. The same configuration can be verified from a switch (e.g., core1) by using the command below:

root@core1:~# ofad-ctl gt vlan_preserve
VLAN PRESERVE TABLE:
--------------------
VLAN:  100  Port:    6  PortClass:    6

5. Verify if a switch has any associated preserve VLAN warnings among the fabric warnings:

(config-vlan-preservation)# show fabric warnings | grep "preserve
1 delivery1 (00:00:52:54:00:85:ca:51) Switch 00:00:52:54:00:85:ca:51 
cannot preserve VLANs for some interfaces due to resource exhaustion.

6. The show fabric warnings feature-unsupported-on-device command provides information
on whether VLAN preservation is configured on any unsupported devices:

(config-switch)# show fabric warnings feature-unsupported-on-device 
# Name Warning                                                      
-|----|------------------------------------------------------------|
1 del1 VLAN preservation feature is not supported on EOS switch eos

If you find any preserve VLAN fabric warnings, please contact the Arista Support Team for assistance.

10.14  Reuse of Policy VLANs

From DMF Release 8.2, policies can reuse VLANs for policies in different switch islands. A switch island is an
isolated fabric managed by a single pair of controllers; there is no data plane connection between fabrics in
different switch islands. For example, with a single Controller pair managing six switches (switch1, switch2,
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switch3, switch4, switch5, and switch6), you can create two fabrics with three switches each (switch1,
switch2, switch3 in one switch island and switch4, switch5, and switch6 in another switch island), as long
as there is no data plane connection between switches in the different switch islands.

There is no command needed to enable this feature. If the above condition is met, creating policies in each
switch island with the same policy VLAN tag is supported.

In the condition mentioned above, assign the same policy VLAN to two policies in different switch islands
using the push-vlan <vlan-tag> command under policy configuration. For example, policy P1 in switch
island 1 assigned push-vlan 10, and policy P2 in switch island 2 assigned the same vlan tag 10 using push-
vlan 10 under policy configuration.

When a data plane link connects two switch islands, it becomes one switch island. In that case, two policies
cannot use the same policy vlan tag, so one of the policies (P1 or P2) will become inactive.

10.15  Rewriting the VLAN ID for a Filter Interface

When sharing a destination tool with multiple filter interfaces, use the VLAN identifier assigned by the rewrite
VLAN option to identify the ingress filter interface for specific packets. To use the rewrite VLAN option, assign
a unique VLAN identifier to each filter interface. This VLAN ID should be outside the auto-VLAN range.

Note:  In push-per-policy mode, you can not enable the rewrite VLAN feature on filter interfaces. If you
try, a validation error is displayed. This feature is available only in the push-per-filter mode.

The following commands change the VLAN tag on packets received on the interface ethernet10 on f-switch1
to 100. The role command in this example also assigns the alias TAP-PORT-1 to Ethernet interface 10.

controller-1(config)# switch f-switch1
controller-1(config-switch-if)# interface ethernet10
controller-1(config-switch-if)# role filter interface-name TAP-PORT-1 rewrite
 vlan 100

The rewrite VLAN option overwrites the original VLAN frame tag if it was already tagged, and this changes
the CRC checksum so it no longer matches the modified packet. The switch CRC option, enabled by default,
rewrites the CRC after the frame has been modified so that a CRC error does not occur.

Note:  Starting with DMF Release 7.1.0, simultaneously rewriting the VLAN ID and MAC address is
supported and uses VLAN rewriting to isolate traffic while using MAC rewriting to forward traffic to
specific VMs.

10.16  Reusing Filter Interface VLAN IDs

A DMF fabric comprises groups of switches, known as islands, connected over the data plane. There are no
data plane connections between switches in different islands. When Push-Per-Filter forwarding is enabled,
monitored traffic is forwarded within an island using the VLAN ID associated with a Filter Interface. These
VLAN IDs are configurable. Previously, the only recommended configuration was for these VLAN IDs to be
globally unique.

This feature adds official support for associating the same VLAN ID with multiple Filter Interfaces as long
as they are in different islands. This feature provides more flexibility when duplicating Filter Interface
configurations across islands and helps prevent using all available VLAN IDs.

Note that within each island, VLAN IDs must still be unique, which means that Filter Interfaces in the same
group of switches cannot have the same ID. Suppose you try to reuse the same VLAN ID within an island. In
that case, a fabric error is generated, and only the first Filter Interface (as sorted alphanumerically by DMF
name) remains in use.
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Configuration

This feature requires no special configuration beyond the existing Filter Interface configuration workflow.

Troubleshooting

A fabric error occurs if the same VLAN ID is configured more than once in the same island. The error
message includes the Filter Interface name, the switch name, and the VLAN ID that is not unique. When
encountering this error, pick a different non-conflicting VLAN ID.

Filter Interface invalid VLAN errors can be displayed in the CLI using the following command:

The following is a vertical representation of the CLI output above for illustrative purposes only.

>show fabric errors filter-interface-invalid-vlan 
~~ Invalid Filter Interface VLAN(s) ~~            
#               1         
DMF Name        filter1-f1          
IF Name         ethernet2        
Switch          filter1 (00:00:52:54:00:4b:c9:bc)  
Rewrite VLAN    1
Details         The configured rewrite VLAN 1 for filter interface filter1-f1
                is not unique within its fabric.       
                

It is helpful to know all of the switches in an island. The following command lists all of the islands (referred to
in this command as switch clusters) and their switch members:

>show debug switch-cluster 
# Member         
-|--------------|
1 core1, filter1

It can also be helpful to know how the switches within an island are interconnected. Use the following
command to display all the links between the switches:

>show link all
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Links ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# Active State Src switch Src IF Name Dst switch Dst IF Name Link Type Since                   
-|------------|----------|-----------|----------|-----------|---------|-----------------------|
1 active       filter1    ethernet1   core1      ethernet1   normal    2023-05-24 22:31:39 UTC
2 active       core1      ethernet1   filter1    ethernet1   normal    2023-05-24 22:31:40 UTC

Considerations

• VLAN IDs must be unique within an island. Filter Interfaces in the same island with the same VLAN ID are
not supported.

• This feature only applies to manually configured Filter Interface VLAN IDs. VLAN IDs that are
automatically assigned are still unique across the entire fabric.

10.17  Using Push-per-filter Mode

The push-per-filter mode setting does not enable tag-based forwarding. Each filter interface is automatically
assigned a VLAN ID; the default range is 1 to 4094. To change the range, use the auto-vlan-range
command.

You can manually assign a VLAN not included in the defined range to a filter interface.
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To manually assign a VLAN to a filter interface in push-per-filter mode, complete the following steps:

1. Change the auto-vlan-range from the default (1-4094) to a limited range, as in the following example:

controller-1(config)# auto-vlan-range vlan-min 1 vlan-max 1000

The example above configures the auto-VLAN feature to use VLAN IDs from 1 to 1000.
2. Assign a VLAN ID to the filter interface that is not in the range assigned to the auto-VLAN feature.

controller-1(config)# role filter interface-name TAP-1 rewrite vlan 1001

10.18  Tag-based Forwarding

The DANZ Monitoring Fabric (DMF) Controller configures each switch with forwarding paths based on the
most efficient links between the incoming filter interface and the delivery interface, which is connected to
analysis tools. The TCAM capacity of the fabric switches may limit the number of policies you can configure.
The Controller can also use VLAN tag-based forwarding, which reduces the TCAM resources required to
implement a policy.

Tag-based forwarding is automatically enabled when the auto-VLAN Mode is push-per-policy, which is the
default. This configuration improves traffic forwarding within the monitoring fabric. DMF uses the assigned
VLAN tags to forward traffic to the correct delivery interface, saving TCAM space. This feature is handy when
using switches based on the Tomahawk chipset because these switches have higher throughput but reduced
TCAM space.

10.19  Policy Rule Optimization

10.19.1  Prefix Optimization

A policy can match with a large number of IPv4 or IPv6 addresses. These matches can be configured
explicitly on each match rule, or the match rules can use an address group. With prefix optimization based on
IPv4, IPv6, and TCP ports, DANZ Monitoring Fabric (DMF) uses efficient masking algorithms to minimize the
number of flow entries in hardware.

Example 1: Optimize the same mask addresses.

controller-1(config)# policy ip-addr-optimization
                controller-1(config-policy)# action forward
                controller-1(config-policy)# delivery-interface TOOL-PORT-1
                controller-1(config-policy)# filter-interface TAP-PORT-1
                controller-1(config-policy)# 10 match ip dst-ip 1.1.1.0
 255.255.255.255
                controller-1(config-policy)# 11 match ip dst-ip 1.1.1.1
 255.255.255.255
                controller-1(config-policy)# 12 match ip dst-ip 1.1.1.2
 255.255.255.255
                controller-1(config-policy)# 13 match ip dst-ip 1.1.1.3
 255.255.255.255
                controller-1(config-policy)# show policy ip-addr-optimization
 optimized-match
                Optimized Matches :
                10 ether-type 2048 dst-ip 1.1.1.0 255.255.255.252

347



 

Example 2: In this case, if a generic prefix exists, all the specific addresses are not programmed in TCAM.

controller-1(config)# policy ip-addr-optimization
                controller-1(config-policy)# action forward
                controller-1(config-policy)# delivery-interface TOOL-PORT-1
                controller-1(config-policy)# filter-interface TAP-PORT-1
                controller-1(config-policy)# 10 match ip dst-ip 1.1.1.0
 255.255.255.255
                controller-1(config-policy)# 11 match ip dst-ip 1.1.1.1
 255.255.255.255
                controller-1(config-policy)# 12 match ip dst-ip 1.1.1.2
 255.255.255.255
                controller-1(config-policy)# 13 match ip dst-ip 1.1.1.3
 255.255.255.255
                controller-1(config-policy)# 100 match ip dst-ip 1.1.0.0
 255.255.0.0
                controller-1(config-policy)# show policy ip-addr-optimization
 optimized-match
                Optimized Matches :
                100 ether-type 2048 dst-ip 1.1.0.0 255.255.0.0

Example 3: IPv6 prefix optimization. In this case, if a generic prefix exists, the specific addresses are not
programmed in the TCAM.

controller-1(config)# policy ip-addr-optimization
                controller-1(config-policy)# 25 match ip6 src-ip 2001::100:100
:100:0 FFFF:FFFF:FFFF::0:0
                controller-1(config-policy)# 30 match ip6 src-ip 2001::100:100
:100:0 FFFF:FFFF::0
                controller-1(config-policy)# show policy ip-addr-optimization
 optimized-match
                Optimized Matches :
                30 ether-type 34525 src-ip 2001::100:100:100:0 FFFF:FFFF::0

Example 4: Different subnet prefix optimization. In this case, addresses belonging to different subnets
are optimized.

controller-1(config)# policy ip-addr-optimization
                controller-1(config-policy)# 10 match ip dst-ip 2.1.0.0
 255.255.0.0
                controller-1(config-policy)# 11 match ip dst-ip 3.1.0.0
 255.255.0.0
                controller-1(config-policy)# show policy ip-addr-optimization
 optimized-match
                Optimized Matches : 10 ether-type 2048 dst-ip 2.1.0.0
 254.255.0.0

10.19.2  Transport Port Range and VLAN Range Optimization

The DANZ Monitoring Fabric (DMF) optimizes transport port ranges and VLAN ranges within a single match
rule. Improvements in DMF version 8.5 now support cross-match rule optimization.

Show Commands

To view the optimized match rule, use the show command:

# show policy policy-name optimized-match
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To view the configured match rules, use the following command:

# show running-config policy policy-name

Consider the following DMF policy configuration.

# show running-config policy p1
! policy
policy p1
action forward
delivery-interface d1
filter-interface f1
1 match ip vlan-id-range 1 4
2 match ip vlan-id-range 5 8
3 match ip vlan-id-range 7 16
4 match ip vlan-id-range 10 12

With the above policy configuration and before the DMF 8.5.0 release, the four match conditions would be
optimized into the following TCAM rules:

# show policy p1 optimized-match
Optimized Matches :
1 ether-type 2048 vlan 0 vlan-mask 4092
1 ether-type 2048 vlan 4 vlan-mask 4095
2 ether-type 2048 vlan 5 vlan-mask 4095
2 ether-type 2048 vlan 6 vlan-mask 4094
3 ether-type 2048 vlan 16 vlan-mask 4095
3 ether-type 2048 vlan 8 vlan-mask 4088

However, with the cross-match rule optimizations introduced in this release, the rules installed in the switch
would further optimize TCAM usage, resulting in:

# show policy p1 optimized-match
Optimized Matches :
1 ether-type 2048 vlan 0 vlan-mask 4080
1 ether-type 2048 vlan 16 vlan-mask 4095

A similar optimization technique applies to L4 ports in match conditions:

# show running-config policy p1
! policy
policy p1
action forward
delivery-interface d1
filter-interface f1
1 match tcp range-src-port 1 4
2 match tcp range-src-port 5 8
3 match tcp range-src-port 7 16
4 match tcp range-src-port 9 14

# show policy p1 optimized-match
Optimized Matches :
1 ether-type 2048 ip-proto 6 src-port 0 -16
1 ether-type 2048 ip-proto 6 src-port 16 -1
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10.20  Switch Dual Management Port

10.20.1  Overview

When a DANZ Monitoring Fabric (DMF) switch disconnects from the Controller, the switch is taken out of the
fabric, causing service interruptions. The dual management feature solves the problem by providing physical
redundancy of the switch-to-controller management connection. DMF achieves this by allocating a switch
data path port to be bonded with its existing management interface, thereby acting as a standby management
interface. Hence, it eliminates a single-point failure in the management connectivity between the switch and
the Controller.

Once an interface on a switch is configured for management, this configuration persists across reboots and
upgrades until explicitly disabling the management configuration on the Controller.

Configure an interface for dual management using the CLI or the GUI.

Note:  Along with the configuration on the Controller detailed below, dual management requires
a physical connection in the same subnet as the primary management link from the data port to a
management switch.

10.20.2  Configuring Dual Management Using the CLI

1. From config mode, specify the switch to be configured with dual management, as in the following example:

Controller-1(config)# switch DMF-SWITCH-1
Controller-1(config-switch)#

The CLI changes to the config-switch submode, which lets you configure the specified switch.
2. From config-switch mode, enter the interface command to specify the interface to be configured as

the standby management interface:

Controller-1(config-switch)# interface ethernet40
Controller-1(config-switch-if)#

The CLI changes to the config-switch-if submode, which lets you configure the specified interface.
3. From config-switch-if mode, enter the management command to specify the role for the interface:

Controller-1(config-switch-if)# management
Controller-1(config-switch-if)#

Note:  When assigning an interface to a management role, no other interface-specific commands are
honored for that interface (e.g., shut-down, role, speed, etc.).
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10.20.3  Configuring Dual Management Using the GUI

1. Select Fabric > Switches from the main menu.
Figure 10-62: Controller GUI Showing Fabric Menu List

2. Click on the switch name to be configured with dual management.
Figure 10-63: Controller GUI Showing Inventory of Switches
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3. Click on the Interfaces tab.
Figure 10-64: Controller GUI Showing Switch Interfaces
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4. Identify the interface to be configured as the standby management interface.
Figure 10-65: Controller GUI Showing Configure Knob

5. Click on the Menu button to the left of the identified interface, then click on Configure.
Figure 10-66: Controller GUI Showing Interface Settings
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6. Set Use for Management Traffic to Yes. This action configures the interface to the standby
management role.
Figure 10-67: Use for Management Traffic

7. Click Save.

10.20.4  Management Interface Selection Using the GUI

By default, the dedicated management interface serves as the management port, with the front panel data
port acting as a backup only when the management interface is unavailable:

• When the dedicated management interface fails, the front panel data port becomes active as the
management port.

• When the dedicated management interface returns, it becomes the active management port.

When the management network is undependable, this can lead to switch disconnects. The Management
Interface choice dictates what happens when the management interface returns after a failover. Make this
selection using the GUI or the CLI.

Select Fabric > Switches.
Figure 10-68: Fabric Switches
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Click on the switch name to be configured.
Figure 10-69: Switch Inventory

Select the Actions tab.
Figure 10-70: Switch Actions
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Click the Configure Switch icon and choose the required Management Interface setting.

Figure 10-71: Controller GUI Showing Dual Management Settings

If selecting Prefer Dedicated Management Interface (the default), when the dedicated management
interface goes down, the front panel data port becomes the active management port for the switch. When
the dedicated management port comes back up, the dedicated management port becomes the active
management port again, putting the front panel data port in an admin down state.

If selecting Prefer Current Interface, when the dedicated management interface goes down, the front
panel data port still becomes the active management port for the switch. However, when the dedicated
management port comes back up, the front panel data port continues to be the active management port.

10.20.5  Management Interface Selection Using the CLI

By default, the dedicated management interface serves as the management port, with the front panel data
port acting as a backup only when the management interface is unavailable:

• When the dedicated management interface fails, the front panel data port becomes active as the
management port.

• When the dedicated management interface returns, it becomes the active management port.
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When the management network is undependable, this can lead to switch disconnects. The management
interface selection choice dictates what happens when the management interface returns after a failover.

Controller-1(config)# switch DMF-SWITCH-1
Controller-1(config-switch)#management-interface-selection ?
prefer-current-interface Set management interface selection algorithm
prefer-dedicated-management-interface Set management interface selection
 algorithm (default selection)
Controller-1(config-switch)#

If selecting prefer-dedicated-management-interface (the default), when the dedicated management
interface goes down, the front panel data port becomes the active management port for the switch. When
the dedicated management port comes back up, the dedicated management port becomes the active
management port again, putting the front panel data port in an admin down state.

If selecting prefer-current-interface, when the dedicated management interface goes down, the front
panel data port still becomes the active management port for the switch. However, when the dedicated
management port comes back up, the front panel data port continues to be the active management port.

10.20.6  Switch Fabric Management Redundancy Status

To check the status of all switches configured with dual management as well as the interface that is being
actively used for management, enter the following command in the CLI:

Controller-1# show switch all mgmt-stats

10.20.7  Additional Notes

• A maximum of one data-plane interface on a switch can be configured as a standby
management interface.

• The switch management interface ma1 is a bond interface, having oma1 as the primary link and the data
plane interface as the secondary link.

• The bandwidth of the data-plane interface is limited regardless of the physical speed of the interface.
Arista Networks recommends immediate remediation when the oma1 link fails.

10.21  Controller Lockdown

Controller lockdown mode, when enabled, disallows user configuration such as policy configuration, inline
configuration, and rebooting of fabric components and disables data path event processing. If there is any
change in the data path, it will not be processed.

The primary use case for this feature is a planned management switch upgrade. During a planned
management switch upgrade, DANZ Monitoring Fabric (DMF) switches disconnect from the Controller, and
DMF policies are reprogrammed, disrupting traffic forwarding to tools. Enabling this feature before starting a
management switch upgrade will not disrupt the existing DMF policies when DMF switches disconnect from
the Controller, thereby forwarding traffic to the tools.

Note:  DMF policies are reprogrammed when the switches reconnect to the DMF fabric when
Controller lockdown mode is disabled after the management switch upgrade is completed. Controller
lockdown mode is a special operation and should not be enabled for a prolonged period.

• Operations such as switch reboot, Controller reboot, Controller failover, Controller upgrade, policy
configuration, etc., are disabled when Controller lockdown mode is enabled.

• The command to enable Controller lockdown mode, system control-plane-lockdown enable,
is not saved to the running config. Hence, Controller lockdown mode is disabled after Controller power
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down/up. When failover happens with a redundant Controller configured, the new active Controller will be
in Controller lockdown mode but may not have all policy information.

• In Controller lockdown mode, copying the running config to a snapshot will not include the system
control-plane-lockdown enable command.

• The CLI prompt will start with the prefix LOCKDOWN when this feature is enabled.
• Link up/down and other events during Controller lockdown mode are processed after Controller lockdown

mode is disabled.
• All the events handled by the switch are processed in Controller lockdown mode. For example, traffic is

hashed to other members automatically in Controller lockdown mode if one LAG member fails. Likewise,
all switch-handled events related to inline are processed in Controller lockdown mode.

Use the below commands to enable Controller lockdown mode. Only an admin user can enable or disable
this feature.

Controller# configure
Controller(config)# system control-plane-lockdown enable
Enabling control-plane-lockdown may cause service interruption. Do you want to
 continue ("y" or "yes
" to continue):yes
LOCKDOWN Controller(config)#

To disable Controller lockdown mode, use the command below:

LOCKDOWN Controller(config)# system control-plane-lockdown disable
Disabling control-plane-lockdown will bring the fabric to normal operation.
 This may cause some
service interruption during the transition. Do you want to continue ("y" or
 "yes" to continue):
yes
Controller(config)#

10.22  CPU Queue Stats and Debug Counters

SwitchLight OS (SWL) switches can now report their CPU queue statistics and debug counters. To view these
statistics, use the DANZ Monitoring Fabric (DMF) Controller CLI. DMF exports the statistics to any connected
DMF Analytics Node.

The CPU queue statistics provide visibility into the different queues that the switch uses to prioritize packets
needing to be processed by the CPU. Higher-priority traffic is assigned to higher-priority queues.

The SWL debug counters, while not strictly limited to packet processing, include information related to the
Packet-In Multiplexing Unit (PIMU). The PIMU performs software-based rate limiting and acts as a second
layer of protection for the CPU, allowing the switch to prioritize specific traffic.

Note:  The feature runs on all SWL switches supported by DMF.

Configuration

These statistics are collected automatically and do not require any additional configuration to enable.

To export statistics, configure a DMF Analytics Node. Please refer to the DMF User Guide for help configuring
an Analytics Node.

Show Commands

Showing the CPU Queue Statistics
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The following command shows the statistics for the CPU queues on a single switch.

controller-1> show switch FILTER-SWITCH-1 queue cpu
# Switch            OF Port Queue ID Type      Tx Packets Tx Bytes  Tx Drops Usage             
-|-----------------|-------|--------|---------|----------|---------|--------|---------------------------------|
1 FILTER-SWITCH-1   local   0        multicast 830886     164100990 0        lldp, l3-delivery-arp, tunnel-arp
2 FILTER-SWITCH-1   local   1        multicast 0          0         0        l3-filter-arp, analytics
3 FILTER-SWITCH-1   local   2        multicast 0          0         0
4 FILTER-SWITCH-1   local   3        multicast 0          0         0
5 FILTER-SWITCH-1   local   4        multicast 0          0         0        sflow
6 FILTER-SWITCH-1   local   5        multicast 0          0         0
7 FILTER-SWITCH-1   local   6        multicast 0          0         0        l3-filter-icmp

There are a few things to note about this output:

• The CPU's logical port is also known as the local port.
• The counter values shown are based on the last time the statistics were cleared.
• Different CPU queues may be used for various types of traffic. The Usage column displays the traffic that

an individual queue is handling. Not every CPU queue is used.

The details token can be added to view more information. This includes the absolute (or raw) counter
values, the last updated time, and the last cleared time.

Showing the Debug Counters

The following command shows all of the debug counters for a single switch:

controller-1> show switch FILTER-SWITCH-1 debug-counters 
#  Switch            Name                            Value   Description 
--|-----------------|-------------------------------|-------|-------------------------------------------|
1  FILTER-SWITCH-1   arpra.total_in_packets          1183182 Packet-ins recv'd by arpra
2  FILTER-SWITCH-1   debug_counter.register          79      Number of calls to debug_counter_register
3  FILTER-SWITCH-1   debug_counter.unregister        21      Number of calls to debug_counter_unregister
4  FILTER-SWITCH-1   pdua.total_pkt_in_cnt           1183182 Packet-ins recv'd by pdua
5  FILTER-SWITCH-1   pimu.hi.drop                    8       Packets dropped
6  FILTER-SWITCH-1   pimu.hi.forward                 1183182 Packets forwarded
7  FILTER-SWITCH-1   pimu.hi.invoke                  1183190 Rate limiter invoked
8  FILTER-SWITCH-1   sflowa.counter_request          9325983 Counter requests polled by sflowa
9  FILTER-SWITCH-1   sflowa.packet_out               7883772 Sflow datagrams sent by sflowa
10 FILTER-SWITCH-1   sflowa.port_features_update     22      Port features updated by sflowa
11 FILTER-SWITCH-1   sflowa.port_status_notification 428     Port status notif's recv'd by sflowa

The counter values shown are based on the last time the statistics were cleared.

Add the name or the ID token and a debug counter name or ID to filter the output.

Add the details token to view more information. This includes the debug counter ID, the absolute (or raw)
counter values, the last updated time, and the last cleared time.

Clear Commands

Clearing the Debug Counters

The following command will clear all of the debug counters for a single switch:

controller-1# clear statistics debug-counters

Clearing all Statistics

To clear both the CPU queue stats and the debug counters for every switch, use the following command:

controller-1# clear statistics

Note:  This command is not only limited to switches. It will clear any clearable statistics for
every device.

Analytics Export

The following statistics are automatically exported to a connected Analytics Node:
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• CPU queue statistics for every switch.

Note:  This does not include the statistics for queues associated with physical switch interfaces.

• The PIMU-related debug counters. These are debug counters whose name begins with pimu. No other
debug counters are exported.

DMF exports these statistics once every minute.

Note:  The exported CPU queue statistics will include port number -2, which refers to the switch CPU's
logical port.

10.22.1  Troubleshooting

Use the details with the new show commands to provide more information about the statistics. This
information includes timestamps showing statistics collection time and the last time the statistics were cleared.

Use the redis-cli command to query the Redis server on the Analytics Node from the Bash shell on the
DMF Controller to view the statistics successfully exported to the Analytics Node.

The following command queries for the last ten exported debug counters:

redis-cli -h analytics-ip -p 6379 LRANGE switch-debug-counters -10 -1

Likewise, to query for the last ten exported CPU queue stats:

redis-cli -h analytics-ip -p 6379 LRANGE switch-queue-stats -10 -1

10.22.2  Limitations

• Only the CPU queue stats are exported to the Analytics Node. Physical interface queue stats are
not exported.

• Only the PIMU-related debug counters are exported to the Analytics Node. No other debug counters
are exported.

• Only SWL switches are currently supported. EOS switches are not supported.
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Chapter 11

Advanced Policy Configuration

This chapter describes advanced features and use cases for DANZ Monitoring Fabric (DMF) policies.

11.1  Advanced Match Rules

Optional parameters of a match rule (such as src-ip, dst-ip, src-port, dst-port) must be listed in a specific
order. To determine the permitted order for optional keywords, use the tab key to display completion options.
Keywords in a match rule not entered in the correct order results in the following message:

Error: Unexpected additional arguments ...

11.1.1  Match Fields and Criteria

The following summarizes the different match criteria available:

• src-ip, dst-ip, src-mac, and dst-mac are maskable. If the mask for src-ip, dst-ip, src-mac, or dst-mac is
not specified, it is assumed to be an exact match.

• For src-ip and dst-ip, the mask can be specified in either CIDR notation (for example, /24) or dotted-
decimal notation (255.255.255.0).

• For src-ip and dst-ip, the mask must be contiguous. For example, a mask of 255.0.0.255 or 0.0.255.255
is not supported.

• For tcp, the tcp-flags option lets you match on the following TCP flags: URG, ACK, PSH, RST, SYN, and
FIN.

The following match combinations are not allowed in the same match rule in the same DMF policy.

• src-ip-range and dst-ip-range
• src-ip address group and dst-ip address group
• ip-range and ip address group

You can match on user-defined L3/L4 offsets instead of matching on these criteria. However, you cannot use
both matching packet methods in the same DANZ Monitoring Fabric (DMF). Switching between these match
modes may cause policies defined under the previous mode to fail.

Apply match rules to the following fields in the packet header:

dscp-value Match on DSCP value. Value range is 0..63
dst-ip Match dst ip
dst-port Match dst port
is-fragment Match if the packet is IP fragmented
is-not-fragment Match if the packet is not IP fragmented
l3-offset Match on l3 offset
l4-offset Match on l4 offset
range-dst-ip Match dst-ip range
range-dst-port Match dst port ramge
range-src-ip Match src-ip range
range-src-port Match src port range
src-ip Match src ip
src-port Match src port
untagged Untagged (no vlan tag)
vlan-id Match vlan-id
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vlan-id-range Match vlan-id range
<ip-proto> IP Protocol

Warning:  Matching on untagged packets cannot be applied to DMF policies when in push-per-policy
mode.

DMF uses a logical AND if a policy match rule has multiple fields. For example, the following rule matches if
the packet has src-ip 1.1.1.1 AND dst-ip 2.2.2.2:

1 match ip src-ip 1.1.1.1 255.255.255.255 dst-ip 2.2.2.2 255.255.255.255

DMF uses a logical OR when configuring two different match rules. For example, the following matches if the
packet has src-ip 1.1.1.1 OR dst-ip 2.2.2.2:

1 match ip src-ip 1.1.1.1 255.255.255.255
2 match ip dst-ip 2.2.2.2 255.255.255.255

A match rule with the any keyword matches all traffic entering the filter interfaces in a policy:

controller-1(config)# policy dmf-policy-1
controller-1(config-policy)# 10 match any

The following commands match on the TCP SYN and SYN ACK flags:

1 match tcp tcp-flags 2 2
2 match tcp tcp-flags 18 18

Note:  In the DMF GUI, when configuring a match on TCP flags, the current GUI workflow also sets
the hex value of the TCP flags for the mask attribute. If you have configured a different value for
the tcp-flags and tcp-flags-mask attributes in a rule via the DMF CLI, editing the rule in the GUI will
override the tcp-flags-mask.

11.1.2  Match-except Rules

The following summarizes match-except rules with examples which allow a policy to permit packets that meet
the match criteria, except packets that match the value specified using the except command.

• Match-except only supports IPv4 source-IP and IPv4 destination-IP match fields.

• Example - Permit src-ip network, except ip-address:

1 match ip src-ip 172.16.0.0/16 except-src-ip 172.16.0.1 

• Example - Permit dst-ip network, except subnet

1 match ip dst-ip 172.16.0.0/16 except-dst-ip 172.16.128.0/17

• In a rule, the except condition can only be used with either src-ip or dst-ip, but not with src-ip and dst-ip
together.

• Example - Except being used with src-ip:

1 match icmp src-ip 172.16.0.0/16 except-src-ip 172.16.0.1 dst-ip
 172.16.0.0/16

• Example - Except being used with dst-ip:

1 match icmp src-ip 224.248.0.0/24 dst-ip 172.16.0.0/16 except-dst-ip
 172.16.0.0/18

• Except-src-ip or except-dst-ip can only be used after a match for src-ip or dst-ip, respectively.
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• Example - Incorrect match rule:

1 match icmp except-src-ip 192.168.1.10 

• Example - Correct match rule:

1 match icmp src-ip 192.168.1.0/24 except-src-ip 192.168.1.10

• In a match rule, only one IP address, or one subnet (range of IP addresses) can be used with the except
command.

• Example - Deny a subnet:

1 match ip dst-ip 172.16.0.0/16 except-dst-ip 172.16.0.0/18

• Example - Deny an IP Address:

1 match ip dst-ip 172.16.0.0/16 except-dst-ip 172.16.0.1

11.1.3  Matching with IPv6 Addresses

The value of the EtherType field determines whether the src-ip field to match is IPv4 or IPv6. The DANZ
Monitoring Fabric (DMF) Controller displays an error if there is a mismatch between the EtherType and the IP
address format.

DMF supports IPv6 address/mask matching, either on src-IP or dst-IP. Optionally, UDP/TCP ports can be
used with the IPv6 address/mask match. Specify an address/mask or a group; DMF does not support ranges
for IPv6 addresses.

Note:  Match rules containing both MAC addresses and IPv6 addresses are not accepted and cause a
validation error.

• The preferred IPv6 address representation is as follows: xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx,
where each x is a hexadecimal digit representing 4 bits.

• IPv6 addresses range from 0000:0000:0000:0000:0000:0000:0000:0000 to ffff:ffff:ffff:ffff:ffff:ffff:ffff.

In addition to this preferred format, IPv6 addresses may be specified in two other shortened formats:

• Omit Leading Zeros: Specify IPv6 addresses by omitting leading zeros. For example, write IPv6
address 1050:0000:0000:0000:0005:0600:300c:326b as 1050:0:0:0:5:600:300c:326b.

• Double Colon: Specify IPv6 addresses using double colons (::) instead of a series of zeros. For
example, write IPv6 address ff06:0:0:0:0:0:0:c3 as ff06::c3. Double colons may be used only once in
an IP address.

DMF does not support the IPv4 address embedded in the IPv6 address format. For example, neither
0:0:0:0:0:0:101.45.75.219 nor ::101.45.75.219 can be used.

Both IPv4 and IPv6 masks must be in CIDR format. For example, FFFF:FFFF:FFFF:FFFF:0:0:0:0 is valid in
DMF, but FFFF:0:0:FFFF:FFFF:0:0:0:0 is not a valid mask.

Both the colon-separated hexadecimal representation and the CIDR-style mask format are supported. The
following example shows the correct format for IPv6 addresses and subnet masks:

controller-1(config)# policy dmf-ipv6-policy
controller-1(config-policy)# 10 match ip6 src-ip 2001::0 ffff:ffff:fff
f:ffff:0:0:0:0
controller-1(config-policy)# 11 match ip6 dst-ip 2001:db8:122:344::/64
controller-1(config-policy)# filter-interface all
controller-1(config-policy)# action drop
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11.1.4  Port and VLAN Range Matches

DANZ Monitoring Fabric (DMF) policy supports matching on source and destination port ranges with
optimized hardware resource utilization. DMF uses efficient masking algorithms to minimize the number of
flow entries in hardware for each VLAN range. For example, a VLAN range of 12-99 uses only five flows
in hardware.

Note:  Use the untagged keyword to match traffic without a VLAN tag.

Provide the IP protocol information when using source and destination port ranges, fully supported for IPv4
and IPv6 for TCP and UDP. These keywords have the following options:

• range-dst-ip: Match dst-ip range.
• range-dst-port: Match dst port range.
• range-src-ip: Match src-ip range.
• range-src-port: Match src port range.

Either src-port-range or dst-port-range or both can be specified in each match rule, as shown in the
following example:

controller-1(config)# policy ip-port-range-policy
controller-1(config-policy)# 10 match tcp range-src-port 10 100
controller-1(config-policy)# 15 match udp range-dst-port 300 400
controller-1(config-policy)# 20 match tcp range-src-port 10 2000 range-dst-port
 400 800
controller-1(config-policy)# 30 match tcp6 range-src-port 8 20
controller-1(config-policy)# 40 match tcp6 range-src-ip 1:2:3:4::/64 range-src-
port 10 300
controller-1(config-policy)# filter-interface all
controller-1(config-policy)# delivery-interface all
controller-1(config-policy)# action forward

DMF policy supports matches for the VLAN ID range with optimized hardware resource utilization. Combining
a VLAN ID range with a source or destination port range is supported, but you cannot use all three ranges in
a single match. The following example shows a valid use of the VLAN ID range option:

controller-1(config)# policy vlan-range-policy
controller-1(config-policy)# 10 match mac vlan-id-range 30 400
controller-1(config-policy)# 20 match full ether-type ip protocol 6 vlan-id-
range 1000 3000 srcip 1.
1.1.1 255.255.255.255 src-port-range 100 500

To determine the number of flow entries required for a range, use the optimized-match option, as shown in
the following example:

controller-1(config-policy)# show running-config policy
! policy
policy vlan-range-policy
action forward
delivery-interface TOOL-PORT-1
filter-interface TAP-PORT-1
10 match mac vlan-id-range 12 99
controller-1(config-policy)# show policy vlan-range-policy optimized-match
Optimized Matches :
10 vlan-min 12 vlan-max 15
10 vlan-min 16 vlan-max 31
10 vlan-min 32 vlan-max 63
10 vlan-min 64 vlan-max 95
10 vlan-min 96 vlan-max 99
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11.1.5  User Defined Filters

Up to eight two-byte user-defined offsets are allowed on each switch. To view the currently defined offsets,
select Monitoring > User Defined Offsets.

Note:  The DANZ Monitoring Fabric (DMF) Controller must be in push-per-policy mode for a user-
defined filter to work accurately.

Selecting the User Defined Offsets option when the L3-L4 Offset Match switching mode is not enabled, the
system displays a message to enable the correct match mode.

After enabling the L3-L4 Offset Match mode and selecting Monitoring > User Defined Offsets, DMF
displays a table listing the currently defined offsets.

Note:  Matching on a user-defined offset is not recommended when forwarding traffic to a tunnel,
because some packets may be dropped.

Each offset match has the following four components:

• Anchor: Specified from where the user can define the matching criteria. There are three options: a) L3-
start: Start of layer 3 header. b) L4-start: Start of layer 4 header. c) Packet-start: Start of the packet from
layer 2 header.

• Offset: The number of bytes from the specified anchor.
• Length: The number of matching bytes, either 2 or 4 bytes.
• Value: The matching value of the specified length in hexadecimal, decimal, or IPv4 format.
• Mask: The value that is ANDed with the match value.

Note:  DMF allows users to combine up to four 4-byte user-defined offsets or up to eight 2-byte offsets
to match up to sixteen bytes in the same match condition. In this case, the multiple offset matching
conditions in a single match statement will be considered ANDed. For example, to match on eight
bytes, in a single match condition, define two user-defined offsets and configure two rules in an
AND fashion so that the first rule matches on the first four bytes and the second rule matches on the
remaining four bytes.

Configure each switch with a maximum of eight different offsets matching two bytes each, used in a single
policy or any combination in different policies. In the example below, the policy matches on a value of
0x00001000 at offset 40 from the start of the L3-header and a value of 0x00002000 at offset 64 from the start
of the L4-header.

controller-1(config-policy)# 1 match udp dst-port 2152 l3-offset 40 length 4
 value 0x00001000 mask
0xffffffff l4-offset 64 length 4 value 0x00002000 mask 0xffffffff

Enter the show user-defined-offset command to display the values configured in the user-defined-
offset table.

controller-1# show user-defined-offset
# Switch         Slot Anchor   Offset Length Policy
-|--------------|----|--------|------|------|-------------------------------------------------------|
1 DMF-FILTER-SW1 0    l4-start 64     2      DMF-UDF-TEST-1, _DMF-UDF-TEST-1_o_SAVE-TO-RECORDER-NODE
2 DMF-FILTER-SW1 1    l4-start 66     2      DMF-UDF-TEST-1, _DMF-UDF-TEST-1_o_SAVE-TO-RECORDER-NODE
3 DMF-FILTER-SW1 2    l3-start 40     2      DMF-UDF-TEST-1, _DMF-UDF-TEST-1_o_SAVE-TO-RECORDER-NODE
4 DMF-FILTER-SW1 3    l3-start 42     2      DMF-UDF-TEST-1, _DMF-UDF-TEST-1_o_SAVE-TO-RECORDER-NODE
controller-1#

DMF supports user-defined filtering on Trident 3 switches. The following are the UDF limitations on a Trident 3
switch in comparison to a non-Trident 3 switch:
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UDF Features Non-Trident SWL Switch Trident 3 SWL Switch EOS Switches

Total UDF Length 16 bytes 12 bytes 12 bytes

Minimum Chunk Size 2 bytes 2 bytes 2 bytes

Packet Start (Layer 2 Anchor) 8 offsets 2 offsets 6 offsets

Layer 3 Anchor 8 offsets 6 offsets 6 offsets

Layer 4 Anchor 8 offsets 6 offsets 6 offsets

Layer 2 Offset Range 0 - 126 bytes 0 - 62 bytes 0 - 126 bytes

Layer 3 Offset Range 0 - 114 bytes 0 - 112 bytes 0 - 114 bytes

Layer 4 Offset Range 0 - 96 bytes 0 - 112 bytes 0 - 96 bytes

Note:  Please refer to the DMF Hardware Compatibility List for a complete list of supported switches
and their corresponding Network ASIC types (Trident 3, Trident 2, etc).

11.2  Using the Filter and Delivery Role with MAC Loopback for a Two-stage
Policy

Use the Filter and Delivery role with a MAC (software) loopback to support monitoring as a service. This
option uses a two-stage policy to replicate the incoming feed from one or more filter interfaces and send it to
multiple intermediate interfaces (one per end customer or organization).

Define policies on the intermediate interface for forwarding to customer-specific tools. These intermediate
interfaces must also be assigned the Filter and Delivery role enabled with the MAC loopback option. This
method eliminates the need for a physical loopback cable and a second interface, simplifying monitoring
deployment as a service.

When multiple user-defined policies with overlapping rules select traffic from the same filter interfaces for
forwarding to different delivery interfaces, overlapping policies are automatically generated to replicate the
requisite traffic to the delivery interfaces. The number of overlapping policies increases exponentially with the
number of user-defined policies.

Switch hardware limits limit the total number of policies in the fabric. Using a Filter and Delivery role with a
MAC loopback can also help eliminate scale and operational issues seen with overlapping policies.

To configure an interface with the Filter and Delivery role and enable the MAC (software) loopback option, use
the loopback-mode mac command to assign an unused interface as a loopback. This command enables
the physical interface without requiring a physical connection to the interface. Use a software loopback
interface for copying traffic in any scenario where a physical loopback is required.

The user can also assign the Filter and Delivery role to a software loopback interface, which allows the use of
a single interface for copying traffic to multiple destination interfaces. When assigning this role to an interface
in loopback mode, use the interface as a delivery interface in relation to the original filter interface and as a
filter interface in relation to the final destination interface.
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The following figure illustrates the physical configuration for a switch that uses four software loopback
interfaces to copy traffic from a single filter interface to four different tools:
Figure 11-1: Using Software Loopback Interfaces to Avoid Overlapping Policies

Use this configuration to copy different types of traffic from a single filter interface (F1) to four delivery
interfaces (D1 to D4). Assign the Filter and Delivery role to the software loopback interfaces (LFD1 through
LFD4) using just four physical interfaces. Physical loopbacks would require twice as many interfaces.

Considerations

1. The SFP decides the Mac loopback speed. DMF uses the max port speed if there is no SFP (i.e., an
empty port).

2. The port speed configuration (if any) will not impact the Mac loopback speed. The Mac loopback speed is
set based on the SFP or the max port speed if there is no SFP.

3. The Rate-limit option limits the Mac loopback traffic at Rx side.

Note:  When using a switch with the T2 chip, the 40G port Mac loopback is limited to the 10G speed.

11.2.1  Using the GUI To Configure a Filter and Delivery Interface with MAC Loopback

To configure an interface with the Filter and Delivery role and enable the MAC (software) loopback option in
the GUI, complete the following steps:
1. Display the available interfaces by selecting Fabric > Interfaces.

The system displays the Interfaces page, which lists the interfaces connected to the DANZ Monitoring
Fabric (DMF) fabric.
Figure 11-2: Fabric Interfaces

2. Click the Menu control for the interface you want to use and select Configure from the pull-down menu.
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The system displays the following dialog:
Figure 11-3: Fabric > Interfaces > Edit Interface > Port

3. (Optional) Type a description for the interface.
4. Enable the MAC Loopback Mode slider.
5. Click Next.

Figure 11-4: Fabric > Interfaces > Edit Interface > Traffic
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6. (Optional) Configure Rate Limiting, if required, and click Next.
Figure 11-5: Fabric > Interfaces > Edit Interface > DMF

7. Enable the Filter and Delivery radio button.
You can optionally enable the Rewrite VLAN option.

Note:  The rewrite VLAN ID feature cannot be used with tunneling.

8. Click Save to complete and save the configuration.

11.2.2  Using the CLI To Configure a Filter and Delivery Interface with MAC Loopback

The CLI interface configuration for copying traffic to multiple delivery ports is shown in the following example:

switch DMF-FILTER-SWITCH-1
admin hashed-password
$6$5niT1gPm$Jc24qOMF.hxNPI20DvnKaFZKYD6lIo59IMp3O4xIdwVTu2hx0s8Djpvz9xXAXXndiSkKe5jH.9PKoHHrWviSl0
mac 70:72:cf:dc:99:5c
interface ethernet1
role filter interface-name TAP-PORT-1
interface ethernet13
role delivery interface-name TOOL-PORT-1
interface ethernet15
role delivery interface-name TOOL-PORT-1
interface ethernet17
role delivery interface-name TOOL-PORT-3
interface ethernet19
role delivery interface-name TOOL-PORT-4
interface ethernet25
loopback-mode mac
role both-filter-and-delivery interface-name LOOPBACK-PORT-1
interface ethernet26
loopback-mode mac
role both-filter-and-delivery interface-name LOOPBACK-PORT-2
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interface ethernet27
loopback-mode mac
role both-filter-and-delivery interface-name LOOPBACK-PORT-3
interface ethernet28
loopback-mode mac
role both-filter-and-delivery interface-name LOOPBACK-PORT-4

The following example shows how to use five policies to implement this use case without creating overlapping
policies. Otherwise, sixteen overlapping policies would be created without using the loopback interfaces to
copy the traffic to separate filter interfaces.

! policy
policy TAP-NETWORK-1
action forward
delivery-interface LOOPBACK-PORT-1
delivery-interface LOOPBACK-PORT-2
delivery-interface LOOPBACK-PORT-3
delivery-interface LOOPBACK-PORT-4
filter-interface TAP-PORT-1
1 match any
!
policy DUPLICATED-TRAFFIC-1
action forward
delivery-interface TOOL-PORT-1
filter-interface LOOPBACK-PORT-1
1 match ip src-ip 100.1.1.1 255.255.255.252
!
policy DUPLICATED-TRAFFIC-2
action forward
delivery-interface TOOL-PORT-2
filter-interface LOOPBACK-PORT-2
1 match ip dst-ip 100.1.1.1 255.255.255.252
!
policy DUPLICATED-TRAFFIC-3
action forward
delivery-interface TOOL-PORT-3
filter-interface LOOPBACK-PORT-3
1 match tcp src-port 1234
!
policy DUPLICATED-TRAFFIC-4
action forward
delivery-interface TOOL-PORT-4
filter-interface LOOPBACK-PORT-4
1 match tcp dst-port 80

Use the show policy command to verify the policy configuration.

11.3  Rate Limiting Traffic to Delivery Interfaces

You can limit the traffic rate on a delivery interface, which can be a regular interface, a port channel, a tunnel
interface, or a loopback interface.

For information about using rate limiting on tunnels, refer to the section Using the CLI to Rate Limit the
Packets on a VxLAN Tunnel.

Use kbps to configure the rate-limit for the regular delivery interface. Arista Networks recommends configuring
the rate limit in multiples of 64 kbps.

11.3.1  Rate Limiting Using the GUI

To use the GUI to set the rate limit for an interface, complete the following steps:
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1. Select Fabric > Interfaces.
2. Click the Menu control for a specific interface and select Configure.
3. Click Next or select Traffic to display the Traffic page on the Edit Interface dialog.

Figure 11-6: Setting the Rate Limit for an Interface

4. Enable the Rate Limit checkbox.
5. Use the number spinner to set the number of Kbps traffic limit.
6. Click Save.

11.3.2  Rate Limiting Using the CLI

CLI Procedure

The following example applies a rate limit of 10 Mb/s to the delivery interface tobcotDelivery:

CONTROLLER-1(config)#switch DMF-DELIVERY-SWITCH-1
CONTROLLER-1(config-switch)# interface ethernet1
CONTROLLER-1(config-switch-if)# role delivery interface-name TOOL-PORT-1
CONTROLLER-1(config-switch-if)# rate-limit 10240

To view the configuration, enter the show this command, as in the following example:

CONTROLLER-1(config-switch-if)# show this
! switch
switch DMF-DELIVERY-SWITCH-1
!
interface ethernet1
rate-limit 10000
role delivery interface-name TOOL-PORT-1
CONTROLLER-1 (config-switch-if)#

Configure the rate limit for each member interface to rate limit a port channel. Configure individual rate limits
for each member interface if the port channel has two member interfaces.

lag-interface lag1
hash-type l3
member ethernet43
member ethernet45
interface ethernet43
rate-limit 10000 <------ set the rate-limit to 10 Mbps
interface ethernet45
rate-limit 128000 <---------- set the rate-limit to 128 Mbps

To display the configured rate limit, use the show topology and show interface-names commands, as
in the following examples:
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Note:  In the current release, the Rate Limit column does not show the configured value for LAG and
tunnel interfaces.

11.4  Configuring Overlapping Policies

When two or more policies have one or more filter ports in common, the match rules in these policies may
intersect. If the priorities are different, the policy with the higher priority takes effect. However, if the policies
have the same priority, the policies overlap, as illustrated in the figure below:
Figure 11-7: Overlapping Policies

In the policy illustrated, packets received on interface Filter 1 with the source-IP address 10.1.1.x/24 are
delivered to D1. In a separate policy, with the same priority, packets received at Filter 1 with the destination
IP address 20.1.1.y/24 are delivered to D2. With both these policies applied, when a packet arrives at F1
with a source IP address 10.1.1.5/24 and a destination IP address 20.1.1.5/24, the packets are copied and
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forwarded to both D1 and D2. Enabled by default, the DANZ Monitoring Fabric (DMF) policy overlap feature
causes this behavior.

DMF manages overlapping policies automatically by copying packets received on the same filter interface that
match multiple rules but which the policy forwards to different delivery interfaces.

Two policies are said to be overlapping when all of the following conditions are met:

• At least one delivery interface is different.
• At least one filter interface is shared.
• Match rules across policies intersect, which occurs under these conditions:

• The match rules match on the same field, but a different value OR both policies have the same
configured priority (or same default priority).

• The match rules match on completely different fields.

Note:  Automatically created dynamic policies will be visible in the show policy command. However,
they will not be visible in the running config, nor can they get deleted manually.

When overlapping policies are detected, by default, DMF performs the following operations:

• Creates a new dynamic policy that aggregates the policy actions.
• Assigns policy names, using this dynamic policy naming convention: _<policy1>_o_<policy2>_
• Adds match combinations and configuration as appropriate.
• Assigns a slightly higher priority to the new aggregated policy so that it overrules the overlapping policies,

which, as a result, only applies to traffic that does not match the new aggregated policy. An incremental
value of .1 is added to the original policy priority. For example, if the original policies have a priority of 100,
the dynamic policy priority is 101.

Note:  When changing the configurable parameters in an existing DMF out-of-band policy, any
counters associated with the policy, including service-node-managed services counters, are reset
to zero.

The overlap-limit-strict command, enabled by default, strictly limits the number of overlapping
policies to the maximum configured using the overlap-policy-limit command. For example, when
setting the maximum number of overlapping policies to four (the default) and you create a fifth policy using
the same filter interface, the operation fails with a validation error. To disable strict enforcement, use the no
overlap-limit-strict command.

Note:  The overlap-strict-limit command is disabled and must be manually enabled to enforce
configurable policy limits.

11.4.1  Configuring the Policy Overlap Limit Using the GUI

Policy Overlap Limit

Perform the following steps to configure the Policy Overlap Limit.
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1. Control the configuration of this feature using the Edit icon by locating the corresponding card and clicking
on the pencil icon.
Figure 11-8: Policy Overlap Limit

2. A configuration edit dialogue window pops up, displaying the corresponding prompt message. By default,
the Policy Overlap Limit is 4.
Figure 11-9: Edit Policy Overlap Limit

3. Adjust the Value (minimum value: 0, maximum value: 10). There are two ways to adjust the value:

• Directly enter the desired value in the input area.
• Use the up and down arrow buttons in the input area to adjust the value accordingly. Pressing the up

arrow increments the value by 1, while pressing the down arrow decrements it by 1.
4. Click the Submit button to confirm the configuration changes or the Cancel button to discard the changes.
5. After successfully setting the configuration, the current configuration status displays next to the edit button.

Figure 11-10: Policy Overlap Limit Change Success
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11.4.2  Configuring the Overlapping Policy Limit Using the CLI

By default, the number of overlapping policies allowed is four. The maximum number that you can configure
for overlapping policies is ten. Set the overlap policy limit to zero to disable the overlapping policy feature.

To change the default limit for overlapping policies, use the following command:

controller-1(config)# overlap-policy-limit integer

Replace integer with the maximum number of overlapping policies to support fabric-wide.

For example, the following command sets the number of overlapping policies supported to the maximum
value (10):

controller-1(config)# overlap-policy-limit 10

The following command disables the overlapping policies feature:

controller-1(config)# overlap-policy-limit 0

Note:  If you set the Policy Overlap Limit to zero, ensure the policies do not overlap. If active policies
overlap after disabling this feature, the forwarding result may be unpredictable.

11.4.3  Using the CLI to View Overlapping Policies

Enter the show policy command to view statistics for dynamic (overlapping) policies. If an overlapping
policy appears in the output, the parent policies are identified, as in the following example:
controller-1(config-policy)# show policy
# Policy Name Config Status         Runtime Status Action  Type       Priority Overlap Priority Rewrite VLAN Filter BW Delivery BW Services
-|-----------|---------------------|--------------|-------|----------|--------|----------------|------------|---------|-----------|--------|
1 _p2_o_p1    active and forwarding installed      forward Dynamic    100      1                0            -         -
2 p1          active and forwarding installed      forward Configured 100      0                0            -         -
3 p2          active and forwarding installed      forward Configured 100      0                0            -         -

In this example:

• show overlap _P1_O_P2, lists component policies: source P1, P2.
• show P1, lists dynamic policies: overlap _P1_O_P2.

To view the details for a specific overlapping policy, append the policy name to the show policy command,
as in the following example:
controller-1(config-policy)# show policy _p1_o_p2
Policy Name : _p1_o_p2
Config Status : active and forwarding
Runtime Status : installed
Detailed Status : installed - installed to forward
Action : forward
Priority : 100
Overlap Priority : 1
Description : runtime policy
# of switches with filter interfaces : 1
# of switches with delivery interfaces : 1
# of switches with service interfaces : 0
# of filter interfaces : 1
# of delivery interfaces : 2
# of core interfaces : 4
# of services : 0
# of pre service interfaces : 0
# of post service interfaces : 0
Rewrite VLAN : 0
Total Ingress Rate : -
Total Delivery Rate : -
Total Pre Service Rate : -
Total Post Service Rate : -
Overlapping Policies : none
Component Policies : p2, p1,
Failed Overlap Policy Exceeding Max Rules :
Rewrite valid? : False
Service Names :
Overlap Matches :
1 ether-type 2048 src-ip 10.1.1.1 255.255.255.0 dst-ip 20.1.1.1 255.255.255.0
Strip VLAN : False
Delivery Bandwidth : 20 Gbps
explicitly-scheduled : False
Filter Bandwidth : 10 Gbps
Type : Dynamic
~ Match Rules ~
None.
~~~~~~~~~~~~~~~~~~~~~~~~~~~ Filter Interface(s) ~~~~~~~~~~~~~~~~~~~~~~~~~~~
# IF Switch IF Name State Dir Packets Bytes Pkt Rate Bit Rate
-|---------|-----------|--------|-----|---|-------|-----|--------|--------|
1 f1 filter-sw-1 s11-eth1 up rx 0 0 0 -
~~~~~~~~~~~~~~~~~~~~~~~~~~ Delivery Interface(s) ~~~~~~~~~~~~~~~~~~~~~~~~~~
# IF Switch IF Name State Dir Packets Bytes Pkt Rate Bit Rate
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-|---------|-----------|--------|-----|---|-------|-----|--------|--------|
1 d1 filter-sw-2 s12-eth1 up tx 0 0 0 -
2 d2 filter-sw-2 s12-eth2 up tx 0 0 0 -
~ Service(s) ~
None.
~~~~~~~~~~~~~~~~~~~~~~~ Core Interface(s) ~~~~~~~~~~~~~~~~~~~~~~~
# Switch IF State Dir Packets Bytes Pkt Rate Bit Rate
-|-----------|--------|-----|---|-------|-----|--------|--------|
1 filter-sw-1 s11-eth3 up tx 0 0 0 -
2 core-sw-2 s10-eth1 up rx 0 0 0 -
3 core-sw-2 s10-eth2 up tx 0 0 0 -
~ Failed Path(s) ~
None.
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Event History ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# Time Event Detail
-|-------------------|---------------------|-------------------------------------------|
1 2014-08-05 22:22:27 start forward pending installation - installed to forward
2 2014-08-05 22:22:27 installation complete installed - installed to forward

11.4.4  Configuring the Policy Overlap Limit Strict using the GUI

The Policy Overlap Limit Strict option, enabled by default, strictly limits the number of overlapping policies to
the maximum configured. For example, when setting the maximum number of overlapping policies to 4 (the
default) and users create a fifth policy using the same filter interface, the operation fails with a validation error.

From the DANZ Monitoring Fabric (DMF) Features page, proceed to the Configuring the Policy Overlap Limit
Strict feature card.
1. Select the Policy Overlap Limit Strict card.

Note:  The Policy Overlap Limit Strict option is enabled by default. The following steps guide if the
Policy Overlap Limit Strict option is disabled.

Figure 11-11: Policy Overlap Limit Strict Disabled

2. Toggle the Policy Overlap Limit Strict switch to On.
3. Confirm the activation by clicking Enable or Cancel to return to the DMF Features page.

Figure 11-12: Enable Policy Overlap Limit Strict

4. Retain Configuring the Policy Overlap Limit Strict is running.
Figure 11-13: Policy Overlap Limit Strict Enabled
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5. To disable the feature, toggle the Policy Overlap Limit Strict switch to Off. Click Disable and confirm.
Figure 11-14: Disable Policy Overlap Limit Strict

The feature card updates with the status.
Figure 11-15: Policy Overlap Limit Strict Disabled

11.4.5  Configuring the Policy Overlap Limit Strict using the CLI

The Policy Overlap Limit Strict option, enabled by default, strictly limits the number of overlapping policies to
the maximum configured. For example, when setting the maximum number of overlapping policies to 4 (the
default) and users create a fifth policy using the same filter interface, the operation fails with a validation error.

Use the following commands to disable or enable the Policy Overlap Limit Strict feature using the CLI.

controller-1(config)# no overlap-limit-strict

controller-1(config)# overlap-limit-strict

11.4.6  Exclude Inactive Policies from Overlap Limit Calculation

Previously, DANZ Monitoring Fabric (DMF) calculated the overlap policy limit by determining how many
policies use the same filter interface, irrespective of whether the policies are active or inactive. By default, the
overlap policy limit is 4, and the maximum is 10.

Suppose the limit is 4, and a user attempts to create a 5th policy using the same filter interface (f1). DMF
throws the following error message: Error: Validation failed: Filter interfaces used in
more than 4 policies: f1.

This count will include filter interfaces used in active or inactive policies.

The DMF 8.5 policy overlap calculation excludes inactive policies when using the inactive command in
policy configuration. For example, using the same policy limit settings described above, DMF 8.5 supports
creating a 5th policy using the same filter interface (f1) by first putting the 5th policy in an inactive state using
the inactive command under policy configuration.

Note:  This feature applies to switches running SWL OS and EOS.

Global Configuration Example

1. Select a switch and enter the config mode using the following command:

(config)# switch core1
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2. Select an interface on the switch used as the filter-interface, as shown in the following example.

(config-switch)# interface ethernet1

3. Create a filter interface, for example, f1, using the following command:

(config-switch-if)# role filter interface-name f1

4. Repeat the process to create the delivery interfaces.

(config-switch)# interface ethernet2
(config-switch-if)# role delivery interface-name d1
(config-switch)# interface ethernet3
(config-switch-if)# role delivery interface-name d2
(config-switch)# interface ethernet4
(config-switch-if)# role delivery interface-name d3

5. Set a max overlap-policy-limit value, for example, 2.

(config-switch)# overlap-policy-limit 2

6. Create overlap policies using the same filter-interface, in this example, f1.

(config-switch)# policy p1
(config-policy)# filter-interface f1
(config-policy)# delivery-interface d1
(config-policy)# action forward 
(config-policy)# 1 match any 
            
(config-switch)# policy p2
(config-policy)# filter-interface f1
(config-policy)# delivery-interface d2
(config-policy)# action forward 
(config-policy)# 1 match any

7. Since the overlap-policy-limit value is 2, the third overlap policy will not allow the use of the same
filter interface f1 in the third policy, p3. DMF throws a validation error.

(config-switch)# policy p3
(config-policy)# delivery-interface d3
(config-policy)# action forward 
(config-policy)# filter-interface f1
Error: Validation failed: Filter interfaces used in more than 2 policies: f1

Show Commands

The following command example displays the configured policies listing two overlap policies _p1_o_p2.

(config-policy)# show policy
# Policy Name Action  Runtime Status               Type       Priority Overlap Priority Push VLAN Filter BW (truncated...) 
-|-----------|-------|----------------------------|----------|--------|----------------|---------|--------- (truncated...)
1 _p1_o_p2    forward A component policy failed    Dynamic    100      1                3         10Gbps    (truncated...) 
2 p1          forward all delivery interfaces down Configured 100      0                1         10Gbps    (truncated...)
3 p2          forward all delivery interfaces down Configured 100      0                2         10Gbps    (truncated...)
4 p3          forward inactive                     Configured 100      0                4         -         (truncated...)

To add filter interface f1 to the third overlap policy, p3, set the policy to inactive.

(config-switch)# policy p3
(config-policy)# inactive
(config-policy)# filter-interface f1
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This results in an inactive policy p3 being configured with filter interface f1. Use the show running-config
policy command to view the status.

(config-policy)# show running-config policy 
! policy
policy p1
action forward
delivery-interface d1
filter-interface f1
1 match any
                
policy p2
action forward
delivery-interface d2
filter-interface f1
1 match any
                
policy p3
action forward
delivery-interface d3
filter-interface f1
inactive
1 match any

11.5  Viewing Information about Policies

Installing and activating overlapping policies may take more than a minute, depending on the number of
overlapping policies and the number of rules in each policy.

11.5.1  Viewing Policy Flows

The show policy-flow command lists all the flows installed by the DANZ Monitoring Fabric (DMF)
application on the switches in the monitoring fabric. The following is the command syntax:

show policy-flow policy_name

Flows are sorted on a per-policy basis. Each flow entry includes the configured policy name. The packet and
byte count is associated with each flow entry, as shown in the following example:
controller-1# show policy-flow _P1_o_P2
# Policy Name Switch                                          Pkts Bytes Pri  T Match   Instructions
1 _P1_o_P2    DMF-CORE-SWITCH-1 (00:00:cc:37:ab:a0:90:71)     0    0     6401 1 in-port 16,vlan-vid 7 apply: name=_P1_o_P2 output: max-length=65535, port=15
2 _P1_o_P2    DMF-CORE-SWITCH-1 (00:00:cc:37:ab:a0:90:71)     0    0     6401 1 in-port 16,eth-type ipv6,vlan-vid 7 apply: name=_P1_o_P2 output: max-length=65
535, port=15
3 _P1_o_P2    DMF-DELIVERY-SWITCH-1 (00:00:cc:37:ab:60:d4:74) 0    0     6401 1 in-port 49,eth-type ipv6,vlan-vid 7 apply: name=_P1_o_P2 output: max-length=65
535, port=15,output: max-length=65535, port=1
4 _P1_o_P2    DMF-DELIVERY-SWITCH-1 (00:00:cc:37:ab:60:d4:74) 0    0     6401 1 in-port 49,vlan-vid 7 apply: name=_P1_o_P2 output: max-length=65535,
 port=15,output: max-length=65535, port=1
--------------------------------------------------------------------------------------output truncated--------------------------------------------------

11.5.2  Viewing Packets Dropped by Policies

The drops option displays the current value of the transmit drop packet counters at the filter, delivery, and
core interfaces for the specified policy, as shown in the following example:
controller-1# show policy p1 drops
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Filter Interface(s) Drops ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# IF  Switch IF               Name     state speed   Xmit Drops Pkt Count Xmit Drops Pkt Rate Rx Drops Pkt Count Rx Drops Pkt Rate
-|---|-----------------------|--------|-----|-------|--------------------|-------------------|------------------|-----------------|
1 f1  00:00:00:00:00:00:00:0c s12-eth1 up    10 Gbps 0                    0                   0                  0
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Delivery Interface(s) Drops ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# IF  Switch IF               Name     state speed   Xmit Drops Pkt Count Xmit Drops Pkt Rate Rx Drops Pkt Count Rx Drops Pkt Rate
-|---|-----------------------|--------|-----|-------|--------------------|-------------------|------------------|-----------------|
1 d1  00:00:00:00:00:00:00:0c s12-eth2 up    10 Gbps 0                    0                   0                  0
~ Core Interface(s) Drops ~
None.
~ Service Interface(s) Drops ~
None.
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11.6  Using Rule Groups

DANZ Monitoring Fabric (DMF) supports using an IP address group in multiple policies, referring to the group
by name in match rules. If no subnet mask is provided in the address group, it is assumed to be an exact
match. For example, for an IPv4 address group, no mask is interpreted as a mask of /32. For an IPv6 address
group, no mask is interpreted as /128.

You can identify only a single IP address group for a specific policy match rule. Address lists with both src-ip
and dst-ip options cannot be used in the same match rule.

11.6.1  Using the GUI to Configure Rule Groups

To create an interface group from the Monitoring > Interfaces table, complete the following steps:

1. Select the Monitoring > Rule Groups option.
Figure 11-16: Creating Rule Groups

2. On the Rule Groups table, click on the + sign to create a new rule group.
3. In the pop-up menu, enter a preferred name for the rule group and, optionally, a description.

Figure 11-17: Creating Rule Groups: Enter a Rule Group Name and Description

4. Click NEXT to add specific rules to the rule group.
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5. In this pop-up section, add predefined rules by clicking on the options provided. In the example below, add
a rule to match all IPv4 traffic by clicking on IPv4.
Figure 11-18: Creating Rule Groups: Add a Predefined Rule to the Rule Group

6. As an alternative to the previous step, add custom rules by clicking the + sign under Rules and adding the
necessary fields in the new pop-up screen.
Figure 11-19: Creating Rule Groups: Add Custom Rules to the Rule Group

7. Complete the dialog that appears to assign a descriptive name to the rule group.
8. Add this rule group to DANZ Monitoring Fabric (DMF) policies as a match condition.
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11.6.2  Using the CLI to Configure Interface Groups

The following example shows how to configure two interface groups: a filter interface group, TAP-PORT-GRP,
and a delivery interface group, TOOL-PORT-GRP.

controller-1(config-switch)# filter-interface-group TAP-PORT-GRP
controller-1(config-filter-interface-group)# filter-interface TAP-PORT-1
controller-1(config-filter-interface-group)# filter-interface TAP-PORT-2
controller-1(config-switch)# delivery-interface-group TOOL-PORT-GRP
controller-1(config-delivery-interface-group)# delivery-interface TOOL-PORT-1
controller-1(config-delivery-interface-group)# delivery-interface TOOL-PORT-2

To view information about the interface groups in the DANZ Monitoring Fabric (DMF) fabric, enter the show
filter-interface-group command, as in the following examples:

• Filter Interface Groups

controller-1(config-filter-interface-group)# show filter-interface-group
! show filter-interface-group TAP-PORT-GRP
# Name Big Tap IF Name                    Switch            IF Name    Direction Speed   State VLAN Tag
-|------------|--------------------------|-----------------|----------|---------|-------|-----|--------|
1 TAP-PORT-GRP TAP-PORT-1                 DMF-CORE-SWITCH-1 ethernet17 rx        100Gbps up           0
2 TAP-PORT-GRP TAP-PORT-2                 DMF-CORE-SWITCH-1 ethernet18 rx        100Gbps up           0
controller1(config-filter-interface-group)#

• Delivery Interface Groups

controller1(config-filter-interface-group)# show delivery-interface-group
! show delivery-interface-group DELIVERY-PORT-GRP
# Name Big Tap      IF Name         Switch                IF Name    Direction Speed  Ratelimit State Strip Forwarding Vlan
-|-----------------|---------------|---------------------|----------|---------|------|---------|-----|---------------------|
1 TOOL-PORT-GRP     TOOL-PORT-1     DMF-DELIVERY-SWITCH-1 ethernet15 tx        10Gbps           up    True
2 TOOL-PORT-GRP     TOOL-PORT-2     DMF-DELIVERY-SWITCH-1 ethernet16 tx        10Gbps           up    True
controller-1(config-filter-interface-group)#

11.7  PTP Timestamping

DANZ Monitoring Fabric (DMF) rewrites the source MAC address of packets that match a policy with a 48-bit
timestamp value sourced from a high-precision hardware clock.

• Connect a switch with a filter interface to a PTP network with a dedicated interface for the Precision Time
Protocol. With a valid PTP interface, the switch will be configured in boundary clock mode and can sync
the hardware clock with an available Grandmaster clock.

• Once configuring a policy to use timestamping, any packet matching on this policy will get its source MAC
address rewritten with a timestamp value. The same holds true for any overlapping policy that carries
traffic belonging to a user policy with timestamp enabled.

• The following options are available to configure a switch in boundary mode:

• domain: Value for data plane PTP domain (0-255) (optional)
• Priority1: Value of priority1 data plane PTP (0-255) (optional)
• Source IPv4 Address: Used to restamp PTP messages from a switch to the endpoints (optional)
• Source IPv6 Address: Used to restamp PTP messages from a switch to the endpoints (optional)

• The following options are available to configure an interface with role “ptp”:

• Announce Interval: Set ptp announce interval between messages (-3,4). Default is 1 (optional)
• Delay Request Interval: Set ptp delay request interval between messages (-7,8). The default is 5

(optional)
• Sync Message Interval: Set ptp sync message interval between messages (-7,3). The default is 0

(optional)
• PTP Vlan: VLANs used for Trunk or Access mode of operation for a ptp interface

• A policy should have enabled timestamping and have its filter interfaces on a switch with a valid PTP
config to get its packets timestamped.
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11.7.1  Platform Compatibility

DANZ Monitoring Fabric (DMF) supports the timestamping feature on 7280R3 switches.

Use the show switch all property command to check which switch in DMF fabric supports
timestamping. If the following properties exist in the output, the feature is supported:

• ptp-timestamp-cap-replace-smac
• ptp-timestamp-cap-header-48bit
• ptp-timestamp-cap-flow-based

# show switch all property
# Switch                        ...   PTP Timestamp Supported Capabilities  
-|----------------------------| ...  |-------------------------------------|
1 S1 (00:00:2c:dd:e9:96:2b:ff)  ...   ptp-timestamp-cap-replace-smac,
                                ...   ptp-timestamp-cap-header-64bit, 
                                ...   ptp-timestamp-cap-header-48bit,
                                ...   ptp-timestamp-cap-flow-based, 
                                ...   ptp-timestamp-cap-add-header-after-l2 
2 S2 (00:00:cc:1a:a3:91:a7:6c)  ...   
2 S3 (00:00:cc:1a:a3:c0:94:3e)  ...                        

Note:  The CLI output example above is truncated for illustrative purposes. The actual output
will differ.

11.7.2  Configuration

The following three sections describe the configuration for PTP and timestamping:

• PTP Switch Configuration
• PTP Interface Configuration
• Policy Configuration for Timestamping

Note:  Configuring the PTP domain for the distribution of PTP-based time sync in the network is
beyond the scope of this document. The assumption is the network exists with a PTP domain and all
necessary components.

11.7.3  Configuring PTP Timestamping using the CLI

Configure the switch at a global level under the config submode in the CLI or for each switch under the
config-switch submode. Irrespective of the place, it has the following options:

1. Domain: Set the data plane PTP domain. The default value is 0. Valid values are [0 to 255] inclusive.
2. Priority1: Set the value of priority1 data plane PTP. The default value is 128. Valid values are [0 to 255]

inclusive.
3. Source-ipv4-address: This is the source IPv4 address used to restamp PTP messages from this

switch to the endpoints. Some master clock devices do not accept default source IP (0.0.0.0). If so,
configure it can to sync with such devices. The default is 0.0.0.0 .

4. Source-ipv6-address: This is the source IPv6 address used to restamp PTP messages from this
switch to the endpoints. Some master clock devices do not accept default source IP (::/0). If so, configure it
to sync with such devices. The default is ::/0 .

All fields are optional, and default values are selected if not configured by the user.

Global Configuration
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The global configuration is a central place to provide a common switch config for PTP. It only takes effect after
creating a ptp-interface for a switch. Under the config submode, provide PTP switch properties using the
following commands:

> enable
# config
(config)# ptp priority1 0 domain 1 source-ipv4-address 1.1.1.1
        

Local Configuration

The local configuration provides a local PTP configuration or overrides a global PTP config for a selected
switch. Select the switch using the command switch switch name. PTP switch config (local or global) only
takes effect after creating a ptp-interface for a switch. Under the config-switch submode, provide local
PTP switch properties using the following commands:

(config)# switch eos
(config-switch)# ptp priority1 1 domain 2

11.7.4  Configuring PTP Timestamping using the GUI

Global Configuration

To view or edit the global PTP configuration, navigate to the DANZ Monitoring Fabric (DMF) Features page by
clicking the gear icon.
Figure 11-20: DMF Menu Gear Icon

The DMF Feature page is new in DMF release 8.4. It provides fabric-wide settings management for DMF.
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Scroll to the PTP Timestamping card and click the edit button (pencil icon) to configure or modify the global
PTP Timestamping settings.
Figure 11-21: DMF Features Page

Figure 11-22: Edit PTP

Local Configuration
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Provide a local PTP configuration for the switch or override the global PTP configuration for a selected switch
while configuring or editing a switch configuration (under the PTP step) using the Monitoring > Switches
page.
Figure 11-23: Configure Switch

PTP Interface Configuration

Configure a PTP Interface on the Monitoring > Interfaces page.
Figure 11-24: Create Interface

Timestamping Policy Configuration

386



Advanced Policy Configuration

DMF supports flow-based timestamping. This function requires programming a policy to match relevant traffic
and enable timestamping for the matched traffic. In the Create/Edit Policy workflow (on the Monitoring >
Policies page), use the PTP Timestamping toggle to enable or disable timestamping.
Figure 11-25: Create Timestamping Policy

11.7.5  PTP Interface Configuration

A switch that syncs its hardware clock using PTP requires a physical front panel interface configured as a
PTP interface. This interface is solely responsible for communication with the master clock and has no other
purpose.

To configure the PTP interface, select an interface on the switch, as illustrated in the following command.

(config-switch)#  interface Ethernet6/1

Use the role command to assign a ptp role and interface name and select switchport-mode for the
specified interface.

(config-switch-if)# role ptp interface-name ptp1 access-mode announce-interval
 1 delay-request-interval 1 sync-message-interval 1

A switchport is required to configure a PTP interface. The options for switchport mode are:

• trunk-mode
• access-mode
• routed-mode

The switchport mode configuration for a PTP interface is necessary to match the PTP master switch's
interface configuration. Configure the master switch to communicate PTP messages with or without a
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vlan tag. Use the trunk-mode with the appropriate ptp vlan when configuring the neighbor similarly. If the
neighbor's interface is in switch-port access mode or routed mode, use either of these to match it on the
filter switch.

Other fields are optional, using default values when no configuration is provided.

Optional fields:

• announce-interval: Set PTP to announce interval between messages [-3,4]. The default value is 1.
• delay-request-interval: Set PTP delay request interval between messages [-7,8]. The default value is 5.
• sync-message-interval: Set PTP sync message interval between messages (-7,3). The default value is 0.

Depending on the switchport mode selected for this interface, you can provide VLANs that will be associated
with the selected ptp-interface using the following commands:

(config-switch-if)# ptp vlan 1
(config-switch-if)# ptp vlan 2

In routed switchport mode, we ignore the configured VLANs. In access switchport mode, the first VLAN
is used for programming while ignoring the rest. In trunk switchport mode, all configured VLANs are
programmed into the switch.

11.7.6  Policy Configuration for Timestamping

DANZ Monitoring Fabric (DMF) supports flow-based timestamping. This function requires programming a
policy to match relevant traffic and enable timestamping for the matched traffic.

Create a policy using the command policy policy name.

Under config-policy submode, enable timestamping using the following command:

(config-policy)# use-timestamping

11.7.7  L2GRE Encapsulation of Packets with Arista Timestamp Headers

L2GRE encapsulation of packets with Arista timestamp headers is an extension of an existing feature
allowing DANZ Monitoring Fabric (DMF) to use intra-fabric L2GRE tunnels.

These tunnels enable forwarding unmodified production network packets over intermediate L3 networks used
by DMF, which can now forward packets with Arista Networks Timestamp headers across L2GRE tunnels
defined on EOS switches.

When a PTP header-based timestamping capable filter switch is in a remote location, and the remote
filter switches connect to the centralized tool farm via L2GRE tunnels, timestamp the packets using PTP
timestamping. These packets are encapsulated in an L2GRE header and sent to the core switch via the
L2GRE tunnel. The timestamped packets will properly decapsulate at the remote end and be forwarded to the
destination tools.

Note:  DMF only supports PTP timestamping with L2GRE encapsulation with the header-based
timestamping feature introduced in DMF 8.5.

Please refer to the Tunneling Between Data Centers section on using L2GRE tunnels in DMF.

11.7.8  Using the CLI Show Commands

PTP State Show Commands

Use the show switch switch name ptp info| masters | interface | local-clock command to obtain the PTP
state of the selected switch.

388



Advanced Policy Configuration

The show switch switch name ptp info command summarizes the switch's PTP state and the PTP
interfaces' status.

Controller# show switch eos ptp info
PTP Mode: Boundary Clock
PTP Profile: Default ( IEEE1588 )
Clock Identity: 0x2c:dd:e9:ff:ff:96:2b:ff
Grandmaster Clock Identity: 0x44:a8:42:ff:fe:34:fd:7e
Number of slave ports: 1
Number of master ports: 1
Slave port: Ethernet1
Offset From Master (nanoseconds): -128
Mean Path Delay (nanoseconds): 71
Steps Removed: 2
Skew (estimated local-to-master clock frequency ratio): 1.0000080070748882
Last Sync Time: 00:52:44 UTC Aug 09 2023
Current PTP System Time: 00:52:44 UTC Aug 09 2023
Interface       State        Transport    Delay
Mechanism
--------------- ------------ --------------- ---------
Et1 Slave        ipv4         e2e
Et47Master       ipv4         e2e

The show switch switch name ptp master command provides information about the PTP master and
grandmaster clocks.

Controller# show switch eos ptp master
Parent Clock:
Parent Clock Identity: 0x28:99:3a:ff:ff:21:81:d3
Parent Port Number: 10
Parent IP Address: N/A
Parent Two Step Flag: True
Observed Parent Offset (log variance): N/A
Observed Parent Clock Phase Change Rate: N/A

Grandmaster Clock:
Grandmaster Clock Identity: 0x44:a8:42:ff:fe:34:fd:7e
Grandmaster Clock Quality:
Class: 127
Accuracy: 0xfe
OffsetScaledLogVariance: 0x7060
Priority1: 120
Priority2: 128

The show switch switch name ptp interface interface name command provides the PTP
interface configuration and state on the device.

Controller# show switch eos ptp interface Ethernet1
Ethernet1
Interface Ethernet1
PTP: Enabled
Port state: Slave
Sync interval: 1.0 seconds
Announce interval: 2.0 seconds
Announce interval timeout multiplier: 3
Delay mechanism: end to end
Delay request message interval: 2.0 seconds
Transport mode: ipv4
Announce messages sent: 3
Announce messages received: 371
Sync messages sent: 4
Sync messages received: 739

389



 

Follow up messages sent: 3
Follow up messages received: 739
Delay request messages sent: 371
Delay request messages received: 0
Delay response messages sent: 0
Delay response messages received: 371
Peer delay request messages sent: 0
Peer delay request messages received: 0
Peer delay response messages sent: 0
Peer delay response messages received: 0
Peer delay response follow up messages sent: 0
Peer delay response follow up messages received: 0
Management messages sent: 0
Management messages received: 0
Signaling messages sent: 0
Signaling messages received: 0

The show switch switch name ptp local-clock command provides PTP local clock information.

Controller# show switch eos ptp local-clock
PTP Mode: Boundary Clock
Clock Identity: 0x2c:dd:e9:ff:ff:96:2b:ff
Clock Domain: 0
Number of PTP ports: 56
Priority1: 128
Priority2: 128
Clock Quality:
Class: 248
Accuracy: 0x30
OffsetScaledLogVariance: 0xffff
Offset From Master (nanoseconds): -146
Mean Path Delay: 83 nanoseconds
Steps Removed: 2
Skew: 1.0000081185368557
Last Sync Time: 01:01:41 UTC Aug 09 2023
Current PTP System Time: 01:01:41 UTC Aug 09 2023
        

Policy State Show Commands

Use the show policy command to view the timestamping status for a given policy.

> show policy
# Policy Name Action             Runtime Status Type       Priority Overlap
 Priority Push VLAN Filter BW Delivery BW Post Match Filter Traffic Delivery
 Traffic Services Installed Time Installed Duration Ptp Timestamping
-|-----------|------------------|--------------|----------|--------|----------
------|---------|---------|-----------|-------------------------|-------------
---|--------|--------------|------------------|----------------|
1 p1          unspecified action inactive       Configured 100      0          
      1         -         -           -                         -              
                                             True
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11.7.9  Configuration Validation Messages

In push-per-policy mode, a validation exception occurs if a policy uses NetFlow managed-service with
records-per-interface option and the same policy also uses timestamping. The following message appears:

Validation failed: Policy policy1 cannot have timestamping enabled along with
 header modifying netflow service. 
Netflow service netflow1 is configured with records-per-interface in push-per-
policy mode

In push-per-policy mode, a validation exception occurs if a policy uses the ipfix managed-service (using
a template with records-per-dmf-interface key) and the same policy also uses timestamping. The
following message appears:

Validation failed: Policy policy1 cannot have timestamping enabled along with
 header modifying ipfix service. 
Ipfix service ipfix1 is configured with records-per-dmf-interface in push-per-
policy mode

Only unicast source-ipv4-address or source-ipv6-address are allowed in the switch PTP config.

Examples of invalid ipv6 addresses: ff02::1, ff02::1a, ff02::d, ff02::5

Validation failed: Source IPv6 address must be a unicast address

Examples of invalid ipv4 addresses: 239.10.10.10, 239.255.255.255, 255.255.255.255

Validation failed: Source IPv4 address must be a unicast address

11.7.10  Troubleshooting

A policy programmed to use timestamping can fail for the following reasons:
1. The filter switch does not support syncing its hardware clock using PTP.
2. An unconfigured PTP interface or the interface is inactive.
3. The PTP switch configuration or PTP interface configuration is invalid or incomplete.
4. Configuring the PTP interface on a logical port (Lag or Tunnel).

Reasons for failure will be available in the runtime state of the policy and viewed using the show policy
policy name command.

As the Platform Compatibility Section describes, use the show switch all properties command to
confirm a switch supports the feature.

11.7.11  Limitations

The source MAC address of the user packet is re-written with a 48-bit timestamp value on the filter switch.
This action can exhibit the following behavior changes or limitations:
1. Dedup managed service will not work as expected. A high-precision timestamp can be different for

duplicate packet matching on two different filter interfaces. Thus, the dedup managed service will consider
this duplicate packet to be different in the L2 header. To circumvent this limitation, use an anchor/offset in
the dedup managed-service config to ignore the source MAC address.

2. Any Decap managed service except for decap-l3-mpls will remove the timestamp information header.
3. The user source MAC address is lost and unrecoverable when using this feature.
4. The rewrite-dst-mac feature cannot be used on the filter interface that is part of the policy using the

timestamping feature.
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5. In push-per-filter mode, if a user has src-mac match condition as part of their policy config, the traffic will
not be forwarded as expected and can get dropped at the core switch.

6. The in-port masking feature will be disabled for a policy using PTP timestamping.
7. Logical ports (Lag/Tunnel) as PTP interfaces are not allowed.

392



Appendix A

Stenographer Reference for DMF Recorder Node

This appendix provides information about composing Stenographer queries and submitting them through
REST API.

A.1  Stenographer Query Syntax

The DANZ Monitoring Fabric (DMF) Recorder Node accepts Stenographer queries using a syntax based
on the Berkeley Packet Filter (BPF) syntax. When entering a malformed BPF string, the recorder node will
respond with an error. The entire BPF grammar is not supported, but query strings can be composed using
the predicates in the following table.
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Table 14: Table 1: Supported Stenographer BPF Query Strings

BPF Predicate Value Description

before value time string before the specified time

before value m ago duration before value minutes ago

before value h ago duration before value hours ago

before value d ago duration before value days ago

before value w ago duration before value weeks ago

after value time string after the specified time

after value m ago duration after value minutes ago

after value h ago duration after value hours ago

vlan value VLAN ID match the specified VLAN tag
(outer, inner, or inner inner)

outer vlan value VLAN ID match the specified outer
VLAN tag

inner vlan value VLAN ID match the specified inner
VLAN tag (or middle tag of
triple-tagged packets)

inner vlan value VLAN ID match the specified innermost
VLAN tag of triple-tagged
packets

src mac value MAC address match the specified
MAC address in typical
colon-delimited form (e.g.
11:22:33:44:55)

dst mac value MAC address match the specified
MAC address in typical
colon-delimited form (e.g.
11:22:33:44:55)

mpls value MPLS label match the specified MPLS
label

src host value IPv4/v6 address match the specified source
address exactly

dst host value IPv4/v6 address match the specified
destination address exactly

src net value IPv4/v6 address match the specified source
address with an optional CIDR
mask. All octets of address
must be specified, e.g. good →
1.2.3.0/24, bad → 1.2.3/24

src net value mask value IPv4/v6 address match the specified source
address with masked with the
specified address
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BPF Predicate Value Description

dst net value IPv4/v6 address match the specified
destination address with an
optional CIDR mask. All octets
of address must be specified,
e.g. good → 1.2.3.0/24, bad →
1.2.3/24

dst net value mask value IPv4/v6 address match the specified
destination address with
masked with the specified
address

ip proto value protocol number match the specified IP protocol
number

icmp match ICMP packets (shortcut
for “ip proto 1”)

tcp match TCP packets (shortcut
for “ip proto 6”)

udp match UDP packets (shortcut
for “ip proto 17”)

src port value transport port number match the specified transport
port number

dst port value transport port number match the specified transport
port number

cid value Community ID match the provided
community ID in standard
version:base-64 encoded
form (e.g. 1:hO+sN4H
+MG5MY/8hIrXPqc4ZQz0=)

policy value DMF policy name match the forwarding VLAN(s)
of the specified DMF policy.
Only supported through the
DMF Controller. Not supported
when using a Recorder Node
REST API directly.

filter-interface value DMF filter interface name match the forwarding VLAN
of the specified filter interface.
Only supported through the
DMF Controller. Not supported
when using a Recorder Node
REST API directly.

event value Recorder Node event name match the time range of
the specified event. Only
supported through the DMF
Controller. Not sup- ported
when using a Recorder Node
REST API directly.

and logical “and”
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BPF Predicate Value Description

&& logical “and”

or logical “or”

|| logical “or”

( begin grouping

) end grouping

A.2  Example Stenographer Queries

Note:  Arista Networks recommends always using a specific time range in each query.

After two hours ago but before one hour ago, search for all packets to or from Google DNS (8.8.8.8).

(after 2h ago and before 1h ago) and (src host 8.8.8.8 or dst host 8.8.8.8)

In the last twenty-four hours, search for all SSH (TCP port 22) packets destined for IP 10.4.100.200.

Note:  This will not match any SSH packets from 10.4.100.200.

after 24h ago and dst host 10.4.100.200 and tcp and src port 22

Within the last five minutes, search for all packets to or from 10.1.1.100. And, in the five minutes before that,
search for all packets to or from 10.1.100.101.

(after 5m ago and (src host 10.1.1.100 or dst host 10.1.1.100)) or (after 10m
 ago and before 5m ago
and (src host 10.1.1.101 or dst host 10.1.1.101))

Within the timespan of event abc and within the last hour, search for all SSH (TCP port 22) packets destined
for IP 1.2.3.4.

(event abc or after 1h ago) and dst host 1.2.3.4 and tcp and dst port 22

Within the timespan defined by the intersection of events abc and def, search for all packets sent from any
IP in subnet 1.2.3.0/24 seen on filter interface xyz.

(event abc and event def) and filter-interface xyz and src net 1.2.3.0/24
.. note::
To use the filter-interface predicate, the DMF Controller must be in the push-
per-filter Auto
VLAN mode.

Within the last five minutes, search for all packets sent from IP 1.2.3.4 to the DANZ Monitoring Fabric (DMF)
Recorder Node using DMF policy abc.

after 5m ago and policy abc and src host 1.2.3.4
.. note::
To use the policy predicate the DMF Controller must be in the push-per-policy
 or push-per-
filter Auto VLAN mode. When in push-per-policy auto-vlan-mode, the policy's
 forwarding tag will
be queried. When in push-per-filter mode, the forwarding tags of the filter
 interfaces used in
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the policy are queried.

Within the last five minutes, search for all packets with any VLAN tag 100.

after 5m ago and vlan 100

Within the last five minutes, search for all packets with an outer VLAN tag 100.

after 5m ago and outer vlan 100

Within the last five minutes, search for all packets with an inner (or middle) VLAN tag 100.

after 5m ago and inner vlan 100

Within the last five minutes, search for all triple-tagged packets with innermost VLAN tag 100.

after 5m ago and inner inner vlan 100

Within the last five minutes, search for packets belonging to a flow with community ID of 1:hO+sN4H
+MG5MY/8hIrXPqc4ZQz0=.

after 5m ago and cid 1:hO+sN4H+MG5MY/8hIrXPqc4ZQz0=

This matches packets in each direction of the flow, if applicable.

Within the last five minutes, search for all L2 broadcast packets originating from MAC address
11:22:33:44:55:66.

after 5m ago and src mac 11:22:33:44:55:66 and dst mac ff:ff:ff:ff:ff:ff
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Appendix B

DMF Recorder Node REST API

The REST server is available over HTTPS on the default port (443) using either of the two authentication
methods supported:

• HTTP basic: The client presents a valid username and password for the Controller connected with
the Recorder. The DANZ Monitoring Fabric (DMF) Recorder Node verifies at the DMF Controller if the
provided username and password are valid and have sufficient privileges to use the Recorder REST API.

• Authentication tokens: The DMF Recorder Node REST API accepts revocable authentication tokens as an
alternative to HTTP basic. Valid authentication tokens are configured in the Controller and pushed down to
the DMF Recorder Node using a gentable. Any client with a valid authentication token can query the DMF
Recorder Node REST API without real-time consultation with the Controller.

Some APIs accept a Stenographer query string as input or return a Stenographer query string as output.
A Stenographer query string is a BPF-like syntax for defining the scope of a query. Packets that match
this scope are included in the query result or operation. For details about the Stenographer query syntax
supported by the DMF Recorder Node, refer to the Stenographer Reference for DMF Recorder Node. The
DMF Recorder Node provides a REST API so clients can look up packets and metadata. The REST server
runs securely (HTTPS) on TCP port 443.

B.1  Authentication

Clients must either authenticate using a valid DANZ Monitoring Fabric (DMF) Controller username and
password over HTTP Basic or with an authentication token configured on the DMF controller specifically for
DMF Recorder Node REST API authentication.

B.1.1  Basic HTTP Authentication

Use a valid DANZ Monitoring Fabric (DMF) Controller username and password to authenticate with a DMF
Recorder Node over its REST API. The recorder node delegates authentication to the DMF Controller. If the
username and password provided are valid, the recorder node authorizes the user for the invoked recorder
node REST endpoint.

In the following example, the query uses the HTTP Basic method of authentication:

$ curl https://1.2.3.4/query/window -u admin:12345 -k | python -m json.tool
% Total % Received % Xferd Average Speed Time Time Time Current
Dload Upload Total Spent Left Speed
100 79 100 79 0 0 143 0 --:--:-- --:--:-- --:--:-- 143
{
"begin": "2019-01-23 15:15:23 +0000 UTC",
"end": "2019-02-04 17:39:52 +0000 UTC"
}

In this example, the recorder node IP address is 1.2.3.4. The username on the DMF Controller is admin, and
the password is 12345.

B.1.2  Authentication with an Authentication Token

An authentication token is primarily designed for third-party applications and automation scripts where
creating an account or storing a username and password is undesirable. This method can also allow a DANZ
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Monitoring Fabric (DMF) Recorder Node access if the management network connection to the Controller
is disrupted.

To create an authentication token, log in to the DMF Controller associated with the recorder node, then
complete the following steps:
1. Change to config mode on the active DMF Controller.

controller-1# configure
controller-1(config)#

2. Define the authentication token using a unique name.

controller-1(config)# recorder-node auth token my-token
Auth : my-token
Token : the-secret-token

Note:  This name does not need to be secret. This example uses the name my-token.

The Controller generates a secret token for you (in this example, the-secret-token). Treat this token as
private. Anyone who presents it to the DMF Recorder Node can use the DMF Recorder Node REST APIs.

Note:  Only the non-reversible hash of this token is stored on the DMF Recorder Node and Controller.
There is no way to recover the token if it is lost. (See below for how to revoke the token if it is lost
or compromised.)

The Controller stores the token hash and the name assigned, viewable by entering the show running-
config recorder-node command, as in the following example:

controller-1(config)# show running-config recorder-node auth token
! recorder-node
recorder-node auth token my-token $2a$12$pXm62tl5rMD8c4vSrzU6X.DTjeoBmRUw
ZvTkvNXatsZ8TFb4PxanC

If the token is lost or compromised, remove it from the Controller, and the Controller will fail any attempt to
authenticate to the recorder using the token.

controller-1(config)# no recorder-node auth token my-token
controller-1(config)# show running-config recorder-node auth token
controller-1(config)#

The following example shows a query using the authentication token method. The authentication token is
defined in the HTTP request as the value of the cookie header.

$ curl https://1.2.3.4/query/inventory/window --header "Cookie:plaintext-
secret-auth-token" -k |
python
-m json.tool
% Total % Received % Xferd Average Speed Time Time Time Current
Dload Upload Total Spent Left Speed
100 79 100 79 0 0 83 0 --:--:-- --:--:-- --:--:-- 83
{
"begin": "2019-01-23 15:15:23 +0000 UTC",
"end": "2019-02-04 17:50:46 +0000 UTC"
}

In this example, the DMF Recorder Node IP address is 1.2.3.4. The authentication token has already been
generated on the DMF controller associated with the recorder node and is included in the cookie header as
plaintext-secret-auth-token.
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You must include the plaintext authentication token, not the token hash, saved in the controller running
configuration. If you do not know the plaintext token, revoke access for the token and generate a new one.
Note the plaintext value displayed after generating the new token.

B.2  DMF Recorder Node API Headers

The supported REST API HTTP header entries are listed in the following table.

Table 15: DANZ Monitoring Fabric (DMF) Recorder Node REST API HTTP Headers

Header Value Type Description

Steno-Limit-Bytes:value integer max number of bytes to accept
in a packet query response

Steno-Limit-Packets:value integer max number of packets to
accept in a packet query
response

Cookie:value string auth token to use in lieu of
HTTP basic auth

B.3  DMF Recorder Node REST APIs

The supported DANZ Monitoring Fabric (DMF) Recorder Node REST APIs are listed below.

B.3.1  Ready

/ready

• Description: Is the DANZ Monitoring Fabric (DMF) Recorder Node able to accept queries? Return payload
indicates progress towards start up completion.

• HTTP Method: GET
• Request Payload:
• Return MIME Type:
• Return Payload:

{
"current-value": <int>,
"max-value": <int>,
"percent-complete": <float>
}

• Return Status Code:

• 200, ready
• 503, not ready

B.3.2  Query Window

/query/window

• Description: Get timestamp of oldest and newest packet available for query.
• HTTP Method: GET
• Request Payload:
• Return MIME Type: application/json
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• Return Payload:

{
"begin" : <RFC-3339>,
"end" : <RFC-3339>
}

• Return Status Code:

• 200, success
• 400, input error
• 500, internal error
• 503, not ready

B.3.3  Query Size

/query/size

• Description: Get count and aggregate size of packets matching provided filter.
• HTTP Method: POST
• Request Payload: Stenographer query string
• Return MIME Type: application/json
• Return Payload:

{
"packet-count" : <int>,
"aggregate-size" : <int>
}

• Return Status Code:

• 200, success 400, input error
• 500, internal error
• 503, not ready

B.3.4  Query Application

/query/application

• Description: Perform DPI on packets matching provided filter. DPI is performed using nDPI.
• HTTP Method: POST
• Request Payload: Stenographer query string
• Return MIME Type: application/json
• Return Payload: Defined by nDPI
• Return Status Code:

• 200, success
• 400, input error
• 500, internal error
• 503, not ready

B.3.5  Query Packet

/query/packet

• Description: Download pcap of packets matching provided filter.
• HTTP Method: POST
• Request Payload: Stenographer query string
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• Return MIME Type: application/vnd.tcpdump.pcap
• Return Payload: .pcap file
• Return Status Code:

• 200, success
• 400, input error
• 500, internal error
• 503, not ready

B.3.6  Query Analysis Filter Stenographer Analysis Type

/query/analysis[filter="<stenographer-query-string>"][type ="<analysis-type>"]

• Description: Perform an analysis on the packets matching the stenographer query string. Supported values
for analysis-type are:

• analysis_http_tree
• analysis_http_stat
• analysis_http_req_tree
• analysis_http_srv_tree
• analysis_dns_tree
• analysis_hosts
• analysis_conv_ipv4
• analysis_conv_ipv6
• analysis_conv_tcp
• analysis_conv_udp
• analysis_rtp_streams
• analysis_sip_stat
• analysis_conv_sip
• analysis_tcp_packets
• analysis_tcp_flow_health

• HTTP Method: GET
• Request Payload:
• Return MIME Type: application/json
• Return Payload: Determined by the analysis type selected.
• Return Status Code:

• 200, success
• 400, input error
• 500, internal error
• 503, not ready

B.3.7  Query Replay Request Stenographer Real-time Boolean

/query/replay/request[filter="<stenographer-query-string>"][real-
time="<boolean>"]

• Description: Asynchronously request packets matching filter be replayed into the monitoring fabric. Replay
is performed using tcp replay.

• HTTP Method: POST
• Request Payload:
• Return MIME Type: application/json
• Return Payload:

{
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"id" : <int>,
"message": <string>
}

• Return Status Code:

• 200, success
• 400, input error
• 500, internal error
• 503, not ready

B.3.8  Query Replay Request Filter Stenographer Integer

/query/replay/request[filter="<stenographer-query-string>"][speed-mbps="<int>"]

• Description: Asynchronously request packets matching filter be replayed into the monitoring fabric. Replay
is performed using tcp replay.

• HTTP Method: POST
• Request Payload:
• Return MIME Type: application/json
• Return Payload:

{
"id" : <int>,
"message": <string>
}

• Return Status Code:

• 200, success
• 400, input error
• 500, internal error
• 503, not ready

B.3.9  Query Replay Done

/query/replay/done

• Description: Check the status of a replay matching the provided ID. Message contains replay result from
tcp replay.

• HTTP Method: POST
• Request Payload: Replay ID
• Return MIME Type: application/json
• Return Payload:

{
"id" : <int>,
"done" : <boolean>,
"message": <string>
}

• Return Status Code:

• 200, success
• 400, input error
• 404, replay ID unknown
• 406, replay not done
• 500, internal error
• 503, not ready
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B.3.10  Erase Packet Filter Stenographer Query String

/erase/packet[filter="<stenographer-query-string>"]

• Description: Erase packets matching the provided filter. Note that any packet not matching the filter but in
the same packet file of a packet matching the filter will also be deleted.

• HTTP Method: POST
• Request Payload:
• Return MIME Type: application/json
• Return Payload:

{
"bytes-erased" : <int>,
"message" : <string>
}

• Return Status Code:

• 200, success
• 400, input error
• 500, internal error
• 503, not ready

B.3.11  Event Update Trigger Boolean Name Integer

/event/update[trigger="<boolean>"][name="<string>"][pre-buffer-minutes="<int>"]

• Description: Trigger or terminate the named event. Set pre-buffer-minutes to 0 to use the available pre-
buffer.

• HTTP Method: POST
• Request Payload:
• Return MIME Type: application/json
• Return Payload:

{
"message" : <string>,
"event-queued" : <boolean>
}

• Return Status Code:

• 200, success
• 400, input error
• 500, internal error
• 503, not ready

B.3.12  Abort Query

/abort/query

• Description: Terminate a particular query defined by the provided Stenographer query string.
• HTTP Method: POST
• Request Payload:
• Return MIME Type: application/json
• Return Payload:

{
"message" : <string>
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}

• Return Status Code:

• 200, success
• 400, input error
• 500, internal error
• 503, not ready

B.3.13  Abort All Query

/abort-all/query

• Description: Terminate all running queries.
• HTTP Method: POST
• Request Payload:
• Return MIME Type: application/json
• Return Payload:

{
"message" : <string>
}

• Return Status Code:

• 200, success
• 400, input error
• 500, internal error
• 503, not ready

B.3.14  Queries

/queries

• Description: Determine the currently running queries, enumerated by the Stenographer query string of
the query.

• HTTP Method: GET
• Request Payload:
• Return MIME Type: application/json
• Return Payload:

{
"queries" : [
<stenographer-query-string>, ...
]
}

• Return Status Code:

• 200, success
• 400, input error
• 500, internal error
• 503, not ready

B.3.15  Status Query

/status/query
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• Description: Determine how far a given query has progressed. This can be used to estimate the time
remaining to run the query.

• HTTP Method: GET
• Request Payload:
• Return MIME Type: application/json
• Return Payload:

{
"query" : <stenographer-query-string>, "current-value" : <int>,
"max-value" : <int>, "percent-complete" : <float>
}

• Return Status Code:

• 200, success
• 400, input error
• 500, internal error
• 503, not ready

B.3.16  Status All

/status/all

• Description: Determine how far all queries have progressed. This can be used to estimate the time
remaining to run the queries.

• HTTP Method: GET
• Request Payload:
• Return MIME Type: application/json
• Return Payload:

{
"queries" : [
{
"query" : <stenographer-query-string>,
"current-value" : <int>,
"max-value" : <int>,
"percent-complete" : <float>
},
...
]
}

• • Return Status Code:

• 200, success
• 400, input error
• 500, internal error
• 503, not ready
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Appendix C

DMF Controller in Microsoft Azure (Beta Version)

The DANZ Monitoring Fabric (DMF) Controller in Azure feature supports the operation of the Arista Networks
DMF Controller on the Microsoft Azure platform and uses the Azure CLI or the Azure portal to launch the
Virtual Machine (VM) running the DMF Controller.
Figure C-1: Customer Azure Infrastructure

The DMF Controller in Azure feature enables the registration of VM deployments in Azure and supports
auto-firstboot using Azure userData or customData.
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C.1  Configuration

Configure Azure VMs auto-firstboot using customData or userData. There is no data merging from
these sources, so provide the data via customData or userData, but not both.

Arista Networks recommends using customData as it provides a better security posture because it is
available only during VM provisioning and requires sudo access to mount the virtual CDROM.

userData is less secure because it is available via Instance MetaData Service (IMDS) after provisioning and
can be queried from the VM without any authorization restrictions.

If sshKey is configured for the admin account during Azure VM provisioning along with auto-firstboot
parameters, then it is also configured for the admin user of DMF controllers.

The following table lists details of the firstboot parameters for the auto-firstboot configuration.

Firstboot Parameters - Required Parameters

Key Description Valid Values

admin_password This is the password to set for the admin user. When joining
an existing cluster node this will be the admin-password for the
existing cluster node.

string

recovery_password This is the password to set for the recovery user. string
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Additional Parameters

Key Description Required Valid Values Default Value

hostname This is the hostname to set
for the appliance.

no string configured from
Azure Instance
Metadata Service

cluster_name This is the name to set for the
cluster.

no string Azure-DMF-Cluster

cluster_to_join This is the IP which firstboot
will use to join an existing
cluster. Omitting this
parameter implies that the
firstboot will create a new
cluster.

Note:  If this
parameter is present
ntp-servers, cluster-
name, and cluster-
description will be
ignored. The existing
cluster node will
provide these values
after joining.

no IP Address
String

cluster_description This is the description to set
for the cluster.

no string
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Networking Parameters

Key Description Required Valid Values Default Value

ip_stack What IP protocols should
be set up for the appliance
management NIC.

no enum: ipv4,
ipv6, dual-
stack

ipv4

ipv4_method How to setup IPv4 for the
appliance management NIC.

no enum: auto,
manual

auto

ipv4_address The static IPv4 address
used for the appliance
management NIC.

only if ipv4-
method is set
to manual

IPv4 Address
String

ipv4_prefix_length The prefix length for the IPv4
address subnet to use for the
appliance management NIC.

only if ipv4-
method is set
to manual

0..32

ipv4_gateway The static IPv4 gateway
to use for the appliance
management NIC.

no IPv4 Address
String

ipv6_method How to set up IPv6 for the
appliance management NIC.

no enum: auto,
manual

auto

ipv6_address The static IPv6 address
to use for the appliance
management NIC.

only if ipv6-
method is set
to manual

IPv6 Address
String

ipv6_prefix_length The prefix length for the IPv6
address subnet to use for the
appliance management NIC.

only if ipv6-
method is set
to manual

0..128

ipv6_gateway The static IPv6 gateway
to use for the appliance
management NIC.

no IPv6 Address
String

dns_servers The DNS servers for the
cluster to use

no List of IP
address
strings

dns_search_domains The DNS search domains for
the cluster to use.

no List of the
host names
or FQDN
strings

ntp_servers The NTP servers for the
cluster to use.

no List of the host names of FQDN
strings

0.bigswitch.pool.ntp.org

1.bigswitch.pool.ntp.org

2.bigswitch.pool.ntp.org

3.bigswitch.pool.ntp.org
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Examples

{
    "admin_password": "admin_user_password",
    "recovery_password": "recovery_user_password"
}

Full List of Parameters

{
    "admin-password": "admin_user_password",
    "recovery_password": "recovery_user_password",
    "hostname": "hostname",
    "cluster_name": "cluster name",
    "cluster_description": "cluster description",
    "ip_stack": "dual-stack",
    "ipv4_method": "manual",
    "ipv4_address": "10.0.0.3",
    "ipv4_prefix-length": "24",
    "ipv4_gateway": "10.0.0.1",
    "ipv6_method": "manual",
    "ipv6_address": "be:ee::1",
    "ipv6_prefix-length": "64",
    "ipv6_gateway": "be:ee::100",
    "dns_servers": [
    "10.0.0.101",
    "10.0.0.102"
    ],
    "dns_search_domains": [
    "dns-search1.com",
    "dns-search2.com"
    ],
    "ntp_servers": [
    "1.ntp.server.com",
    "2.ntp.server.com"
    ]
}
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C.2  Limitations

The following limitations apply to the DANZ Monitoring Fabric (DMF) Controller in Microsoft Azure.

• There is no support for any features specific to Azure-optimized Ubuntu Linux, including
Accelerated Networking.

• The DMF controllers in Azure are only supported on Gen-1 VMs.
• The DMF controllers in Azure do not support adding the virtual IP address for the cluster.
• There is no support for capture interfaces in Azure.
• DMF ignores the Azure username and password fields.
• There is no support for static IP address assignment that differs from what is configured on the Azure NIC.
• The DMF controllers are rebooted if the static IP on the NIC is updated.

C.3  Resources

Please refer to the following resources for more information.

• Azure user data details: https://learn.microsoft.com/en-us/azure/virtual-machines/user-data
• Azure custom data details: https://learn.microsoft.com/en-us/azure/virtual-machines/custom-data
• Azure Gen1 vs Gen2 VMs: https://learn.microsoft.com/en-us/azure/virtual-machines/generation-2
• Azure optimized Ubuntu Linux features: https://ubuntu.com/blog/microsoft-and-canonical-increase-velocity-

with-azure-tailored-kernel
• Azure NIC assignment behavior: https://learn.microsoft.com/en-us/troubleshoot/azure/virtual-machines/

reset-network-interface-azure-linux-vm

C.4  Syslog Messages

• Azure DMF controller VMs can be accessed via an ssh login.
• systemctl should be in a running state without any failed units for controllers to be in a healthy state as

shown in the following example:

dmf-controller-0-vm> debug bash
admin@dmf-controller-0-vm:~$ sudo systemctl status
dmf-controller-0-vm
State: running
Jobs: 0 queued
Failed: 0 units
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C.5  Troubleshooting

• There are three possible failure modes:

• VM fails Azure registration.
• auto-firstboot fails due to a transient error or bug.
• auto-firstboot parameter validation fails.

• These failures can be debugged by accessing the firstboot logs, after manually booting the VM.
• Azure DMF Controller VMs can be accessed via ssh. Firstboot logs can be accessed using debug bash

as shown below:

dmf-controller-0-vm> debug bash
admin@dmf-controller-0-vm:~$ less /var/log/floodlight/firstboot/firstboot
.log

• For debugging parameter validation errors, access the parameter validation results using debug bash as
shown below:

dmf-controller-0-vm> debug bash
admin@dmf-controller-0-vm:~$ less /var/lib/floodlight/firstboot/validation-
results.json
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Appendix D

Telemetry Collector

A DANZ Monitoring Fabric (DMF) consists of a pair of Controllers, switches, and managed appliances. The
Telemetry Collector feature centrally retrieves the infrastructure metrics (interface counters, CPU usage, etc.)
associated with all these devices from the controllers using its REST API.

Deployment

Figure D-1: DMF Deployment

The diagram above shows a DMF deployment with an Active/Standby Controller cluster. In this environment,
each Controller collects metrics from all the devices it manages and the controller nodes. Each Controller
establishes a gNMI connection to all the devices and the other Controller in a fabric to collect telemetry
streams. gNMI is a gRPC-based protocol to configure and access states on network devices. The REST API
exposes this information in the /api/v1/data/controller/telemetry/data subtree. The Controller
exposes several metrics about CPU, memory, disk utilization, interface counters, and sensor states of
all devices in a fabric. All metrics are fetched at a 10-second frequency except those associated with the
sensors, which are collected every minute.
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Configuration

No additional configuration is necessary on the DMF Controller to enable the metric collection. However, to
read these metrics, the user must be an admin user or configured with the privilege, category:TELEMETRY.
To set the telemetry permission for a custom group and associate the user with this group, use the
following commands:

dmf-controller(config)# group group_name
dmf-controller(config)# permission category:TELEMETRY privilege read-only
dmf-controller(config)# associate user username 

Connection Status

The Controller uses the gNMI protocol to collect telemetry data from all devices. DMF reports the status of
these connections in both the REST API and the CLI.

REST API

The REST API subtree /api/v1/data/controller/telemetry/connection reports the telemetry
connection state. The API Schema browser of the GUI provides more details.

CLI

The following show commands display the connection details. All these commands support filtering the output
with a device name.

show telemetry connection device-name | all 
show telemetry connection device-name | all details
show telemetry connection device-name | all last-failure

The show telemetry connection device-name all command shows the state and the latest state
change of the connection between the Controller and the devices.

dmf-controller# show telemetry connection all
# Name                         State Last state change              
-|----------------------------|-----|------------------------------|
1 c2                           ready 2023-11-10 13:10:02.718000 UTC
2 core2                        ready 2023-11-10 13:22:56.311000 UTC
<snip>

The show telemetry connection device-name all command displays the state and the latest state
change of the connection between the Controller and the devices.

dmf-controller# show telemetry connection all details 
# Name  State Last state change              Target              Connection type Last message time              
-|-----|-----|------------------------------|-------------------|---------------|------------------------------|
1 core2 ready 2023-11-10 13:22:56.311000 UTC 10.243.255.102:6030 clear-text      2023-11-10 13:59:35.437000 UTC
<snip>

The show telemetry connection device-name all last-failure command displays more
details about a connection failure. The time of the latest failure and the potential reason appear in the
output. If the connection is still in the failed state, this output also shows when the next reconnection will
be attempted.

dmf-controller# show telemetry connection all last-failure 
# Name  Fail time                      Fail type       Root cause              
  Next retry in 
-|-----|------------------------------|---------------|----------------------
---|-------------|
1 core2 2023-11-10 13:19:34.237000 UTC unavailable     UNAVAILABLE: io
 exception 0
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<snip>

Limitations

• Software interfaces (for example, loopback, bond, and management) do not report counters for broadcast
and unicast packets.

• The reported interface names are the raw physical interface name (e.g., et1) rather than the user-
configured name associated with the role of an interface (e.g., filter1).

• Resetting the interface counter does not affect the counter values stored at the /telemetry/data path.
The value monotonically increases and corresponds to the total count since the device was last powered
up. This value only gets reset when rebooting the device.

Usage Notes

• DMF uses the configured name of a managed device (e.g., switch, recorder node, etc.) on the Controller
as the value of the key name for the node device for all the metrics corresponding to it. In the case of a
Controller, DMF uses the configured hostname as the key. Thus, these names must be unique in a specific
DMF deployment.

• The possibility exists that metrics are not collected from a device for a short period. This data gap may
happen when rebooting the device or when the Controllers experience a failover event.

• If the gNMI connection between the Controller and the device is interrupted, the Controller attempts a new
connection after 2 minutes. The retry timeout for a subsequent connection attempt increases exponentially
and can go up to 120 minutes. Upon a successful reconnection, this timeout value resets to 2 minutes.

• There might be gNMI warning messages in the floodlight log during certain events, e.g., when first adding
a device or it is reloading. Ignore these messages.

• This feature enables an OpenConfig agent on switches running EOS to collect telemetry.
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Telemetry Availability

As a DMF fabric consists of different types of devices, the metrics of each vary. The following outlines the
metrics collected from each device type by the Controller and typically made available over its REST API.
However, some specific platforms or hardware might not report a particular metric. For brevity, the following
list mentions the leaves that can correspond to a metric. For more details, use the API Schema browser of
the GUI.

telemetry
+-- data
     +-- device
         +-- interface
         |  +-- oper-status                Ctrl, SWL, EOS, SN, RN
         |  +-- counters
         |     +-- in-octets               Ctrl, SWL, EOS, SN, RN
         |     +-- in-pkts                 Ctrl, SWL, EOS, SN, RN
         |     +-- in-unicast-pkts         Ctrl, SWL, EOS, SN, RN
         |     +-- in-broadcast-pkts       Ctrl, SWL, EOS, SN, RN
         |     +-- in-multicast-pkts       Ctrl, SWL, EOS, SN, RN
         |     +-- in-discards             Ctrl, SWL, EOS, SN, RN
         |     +-- in-errors               Ctrl, SWL, EOS, SN, RN
         |     +-- in-fcs-errors           Ctrl, SWL, EOS, SN, RN
         |     +-- out-octets              Ctrl, SWL, EOS, SN, RN
         |     +-- out-pkts                Ctrl, SWL, EOS, SN, RN
         |     +-- out-unicast-pkts        Ctrl, SWL, EOS, SN, RN
         |     +-- out-broadcast-pkts      Ctrl, SWL, EOS, SN, RN
         |     +-- out-multicast-pkts      Ctrl, SWL, EOS, SN, RN
         |     +-- out-discards            Ctrl, SWL, EOS, SN, RN
         |     +-- out-errors              Ctrl, SWL, EOS, SN, RN
         +-- cpu
         |  +-- utilization                Ctrl, SWL, EOS, SN, RN
         +-- memory
         |  +-- total                      Ctrl, SWL, SN, RN
         |  +-- available                  Ctrl, SWL, EOS, SN, RN
         |  +-- utilized                   Ctrl, SWL, EOS, SN, RN
         +-- sensor
         |  +-- fan
         |  |  +-- oper-status             Ctrl, SWL, EOS, SN, RN
         |  |  +-- rpm                     Ctrl, SWL, EOS, SN, RN
         |  |  +-- speed                   SWL
         |  +-- power-supply
         |  |  +-- oper-status             Ctrl, SWL, EOS, SN, RN
         |  |  +-- capacity                EOS
         |  |  +-- input-current           Ctrl, SWL, EOS, SN, RN
         |  |  +-- output-current          SWL, EOS
         |  |  +-- input-voltage           Ctrl, SWL, EOS, SN, RN
         |  |  +-- output-voltage          SWL, EOS
         |  |  +-- input-power             Ctrl, SWL, SN, RN
         |  |  +-- output-power            SWL, EOS
         |  +-- thermal
         |     +-- oper-status             Ctrl, SWL, SN, RN
         |     +-- temperature             Ctrl, SWL, EOS, SN, RN
         +-- mount-point
         |  +-- size                       Ctrl, SWL, SN, RN
         |  +-- available                  Ctrl, SWL, SN, RN
         |  +-- utilized                   Ctrl, SWL, SN, RN
         |  +-- usage-percentage           Ctrl, SWL, SN, RN
         +-- control-group
         +-- memory                     Ctrl, SWL, SN, RN
         +-- cpu                        Ctrl, SWL, SN, RN
            
* Ctrl = Controller, SWL = A switch running SwichLight OS, 
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EOS = A switch running Arista EOS, SN = Service Node, RN = Recorder Node
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Appendix E

Configuring Third-party Services

E.1  Services in the DANZ Monitoring Fabric

Services in the DANZ Monitoring Fabric (DMF) refer to packet modification operations provided by third-party
network packet brokers (NPBs), referred to as service nodes. Services can include operations that refine or
modify the data stream delivered to analysis tools.

Each service instance is assigned a numeric identifier because multiple services can be specified for a given
policy. Services are applied sequentially, applying a service with a lower sequence number first.

Service nodes are optional devices that process interesting traffic before forwarding it to the delivery
ports specified by the policy. Example services include time-stamping packets, packet slicing, or payload
obfuscation. To configure a service node:

• Create all the pre-service and post-service interfaces used with the service.
• Use the DMF interface names to create a service node and add pre-service and post-service interfaces.
Figure E-1: Using Services with a Policy

In the figure above, the time-stamping service is applied first, followed by the packet-slicing service. The
illustration shows the CLI commands that associate the service with a specific policy. For the illustrated policy,
the packet path is as follows:
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1. Filter interface (F3)
2. Time-stamping service node (pre-service and post-service interfaces)
3. (optional) Packet-slicing service node (pre-service and post-service interfaces)
4. Delivery-interface (D2)

Once a policy includes a service, it is only optional if defined explicitly as optional. If not defined as optional
in the policy, packet forwarding does not occur when the service is unavailable. For example, configuring
the packet-slicing service as optional and a pre-service or post-service interface assigned to that service
node is down, the service is skipped, and the packets are delivered to the D2 delivery interface after the time-
stamping service is completed. However, if at least one pre-service and post-service interface is unavailable
for the time-stamping service, this policy does not forward packets to the delivery interfaces.

Configure all the service interfaces before you create a service definition that uses them.

Note:  Before defining a service, first create the service interface names. Otherwise, the service
might enter an inconsistent state. If that happens, delete the service definition, create the interfaces,
and then re-create the service definition. Alternatively, re-create the service definition without the
nonexistent interfaces.

A DMF service can have multiple pre-service and post-service interfaces. Use a Link Access Group (LAG) as
a pre-service or a post-service interface.

Note:  Arista Networks strongly recommends configuring the post-service and pre-service interfaces
on the same switch for any DMF service.

E.1.1  Using the GUI to Configure a DMF Unmanaged Service

To create a DANZ Monitoring Fabric (DMF) unmanaged service, perform the following steps:
1. Select Monitoring > Services.

The system displays the following table:
Figure E-2: DMF Unmanaged Service

This table lists the services configured for the DANZ Monitoring Fabric and lets you add, delete, or modify
existing services.

2. To create a new service, click the provision control (+) in the table.
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The system displays the following dialog:
Figure E-3: Create Service Dialog: Info

3. Type a unique name for the service and optional text description, then click Next.
The system displays the following dialog:
Figure E-4: Create Service Dialog: Pre-service Interfaces

This table lists the interfaces assigned as pre-service interfaces for the current service.
4. To add a pre-service interface, click the provision control (+) in the table.

The system displays the following dialog:
Figure E-5: Select Pre-service Interfaces

This table lists the interfaces available for assignment as pre-service interfaces. To configure a
new interface, click the provision control (+) in the table. The system displays a dialog for adding a
service interface.
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5. Enable the checkbox for one or more interfaces to assign as a pre-service interface for the current service
and click Append Selected.

6. On page two of the Create Service Interface dialog, click Next.
The system displays the following dialog:
Figure E-6: Create Service Dialog: Post-service Interfaces

This table lists the interfaces assigned as post-service interfaces for the current service.
7. To add a post-service interface, click the provision control (+) in the table.

The system displays the following dialog.
Figure E-7: Select Post-service Interfaces

This table lists the interfaces available for assignment as post-service interfaces.

To configure a new interface, click the provision control (+) in the table. The system displays a dialog for
adding a service interface, as described in the Configuring DMF Unmanaged Services section.

8. Enable the checkbox for one or more interfaces to assign as a post-service interface for the current service
and click Append Selected.

9. Click Save on page three of the Create Service Dialog.

E.1.2  Using the CLI to Configure a DMF Unmanaged Service

In the DANZ Monitoring Fabric (DMF), third-party tools that provide packet manipulation services, such as
time stamping and packet slicing, are called DMF Unmanaged Services. These optional devices process
traffic from filter interfaces before being forwarded to delivery interfaces.

Note:  After adding a service to a policy, it is no longer optional unless you define it as optional. If not
defined as optional, the policy does not forward packets if the service is unavailable.

To configure an unmanaged service using the CLI, complete the following steps:
1. Create one or more pre-service interfaces for delivering traffic to the NPB, as in the following example.

controller-1(config-switch-if)# switch DMF-CORE-SWITCH
controller-1(config-switch-if)# interface s9-eth1
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controller-1(config-switch-if)# role service interface-name pre-serv-intf-1

2. Create one or more post-service interfaces for receiving traffic from the NPB, as in the following example:

controller-1(config-switch-if)# interface s9-eth2
controller-1(config-switch-if)# role service interface-name post-serv-intf-1

3. Create a service node and add at least one pre-service and at least one post-service interface using the
DMF interface names, as in the following example:

controller-1(config)#controller-1(config)# unmanaged-service THIRD-PARTY-S
ERVICE-1
controller-1(config-unmanaged-srv)# description "this is a third-party
 unmanaged service"
controller-1(config-unmanaged-srv)# pre-service PRE-SERVICE-INTF-1
controller-1(config-unmanaged-srv)# post-service POST-SERVICE-INTF-1

To list the configured services in the DMF fabric, enter the show unmanaged-services command, as in the
following example:
controller-1# show unmanaged-service
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Services ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# Service Name          Max from service bandwidth bps Max to service bandwidth bps Total from service bps Total to service bps
-|---------------------|------------------------------|----------------------------|----------------------|--------------------|
1 THIRD-PARTY-SERVICE-1 10Gbps                         10Gbps                       -                      -
~~~~~~~ Post-groups of Service Names ~~~~~~~
# Service Name          Dmf name
-|---------------------|-------------------|
1 THIRD-PARTY-SERVICE-1 POST-SERVICE-INTF-1
~~~~~~~ Pre-groups of Service Names ~~~~~~~
# Service Name          Dmf name
-|---------------------|------------------|
1 THIRD-PARTY-SERVICE-1 PRE-SERVICE-INTF-1

To display information about a service, specify the service name, as in the following example:
controller-1 # show unmanaged-service THIRD-PARTY-SERVICE-1
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Services ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
# Service Name          Max from service bandwidth bps Max to service bandwidth bps Total from service bps Total to service bps
-|---------------------|------------------------------|----------------------------|----------------------|--------------------|
1 THIRD-PARTY-SERVICE-1 10Gbps                         10Gbps                       -                      -
~~~~~~~ Post-groups of Service Names ~~~~~~~
# Service Name          Dmf name
-|---------------------|-------------------|
1 THIRD-PARTY-SERVICE-1 POST-SERVICE-INTF-1
~~~~~~~ Pre-groups of Service Names ~~~~~~~
# Service Name SERVICE-1 PRE-SERVICE-INTF-1
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E.2  Service Insertion and Chaining in a DMF Policy

To configure a DANZ Monitoring Fabric (DMF) policy that uses services provided by an NPB, add the use-
service command to the policy. Services can be configured in series, called chaining, as shown below:
Figure E-8: Service Insertion and Chaining

Because a given policy can specify multiple services, set a sequence number for each service instance so the
services are applied in order for the policy traffic. A lower sequence number applies the service first.

To configure a DMF out-of-band policy that uses services provided by an NPB, use the use-service
command from the config-policy submode to add the service to the policy.

The following are the configuration commands for implementing the illustrated example:

controller-1(config)# policy DMF-POLICY-1
controller-1(config-policy)# use-service UMS-DEDUPLICATE-1 sequence 100
controller-1(config-policy)# use-service UMS-TIMESTAMP-1 sequence 101

In this example, the packet deduplication service is applied first, followed by time stamping. If all the pre-
service or post-service interfaces for the packet-slicing service nodes are down, then this service is skipped if
configured as optional. In this example, the time-stamping service is applied before the packet deduplication
service, and the packet deduplication service is configured as optional.

controller-1(config)# policy DMF-POLICY-1
controller-1(config-policy)# use-service UMS-TIMESTAMP-1 sequence 100
controller-1(config-policy)# use-service UMS-DEDUPLICATE-1 sequence 101
 optional
.. note::
If a service is inserted, the policy can only become active and begin
 forwarding when at
least one delivery port is reachable from all the post-service interfaces
 defined for the service.

Enter the show policy command from any mode to display the run time services being applied.
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Appendix F

References

F.1  Related Documents

The following documentation is available for DANZ Monitoring Fabric:

• DANZ Monitoring Fabric Release Notes
• DANZ Monitoring Fabric User Guide
• DANZ Monitoring Fabric Deployment Guide
• DANZ Monitoring Fabric Hardware Compatibility List
• DANZ Monitoring Fabric Hardware Guide
• DANZ Monitoring Fabric Verified Scale Guide
• DANZ Monitoring Fabric REST API Guide
• DANZ Monitoring Fabric SNMP MIB Reference Guide
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